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Notice:
OMRON products are manufactured for use according to proper procedures by a qualified operator
and only for the purposes described in this manual.

The following conventions are used to indicate and classify precautions in this manual. Always heed
the information provided with them. Failure to heed precautions can result in injury to people or dam-
age to the product.

!DANGER Indicates information that, if not heeded, is likely to result in loss of life or serious injury.
Additionally, there may be severe property damage.

!WARNING Indicates information that, if not heeded, could possibly result in loss of life or serious
injury. Additionally, there may be severe property damage.

!Caution Indicates information that, if not heeded, could result in relatively serious or minor injury,
damage to the product, or faulty operation.

OMRON Product References
All OMRON products are capitalized in this manual. The word “Unit” is also capitalized when it refers to
an OMRON product, regardless of whether or not it appears in the proper name of the product.

The abbreviation “Ch,” which appears in some displays and on some OMRON products, often means
“word” and is abbreviated “Wd” in documentation in this sense.

The abbreviation “PLC” means Programmable Controller and the abbreviation “PC” means personal
computer and are not used as abbreviations for anything else.

The abbreviation “PMSU” means Protocol Macro Support Unit and refers to the Communications
Board for the C200HX/HG/HE, Serial Communications Board for the CS, and Serial Communications
Units for the CS/CJ.

Visual Aids
The following headings appear in the left column of the manual to help you locate different types of
information.

Note Indicates information of particular interest for efficient and convenient opera-
tion of the product.

1,2,3... 1. Indicates lists of one sort or another, such as procedures, checklists, etc.
v
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About this Manual:
The CX-Protocol is Support Software for the protocol macro functionality. This manual describes the
installation and operation of the CX-Protocol and includes the sections described below. 
This manual is intended for the following personnel:

Personnel in charge of installing FA devices
Personnel designing FA systems
Personnel managing FA facilities

Name Cat. No. Contents

CXONE-AL@@D-V4
CX-Protocol 
Operation Manual 

W344
(this manual)

Describes the use of the CX-Protocol to create protocol macros 
as communications sequences to communicate with external 
devices. (This manual)

CXONE-AL@@D-V4/LT@@@-V4
CX-One Setup Manual 

W463 Installation and overview of CX-One FA Integrated Tool Pack-
age.

Sysmac Studio Version 1 
Operation Manual

W504 Describes the procedures and operations of the Sysmac Studio, 
including operations for functions, function blocks, and struc-
tured text programming.

SYSMAC CS/CJ Series 
CS1W-SCB@1-V1, CS1W-SCU@1-V1
CJ1W-SCU@1-V1, CJ1W-SCU@2
Serial Communications Boards and Serial 
Communications Unit Operation Manual

W336 Describes the use of Serial Communications Unit and Boards to 
perform serial communications with external devices, including 
the usage of standard system protocols for OMRON products.

SYSMAC CS/CJ/CP/NSJ Series 
CS1G/H-CPU@@H
CS1G/H-CPU@@-EV1
CS1D-CPU@@HA
CS1D-CPU@@SA
CS1D-CPU@@P
CS1D-CPU@@H
CS1D-CPU@@S
CS1W-SCU@@-V1
CS1W-SCB@@-V1
CJ2H-CPU6@-EIP
CJ2H-CPU6@
CJ2M-CPU1@
CJ2M-CPU3@
CJ1H-CPU@@H-R
CJ1G/H-CPU@@H
CJ1G-CPU@@P
CJ1G-CPU@@
CJ1M-CPU@@
CJ1W-SCU@@-V1
CP1L-M/L@@@-@
CP1H-X@@@@-@
CP1H-XA@@@@-@
CP1H-Y@@@@-@
CP1E-E@@D@-@
CP1E-N@@D@-@
NSJ@-@@@@(B)-G5D
NSJ@-@@@@(B)-M3D
Communications Commands Reference 
Manual

W342 Describes the C-series (Host Link) and FINS communications 
commands used with CS/CJ/CP-series PLCs and NSJ-series 
Controllers.

SYSMAC CJ Series
CJ2H-CPU6@-EIP
CJ2H-CPU6@
CJ2M-CPU1@
CJ2M-CPU3@
Programmable Controllers
Hardware User's Manual

W472 Provides an outline of and describes the design, installation, 
maintenance, and other basic operations for the CJ-series CJ2 
CPU Units.
The following information is included:
Overview and features
System configuration
Installation and wiring
Troubleshooting
Use this manual together with the W473.

SYSMAC CJ Series
CJ2H-CPU6@-EIP
CJ2H-CPU6@
CJ2M-CPU1@
CJ2M-CPU3@
Programmable Controllers
Software User's Manual

W473 Describes programming and other methods to use the functions 
of the CJ2 CPU Units.
The following information is included:
CPU Unit operation
Internal memory areas
Programming
Tasks
CPU Unit built-in functions
Use this manual together with the W472.
xi



SYSMAC CS Series 
CS1G/H-CPU@@H
Programmable Controllers 
Operation Manual

W339 Describes the installation and operation of the CS-series PLCs.

SYSMAC CJ Series 
CJ1H-CPU@@H-R, CJ1G/H-CPU@@H, 
CJ1G-CPU@@P, 
CJ1G-CPU@@, CJ1M-CPU@@
Programmable Controllers 
Operation Manual

W393 Describes the installation and operation of the CJ-series PLCs.

SYSMAC CS/CJ/NSJ Series 
CS1G/H-CPU@@H, CS1G/H-CPU@@-
EV1, CS1D-CPU@@HA, CS1D-
CPU@@SA, CS1D-CPU@@P, CS1D-
CPU@@H, CS1D-CPU@@S, CJ1H-
CPU@@H-R, CJ1G/H-CPU@@H, CJ1G-
CPU@@P, CJ1G-CPU@@, CJ1M-
CPU@@, NSJ@-@@@@(B)-G5D
NSJ@-@@@@(B)-M3D
Programmable Controllers 
Programming Manual

W394 Describes programming and other methods to use the functions 
of the CS/CJ/NSJ-series PLCs.
The following information is included:
• Programming
• Tasks
• File memory
• Other functions
Use this manual in combination with the SYSMAC CS Series 
Operation Manual (W339) or SYSMAC CJ Series Operation 
Manual (W393).

SYSMAC CS/CJ Series
CS1G/H-CPU@@-EV1, 
CS1G/H-CPU@@H, CS1D-CPU@@HA, 
CS1D-CPU@@SA, CS1D-CPU@@P,
CS1D-CPU@@H, CS1D-CPU@@S,
CJ2H-CPU6@-EIP, CJ2H-CPU6@, 
CJ2M-CPU1@, CJ2M-CPU3@
CJ1H-CPU@@H-R
CJ1G-CPU@@, CJ1G/H-CPU@@H,
CJ1G-CPU@@P, CJ1M-CPU@@
SYSMAC One NSJ Series
NSJ@-@@@@(B)-G5D
NSJ@-@@@@(B)-M3D
Programmable Controllers
Instructions Reference Manual

W474 Describes the ladder diagram programming instructions sup-
ported by CS/CJ-series or NSJ-series PLCs.
When programming, use this manual together with the Opera-
tion Manual or Hardware User's Manual (CS1: W339, CJ1: 
W393,or CJ2:W472) and Programming Manual or  Software 
User's Manual (CS1/CJ1:W394 or CJ2:W473).

SYSMAC CP Series 
CP1H-X@@@@-@
CP1H-XA@@@@-@
CP1H-Y@@@@-@
CP1H CPU Unit Operation Manual

W450 Provides the following information on the CP Series:
• Overview/Features
• System configuration
• Mounting and wiring
• I/O memory allocation
• Troubleshooting
Use this manual together with the CP1H Programmable Control-
lers Programming Manual (W451). 

NSJ Series
NSJ5-TQ@@(B)-G5D, NSJ5-SQ@@(B)-
G5D, NSJ8-TV@@(B)-G5D, NSJ10-
TV@@(B)-G5D, NSJ12-TS@@(B)-G5D, 
NSJ5-TQ@@(B)-M3D, NSJ5-SQ@@(B)-
M3D, NSJ8-TV@@(B)-M3D, NSJW-
ETN21, NSJW-CLK21-V1, NSJW-IC101
Operation Manual

W452 Provides the following information about the NSJ-series NSJ 
Controllers:
Overview and features
Designing the system configuration
Installation and wiring
I/O memory allocations
Troubleshooting and maintenance
Use this manual in combination with the following manuals: 
SYSMAC CS Series Operation Manual (W339), SYSMAC CJ 
Series Operation Manual (W393), SYSMAC CS/CJ Series Pro-
gramming Manual (W394), and NS-V1/-V2 Series Setup Manual 
(V083)

SYSMAC CP Series 
CP1H-X40D@-@
CP1H-XA40D@-@
CP1H-Y20DT-D
CP1L-L14D@-@
CP1L-L20D@-@
CP1L-M30D@-@
CP1L-M40D@-@
CP1H and CP1L CPU Unit Programming 
Manual

W451 Provides the following information on the CP Series:
• Programming instructions
• Programming methods
• Tasks
• File memory
• Functions
Use this manual together with the CP Series CP1H CPU Units 
Operation Manual (W450) and CP Series CP1L CPU Units 
Operation Manual (W462)

CXONE-AL@@D-V4
CX-Programmer 
Operation Manual

W446 Provides information on how to use the CX-Programmer, a pro-
gramming device that supports the CS/CJ-series PLCs, and the 
CX-Net contained within CX-Programmer.
xii



SYSMAC CS/CJ Series 
CQM1H-PRO-E1
C200H-PRO27-E, CQM1-PRO01-E
Programming Consoles 
Operation Manual 

W341 Provides information on how to program and operate 
CS/CJ-series PLCs using a Programming Console.

!WARNING Failure to read and understand the information provided in this manual may result in per-
sonal injury or death, damage to the product, or product failure. Please read each section
in its entirety and be sure you understand the information provided in the section and
related sections before attempting any of the procedures or operations given.
xiii



Please read this manual carefully and be sure you understand the information provided before
attempting to install and/or operate the CX-Protocol. Be sure to read the precautions provided in
the following section.

Section 1 Introduction outlines the Protocol Macro function and the CX-Protocol.

Section 2 Environment/Installing/Uninstalling/Starting/Editing outlines the functions of CX-Proto-
col and describes the operating environment, installation procedure, and the setting of the usage envi-
ronment.

Section 3 Protocol Macro describes details of the protocol macro functions.

Section 4 Using the Protocol Macro Function describes various precautions in using the protocol
macro function.

Section 5 Object Creation describes how to create objects, such as projects, protocols, sequences,
steps, messages, and matrices.

Section 6 Project and Protocol Editing describes details of the editing of projects and protocols.

Section 7 Sequence Setting and Editing describes details of the setting and editing of sequences.

Section 8 Step Setting and Editing describes details of the setting and editing of steps.

Section 9 Setting and Editing Messages and Matrix Lists describes details of the setting and edit-
ing of messages and matrix lists.

Section 10 Communications PLC Setup and Online Connections describes details of the commu-
nications settings and online connections.

Section 11 Protocol Data Transferring and Printing describes details of the transferring, converting,
and printing of protocol data.

Section 12 Tracing and Monitoring describes details of PLC memory area monitoring and the trans-
mission line tracing.

Section 13 Error and Error Log Display describes details of the displaying of errors and the error
log.

Section 14 Troubleshooting lists the error messages and describes their causes and remedies.

Section 15 Help describes the online help services.

Appendix A Creating the Protocol Applications shows some examples of data transmission
between personal computers using the protocol macro function.

Appendix B PLC Setup and PMSU Settings provides the settings for the PLC Setup and PMSU.

Appendix C Wiring RS-232C Cable Connectors describes how to wire RS-232C connectors.
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The CS Series, CJ Series, NSJ Series, and CP Series are subdivided as shown below.

  

CS1H-CPU@@H 
CS1G-CPU@@H  

CS1-H CPU Units  

CS Series  

CS1 CPU Units  

CS1H-CPU@@(-V1) 
CS1G-CPU@@(-V1)  

CS1D CPU Units  

CS1D CPU Units for 
Duplex Systems  

CS1D-CPU@@H
CS1D-CPU@@HA 

CS1D CPU Units for 
Simplex Systems  

CS1D-CPU@@S
CS1D-CPU@@SA 

CS1D Process-control CPU Units  

CS1D-CPU@@P 

CS-series Basic I/O Units  

CS-series Special I/O Units  

CS-series CPU Bus Units  

CS-series Power Supply Units 
Note: A special Power Supply Unit must 

be used for CS1D CPU Units.  

CS/CJ/NSJ/CP Series  

CP Series  

CP1H CPU Units  

CP1H-X@@@@-@ 
CP1H-XA@@@@-@  
CP1H-Y@@@@-@  

CPM1A-series Expansion I/O Units  

CPM1A-series Expansion Units   

CJ-series Special I/O Units  

CJ-series CPU Bus Units  

NSJ Series 

NSJ Controllers 

NSJ5-TQ@@(B)-G5D 
NSJ5-SQ@@(B)-G5D  
NSJ8-TV@@(B)-G5D 
NSJ10-TV@@(B)-G5D 
NSJ12-TS@@(B)-G5D 

NSJ Controllers 

NSJ5-TQ@@(B)-M3D 
NSJ5-SQ@@(B)-M3D 
NSJ8-TV@@(B)-M3D 

NSJ-series Expansion Units 

CJ-series Power Supply Units  

CJ-series CPU Bus Units  

CJ-series Special I/O Units  

CJ-series Basic I/O Units  

CJ1G-CPU@@ 

CJ1 CPU Units  

CJ1M CPU Units  

CJ1M-CPU@@ 

CJ2H CPU Units 

CJ2H-CPU6@-EIP 
CJ2H-CPU6@ 

CJ1H-CPU@@H-R 
CJ1H-CPU@@H  
CJ1G-CPU@@H  
CJ1G -CPU@@P  
(Loop-control CPU Units)  

CJ1-H CPU Units  

CJ1 CPU Units 

CJ2 CPU Units 

CJ Series  

CJ2M CPU Units 

CJ2M-CPU3@
CJ2M-CPU1@
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Terms and Conditions Agreement

WARRANTY
• The warranty period for the Software is one year from the date of purchase, unless otherwise specif-

ically agreed.
• If the User discovers defect of the Software (substantial non-conformity with the manual), and return

it to OMRON within the above warranty period, OMRON will replace the Software without charge by
offering media or download from OMRON’s website. And if the User discovers defect of media which
is attributable to OMRON and return it to OMRON within the above warranty period, OMRON will
replace defective media without charge. If OMRON is unable to replace defective media or correct
the Software, the liability of OMRON and the User’s remedy shall be limited to the refund of the
license fee paid to OMRON for the Software.

LIMITATION OF LIABILITY
• THE ABOVE WARRANTY SHALL CONSTITUTE THE USER'S SOLE AND EXCLUSIVE REME-

DIES AGAINST OMRON AND THERE ARE NO OTHER WARRANTIES, EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO, WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR PARTICULAR PURPOSE. IN NO EVENT, OMRON WILL BE LIABLE FOR ANY LOST PROF-
ITS OR OTHER INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF USE OF THE SOFTWARE.

• OMRON SHALL HAVE NO LIABILITY FOR DEFECT OF THE SOFTWARE BASED ON MODIFICA-
TION OR ALTERNATION TO THE SOFTWARE BY THE USER OR ANY THIRD PARTY. OMRON 
SHALL NOT BE RESPONSIBLE AND/OR LIABLE FOR ANY LOSS, DAMAGE, OR EXPENSES 
DIRECTLY OR INDIRECTLY RESULTING FROM THE INFECTION OF OMRON PRODUCTS, ANY 
SOFTWARE INSTALLED THEREON OR ANY COMPUTER EQUIPMENT, COMPUTER PRO-
GRAMS, NETWORKS, DATABASES OR OTHER PROPRIETARY MATERIAL CONNECTED 
THERETO BY DISTRIBUTED DENIAL OF SERVICE ATTACK, COMPUTER VIRUSES, OTHER 
TECHNOLOGICALLY HARMFUL MATERIAL AND/OR UNAUTHORIZED ACCESS.

• OMRON SHALL HAVE NO LIABILITY FOR SOFTWARE DEVELOPED BY THE USER OR ANY 
THIRD PARTY BASED ON THE SOFTWARE OR ANY CONSEQUENCE THEREOF. 

APPLICABLE CONDITIONS
USER SHALL NOT USE THE SOFTWARE FOR THE PURPOSE THAT IS NOT PROVIDED IN THE
ATTACHED USER MANUAL.

CHANGE IN SPECIFICATION
The software specifications and accessories may be changed at any time based on improvements and
other reasons.

ERRORS AND OMISSIONS
The information in this manual has been carefully checked and is believed to be accurate; however, no
responsibility is assumed for clerical, typographical, or proofreading errors, or omissions.
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Version Upgrades
Improvements from Version 1.991 to Version 2.00
The following functionality has been added in upgrading the CX-Protocol from version 1.991 to 2.00.

New PLCs Supported

The following CS1D CPU Units are now supported.

Improvements from Version 1.99 to 1.991
The following functionality has been added in upgrading the CX-Protocol from version 1.99 to 1.991.

Support for Microsoft Windows 10

Improvements from Version 1.97 to 1.99
The following functionality has been improved in upgrading the CX-Protocol from version 1.97 to 1.99.

New CPU Units Supported

The following NJ-series CPU Units are now supported.

Improvements from Version 1.96 to 1.97
The following functionality has been added in upgrading the CX-Protocol from version 1.96 to 1.97.

Support for Microsoft Windows 8 and 8.1

Improvements from Version 1.95 to 1.96
The following functionality has been added in upgrading the CX-Protocol from version 1.95 to 1.96.

New CPU Units Supported

The following NJ-series CPU Units are now supported.

Supported the models CJ1W-SCU22, -SCU32 and -SCU42 Unit Ver.2.1.

Improvements from Version 1.94 to Version 1.95
The following functionality has been added in upgrading the CX-Protocol from version 1.94 to 1.95.

New CPU Units Supported

The following NJ-series CPU Units are now supported.

Improvements from Version 1.93 to Version 1.94
The following functionality has been added in upgrading the CX-Protocol from version 1.93 to 1.94.

Support for Sysmac Studio Trial Version

Series Model

CS1D Series CS1D-CPU68HA/67HA/67SA/44SA

Series Model

NJ Series NJ101-9000/9020/1000/1020

Series Model

NJ Series NJ501-4300/4400/4500

Series Model

NJ-series CPU Unit models NJ301-1100/1200
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Improvements from Version 1.92 to Version 1.93
The following functionality has been added in upgrading the CX-Protocol from version 1.92 to 1.93.

New CPU Units Supported

The following NJ-series CPU Units are now supported.

Improvements from Version 1.91 to Version 1.92
The following functionality has been added in upgrading the CX-Protocol from version 1.91 to 1.92.

New PLCs Supported

The following CJ2 CPU Units are now supported.

Improvements from Version 1.9 to Version 1.91
The following functionality has been added in upgrading the CX-Protocol from version 1.9 to 1.91. 

Support for Microsoft Windows 7

Note This upgrade accompanies the upgrade of CX-One version 3.2 to CX-One version 4.03.

Improvements from Version 1.81 to Version 1.9
The following functionality has been added in upgrading the CX-Protocol from version 1.81 to 1.9.

New Units Supported 

The following Units are now supported.

Upgraded Functions

The EM Area banks that can be directly specified have been expanded from 0 to C hex to 0 to 18 hex.

!Caution If you attempt to access EM banks 0D to 18 hex from any Unit other than the
CJ1W-SCU22/32/42, a data read/write area exceeded error will occur in the
protocol status. (This will occur even if EM banks 0D to 18 hex are supported
by the CPU Unit.)

Improvements from Version 1.8 to Version 1.81
The following functionality has been added in upgrading the CX-Protocol from version 1.8 to 1.81.

New Units Supported

The following CPU Units are now supported.

Series Model

NJ Series NJ501-1300/1400/1500

Series Model

CJ Series CJ2M-CPU11/12/13/14/15/31/32/33/34/35

Series Unit Model

CJ Series Serial Communications Unit CJ1W-SCU22

CJ1W-SCU32

CJ1W-SCU42

Series Models

CJ Series CJ2H-CPU68/67/66/65/64
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Improvements from Version 1.71 to Version 1.8
The following functionality has been added in upgrading the CX-Protocol from version 1.71 to 1.8.

New Units Supported

The following CPU Units are now supported.

Improvements from Version 1.70 to Version 1.71
The following functionality has been added in upgrading the CX-Protocol from version 1.70 to 1.71.

New Units Supported

The following CPU Units are now supported. 

Windows Vista Supported

Improvements from Version 1.6 to Version 1.7
The following functionality has been added in upgrading the CX-Protocol from version 1.6 to 1.7.

New Units Supported

The following Serial Communications Units are now supported. 

The following PLCs are now supported.

Protocol Comparisons

• The CX-Protocol can now be used to compare the protocols in the project with those in the PLC. 

Improvements from Version 1.5 to Version 1.6
Installing the CX-Protocol from the CX-One FA Integrated Tool Package

Series Models

CJ Series CJ2H-CPU68-EIP/67-EIP/66-EIP/65-EIP/64-EIP

Series Models

CJ Series CJ1H-CPU67H-R/66H-R/65H-R/64H-R

Series Unit Model

CS Series Serial Communications Unit CS1W-SCU31-V1

CJ Series Serial Communications Unit CJ1W-SCU31-V1

Series CPU Units Models

CP Series CP1H-series CPU Units CP1H-XA, CP1H-X, and CP1H-Y

NSJ Series NSJ Controller NSJ@-@@@@(B)-G5D

NSJ@-@@@@(B)-M3D

Ver. 1.5 Ver. 1.6

The CX-Protocol could be installed only indepen-
dently.

The CX-Protocol can be installed as one of the func-
tions of the CX-One Integrated Tool Package.
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CX-Programmer Startup Method

Version 1.5 Upgrade Information
The changes that have been made from version 1.4 to version 1.5 of the CX-Protocol to support the
upgraded functionality of CS/CJ-series Serial Communications Boards/Units with unit version 1.2 are
explained here.

Version 1.5 Improved Functionality from Version 1.4
Compatible PLCs

Serial Communications Board/Unit Version Upgrade Compatibility
CX-Protocol version 1.5 supports the following CS/CJ-series Serial Communications Boards/Units with
unit version 1.2.

CX-Protocol version 1.5 supports the following new CPU Units.

Ver. 1.5 Ver. 1.6

The CX-Protocol could be started only from the Win-
dows Start Menu.

The CX-Protocol can also be started by right-clicking 
one of the following Serial Communications Boards/
Units in the I/O Table Window opened from the CX-
Programmer that was installed from the CX-One and 
selecting Start Special Application from the pop-up 
menu. 

• CS1W-SCU@@-V1
• CS1W-SCB@@-V1
• CJ1W-SCU@@-V1

Note When the Start with Settings Inherited Option 
is selected, a new project will be created and 
the device type setting will be automatically 
performed. 

Series Unit Model

CS Series Serial Communications Board CS1W-SCB21-V1, CS1W-SCB41-V1

Serial Communications Unit CS1W-SCU21-V1

CJ Series Serial Communications Unit CJ1W-SCU21-V1, CS1W-SCU41-V1

Series CPU Unit model

CJ Series CJ1H-CPU67H
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Communications Port Settings for Serial Communications Boards/Units

The communications port settings for CS/CJ-series Serial Communications Boards/Units with unit ver-
sion 1.2 can be set using CX-Protocol version 1.5 in the Communications Port Settings for Boards/
Units. The following Communications Port Settings Dialog Box will be displayed.

For details on each of the settings, refer to the CS/CJ Series Serial Communications Boards and Serial
Communications Units Operation Manual (W336-E1-06 or later).

CX-Protocol version 1.4 or earlier cannot read the CX-Protocol version 1.5 project files (.psw) that con-
tain the communications port settings for the upgrade functions, such as no-protocol and Serial Gate-
way, in the Serial Communications Boards/Units with unit version 1.2. If an attempt to read these files
is made, the message “Unexpected file format.” will be displayed.

Standard System Protocol Additions

CX-Protocol version 1.5 includes the following additional standard system protocols that have been
added to Serial Communications Boards/Units with unit version 1.2.

• Host Link C-mode Command Master (Sequence numbers 700 to 721)

• Host Link FINS Command Master (Sequence numbers 750 to 767)

• Mitsubishi Computer Link Master (A-compatible, 1C frame, model 1) (Sequence numbers 802 to
817)

• Additional communications sequences for CompoWay/F Master (added Sequence numbers 606 to
621)

Operation Manual
The CX-Protocol Ver. 1.4 Operation Manual (W344) is included with CX-Protocol version 1.5. Apart
from the new functions and improvements in version 1.5 explained here, however, there are no other
changes in the upgrade that will affect operation or functionality.

Version 1.4
The following functions have been added to the CX-Protocol with the upgrade from Ver. 1.3 to Ver. 1.4. 

New PLCs Supported

Simulation is newly supported for the following PLCs.

Series CPU Unit model numbers

CS CS1D-CPU67H/65H
CS1D-CPU67S/65S/44S/42S

CJ CJ1M-CPU11/21
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Version 1.3
The following functions have been added to the CX-Protocol with the upgrade from Ver. 1.2 to Ver. 1.3.

CJ1M-CPU23/22/13/12 CPU Units Supported

Windows XP Supported

Version 1.2
The following functions have been added to the CX-Protocol with the upgrade from Ver. 1.1 to Ver. 1.2.

CS1-H, CJ1, and CJ1-H CPU Units Supported
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PRECAUTIONS

This section provides general precautions for using the CX-Protocol and related devices.

The information contained in this section is important for the safe and reliable application of the CX-Protocol. You
must read this section and understand the information contained before attempting to set up or operate the CX-
Protocol.

1 Intended Audience  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiv
2 General Precautions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiv
3 Safety Precautions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiv
4 Operating Environment Precautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiv
5 Application Precautions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxv
6 Software Operating Procedures. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxvi
xxiii



Intended Audience 1
1 Intended Audience
This manual is intended for the following personnel, who must also have
knowledge of electrical systems (an electrical engineer or the equivalent).

• Personnel in charge of installing FA systems.

• Personnel in charge of designing FA systems.

• Personnel in charge of managing FA systems and facilities.

2 General Precautions
The user must operate the product according to the performance specifica-
tions described in the operation manuals.

Before using the product under conditions which are not described in the
manual or applying the product to nuclear control systems, railroad systems,
aviation systems, vehicles, combustion systems, medical equipment, amuse-
ment machines, safety equipment, and other systems, machines, and equip-
ment that may have a serious influence on lives and property if used
improperly, consult your OMRON representative. 

Make sure that the ratings and performance characteristics of the product are
sufficient for the systems, machines, and equipment, and be sure to provide
the systems, machines, and equipment with double safety mechanisms.

This manual provides information for programming and operating OMRON
PLCs. Be sure to read this manual before attempting to use the software and
keep this manual close at hand for reference during operation.

!WARNING It is extremely important that a PLC and all PLC Units be used for the speci-
fied purpose and under the specified conditions, especially in applications that
can directly or indirectly affect human life. You must consult with your OMRON
representative before applying a PLC System to the above mentioned appli-
cations.

3 Safety Precautions

!WARNING Never attempt to disassemble any Units while power is being supplied. Doing
so may result in serious electrical shock or electrocution.

!WARNING Never touch any of the terminals while power is being supplied. Doing so may
result in serious electrical shock or electrocution.

4 Operating Environment Precautions
Do not operate the control system in the following places.

• Where the PLC is exposed to direct sunlight.

• Where the ambient temperature is below 0°C or over 55°C.

• Where the PLC may be affected by condensation due to radical tempera-
ture changes.

• Where the ambient humidity is below 10% or over 90%.

• Where there is any corrosive or inflammable gas.

• Where there is excessive dust, saline air, or metal powder.

• Where the PLC is affected by vibration or shock.

• Where water, oil, or chemical may splash onto the PLC.
xxiv



Application Precautions 5
!Caution The operating environment of the PLC system can have a large effect on the
longevity and reliability of the system. Improper operating environments can
lead to malfunction, failure, and other unforeseeable problems with the PLC
system. Be sure that the operating environment is within the specified condi-
tions at installation and remains within the specified conditions during the life
of the system.

5 Application Precautions
Observe the following precautions when using the PLC.

!WARNING Failure to abide by the following precautions could lead to serious or possibly
fatal injury. Always heed these precautions.

• Always ground the system to 100 Ω or less when installing the system to
protect against electrical shock.

• Always turn OFF the power supply to the PLC before attempting any of
the following. Performing any of the following with the power supply turned
ON may lead to electrical shock:

• Mounting or removing any Units (e.g., I/O Units, CPU Unit, etc.) or
memory cassettes.

• Assembling any devices or racks.

• Connecting or disconnecting any cables or wiring.

!Caution Failure to abide by the following precautions could lead to faulty operation of
the PLC or system or could damage the PLC or PLC Units. Always heed
these precautions.

• Use the Units only with the power supplies and voltages specified in the
operation manuals. Other power supplies and voltages may damage the
Units.

• Take measures to stabilize the power supply to conform to the rated sup-
ply if it is not stable.

• Provide circuit breakers and other safety measures to provide protection
against shorts in external wiring.

• Do not apply voltages exceeding the rated input voltage to Input Units.
The Input Units may be destroyed.

• Do not apply voltages exceeding the maximum switching capacity to Out-
put Units. The Output Units may be destroyed.

• Always disconnect the LG terminal when performing withstand voltage
tests.

• Install all Units according to instructions in the operation manuals.
Improper installation may cause faulty operation.

• Provide proper shielding when installing in the following locations:

• Locations subject to static electricity or other sources of noise.

• Locations subject to strong electromagnetic fields.

• Locations subject to possible exposure to radiation.

• Locations near to power supply lines.

• Be sure to tighten Backplane screws, terminal screws, and cable connec-
tor screws securely.
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Software Operating Procedures 6
• Do not attempt to take any Units apart, to repair any Units, or to modify
any Units in any way.

!Caution The following precautions are necessary to ensure the general safety of the
system. Always heed these precautions.

• Provide double safety mechanisms to handle incorrect signals that can be
generated by broken signal lines or momentary power interruptions.

• Provide external interlock circuits, limit circuits, and other safety circuits in
addition to any provided within the PLC to ensure safety.

6 Software Operating Procedures
Observe the following precautions when using the CX-Protocol.

!WARNING Confirm safety before transferring the I/O memory area state to the CIO area
of the PLC using the PLC memory window function of the CX-Protocol. Not
doing so may cause malfunction in devices connected to the I/O Units regard-
less of the operating mode of the CPU Unit.

!Caution Confirm safety at the destination node before transferring a protocol to
another node or editing the I/O area. Doing either of these without confirming
safety may result in injury.

!Caution Confirm that no adverse effect will occur in the system before changing the
present value of any word in memory. Not doing so may result in an unex-
pected operation.

!Caution Confirm that no adverse effect will occur in the system before changing the
operating mode of the CPU Unit. Not doing so may result in an unexpected
operation.

!Caution Confirm that no adverse effect will occur in the system before force-setting/
force-resetting any bit in memory. Not doing so may result in an unexpected
operation.

!Caution Confirm that no adverse effect will occur in the system before transferring the
communications port A/B settings to the Protocol Macro Support Unit
(PMSU). Not doing so may result in an unexpected operation.

!Caution Check the user protocol for proper execution before actually running it on the
Unit. Not checking the protocol may result in an unexpected operation.

!Caution Online connection of the CX-Protocol cannot be made to a PLC which is con-
nected online to SYSMAC-CPT or SYSMAC-PST. Therefore, when SYSMAC-
CPT or SYSMAC-PST is running and connected online to a PLC, it must be
offline before making online connection to the CX-Protocol. Similarly, when
the CX-Protocol is connected online to a PLC, it must be switched to offline
before making online connection to SYSMAC-CPT or SYSMAC-PST.
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SECTION 1
Introduction

This section outlines the Protocol Macro function and the CX-Protocol.

1-1 Overview of the CX-Protocol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
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Overview of the CX-Protocol Section 1-1
1-1 Overview of the CX-Protocol
The CX-Protocol is the software for creating a procedure (or protocol) for
sending or receiving data to or from general-purpose external devices con-
nected to a Protocol Macro Support Unit (PMSU) through RS-232C or RS-
485A/422.

A protocol consists of a set of communications sequences. CX-Protocol trans-
fers a protocol to the PMSU, specifies the sequence number of the protocol
using the PMCR instruction on the CPU Unit, and executes the communica-
tions sequence.

The communications sequence consists of several steps and allows the user
to iterate, branch, or end these steps according to the result of the process.

Note 1. In the following section, the Communications Board for the C200HX/HG/
HE, Serial Communications Board for the CS and CQM1H, and Serial
Communications Units for the CS/CJ are referred to as the “PMSU.”

2. The CJ-series protocol macro function of the CJ-series Serial Communi-
cations Unit is used even for the system configuration described below,
which uses a CP-series CPU Unit with a CJ-series Serial Communications
Unit. The CJ Series is thus specified in descriptions unless there is infor-
mation unique to the CP Series. 

1-2 Features

1-2-1 Features of the Protocol Macro Function
Support for a wide range of communications protocols

Supports communications with almost all external general-purpose devices
that have RS-232C or RS-422A/485 ports and support half-duplex or full-
duplex mode (full-duplex is for CS/CJ only) and start-stop synchronization
2



Features Section 1-2
mode (refer to 4-1 Applicable Range of the Protocol Macro Function for
restrictions).

Creation of send frames and receive (expected) frames according to the desired communications 
frame specifications

Enables creation of almost all send frames (frames composed of commands,
data, and so on) and receive (expected) frames (frames composed of
responses and so on) according to the communications frame (message)
specifications of external devices.

Support for operation functions relating to communications
Supports error check code calculation, frame length calculation during trans-
mission process, and numeral data conversion between ASCII and hexadeci-
mal.

Support for the send and receive time monitoring function
Supports the receive wait monitoring, receive finish monitoring, and send fin-
ish monitoring functions. This function lets you designate whether to finish
send/receive process or to start retry process when those monitoring times
are exceeded.

Support for retry process Lets you designate, only by designating the number of retries, whether to
automatically execute send/receive retries when an error occurs.

Integration of variables for read/write process with PLC into send frames and receive (expected) 
frames

Enables integration of variables for read process from PLC’s I/O memory into
send frames (messages) themselves. Data in the PLC that has been read
during transmission process can be used for addresses (destinations) or data.
This function also enables integration of variables for write process to PLC’s I/
O memory into receive frames (messages) themselves. Addresses (destina-
tions) or data can be written into the PLC during the receive process.

Easy realization of rich functions including 1:N communications and switching data write destinations, 
using repetition variables

Lets you designate repeat variables for send/receive process (repeat counter)
in variables. With this function, a wide variety of process can be easily real-
ized: for example, sending the same data to multiple addresses (destinations)
by switching them during 1:N communications; switching write destination
addresses in PLC’s I/O memory during data receive process.

Execute interrupt program on the PLC while receiving data
Enables interrupt program execution on the PLC (CPU Unit) while receiving
data. The interrupt function is supported only by the Communications Board
for the C200HX/HG/HE and Serial Communications Board for the CS. It can-
not be used with the Serial Communications Unit for the CS/CJ.

Switch the next process depending on the received data
The next process can be switched according to the data comparison with the
data registered to the maximum of 15 types.

The following functions have been added to the protocol macro for the CS/CJ.

Error check code (only for the CS/CJ protocol macro)
LRC2 (2’s complement of LRC) and SUM1 (1’s complement of SUM) have
been added to the error check codes.
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Features Section 1-2
Wait command to keep the next process on standby until a synchronous signal is input from the PLC 
(only for the CS/CJ protocol macro)

During the send/receive sequence step, the next process can be kept on
standby until a synchronous signal is input from the PLC (CPU Unit). This
enables computation processing such as data processing on the CPU Unit
during the send/receive sequence.

Supports half-duplex and full-duplex transmission mode (only for the CS/CJ protocol macro)
The conventional protocol macro provides only the half-duplex macro. With
the half-duplex macro, the receive buffer is cleared right after the send opera-
tion, thus the received data cannot be used. With the full-duplex mode, all the
data received within the sequence can be used and data can be sent and
received at the same time.

Note The full-duplex mode can be used with the RS-232C or four-wire setting. It
cannot be used with the 1:N or two-wire setting. (Only for models with the RS-
422A/485.)

Clear data using Flush command within the receive buffer at any time (only for the CS/CJ protocol 
macro)

With the full-duplex mode, the receive buffer is cleared only right before exe-
cuting the send/receive sequence. If any reception error occurs, the received
data can be cleared at any time using the Flush command (receive buffer
clear).

Turn the DTR control signal ON and OFF using the Open/Close command (only for the CS/CJ protocol 
macro)

When connected to a modem device, DTR signal is used to indicate that the
Serial Communications Board or Unit (DTE) is ready to send or receive data.
Previously, the DTR signal could be turned ON only during the send/receive
sequence.

Now the DTR signal can be turned ON or OFF at any time within the send/
receive sequence. This allows connection or disconnection with a modem
using the protocol macro.

The DTR signal can be set to ON even after the send/receive sequence has
completed. The DTR signal can be retained even after changing to another
protocol mode (for example, host link). 

With this function, remote programming or monitoring can be performed
through a remote Programming Device by changing to the host link mode
using the STUP instruction after connecting to a modem.

1-2-2 Features of the CX-Protocol
Simultaneous display of tree (hierarchical) view and list (table) view

The CX-Protocol displays data in the form of a tree in the left pane, which
gives you easier understanding of the hierarchical structure of data you are
setting/monitoring.

Object-oriented operation Double-clicking target data, instead of choosing from menus, opens its corre-
sponding pop-up dialog, which enables you to create protocols quickly without
a thorough understanding of operation menus.

Supplied standard system protocols
Data exchange protocols for OMRON’s components (Temperature Control-
lers, Panel Meters, Bar Code Readers, Modems, and so on) are included as
standard system protocols.

Notice that those standard system protocols are included also in the PMSU.
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Supported PLC Models and Personal Computers Section 1-3
Possible to trace send/receive message
By executing the trace function from the CX-Protocol, the PMSU can trace
and save chronological data of send/receive messages up to 670 bytes for the
C200HX/HG/HE and up to 1,700 bytes for the CS/CJ. Each data item can be
displayed and printed for reading and saved as a trace file.

1-3 Supported PLC Models and Personal Computers
1-3-1 Supported PLC Models

The CX-Protocol supports the following PLCs (Programmable Controllers).

Note 1. When using the CS1D-H, set the device type as follows:
CS1D-H with unit Ver.1.1 or later:CS1D-H
Pre-Ver. 1.1 CS1D-H: CS1H-H

2. CX-Protocol Version 1.0 does not support the C200HX/HG/HE. 
3. When using CQM1H-series PLCs, use the C200HG-CPU43 from the

C200HX/HG/HE Series as the CPU Unit.

1-3-2 Supported PMSUs
CS-series PLCs

Series CPU Unit
NJ NJ501-1300/1400/1500/4300/4400/4500

NJ301-1100/1200
CS (See note 1.) CS1H-CPU67/66/65/64/63

CS1G-CPU45/44/43/42
CS1H-CPU67H/66H/65H/64H/63H
CS1G-CPU45H/44H/43H/42H
CS1D-CPU67H/65H/68HA/67HA
CS1D-CPU67S/65S/44S/42S/67SA/44SA

CJ CJ2H-CPU68/67/66/65/64/68-EIP/67-EIP/66-EIP/65-EIP/64-EIP
CJ2M-CPU11/12/13/14/15/31/32/33/34/35
CJ1G-CPU45/44
CJ1G-CPU45H/44H/43H/42H
CJ1G-CPU45P/44P/43P/42P
CJ1H-CPU67H-R/66H-R/65H-R/64H-R/67H/66H/65H
CJ1M-CPU23/22/21/13/12/11

CP CP1H-XA@@@@-@
CP1H-X@@@@-@
CP1H-Y@@@@-@

NSJ G5D (Same for the NSJ5-TQ@@-G5D, NSJ5-SQ@@-G5D, NSJ8-TV0@-G5D, NSJ10-TV0@-G5D, 
and NSJ12-TS0@-G5D.)
M3D (Same for the NSJ5-TQ@@- M3D, NSJ5-SQ@@- M3D, and NSJ8-TV0@- M3D.)

C200HX/HG/HE 
(See note 2.)

C200HX-CPU34-E/44-E/54-E/64-E/34-ZE/44-ZE/54-ZE/64-ZE/65-ZE/85-ZE
C200HG-CPU33-E/43-E/53-E/63-E/33-ZE/43-ZE/53-ZE/63-ZE
C200HE-CPU-32-E/42-E/32-ZE/42-ZE

CQM1H 
(See note 3.)

CQM1H-CPU51/61

Product name Installation Model Serial communications ports
Serial Communications 
Boards (Inner Board) Installed in the CPU Unit

CS1W-SCB21-V1 RS-232C port x 1 + RS-232C port x 1
CS1W-SCB41-V1 RS-232C port x 1 + RS-422A/485 port x 1

Serial Communications 
Unit (CPU Bus Unit)

Installed on the CPU Rack 
or CS Expansion Rack

CS1W-SCU21-V1 RS-232C port x 1 + RS-232C port x 1
CS1W-SCU31-V1 RS-422A/485 port x 1 + 

RS422A/485 port x 1
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Supported PLC Models and Personal Computers Section 1-3
NJ-series, CJ-series, and 
CP-series PLCs

Connecting the Serial Communications Unit

• Mounting to an NJ-series and CJ-series CPU Unit

Mounting the Serial Communications 
Board on the CPU Unit

Mounting the Serial Communications 
Unit on the CPU Rack

CPU Rack CPU Unit

Power Supply Unit

Serial Com-
munications 
Units

CS1 Expansion Rack

Power Supply Unit

Product name Classification Installation Model Serial communications ports

Serial Communi-
cations Unit

CJ-series CPU 
Bus Unit

CPU Rack or 
CJ Expansion Rack

CJ1W-SCU21-V1
CJ1W-SCU22

RS-232C port x 1 + RS-232C port x 1

CJ1W-SCU31-V1
CJ1W-SCU32

RS-422A/485 port x 1 + 
RS422A/485 port x 1

CJ1W-SCU41-V1
CJ1W-SCU42

RS-232C port x 1 + 
RS-422A/485 port x 1

PA205R

POWER

INPUT
AC100-240V

L2/N

L1

DC24V
AC240V

OUTPUT
RUN

PERIPHERAL

ERR/ALM
RUN

INH

COMM

PRPHL
CONTROLLER

CJ1G-CPU44
SYSMAC

PROGRAMMABLE

PORT

OPEN

BUSY
MCPWR

2

ON

4

TERM

RD2SD2RDY

NO.
UNIT

ERH

OFF

WIRE

01
23456789ABCDEF

ERCRUN
SCU41

RD1 TER1SD1

PORT1
(RS422
/485)

PORT2

Power Supply Unit CPU Unit

Serial Communications Unit
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Supported PLC Models and Personal Computers Section 1-3
• Mounting to a CP-series CPU Unit

C200HX/HG/HE PLCs

Note 1. The enhanced functions are as follows:

• SUM2 (2’s complement of SUM) and CRC-16 are added as error
check codes.

• Repeat counter N current value, Sequence End Finish Flag, and Se-
quence Abort Finish Flag are added to the auxiliary area.

• A check code can be located behind a terminator in messages.

• Swap between high byte and low byte can be designated for error
check codes.

CP1H CPU Unit 
CP1W-EXT01   
CJ-series Unit Adapter 

CJ1W-TER01   
CJ-series End Cover 
(Included with CJ-series 
Unit Adapter) 

Connect the Serial Communications 
Unit to one of these. 

Product 
name

Installation Model Enhanced 
functions (see 

note)

Specifications

PMSU
Installed in 
the CPU 
Unit

C200HW-COM04-E --- CPU bus interface + RS-232C port x 1 
With the protocol macro functionC200HW-COM04-EV1 ❍

C200HW-COM05-E --- RS-232C port x 2
With the protocol macro functionC200HW-COM05-EV1 ❍

C200HW-COM06-E --- RS-232C port x 1 + RS-422A/485 port x 1 
With the protocol macro functionC200HW-COM06-EV1 ❍
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Supported PLC Models and Personal Computers Section 1-3
2. Mounting the Communications Board on the CPU Unit

■ Caution in Using Communications Board for SYSMAC Alpha

When using Communications Board for SYSMAC Alpha with either of the
communications ports set to NT link (1:N), you cannot transfer protocol data
to the other port by using CX-Protocol.
When you want to transfer protocol data to the Communications Board, set its
communications port to any of the settings other than NT link (1:N) before
transfer, and set it to NT link (1:N) after transfer before using the Communica-
tions Board.

CQM1H

■ Caution in Using CQM1H Serial Communications Board

When using CQM1H Serial Communications Board with either of the commu-
nications ports set to NT link (1:N), you cannot transfer protocol data to the
other port by using CX-Protocol.
When you want to transfer protocol data to the Serial Communications Board,
set its serial communications port to any of the settings other than NT link
(1:N) before transfer, and set it to NT link (1:N) after transfer before using the
Serial Communications Board.

Note The following restrictions exist when using the CX-Protocol to create and edit
protocol macros, transferring data between the Board and personal computer,
or performing other functions for the CQM1H.

CPU Unit

Communications Board

Product name Installation Model Serial communications ports

Serial Communications 
Boards

Installed in the CPU Unit CQM1H-SCB41 RS-232C port x 1 + RS-422A/485 port x 1

RUN
ERR/ALM
INH
PRPHL
COMM

PA203

POWER

0 1 2 3 4 5 6 7

8  9 10 11 12 13 14 15

0CH

PORT1

PORT2
RS233
/485

TERM
ON

WIRE
2     4

SCB41

CQM1H CPU Unit

CQM1H Serial Communications Board
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System Configuration Section 1-4
• Always turn ON pin 8 on the DIP switch on the front on the CQM1H CPU
Unit. (When pin 8 is ON, you will not be able to connect the peripheral
port, built-in RS-232C port, or serial communications ports on Boards
mounted in the CPU Unit to the CX-Programmer or other Support Soft-
ware running on a personal computer.)

• Set the device type to “C200HG” and the CPU type to “CPU43.”

• Other than these restrictions, functionality will be the same as for the
C200HX/HG/HE PLCs.

1-3-3 Supported Personal Computers
Refer to the CX-One Setup Manual (Cat. No. W463) for the supported per-
sonal computers.

1-4 System Configuration

1-4-1 Connecting the CX-Protocol and the PLC
For the CS/CJ Connect the peripheral port on the CPU Unit to the built-in RS-232C port.

Note Can be connected to the PMSU port if the port is set to the host link mode.

Note When using the RS-232C Cable to connect to a CPU Unit peripheral port, as
shown below, use the CS1W-CN118.

When combining the CS1W-CN118 with the RS-232C Cable, connections
cannot be made using the Toolbus. Make connections using Host Link
(SYSWAY).

Connection to a IBM PC/AT or 
compatible computer
Peripheral port connection RS-232C port connection

9-pin

Peripheral port 
on the CPU Unit

CS1W-CN226 (2.0 m)
CS1W-CN626 (6.0 m)

9-pin

RS-232C port on the 
CPU Unit or PMSU port 
(host link mode)

9-pin

XW2Z-200S-V (2.0 m)
XW2Z-500S-V (5.0 m)

CS1W-CN118

Peripheral port

XW2Z-@@@S-@
RS-232C Cable
9



System Configuration Section 1-4
CP Series

NJ Series Direct USB Connection

Direct Ethernet Connection

Note If an RS-232C Option Board (CP1W-CIF01) is mounted, it is also possible to
use a XW2Z-200S/500S-V/-CV RS-232C Cable to connect an RS-232C port
on the computer to the RS-232C Option Board. 

Computer Computer port CPU Unit port Cable length Cable

IBM PC/AT or 
compatible

USB port 
(A-type con-
nector)

USB port 
(B-type con-
nector

5 m max. Commercially 
available USB 
1.1 or 2.0 cable

 

IBM PC/AT or 
compatible 

CP1H 
CPU Unit 

USB port 

Commercial 
USB cable 

Peripheral USB port 

Computer Computer port CPU Unit port Cable length Cable

IBM PC/AT or 
compatible

USB port 
(A-type con-
nector)

USB port 
(B-type con-
nector

5 m max. Commercially 
available USB 
1.1 or 2.0 cable

Computer Computer port CPU Unit port Cable length Cable

IBM PC/AT or 
compatible

Ethernet port EtherNet/IP 
port

IBM PC/AT or 
compatible 

NJ-series CPU Unit

USB port 

Commercial 
USB cable 

Peripheral USB port 

IBM PC/AT or 
compatible 

Ethernet port

EtherNet/IP port

Ethernet 
cable

NJ-series CPU Unit
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System Configuration Section 1-4
For the C200HX/HG/HE Connect the peripheral port on the CPU Unit to the built-in RS-232C port.

Note Can be connected to the PMSU port if the port is set to the host link mode.

Note For IBM PC/AT or compatible computers, a conversion connector from D-sub
25P (female) to 9P (female) is required for the personal computer side con-
nector.

1-4-2 Connecting the PLC to External Devices
For the CS/CJ The following figure shows the system configuration of the PMSU in the PLC

and external devices. The RS-232C port provides 1:1 connection and the RS-
422A/485 port 1:N connection.

Types of PMSUs

Peripheral port connection RS-232C port connection

9-pin

Peripheral port 
on the CPU Unit

9-pin

RS-232C port on the 
CPU Unit or PMSU port 
(host link mode)

CQM-CIF02
Connecting Cable XW2Z-200S (2.0 m)

XW2Z-500S (5.0 m)

Connection to a IBM PC/AT or 
compatible computer

9-pin

(see note)

CPU Unit

Port 1

Port 2

Port 1

Port 2

RS-232C

RS-422A/485

RS-232C General-purpose 
external device

RS-232C

General-purpose 
external device

General-purpose 
external device

General-purpose 
external device

General-purpose 
external device

CS1W-SCU21-V1 Serial Communications Unit CS1W-SCB41-V1 Serial Communications Board

Model Name Model Communications 
port

Communications function

Protocol 
macro

Host link NT link Cyclical 
test

Serial 
Communications 

Boards

CS1W-SCB21-V1
RS-232C (port 1) ❍ ❍ ❍ ❍

RS-232C (port 2) ❍ ❍ ❍ ❍

CS1W-SCB41-V1
RS-232C (port 1) ❍ ❍ ❍ ❍

RS-422A/485 
(port 2)

❍ ❍
(see note)

❍ ❍
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System Configuration Section 1-4
Note Cannot be used with two-wire models.

Serial 
Communications 

Units

CS1W-SCU21-V1
RS-232C (port 1) ❍ ❍ ❍ ❍

RS-232C (port 2) ❍ ❍ ❍ ❍

CS1W-SCU31-V1

RS-422A/485 
(port 1)

❍ ❍ ❍ ❍

RS-422A/485 
(port 2)

❍ ❍ ❍ ❍

CJ1W-SCU21-V1
CJ1W-SCU22

RS-232C (port 1) ❍ ❍ ❍ ❍

RS-232C (port 2) ❍ ❍ ❍ ❍

CJ1W-SCU31-V1
CJ1W-SCU32

RS-422A/485 
(port 1)

❍ ❍ ❍ ❍

RS-422A/485 
(port 2)

❍ ❍ ❍ ❍

CJ1W-SCU41-V1
CJ1W-SCU42

RS-232C (port 1) ❍ ❍ ❍ ❍

RS-422A/485 
(port 2)

❍ ❍ ❍ ❍

Devices to be connected

General-
purpose 
external 
devices

Host com-
puter pro-
gramming 
devices

PT None

Model Name Model Communications 
port

Communications function

Protocol 
macro

Host link NT link Cyclical 
test
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System Configuration Section 1-4
For the C200HX/HG/HE The following figure shows the system configuration of the PMSU and exter-
nal devices. The RS-232C port provides 1:1 connection and the RS-422A/485
port provides 1:N connection.

Types of PMSUs (Only Models Having the Protocol Macro Function)

Note 1. C200HW-COM@@-EV1: Enhanced function model

2. Not available for two-wire models.

C200HW-COM06-EV1 Communications Board

Port B

Port A

RS-232C

General-purpose 
external device

CPU Unit

RS-422A/485

General-purpose 
external device

General-purpose 
external device

General-purpose 
external device

Model Communications 
port

Communications Function

Protocol 
macro Host link No-

procedural 1:1 link NT link 
1:1, 1:N CPU bus

C200HW-COM04-
E/EV1

CPU bus interface --- --- --- --- --- ❍

RS-232C (port A) ❍ ❍ ❍ ❍ ❍ ---

C200HW-COM05-
E/EV1

RS-232C (port A) ❍ ❍ ❍ ❍ ❍ ---

RS-232C (port B) ❍ ❍ ❍ ❍ ❍ ---

C200HW-COM06-
E/EV1

RS-422A/485 (port 
A) ❍

❍
(see note 

2)

❍
(see note 

2)

❍ 
(see note 

2)
❍ ---

RS-232C (port B) ❍ ❍ ❍ ❍ ❍ ---

Devices to be connected

General-
purpose 
external 
devices

Host com-
puter pro-
gramming 
devices

General-
purpose 
external 
devices

PLC PT

Interface 
with Com-
munica-

tions Units
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Protocol Macro Section 1-5
1-5 Protocol Macro
1-5-1 Protocol Macro Outline

Protocol macro is a function that creates macros for communications proto-
cols that conform to specifications for communications between general-pur-
pose external devices that have a serial communications port.

Generally the protocol macro performs two kinds of function:

• Creation of communications frames (messages).
• Creation of procedures for sending and receiving communications frames

(messages).

Creation of Communications Frames (Messages)

1,2,3... 1. Communications frames, referred to here as “messages” and which can be
understood by general-purpose external devices, can be created accord-
ing to the communications specifications. 

Note In general, the data area of a send message contains a command code and
data. The data area of a receive message contains a response code.
2. Variables for reading data from (or writing data to, if receiving) the I/O

memory (data memory, for example) of the CPU Unit, can be integrated
into the messages.

This function has the following advantages:
• Ladder program processing will not be necessary at the CPU Unit

when, for example, sending messages after arranging them all in data
memory.

Header Address Data Check 
code

Terminator

I/O memory

Read

Variable R ( )
Variable W ( )

Write

I/O memory

Receive

Send

CPU Unit

Not necessary

Header

Address
Send
14



Protocol Macro Section 1-5
• The components of the previously created messages are stored in
memory at the PMSU, not the CPU Unit. When sending or receiving
data, the CPU Unit only has to execute the PMCR instruction. 

• When handling one part of the I/O memory data, if the variable re-
quired for reading that data has been integrated into a send message,
the PMSU will automatically read the required data from the I/O mem-
ory of the CPU Unit when the PMSU sends the message. Similarly,
when writing data from one part of a received message into I/O mem-
ory, if the variable required to read the data has been integrated into
the reception settings message, the PMSU will automatically write the
data at the designated position in the message into I/O memory when
the PMSU receives the message.

CPU Unit

PMCR instruction

PMSU

Receive

Message

Send

CPU Unit

PMCR instruction

I/O memory

PMSU

Send message

Reads I/O memory data

Receive message

PMSUCPU Unit

PMCR instruction

I/O memory

Writes to I/O memory
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Protocol Macro Section 1-5
Creating Procedures for Sending and Receiving Communications Frames (Messages)

1,2,3... 1. This function enables all the processing needed to send or receive a mes-
sage to be handled as one step, and possesses all the commands (step
commands), such as Send, Receive, Send&Receive and Wait, that are
needed for each step.

2. This step can be set so that the next process (step/end) depends on the
processing result of the previous step. In particular, it is possible to set the
sequence so that the next process depends on the contents of one or sev-
eral set receive messages. 

Note 1. A send message created with a protocol macro will perform settings for
messages that are actually sent.

2. A receive message created with protocol macro will set an expected mes-
sage for comparison with messages that are actually received.

CPU Unit

PMCR instruction

PMSU
General-purpose 
external device

Step 0

Step 1

CPU Unit

PMCR instruction

Next step depends 
on contents of re-

ceived data

PMSU
General-purpose 
external device

Step 0

Step n (depending on con-
tents of received data)

Send

Receive

Sets message being sent
Message received

Sets expected message for comparison

(Send)

(Receive)
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Protocol Macro Structure Section 1-6
1-5-2 Standard System Protocol
Data exchange protocols (called standard system protocols) for OMRON
Units (Temperature Controllers, Panel Meters, Bar Code Readers, Modems,
etc.) have been installed into the PMSU. By setting the prescribed receive/
send data and executing the PMCR instruction, therefore, data exchange can
be easily performed with OMRON Units.

1-6 Protocol Macro Structure
The protocol consists of a communications sequence (“sequence” in short),
which is an independent process for the general-purpose external device (for
example, reading a process variable from a Temperature Controller). One
sequence consists composed of some steps, each of which is composed of a
Send, Receive, or Send&Receive command, send/receive message, branch
or end according to the result of the process.

For example, the sequence to read a process value from the temperature con-
troller sends to the controller a send message (a string containing the read
command with a header, address, check code, and terminator), and then
receives a receive message (a string containing a response to the read com-
mand with a header, address, check code, and terminator).

Protocol Macro Support Unit

RS-232C or
RS-422A/485

Terminator

RX00 :

RX01 :
17



Protocol Macro Structure Section 1-6
The sequence determines, according to the result of process, whether to send
the same send message again (called retry) or execute the next process
(reading process value from the Temperature Controller linked to another
address, etc.), for example.

Note 1. The command is Send, Receive, Send&Receive, Wait, Flush, Open, or
Close.

• A step can be retried with the Send&Receive command.

• A step can wait to transmit a send message upon the Send or
Send&Receive commands.

• A step can select the next process according to the content of the re-
ceived message by using a matrix.

2. There are three types of messages: send messages, receive (expected)
messages, and matrices that switch processes according to multiple re-
ceive (expected) messages. Those messages are managed by lists and
separated from sequences.

Transmis-
sion control
parameter

Link word

Monitoring
timer

Response
Type

Structure of one step
(for Send. Receive, Send&Receive commands)

Command (Note 1)

Next process

(For Wait, Flush, Open,
Close commands)

To be
retried?

N
(Error)

Message lists (see note 2)
Send message list

Header Address Data Check Terminator

Receive message list

Header Address Data Check Terminator

Matrix (see note 2)
Case No. 15

Case No. 00
Receive message Next process

Command
(Note 1)

Normal end?

To be
repeated?

Next process Error process

ied)

N (Not repeated)

Y

Y

Y

Message
(Note 2)

N (Not retr
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Protocol Macro Structure Section 1-6
1-6-1 Step Structure
Each step has the fixed processing framework as follows. Users create proto-
cols by setting parameters for each framework.

One step contains one command (Send, Receive, Send&Receive, Wait,
Flush, Open, or Close) and one or two messages (send, receive, or send/
receive). The step changes from one to another by the Next Process within
the step.

Note The Wait, Flush, Open, and Close commands are for the CS/CJ protocol mac-
ros. (They are not supported by the C200HX/HG/HE protocol macros.)

Setup Parameters that Commonly Affect Steps (in Each Sequence)

Setup Parameters for Each Step

Parameter Description

Transmission control parameter Sets the control mode for control signals including flow control.

Link word Sets area in which data is shared between the PLC and the PMSU.

Monitoring time Sets monitoring time for send and receive process.

Response type Sets timing of writing receive data into PLC’s I/O memory.

Parameter Setup content

Command Send, Receive, Send&Receive, Wait, Flush, Open, or Close

Message

Send message Sets message to be sent for the Send command.

Receive message Sets message expected to be received for the Receive command.

Send message and 
receive message

Sets messages to be sent and expected to be received for the Send&Receive 
command.

Matrix
Selects the next process according to the content of the received message when the 
command is Receive or Send&Receive and up to 15 messages can be expected to 
be received.

Repeat counter The number of times iterating the step (0 to 255). Using this parameter N allows to 
change the content of send and receive messages.

Retry count (Used only for Send&Receive command)
Retries the command when a retry cause such as an error occurs (0 to 9 times).

Send wait time (Used only for Send or Send&Receive command)
Set the waiting time before starting to send data.

With/Without Response Writing Specifies whether to write received data.

Next process Sets the next step to which the step transits or the sequence exits if it ends normally.

Error process Sets the next step to which the step transits or the sequence exits if it ends 
abnormally.

Sequence

Step 00

Step 01

Step n

Step 15

Next process

Next process

Structure of one step
(for Send. Receive, Send&Receive commands)

S
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Command

To be 
retried?

N

Message

Normal end?

To be 
repeated?

Next process Error process

N

N

Y

Y

Y

Command

Next process

(For Wait, Flush, Open, 
Close commands)
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Data Created by the CX-Protocol Section 1-7
1-7 Data Created by the CX-Protocol
The CX-Protocol creates/manages data by file unit, called “project.”
Project files consist of the following data:

Project files are stored with a file extension .PSW.
Note To transfer standard system protocols to the PMSU or create a new protocol

by partially modifying one of the standard system protocols, first copy the
required standard system protocol to another project file and then use the
project file. The standard system protocols themselves cannot be edited or
transferred.
The standard system protocols have been installed into the PMSU at our fac-
tory.

Files that can be Read or Written by CX-Protocol

1 project file Protocol list

Trace list

Protocol

Protocol

Protocol

Up to 20 protocols (see note 1) 
(Up to 1,000 sequences/PLC)

Note 1: Protocol  
           (1 protocol)

Sequence

Sequence

Sequence

Up to 60 sequences (see note 2) 
(The first sequence number and 
the last sequence number are 
designated for each protocol.)

Send message list Message

Message

Receive message list Message

Message

Up to 300 messages

Matrix list Matrix

Matrix

Up to 100 matrices

Note 2: Sequence#@@@ Step 00

Step 01

Step 15

Up to 16 steps

PLC

Protocol list

Protocol list

Type of file Content File 
extension

Read Write

CX-Protocol/SYSMAC-PST 
project files (see note)

CX-Protocol project files consist of the 
following:
Protocol data
PLC (communications conditions between 
PLC and personal computer, communications 
port (A/B) setting of the PSB or the port (1/2) 
setting of the Serial Communications Board/
Unit) 
Trace data

*.PSW Yes Yes

PSS system setting file File that contains communications port (A/B) 
setting data of the PSS Protocol Macro 
Support Unit

*.pts Yes No

PSS protocol file File that contains only PSS protocol data *.pt1 Yes No

Trace data file File that contains only trace data *.ptr Yes No
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Main Screens of the CX-Protocol Section 1-8
Note CX-Protocol project files cannot be read by the PSS (DOS version of Protocol
Support Software) or the SYSMAC-PST.

Refer to 11-3 Importing Protocol Data from PST/PSS Files for loading PST
project files or PSS files.

1-8 Main Screens of the CX-Protocol
The CX-Protocol displays the tree view of the hierarchical data structure in the
left pane. For the highlighted data in the left pane, the list view of its contents
is displayed in the right pane.

Contents of a Project A project consists of protocol list, trace list, and PLC.

Display of Sequences in a Protocol
A protocol consists of sequences.
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Main Screens of the CX-Protocol Section 1-8
Display of Each Step in a Sequence
A sequence consists of steps and their setup parameters for each sequence
(transmission control parameter and so on).

Display of Messages in a Message List
Messages are managed separately from sequences. Messages can be
referred to by their names from each step in a sequence.

Display of Cases in a Matrix
Matrices are managed separately from sequences. Matrices can be referred
to by their names from each step in a sequence.
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Main Screens of the CX-Protocol Section 1-8
Display of Trace Data
Displays the send and receive messages in chronological order up to the
maximum of 1,700 bytes (characters) for the CS/CJ and 670 bytes (charac-
ters) for the C200HX/HG/HE.
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Overview of Project Creation Section 1-9
1-9 Overview of Project Creation

Note 1. A send message in a step can be designated by choosing its message
name in the send message list.

2. A receive message in a step can be designated by choosing its message
name in the receive message list or matrix name in the matrix list.

3. Therefore, you can create a message part during step creation more easily
by choosing a message name of the desired send message, receive mes-
sage, or matrix that you have created in advance.

Project creation from scratch

PLC Setup

Designate the following: Protocol name, 
sequence start number, sequence end 
number, target.

Protocol creation (addition to list)

Sequence creation

Designate the following: link word, 
transmission control parameter, 
response type, and monitoring time 
(Tr, Tfr, Tfs).

Step creation

Designate the following: repeat counter, 
command, retry count, send wait time, 
send message (note), receive message 
(note), with/without response writing, next 
process, and error process.

Message creation

Header, terminator, check code, length, 
address, message edit (including data) 

Protocol transfer (from personal computer to PMSU)

Matrix creation

Protocol sequence number range setting

Menu Operation/Icon Operation

Select New from the File menu

Select Edit PC-PLC Comms Settings from the PLC
menu. Designate target PLC model, Personal Com-
puter ↔ PLC Communication Settings.
Double-click the PMSU icon. Designate setup 
items for each of ports 1(A) and 2(B).

Right-click Create/Protocol.

Right-click Create/Sequence.

Right-click Create/Step.

Right-click the Send Message or 
Receive Message field in the step
list, and select New Message
from the pop-up menu.

Right-click Create/Matrix and 
Create/Matrix Case.

Refer to 

Note: Ports in parentheses 
are for the C200HX/HG/HE.

Display after creating new project.PLC model change

SECTION 5-1

SECTION 10-1/10-2

SECTION 10-1/10-2

SECTION 5-1

SECTION 5-1

SECTION 5-2
SECTION 7

SECTION 5-2
SECTION 8

SECTION 5-3

SECTION 9

SECTION 11-1
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Incorporated Standard System Protocol Section 1-10
1-10 Incorporated Standard System Protocol
The CX-Protocol together with the PMSU provides the following 13 types of
incorporated standard system protocols. (There are 12 types for the Commu-
nications Board of the C200HX/HG/HE because it does not support Compo-
Way/F.)
The protocols can be displayed by selecting the System Tab of the project
workspace.

Note To transfer standard system protocols to the PMSU or create a new protocol
by partially modifying one of the standard system protocols, first copy the
required standard system protocol to another project file and then use the
project file. The standard system protocols themselves cannot be edited or
transferred.
The standard system protocols have been installed into the PMSU at our fac-
tory.

For more information on each protocol, refer to the C200HX/HG/HE Commu-
nications Board Operation Manual (W304), CS/CJ Series Serial Communica-
tions Board/Unit Operation Manual (W336), and CQM1H Series Serial
Communications Board Operation Manual (W365).

Example: Protocol for the Controller (E5_K read)

Protocol name Function

CompoWay/F Protocol for sending a CompoWay/F command and receiving responses from the devices incorpo-
rating the CompoWay/F protocol (Slave function). This protocol operates only with the CS/CJ.

Controller 
(E5_K read)

Protocol for controlling an E5@K Digital Controller via the PMSU. Procedures for reading the MV 
and operating parameter setting.

Controller 
(E5_K write)

Protocol for controlling an E5@K Digital Controller via the PMSU. Procedures for writing set points 
and operating parameters.

Temp Controller 
(E5ZE read)

Protocol for controlling an E5ZE Temperature Controller via the PMSU. Procedures for reading 
measured temperature and operating parameter setting.

Temp Controller 
(E5ZE write)

Protocol for controlling an E5ZE Temperature Controller via the PMSU. Procedures for writing 
control temperatures and operating parameters.

Temp Controller 
(E5_J)

Protocol for controlling a E5@J Temperature Controller via the PMSU. Procedures for writing set 
points, reading output amounts, and reading/writing operating parameters.

Controller (ES100_) Protocol for controlling a ES100@ Temperature Controller via the PMSU. Procedures for writing 
adjustment parameters, reading operation amounts, and writing/reading operating parameters.

Intelligent Signal Pro-
cessor (K3T_)

Protocol for controlling a Digital Panel Meter via the PMSU. Procedures for writing comparison val-
ues and reading display values are set.

Bar Code Reader 
(V500/V520)

Protocol for controlling a Bar Code Reader via the PMSU. Procedures for controlling the Bar Code 
Reader in remote mode, reading the data that has been read by the Bar Code Reader, and 
reading/writing operating parameters.

Laser Micro Meter 
(3Z4L)

Protocol for controlling a Laser Micrometer via the PMSU. Procedures for controlling the Laser 
Micrometer in remote mode, reading measured data, and writing/reading operating parameters.

Visual Inspection 
System (F200/300/
350)

Protocol for controlling a Visual Inspection System via the PMSU. Procedures for controlling the 
Visual Inspection System in remote mode, reading measured values, and writing/reading 
operating parameters.

ID Controller (V600/
620)

Protocol for controlling an ID Controller via the PMSU. Procedures for performing Read/Write 
operations of the ID Controller and writing/reading operating parameters.

Hayes modem AT 
commands

Protocol for controlling a Hayes modem (AT commands) via the PMSU. Procedures for 
initialization of the modem, dialing, data transmission, switching to escape mode, and 
disconnecting the line.

Sequence No. Communications sequence

000 Read process value

001 Read set point during SP ramp

002 Read MV

003 Read set point
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Basic Procedure of the Protocol Macro Usage Section 1-11
1-11 Basic Procedure of the Protocol Macro Usage

1-11-1 For the CS/CJ
Procedure 1 PMSU Setup

Procedure 2 PMSU Mounting

004 Read alarm value

005 Read proportional band, integral time, and derivative time

Sequence No. Communications sequence

Setting the Serial Communications Unit
Front rotary switch setting

Terminating resistance ON/OFF switch

2-wire/4-wire Selection switch

Unit No. setting switch

Set the unit No. in a range from 0 to F (0 to 15).

Setting the Serial Communications Board
(for Serial Communications Boards with 
RS-422A/485)

Mounting the Serial Communications Board Mounting the Serial Communications Unit
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Basic Procedure of the Protocol Macro Usage Section 1-11
Procedure 3 Connection with External Devices

Note For connector pin arrangements and connection methods, refer to the CS/CJ
Series Serial Communications Boards/Unit Operation Manual (W336) and
other relevant manuals for general-purpose external devices.

Procedure 4 Initial Setting

1,2,3... 1. For Connecting Cables between the PLC and the CX-Protocol, refer to 
1-4 System Configuration.

2. PLC Setup of the CPU Unit and the PMSU.

PLC Setup for Connecting the PLC to the CX-Protocol.
Perform the following setups (a) and (b). The communications conditions
designated in (a) and (b) must be coherent.

a) Using the CX-Protocol, designate a target PLC model and perform the
communications setup between the personal computer and the PLC.

b) Using a Programming Device for PLC’s CPU Unit, perform the PLC
setup according to a connected port.

Example: Setting the Default Communications Conditions (m=D30000+100×Unit No.)

RS-232C

RS-422A/485

CPU Unit

Port 1

Port 2

Port 1

Port 2

General-purpose 
external device

General-purpose 
external device

General-purpose 
external device

General-purpose 
external device

General-purpose 
external device

RS-232C RS-232C

CS1W-SCU21-V1 Serial Communications Unit CS1W-SCB41-V1 Serial Communications Board

Board Unit Bits Settings

Port 1 Port 2 Port 1 Port 2

D32000 D32010 m m+10 15 0: Start bit=1 bit, Data length=7 bits, Parity=Even, Stop bit=2 bits

11 to 08 6: Protocol macro

D32001 D32011 m+1 m+11 03 to 00 0: Baud rate: 9600 bits/s

D32008 D32018 m+8 m+18 15 0: Half-duplex

D32009 D32019 m+9 m+19 15 to 00 00C8 Hex: Protocol send/receive data bytes: 200 bytes max. 

PLC Setup of the Serial Communications Board PLC Setup of the Serial Communications Unit
Allocated DM area: D32000 to D32767 Allocated DM area: D30000×100 Unit No.

PLC setup of port 1

PLC setup of port 2
Reserved by the system

D32000 to D32009
D32010 to D32019

D32020 to D32767

Unit No. DM area
m to m+9: PLC setup of port 1
m+10 to m+19: PLC setup of port 2
m+20 to m+99: Not used

D30000 to D30099
D30100 to D30199
D30200 to D30299
D30300 to D30399

D30400 to D30499
D30500 to D30599

D30600 to D30699

D30700 to D30799
D30800 to D30899
D30900 to D30999

D31000 to D31099
D31100 to D31199
D31200 to D31299

D31300 to D31399
D31400 to D31499
D31500 to D31599

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F
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Basic Procedure of the Protocol Macro Usage Section 1-11
Using the CX-Protocol, make the settings for communications ports 1 and 2 of
the PMSU and transfer the settings to the PLC.
For more information, refer to 10-6 PMSU Communications Port Settings and
10-7 Transfer of Communications Port Setting Data to PLC.
3. External Device Settings

Perform required processes including DIP switch settings on external de-
vices.

Procedure 5 Protocol Design
Refer to the SECTION 4, SECTION 5, and SECTION 6.

1,2,3... 1. Creates the status transition chart of the communications sequence.
2. Disassembles the status transition chart into sequences and steps, and

set them up.
3. Creates the send and the receive messages.

Procedure 6 Project (Protocol Data) Creation and Transfer by CX-Protocol
Refer to 1-9 Overview of Project Creation.

1,2,3... 1. Creates a new project.
Refer to 5-1 Creating Projects and Protocols.

2. Creates a new communications sequence.
Refer to 5-2 Creating Sequences and Steps and7-1 Setting Sequences.

3. Creates each step.
Refer to 5-2 Creating Sequences and Steps and 8-1 Step Setting.

4. Creates each message. (See note.)
Refer to 9-1 Creating Messages.

5. Transfers the created projects to the PMSU. 

Refer to 11-1 Transferring and Reading Protocol Data between the Com-
puter and PMSU.

Note Each step can be created after each message creation by designat-
ing the message name.

Procedure 7 The Ladder Program Creation

1,2,3... 1. Allocates a function code for the PMCR instruction.
Example: For the Serial Communications Board

When the input condition is set to “ON” and the Protocol Macro Execution
Flag (191915: port 2) is set to “OFF,” the communications sequence num-
ber 100 registered on the PMSU is called to send and receive data via port
2 of the PMSU if the Communications Port Enabled Flag (A20207: internal
logic port of the communications port No. 7 is used) is ON.
The send data is sent out from the next D00001 according to the number
of effective words (number of words including D00000) designated by
D00000.

Use communications port No. 7 and 
serial port No. 2.
Destination unit number address E1: 
Inner (serial communications) Board

Sequence No. 100

Send data first word

Receive data storage first word

PMCR (260)

   #72E1

   #0064

   D00000

   D00100

Input condition
Execution Flag

191915

Protocol Macro
Enabled Flag

A20207

Communications Port

How many words including 
D0000 are effective?
Designated number at D00000 
of send data are read beginning 
from D00001.

Number of effective words

Send data

D00000

D00001
Effective 
words
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Basic Procedure of the Protocol Macro Usage Section 1-11
The receive data is stored in the successive words beginning from D00101
for the number of effective words actually stored in D00100 (number of
words including D00100).

Note Receive data set before the PMCR is executed will not change if re-
ceive processing fails.

2. Execute the PMCR instruction.

Procedure 8 Confirmation of Operations
Refer to SECTION 12 Tracing and Monitoring.

1,2,3... 1. Traces the transmission lines.

Trace the data in the send and receive messages and the control signals
that are flowing on the transmission line (RS-232C or RS-422A/485).

2. Monitors the I/O memory.

Monitor the send and the receive data and the status of flags.

1-11-2 For the C200HX/HG/HE
Procedure 1 PMSU Setup DIP Switch Setup for the PMSU (For C200HW-COM06-E/EV1 only.)

SW1: Switch between two-wire and four-wire methods
SW2: ON/OFF of terminating resistance (ON during using RS-422A/485
ports)

Procedure 2 PMSU Mounting

1,2,3... 1. Open the memory cassette cover.

How many words including 
D00100 are effective?
Receive data is stored in 
successive words beginning 
from D00101 and the number of 
effective words is stored in 
D00100.

Number of effective words

Receive data

D00100

D00101
Effective 
words
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Basic Procedure of the Protocol Macro Usage Section 1-11
2. Remove the PMSU cover.

3. Insert the PMSU and slide it into the slit completely.

4. Close the memory cassette cover.

Procedure 3 Connection with External Devices
Connect through RS-232C or RS-422A/485.

Note For connector pin arrangements and connection methods, refer to the Com-
munications Board Operation Manual (W304) and other relevant manuals for
general-purpose external devices.

RS-232C

Protocol Macro Support Unit

RS-422A/485
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Basic Procedure of the Protocol Macro Usage Section 1-11
Procedure 4 Initial Setting

1,2,3... 1. For Connecting Cables between the PLC and the CX-Protocol, refer to 
1-4 System Configuration.

2. PLC setup of the CPU Unit and the PMSU.
PLC Setup for Connecting the PLC to the CX-Protocol.
Perform the following setups (a) and (b). The communications conditions
designated in (a) and (b) must be coherent.
a) Using the CX-Protocol, designate a target PLC model and perform

communications setup between the personal computer and the PLC.
b) Using a Programming Device for PLC’s CPU Unit, perform PLC setup

according to a connected port.
• When connected to the peripheral port:

Communications setup of the peripheral port:
DM 6650 to DM 6654 in the PLC setup area

• When connected to the CPU Unit’s built-in RS-232C port:
Communications setup of the RS-232C port:
DM 6645 to DM 6649 in the PLC setup area

For both the peripheral port and the CPU Unit’s built-in RS-232C port,
make the default settings (start bit: 1 bit, data length: 7 bits, parity: even,
stop bit: 2 bits, baud rate: 9600 bps) to correspond to 0000 in DM 6650 for
the peripheral port and DM 6645 for the CPU Unit’s built-in RS-232C port
respectively.
PLC Setup for the PMSU
Use one of the following methods to perform PLC setup of the PMSU port
A/B.
c) Using a Programming Device for the PLC’s CPU Unit, perform the fol-

lowing PLC setup.
PMSU PLC setup
Port A: DM 6555 to DM 6559 in the PLC setup area
Port B: DM 6550 to DM 6554 in the PLC setup area

Example: Setting the Default Communications Conditions

d) Using the CX-Protocol, perform setup of communications port A/B
through the PMSU Icon and transfer the setting to the PLC.
For more information, refer to 10-7 Transfer of Communications Port
Setting Data to PLC.

3. Setup of external devices.

Perform required processes including DIP switch settings on external de-
vices.

15 0

6 0 0 0

Communications conditions of Port A
0 indicates: 
Start bit:1 bit, data length: 7 bits, parity: 
even, stop bit: 2 bits, baud rate: 9,600 bps

Communications mode for port A
6: Protocol macro

DM6555
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Basic Procedure of the Protocol Macro Usage Section 1-11
Procedure 5 Protocol Design
Refer to SECTION 4, SECTION 5, and SECTION 6.

1,2,3... 1. Creates the status transition chart of communications sequence.

2. Disassembles the status transition chart into the sequences and steps and
sets them up.

3. Creates the send and the receive messages.

Procedure 6 Project (Protocol Data) Creation and Transfer by CX-Protocol
Refer to 1-9 Overview of Project Creation.

1,2,3... 1. Creates a new project.
Refer to 5-1 Creating Projects and Protocols.

2. Creates a new communications sequence.
Refer to 5-2 Creating Sequences and Steps and 7-1 Setting Sequences.

3. Creates each step.
Refer to 5-2 Creating Sequences and Steps and 8-1 Step Setting.

4. Creates each message. (See note.)
Refer to 9-1 Creating Messages.

5. Transfers the created projects to the PMSU. 
Refer to 11-1 Transferring and Reading Protocol Data between the Com-
puter and PMSU.

Note Each step can be created after each message creation (by designat-
ing the message name).

Procedure 7 The Ladder Program Creation

1,2,3... 1. Allocates function code for the PMCR instruction.

1) Sets SW4 of the CPU Unit to ON (enables the application commands
setup).

2) Allocates function code for the PMCR instruction through a Program-
ming Device for the CPU Unit.

Note If your PLC is the C200H@-CPU@@-ZE, function code 260 will be as-
signed to the PMCR instruction by default.

2. Describes the PMCR instruction.
Example:

When the input condition is set to “ON” and the Protocol Macro Execution
Flag (28908: port A) is set to “OFF,” the communications sequence No. 100
registered on the PMSU will be called to send and receive data via port A
of the PMSU.
The send data will be sent out from the next DM 00001 according to the
number of effective words (number of words including DM 0000) designat-
ed by DM 0000.

PMCR (260)

#1100

DM0000

DM0010

FAL(06)001
25503

Input condition
Protocol Macro 
Execution Flag
28908

Sequence No. 100 is executed using the Port A.

Send data first word

Receive data storage first word

ER Flag
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Specifications Section 1-12
The receive data is stored in the successive words beginning from DM
0011 for the number of effective words actually stored in DM 0010 (number
of words including DM 0010).

3. Execute the PMCR instruction.

Procedure 8 Confirmation of Operations
Refer to SECTION 12 Tracing and Monitoring.

1,2,3... 1. Traces the transmission lines.

Trace the data in the send and the receive messages and the control sig-
nals flowing on the transmission line (RS-232C or RS-422A/485).

2. Monitors the I/O memory.

Monitor the send and the receive data and the status of flags.

1-12 Specifications

1-12-1 Protocol Macro Specifications

How many words including 
DM 0000 are effective?
Designated number at DM 0000 
of send data are read beginning 
from DM 0001.

Number of effective words

Send data

DM0000

DM0001
Effective 
words

How many words including 
DM 0010 are effective?
Receive data is stored in 
successive words beginning 
from DM 0011 and the number 
of effective words is stored in 
DM 0010.

Number of effective words

Receive data

DM0010

DM0011 Effective 
words

Item Description

Number of protocols 20 max. Can be created and registered by the CX-Protocol.

Number of sequences 1000 max.

Per 
protocol

Sequence 
count

60 max.

Message 
count

300 max.

Matrix count 100 max.

Number of steps per 
sequence

16 max.

Sequence execution 
condition

Designated by the PMCR instruction on the PLC’s CPU Unit (by giving a sequence number).

Transmission mode Half-duplex or full-duplex can be designated. (Full-duplex is only for the CS/CJ protocol 
macro.)

Synchronization method Start-stop synchronization (non-synchronization method)
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Specifications Section 1-12
Sequence 
content 
(common 
parameter 
to all steps)

Transmis-
sion control 
parameters

One of X-on/X-off flow or RTS/CTS flow, delimiter control, contention control, or modem 
control can be designated.

Response 
type

Mode for writing received data to the I/O memory area designated by the third operand 
(for C200HX/HG/HE) or fourth operand (for CS/CJ) of the PMCR instruction.
Either the scan mode or interrupt mode can be designated.

Monitoring 
time for 
sending/
receiving

Receive wait, receive finish, or send finish can be monitored.
Setup range: 0.01 to 0.99 s, 0.1 to 9.9 s, 1 to 99 s, or 1 to 99 minutes

Link word Data are exchanged between the PLC’s CPU Unit and the PMSU when the CPU Unit is 
doing a Peripheral service. Two areas for sending data, and two areas for receiving data.

Step 
content

Command Send, Receive, or Send&Receive, Wait, Flush, DTR-ON (Open), or DTR-OFF (Close) (Wait, 
Flush, DTR-ON, and DTR-OFF are only for the CS/CJ protocol macro.) 

Repeat 
counter

1 to 255 times

Retry count 0 to 9 (Can be designated only for Send&Receive command.)

Send wait 
time

0.01 to 0.99 s, 0.1 to 9.9 s, 1 to 99 s, or 1 to 99 minutes
(Can be designated only for Send or Send&Receive command.)

With/Without 
response 
writing 
(operand 
addressing)

Specifies whether to store the receive message after data receiving is completed (when 
storing received data to the area designated by the third operand (for C200HX/HG/HE) or 
fourth operand (for CS/CJ) of the PMCR instruction.)

Next process Specifies the next process as follows when the step ends normally: End (end the sequence), 
Next (go to the next step number), Goto (go to a designated step number), or Abort (abort 
the step to end the sequence).

Error 
process

Specifies the next process as follows when the step ends abnormally: End (end the 
sequence), Next (go to the next step number), Goto (go to a designated step number), or 
Abort (abort the step to end the sequence).

Send 
message

Settings for the data to 
be sent when the 
command is Send or 
Send&Receive.

Consists of a header (Note 1), address (Note 2), length, data 
(Note 2), error check code (Note 3), and terminator (Note 1).

Receive 
message 

Settings for the data to 
be received when the 
command is Receive or 
Send&Receive.

Matrix When the command is 
Receive or 
Send&Receive, the 
matrix sets up the 
message expected to be 
received (up to 15 sets) 
to switch next process 
by comparing the data.

Designate a receive message and next process for each of case 
numbers 00 to 15.
At least one of 16 cases must be designated to Other for its 
receive message type (other than the designated receive 
message).

Data 
attribute of 
header and 
terminator 

Constant ASCII data, hexadecimal data, or control code.

Item Description
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Specifications Section 1-12
Step 
content

Address 
attributes 
and data 
attributes in 
send or 
receive 
message

Constant ASCII data, hexadecimal data, or control code (For address, the control code 
cannot be used.)

Variable No conversion, hexadecimal to ASCII conversion, or ASCII to hexadecimal 
conversion (Direction of read / write can be designated.)

Specifica-
tion 
method

(X,Y)
X: Effective address (source or destination address)
Y: Data size (1 to 1,000 for CS/CJ and 1 to 255 for C200HX/HG/
HE) (Data size is equal to the number of bites on transmission 
path.)

X Word 
designation

Word read 
(I/O 
memory 
→ send 
data)

Designated by 
the second 
operand (for 
C200HX/HG/
HE) or the third 
operand (for CS/
CJ) of the 
PMCR 
instruction

Designated start 
address + n 
(The linear 
expression 
aN+b, which 
includes the 
repeat counter 
N, can be 
designated for 
n.)Designated by 

the link word.

Designated 
directly.

Word write 
(receive 
data → I/O 
memory)

Designated by 
the third 
operand (for 
C200HX/HG/
HE) or the fourth 
operand (for CS/
CJ) of the 
PMCR 
instruction.

Designated by 
the link word.

Designated 
directly.

Wildcard * Receive any data/address (only for 
receive message)

Linear expres-
sion or constant 
including the 
repeat counter

aN+b a: 0 to 255 (for C200HX/HG/HE) 
or 0 to 1,000 (for CS/CJ)
b: 1 to 255 (for C200HX/HG/HE) 
or 1 to 1,000 (for CS/CJ)
N: Repeat counter value

Item Description
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Step 
content

Address 
attributes 
and data 
attributes in 
send or 
receive 
message

Variable Y Linear expres-
sion or constant 
including the 
repeat counter

aN+b a: 0 to 255 (for C200HX/HG/HE) 
or 0 to 1,000 (for CS/CJ)
b: 1 to 255 (for C200HX/HG/HE) 
or 1 to 1,000 (for CS/CJ)
N: Repeat counter value

Wildcard * Receive any length of data.

Word 
designation

Word read 
(I/O mem-
ory → send 
data)

Designated by 
the second 
operand (for 
C200HX/HG/
HE) or the third 
operand (for CS/
CJ) of the 
PMCR 
instruction

Designated start 
address + 
n (The linear 
expression aN + 
b, which 
includes the 
repeat counter 
N, can be 
designated for 
n.)Designated by 

the link word.

Designated 
directly.

Error check 
code

Supports calculation of LRC, LRC2, CRC-CCITT, CRC-16, SUM, SUM1, and SUM2. 
(LRC2 and SUM1 are only for the CS/CJ protocol macro.)

The 
maximum 
length of the 
send or the 
receive 
message

CS/CJ: 1,000 bytes (possible to set to a range between 200 and 1000 bytes)
Also possible to set to this range at a control of RTS/CTS flow, X-on/X-off flow, or delimiter.

C200HX/HG/HE: 256 bytes (Within 200 bytes of one-step receiving message at a control of 
RTS/CTS flow, X-on/X-off flow, or delimiter.)

Trace function Possible to trace chronological data of send/receive messages. 

CS/CJ: Data length that can be traced is 1,700 bytes (characters).
C200HX/HG/HE: Data length that can be traced is 670 bytes (characters).
Possible to trace changes in the control signals such as step number, RTS, or CTS.

Item Description
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1-12-2 Specifications of the CX-Protocol
The following conditions are for when installing the CX-Protocol as an individ-
ual application. Different conditions will apply when installing the CX-Protocol
as one of the features of the CX-One FA Integrated Tool Package. Refer to the
CX-One Setup Manual (W463) for the specific conditions.

1-13 Differences between Protocol Macros
The protocol macro for the CS/CJ is different from the one for the C200HX/
HG/HE as shown in the following table.

Item Description

Basic functions Creation of protocols, transfer of protocols to and from the PMSU, and file saving

File creation unit Project unit

Components of project Protocol list Up to 20 protocols (components of 
protocol: sequence, send/receive 
message, matrix)

Devices Target PLC, network setup, com-
munications port setup

Trace list

Other functions - Tracing of transmission lines
- Monitoring of PLC’s I/O memory
- Print of protocols
- Standard system protocols are built-in.
- Error display

Supported network Host link (SYSMAC WAY), Tool Bus, Controller Link, SYSMAC LINK, Ethernet, and USB

Connection with PLCs Peripheral port, built-in RS-232C port, or USB port on the CPU Unit; RS-232C port on the 
PMSU (only in the host link mode); or a Network Support Board for the above networks

Item C200HX/HG/HE CS/CJ

Transmission mode Half-duplex Half-duplex or full-duplex

Commands Send, Receive, and Send&Receive Send, Receive, Send&Receive, Wait, 
Flush, DTR-ON (Open), and DTR-OFF 
(Close)

Notes
Wait: Keeps the step on standby and 
controls the next process.
Flush: Clears all data in the receive 
buffer.
Open (DTR-ON): Holds the DTR signal 
even after the sequences has ended 
(only under modem control).
Close (DTR-OFF): Turns OFF the DTR 
signal under the modem control.

Receive 
buffer 
(per port)

256 bytes 2.5 Kbytes

Receive 
buffer 
flow 
control 
(RTS/
CTS, 
Xon/
Xoff) on 
PMSU 
side

Starting point (send stop 
request to the destination 
device: RTS signal OFF) 

200 bytes 2 Kbytes
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Ending point (send 
resumption request to the 
destination device: RTS 
signal ON) 

When shifting steps 0.5 Kbytes

Maxi-
mum 
send/
receive 
mes-
sage 
length

Number of bytes that can be 
sent for one Send processing

256 bytes max. 1,000 bytes max.
Default: 200 bytes
Possible to set between 200 and 1,000 
bytes.
Note
When receiving data, data within the 
receive buffer will be retrieved for each 
maximum length.

Number 
of bytes 
that can 
be 
received 
for one 
Receive 
process-
ing

RTS/CTS flow, 
Xon/Xoff flow, 
delimiter control

200 bytes max.

Others 256 bytes max.

Maxi-
mum 
receive 
mes-
sage 
length 
when a 
wildcard 
(*) is 
used for 
data 
length

RTS/CTS flow, Xon/Xoff flow, 
delimiter control

200 bytes max. As shown above.
Possible to set between 200 and 1,000 
bytes.
Default: 200 bytes

Others 256 bytes max.

Designa-
tion of 
send/
receive 
data 
storage 
location

When 
operand 
is desig-
nated

Maximum send 
data

127 words max. (Not including the 
send data word area)

250 words max. (Including the send 
data word area)

Maximum receive 
data

127 words max. (Not including the 
receive data word area)

250 words max. (Including the receive 
data word area)

Data 
capacity

When 
link word 
is desig-
nated

Area 1 IN Total of 128 words max. Total of 500 words max.

OUT

Area 2 IN

OUT

Direct 
designa-
tion (by 
each 
parame-
ter)

Maximum send or 
receive data

128 words max. (No conversion) 500 words max. (No conversion)

Receive buffer 
clearing timing

Half-duplex 1) Right before sequence is executed.
2) Right before Receive processing is 
executed.

1) Right before sequence is executed.
2) Right before Send processing is 
executed.
3) When Flush command is executed.

Full-duplex Not available. 1) Right before sequence is executed.
2) When Flush command is executed.

Receive processing 
to the receive buffer

Half-duplex Only while Receive processing is 
being executed.

Any time other than when Send 
processing is being executed.

Full-duplex Not available. Every time the sequence is executed. 
(No receive processing if sequence is 
not executed.)

Character trace 
receive record

Half-duplex Every time the sequence is executed. 
(Also recorded while Send processing 
is being executed.)

Every time the sequence is executed. 
(Also recorded while Send processing 
is being executed.)
Execution sequence number 
communications error.

Full-duplex Not available.

Item C200HX/HG/HE CS/CJ
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Transmission con-
trol signal operation

RTS signal When RTS/CTS flow control is desig-
nated: RTS signal turns ON when the 
receive buffer on the PMSU side 
reaches 200 bytes.
When modem control is designated: 
Turns ON when data is sent and turns 
OFF when transmission is completed.

When RTS/CTS flow control is 
designated: RTS signal turns ON when 
the receive buffer on the PMSU side 
reaches approx. 2 Kbytes.
When modem control is designated: 
Turns ON when data is sent and turns 
OFF when transmission is completed.

CTS signal When RTS/CTS flow control is desig-
nated: transmission is kept standby 
when CTS signal is ON and transmis-
sion becomes possible when CTS sig-
nal is OFF.

When RTS/CTS flow control is 
designated: transmission is kept on 
standby when CTS signal is ON and 
transmission becomes possible when 
CTS signal is OFF.

DTR signal When modem control is designated: 
Turns ON when sequence execution is 
started and turns OFF when sequence 
execution is completed.
Note
Does not turn ON in modes other than 
the modem control.

When modem control is designated: 
Turns ON when sequence execution is 
started and turns OFF when sequence 
execution is completed.
Under the modem control, ON/OFF 
can be controlled at any desired timing 
by executing the Open (DTR-ON state 
is retained even after sequence is 
completed) or Close (DTR-OFF) 
command.
DTR signal can be controlled over 
more than one sequence.

Note
When both the RTS/CTS flow control and modem control are designated: 
The DTR signal will follow the modem control and RTS/CTS signal will turn ON 
the RTS signal when sending data and will follow the RTS/CTS flow control 
when receiving data.

Synchronization with the CPU Unit after 
sequence is executed.

Not available. Keeps transition between steps on 
standby using the Wait command and 
starts control when the Wait is cleared 
from the CPU Unit.
Example: Processing can proceed to 
the next step after the CPU Unit com-
pletes internal computation in a 
particular step.

Send/receive 
messages

Receiving data 
length

No check. Data is retrieved as a message for the 
length indicated in the expected 
receive message.

Error check code LRC2 and SUM1: Not available. LRC2 and SUM1: Available

Interrupt notification function Not available. Serial Communications Board: 
Available.
Serial Communications Unit: Not 
available.

Item C200HX/HG/HE CS/CJ
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Installing/Uninstalling/Starting/Ending

This section outlines the functions of the CX-Protocol and describes the operating environment, installation procedure, and
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Connecting to a PLC Section 2-1
2-1 Connecting to a PLC
When transferring protocol data created by the CX-Protocol to Communica-
tions Boards or Units, use the following Cables to connect the computer and
PLC. Connection to the CPU Unit can be made to either the peripheral port or
RS-232C port of the CPU Unit.

Note A personal computer can be connected to the PMSU port if the port is set to
the host link mode. With the C200HX/HG/HE, if one of the PMSU ports is set
to the NT link mode, this connection will not be possible.

CJ2

Note CJ2H-CPU@-EIP and CJ2M-CPU3@ only.

Port at Unit Port at computer Network type 
(communications 

mode)

Model Length Remarks

Peripheral (USB) 
port (Conforms to 
USB 2.0, B connec-
tor)

USB port 12 Mbps, USB 2.0 Commercially avail-
able USB cable (A 
connector- B connec-
tor)

5 m max. ---

Serial port (RS-
232C) (D-sub, 9-pin, 
female)

D-sub, 9-pin, male Serial communica-
tions

XW2Z-200S-CV 2 m Use a static-resis-
tant connector.XW2Z-500S-CV 5 m

Built-in Ether-Net/IP 
port (see note)

Ethernet port 100Base-TX or 
10Base-T

Commercially avail-
able twisted-pair cable

100 m (Recommended 
between hub and nodes.)

---

Commercially avail-
able switching hub

---

Peripheral (USB) port Serial port (RS-232C)

*1 Commercially available USB cable: 5 m max., for USB 1.1 or 2.0.

Built-in EtherNet/IP port

Commercially 
available
USB cable*1

Peripheral (USB) port 
(conforming to USB 2.0, 
B connector)

A connector USB port

B connector
CJ2 CPU Unit

D-sub connector 
(9-pin female)

CJ2 CPU Unit

D-sub connector 
(9-pin male)

Recommended cable: 
XW2Z-200S-CV/500S-CV

D-sub connector 
(9-pin male)

COMM

Serial port (RS-232C) (9-pin female 
D-sub connector) or Serial Option 
Board (for CJ2M-CPU3@)

100Base-TX 
twisted-pair cable 
(straight)

100Base-TX 
twisted-pair cable 
(straight)

Switching hub

Built-in EtherNet/IP port

CJ2 CPU Unit
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CS/CJ

Note The CS1W-CN118 is used when connecting an RS-232C cable to the periph-
eral port.

CP Series

Note If an RS-232C Option Board (CP1W-CIF01) is mounted, it is also possible to
use a XW2Z-200S/500S-V/-CV RS-232C Cable to connect an RS-232C port
on the computer to the RS-232C Option Board. 

Communications 
procedure

Cable used Cable length Connector on the 
computer

Connector on the 
PLC

Peripheral bus CS1W-CN118 (see note) 0.1 m RS-232C Peripheral port

CS1W-CN226 2 m

CS1W-CN626 6 m

XW2Z-200S-V 2 m CPU Unit built-in 
RS-232C portXW2Z-500S-V 5 m

RS-232C

RS-232C RS-232C port

Peripheral port

CPU Unit

Peripheral port

CPU Unit

RS-232C port

XW2Z-200S-V/500S-V

CS1W-CN118/226/626

Connecting the CPU Unit to the peripheral port

Connecting the CPU Unit to the RS-232C port

Computer Computer port CPU Unit port Cable length Cable

IBM PC/AT or 
compatible

USB port 
(A-type con-
nector)

USB port 
(B-type con-
nector

5 m max. Commercially 
available USB 
1.1 or 2.0 cable

 

IBM PC/AT or 
compatible 

CP1H 
CPU Unit 

USB port 

Commercial 
USB cable 

Peripheral USB port 
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C200HX/HG/HE

When creating a specific RS-232C cable, join the connectors listed in the fol-
lowing table.

Connectors and Cables

Connection Signals on the Personal Computer Side 

Communications 
procedure

Cable used Cable length Connector on the 
computer

Connector on the 
PLC

Peripheral bus CQM1-CIF02 3.3 m RS-232C Peripheral port

RS-232C XW2Z-200S-V 2.0 m RS-232C

XW2Z-500S-V 5.0 m

RS-232C

RS-232C RS-232C port

Peripheral port

CPU Unit

Peripheral port

CPU Unit

RS-232C port

XW2Z-200S-V/500S-V
RS-232C cable

CQM1-CIF02

Connecting the CPU Unit to the peripheral port

Connecting the CPU Unit to the RS-232C port

Component name Model Manufacturer

D-sub connector (9-pin, 
PLC side, male)

XM2A-0901 (connector) OMRON

XM2S-0911 (connector hood)

D-sub connector (9-pin, 
PC side, female)

XM2D-0901 (connector) OMRON

XM2S-0911 (connector hood)

Recommended Cable UL2464 AWG28✕5P IFS RVV SB 
(UL item)

Fujikura Ltd.

AWG28P ✕ 5P IFVV-SB (non-UL item)

UL2464-SB 5P ✕ AWG28 (UL item) Hitachi Cable, 
Ltd.CO-MA-VV-SB 5P ✕ AWG28 

(non-UL item)

Wire path length Up to 15 m

Pin number Symbol Circuit name

1 FG Protective Ground

2 RD Receive Data

3 SD Send Data

7 RTS Request To Send

8 CTS Clear To Send

5 SG Signal Ground
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Wiring Cables The following diagram shows the wiring of cables connecting a PLC and com-
puter.

2-2 Installing and Uninstalling the Software
The CX-Protocol is installed from the CX-One Installer. For details, refer to the
CX-One Setup Manual (Cat. No. W463), which is provided with the CX-One. 

2-3 Startup
Use the following procedure to start the CX-Protocol.

1,2,3... 1. Left-click the Start Button on the taskbar and select Programs. 

2. Select the Omron folder.

3. Select the CX-Protocol folder.

4. Left-click the CX-Protocol program to start the CX-Protocol. When the
CX-Protocol is started, the standard system protocol will be displayed.

The CX-Protocol can be started also by right-clicking a Serial Communica-
tions Board/Unit in the I/O Table Window opened from the CX-Programmer
and selecting Start Special Application from the pop-up menu.

In this case, if Start Special Application - Start Only is selected, the CX-
Protocol will be started in the same manner as when started from the Win-
dows Start Menu (i.e., no new project will be created).

If Start Special Application - Start with Setting Inherited is selected, the
CX-Protocol will be started with a new project that inherits the Device Type
and online/offline status from the CX-Programmer. 

PLC
Connector hood FG

---
SD
RD
RTS
CTS
SG

1
2
3
4
5
9

Computer
Connector hood FG

FG
RD
SD

RTS
CTS
SG

1
2
3
7
8
5

D-sub 9-pin plug (Male) D-sub 9-pin plug (Female)

Shield
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2-4 Shutdown
Use one of the following methods to shut down the CX-Protocol.

Select the Control Menu on the title bar and left-click the Close Button.

Select the File Menu and left-click the Exit in the menu.

Left-click the Close Button on the title bar.

Press the Alt+F4 Keys.

A confirmation dialog box will be displayed if any data currently opened in the
CX-Protocol has not been saved.

Left-click the Yes Button to save the changes. Left-click the No Button to dis-
card the changes. The CX-Protocol will close. Left-click the Cancel Button to
abort the operation and return to the CX-Protocol.

2-5 Outline of User Interface
The following is the basic screen configuration of the CX-Protocol. The stan-
dard system protocol screen that is displayed upon startup is always dis-
played in the Project Window.

The screen consists of three panes.

Project nameTitle bar

Menu bar

Tool bar

Project name

Project workspace

Status bar

Standard system protocol project window

Output window

System tabProject tab

Project window

Project Window: The contents of the data highlighted in the project workspace is displayed. 
By double-clicking the icon on the left edge of the screen, the contents of the data are 
displayed as a hierarchy from the highest level to the lowest level scrolled.

Project Workspace:The hierarchy is displayed with the Project as the highest level. The contents of the 
highlighted data will be displayed in the project window.

Output Window: Errors or warnings that occur while compiling data that have been sent to the PMSUs 
connected online are displayed.

System Tab: Left-click the tab to make active the project window of the standard system protocol.
Project Tab: Left-click the tab to make active the project window of the project created by users.
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• The data hierarchy is displayed in the left pane in a tree format. The left
pane is called the Project Workspace.

• The contents of designated data (i.e., highlighted data) in the project
workspace will be displayed in a table format in the right screen portion.
The right pane is called the Project Window.

The menu and tool bars are used for basic Windows functions such as file and
edit functions as well as protocol and trace operating functions.

When the CX-Protocol is started, the standard system protocol will be dis-
played on the screen. When a new protocol is created or when an existing
project file is opened, the project window will be displayed on top of the
screen. This becomes the active window. 

To switch between the standard system protocol project workspace and the
user’s project workspace, either left-click the System Tab or Project Tab or
directly click the project window.

The following are the basic operations required to create, edit, and download
protocols.

• Double-click the icon on the project workspace or project window to shift
from the highest level to the lowest level. Press the Esc Key to shift from
the lowest to the highest level.

• To create a new object such as a protocol, sequence, step, or message,
right-click to display the pop-up menu and select Create. A new object will
be displayed in the project window.

• To input data into the list in the project window, left-click the cell (input
field) or click the Down-arrow Icon to display the settings dialog box and
input set values into the dialog box.

• The pop-up menu is used for setting the communications port of the
PMSU, uploading protocols, tracing data, or downloading trace data.
Right-click or press the Shift+F10 Keys to display the pop-up menu.

Note The pop-up menu that is displayed when the right mouse button is clicked is a
useful feature of the CX-Protocol. Different pop-up menus will be displayed
depending on where the right button is clicked. These pop-up menus are effi-
cient because they include almost all the main functions such as: creating
new protocols, sequences, messages, matrices, and matrix cases, setting the
communications port of the PMSU, uploading protocols, and tracing data.

Right click

Click the right button and select a desired menu.
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2-5-1 Window
Project Workspace Data will be displayed in the following hierarchy.

Project

Protocol List

Protocol

Communications 
Sequence

Send Message 
List

Receive Message 
List

Matrix List

Trace List

Devices (PLC)

Board

–

–

+

+

Project

Protocol List

Protocol Name

Sequence 
Name

Sequence 
Name

Send Message 
List

Receive Message 
List

Matrix List

Trace List

PMSU

Unit 0

PLC

– The data indicated to the right 
displays those in lower levels.

+ The data indicated to the right 
does not display those in lower 
levels.

Sequences under the 
above protocol name 

Lists under the 
above protocol 
name

Displays 
more 
than one.

Displays 
only 
one.

–

Matrix

Protocol Name

Protocol Name

Unit F

Unit (16 from 0 to F)
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Project Window The following items will be displayed depending on selected data items (i.e.,
the highlighted data) in the project workspace.

The highlighting cursor is available in both the project workspace and the
project window.

The focused portion (i.e., the portion actually selected in operation) is sur-
rounded by a dotted line. If a line in the project window is selected, the
focused portion will be in the project window.

Selected data in 
the project 
workspace

Item in the project window

Project ∗ Name Protocol 
List Name

Number 
of Proto-
cols

Trace 
List

Num-
ber of 
Traces

PLC Name Series Model --- ---

Protocol 
List

∗ Protocol 
Name

Sequence 
Start 
Number

Se-
quence 
End 
Number

Type Target --- --- --- --- ---

Protocol 
Name

∗ # 
(Se-
quence 
Number)

Communi-
cations 
Sequence

Link 
Word

Trans-
mission 
Control

Re-
sponse
Type

Timer 
Tr

Timer 
Tfr

Timer 
Tfs

--- ---

Sequence 
Name

∗ Step Repeat 
Counter

Com-
mand

Retry 
Count

Send 
Wait 
Time

Send 
Mes-
sage

Receive 
Mes-
sage

Re-
sponse

Next Error

Send 
Message 
List

∗ Message 
Name

Header 
<h>

Termi-
nator 
<t>

Check 
Code 
<c>

Length 
<l>

Address 
<a>

Data --- --- ---

Receive 
Message 
List

∗ Message 
Name

Header 
<h>

Termi-
nator 
<t>

Check 
Code 
<c>

Length 
<l>

Address 
<a>

Data --- --- ---

Matrix List ∗ Matrix 
Name

Number of 
Cases

--- --- --- --- --- --- --- ---

Matrix ∗ Case 
Number

Receive 
Message

Next 
Process

--- --- --- --- --- --- ---

Trace List ∗ Descrip-
tion

Uploaded Size --- --- --- --- --- --- ---

PLC ∗ Inner 
Board

Type Serial 
Commu-
nica-
tions 
Unit

Type --- --- --- --- --- ---

Board ∗ PMSU 
Trace

Status Commu-
nica-
tions 
Port

Type --- --- --- --- --- ---

Unit ∗ PMSU 
Trace

Status Commu-
nica-
tions 
Port

Type --- --- --- --- --- ---
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To switch over the focus between these two windows, press the Tab Key or
select Swap Focus from the View Menu or left-click either of the screens.

Selecting Elements in 
Projects

Use the mouse, Up, Down, Left, or Right Key, or Function Key to select the
elements in projects.

The following operations are available without the mouse.

• Use the Up or Down Key while the focus is in either of the screens.

To scroll up or down on the tree in the project workspace.

To scroll up or down the rows of the tables in the project window.

• Press the Esc Key or the Backspace Key to shift to the next higher level.

• Press the Page Up or Page Down Key to scroll up or down by a whole
screen in the project window.

• Press the Ctrl+F6 Keys or select Next from the Control Menu to move to
the next active window of the CX-Protocol.

• The size ratio of the project workspace to the project window will automat-
ically be adjusted when displayed.

• The width of each item in the project window will automatically be
adjusted when displayed.

• Click the  or  portion to select the hierarchy in the project workspace.
After the  portion is clicked, the  portion will be displayed at the final
hierarchy level, in which case only the display of the project workspace
will change while the display of the project window will not change.

Scrolling the Hierarchy Double-click or press the Right Key while the focus is in the project work-
space to scroll down the hierarchy. The selected and highlighted data in the
project workspace will shift down.
Press the Esc Key or select Parent in the View Menu to move up in the hier-
archy.

Focused

+ –

+ –

Click this. Displays the lower level data.
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Pop-up Menu Click the right mouse button to display the pop-up menu.

Data Input Left-click each item in the table within the project window, or left-click and then
either left-click the Enter Button or press the Enter Key to input data of each
item displayed in the dialog box.

2-5-2 Control Menu

A new step is created after clicking the right mouse 
button or pressing the Shift+F10 Keys to select the 
corresponding item in the popup menu. In this 
example, Create/Step is selected.

Either click the Enter
button or press the 
Enter Key.

Control Menu Close
Maximize

Minimize

: Closes the CX-Protocol.

: Closes the Project.

Project
Window
Control
Menu
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2-5-3 Menu and Short-cut Keys
Main 
menu

Submenu Description Short-cut 
key

Icon on tool bar

File New Creates a new project. Ctrl+N Yes

Open... Opens the existing project selected. Ctrl+O Yes

Close Closes the project worked on. --- ---

Save Overwrites and saves the project file worked on. Ctrl+S Yes

Save As... Saves the project file worked on as a new file. --- ---

Print... Prints the protocols or trace selected. Ctrl+P Yes

Print Preview Displays the image of print output. --- ---

Print Setup... Sets the printer model, paper size, and printing 
direction.

--- ---

Recent File (1,2,3,4) Displays a maximum of four files recently used. --- ---

Exit Exits CX-Protocol. --- ---

Edit Cut Cuts and transfers the range designated to the 
clipboard.

Ctrl+X Yes

Copy Copies and transfers the range designated to the 
clipboard.

Ctrl+C Yes

Paste Pastes the contents of the clipboard to the position 
designated.

Ctrl+V Yes

Delete Deletes the range designated. Del Yes

Move Scrolls the steps or matrix case upwards or down-
wards to the top or bottom.

--- Yes

View Toolbar Shows or hides the project tool bar. --- ---

Status Bar Shows or hides the status bar. --- ---

Project Workspace Moves the cursor to the project workspace. --- ---

Output Moves the cursor to the output window. --- ---

Parent Scrolls the displayed hierarchy portion in the 
project window to the one upper.

Esc ---

Swap Focus Switches over the focus among the project work-
space, project window, and output window.

Tab ---

Proto-
col

Create Selected when newly creating a protocol list, proto-
col, sequence, step, message matrix, matrix case.

--- ---

Upload Protocol List Displays the name list of protocols in Boards or 
Units.

--- ---

Upload Protocols Transfers the protocol of the Board or Unit to the 
project.

--- Yes

Download Protocols... Transfers the protocol created in the project to the 
Board or Unit.

--- Yes

Compare Protocols... Compares the protocols in the project with those in 
a Board or Unit. 

--- Yes
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Note Disabled for an NJ-series CPU Unit.

2-5-4 Pop-up Menus
When one of the following objects is selected, right-click or press the
Shift+F10 Keys, and a pop-up menu will be displayed according to the hierar-
chy.

Pop-up Edit Menus

PLC Connect to PLC Connects the PLC to online. --- ---

Operating Mode Switches among the PLC operation modes. --- ---

Edit PC-PLC Comms 
Settings...

Sets the PLC model and communications 
specifications between the PLC and computer.

--- ---

Edit Communications 
Port Settings...

Sets the communications specifications of the 
communications port of the Board or Unit.

--- ---

Upload Communica-
tions Port Settings

Uploads the communications port settings of the 
Board or Unit.

--- Yes

Download Communi-
cations Port Settings

Downloads the communications port settings of 
the Board or Unit to the PLC.

--- Yes

Start Trace Selected when executing the continuous tracing or 
one-shot tracing.

--- Yes

Stop Trace Selected when stopping the continuous tracing or 
one-shot tracing.

--- Yes

Upload Trace Uploads the results of continuous tracing or one-
shot tracing to the project.

--- Yes

IO Table (See note.) Sets or edits the I/O table. --- ---

Memory (See note.) Monitors or edits the contents of I/O memory area 
of the PLC.

--- ---

Error Log (See note.) Displays the error contents and history of the PLC 
(CPU Unit).

--- ---

Tools CX-Net Used for specifying the settings required for net-
work communications such as the routing table or 
data link.

--- ---

Customize... Customizes the tool bars or commands. --- ---

Window New Window Creates an identical new window. --- ---

Cascade Shows windows in cascade status. --- ---

Tile Shows windows laid vertically. --- ---

Arrange Icons Aligns icons to with one another. --- ---

Currently Open 
Windows (1,2,3, ...)

Makes the selected window active. --- ---

Help Help Topics Shows the search topic in CX-Protocol’s Help. --- ---

About CX-Protocol... Shows the version of CX-Protocol. --- Yes

Main 
menu

Submenu Description Short-cut 
key

Icon on tool bar

Selected object Pop-up menu or submenu

Project Create (Protocol List)

Close

Save

Save as

Properties
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Protocol List Cut

Copy

Paste

Delete

Create (Protocol)

Print

Protocol Cut

Copy

Paste

Delete

Create (Sequence, Matrix, Send message, 
Receive message)

Print (Print, Print preview, Printer settings)

Communication Sequence Cut

Copy

Paste

Delete

Create (Step)

Step Cut

Copy

Paste

Delete

Move (Top, Bottom, One up, One down)

Send Message List Copy

Paste

Create (Send Message)

Receive Message List Copy

Paste

Create (Receive Message)

Matrix List Cut

Paste

Create (Matrix)

Matrix Cut

Copy

Paste

Delete

Create (Matrix case)

Case Cut

Copy

Paste

Delete

Move (Top, One up, One down)

Trace Delete

Selected object Pop-up menu or submenu
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Pop-up Operation Menus (in Online Operation)

2-5-5 Tool Bar Icons

Selected object Pop-up Edit menu

PMSU icon Upload Communications Port Settings 

Download Communications Port Settings

Upload Protocol List

Upload Protocols

Trace 1(A)/2(B) Start Trace (Continuous Trace, One-shot Trace)

Stop Trace

Upload Trace

Communications Port 1(A)/2(B) Edit Communications Port Settings

Upload Communications Port Settings

Download Communications Port Settings

• Standard Tool Bar

These icons are for the operation of 
project-related functions.

• Trace Tool Bar

These icons are for the operation of trace-related functions.

• Protocol Tool Bar

These icons are for the operation 
of protocol-related functions.

• PLC Status Bar

The PLC modes, such as offline, program, and monitor modes, 
and corresponding PLC models are displayed.
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List of Tool Bar Icons

2-5-6 Status Bar
The status bar displays the explanation of the menu or icon of the position
where the cursor is located.

Note Select the Tool Bar Icon by referring to the corresponding explanation of the
icon displayed on the status bar.

Tool bar Icon Corresponding 
menu

Tool bar Icon Corresponding 
menu

Standard tool 
bar

New Protocol tool bar Download Proto-
cols

Open Download Com-
munications Port 
Settings

Save Upload Commu-
nications Port 
Settings

Cut Upload Protocols

Copy Compare Proto-
cols

Paste Delete

Print Up

About Down

Help Top

Trace tool bar Start one-shot 
trace

Bottom

Start Continuous 
trace

PLC status bar Off-line/PLC 
Mode

Stop trace PLC Model

Upload trace

---

---
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SECTION 3
Protocol Macro
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3-1 Protocol Macro Outline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
3-1-1 Sequence/Step Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
3-1-2 Construction of Send/Receive  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
3-1-3 Transition Stage Between Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
3-1-4 Setting Transmission Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

3-2 Sequence Attributes (Common to All Steps)  . . . . . . . . . . . . . . . . . . . . . . . . . 75
3-2-1 Setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
3-2-2 CX-Protocol Setup Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
3-2-3 Transmission Control Parameter  . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
3-2-4 Link Word Addressing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
3-2-5 Response Type  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
3-2-6 Monitoring Time. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

3-3 Step Attributes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
3-3-1 CX-Protocol Setup Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
3-3-2 Setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
3-3-3 Repeat Counter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
3-3-4 Commands  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
3-3-5 Retry Count. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
3-3-6 Send Wait Time. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
3-3-7 Send Message/Receive Message  . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
3-3-8 With/Without Response Writing. . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
3-3-9 Next Process/Error Process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

3-4 Communication Message Attributes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
3-4-1 CX-Protocol Setup Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
3-4-2 Header. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
3-4-3 Address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
3-4-4 Length . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
3-4-5 Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
3-4-6 Error Check Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
3-4-7 Terminator. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
3-4-8 Message Item Data Attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
3-4-9 Supplemental Notes on Message Setup . . . . . . . . . . . . . . . . . . . . . . 110

3-5 Creating Matrices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
3-6 Examples of Standard System Protocols  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

3-6-1 “Process Value Read” Sequence of the 
“Controller (E5_K Read)” Protocol . . . . . . . . . . . . . . . . . . . . . . . . . 116

3-6-2 “Modem Initialize (MD24FB10V)” Sequence of 
“Hayes Modem AT Commands” Protocol . . . . . . . . . . . . . . . . . . . . 117

3-7 Example of Communications Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
3-7-1 Sequence Setup Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
3-7-2 Step Setup Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
3-7-3 Send and Receive Messages Creation  . . . . . . . . . . . . . . . . . . . . . . . 119
3-7-4 Contents of Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

3-8 Executing a Created Communications Sequence (CS/CJ) . . . . . . . . . . . . . . . 121
3-8-1 Device Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
3-8-2 Initial Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
3-8-3 Creating Ladder Programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
3-8-4 Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
3-8-5 Confirming the Operation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

3-9 Executing a Created Communications Sequence (C200HX/HG/HE)  . . . . . . 128
3-9-1 Device Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
3-9-2 Initial Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
3-9-3 Creating Ladder Programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
3-9-4 Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
3-9-5 Confirming the Operation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

3-10 Auxiliary Area and Allocated Data Areas  . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
3-10-1 Special Auxiliary and Allocated Areas. . . . . . . . . . . . . . . . . . . . . . . 134
3-10-2 Description of Each Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
57



Protocol Macro Outline Section 3-1
3-1 Protocol Macro Outline
The Protocol Support Tool allows users to freely create and edit protocols,
which are procedures for sending data to and receiving data from general-
purpose devices connected to the PMSU (see note) through RS-232C or RS-
422A/485. The protocol macro is a function to implement the sending and the
receiving messages by the execution of a starting instruction for the protocol
macro (PMCR instruction) of the CPU Unit’s user program.

For CJ2 CPU Units, the PMCR2 instruction can be used in addition to the
PMCR instruction. For details of the PMCR and PMCR2 instructions for CS/
CJ-series Units, refer to the SYSMAC CS/CJ-Series Programmable Control-
lers Instructions Reference Manual (W474). For details of the PMCR instruc-
tions for SYSMAC Alpha-Series (C200HX/HG/HE) Units, refer to the
Programmable Controllers C200HX/HG/HE-CPU@@-ZE Operation Manual
(W322).

Note In this section, the Communications Board for the C200HX/HG/HE, the Com-
munications Board for the CQM1H, the Serial Communications Board for the
CS, and the Serial Communications Units for the CS/CJ are all referred to as
the “PMSU” (Protocol Macro Support Unit).

3-1-1 Sequence/Step Structure
One sequence consists of up to 16 steps. One step includes one command
(Send, Receive, Send&Receive, Open, Close, Flush, or Wait (for CS/CJ only))
and one or two messages (Send, Receive, or Send&Receive). Step transition
is designated by the “next process/error process” within the step.

#1001

PMSU

Peripheral
servicing

Shared memory

Receive data
address

Sequence number
specification

Step mechanism outline for Send, 
Receive, or Send&Receive

Command

To be 
retried?

N

Message

Normal end?

To be 
repeated?

Next process Error process

N

N

Y

Y

Y

Command

Next process

Step mechanism outline for 
Wait, Flush, or Open & Close
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1,2,3... 1. Sequence-specific data (common to all steps)

2. Step-specific data 

Note For CS/CJ protocol macro only.

3. Message structure and content

Messages to be sent and received are generally structured as follows:

1) Messages containing header and terminator

Setup Item Description

Transmission 
control parameter

X-on/X-off flow control, RTS/CTS flow control, modem control, 
delimiter control, or contention control

Link word Shared memory area between the PLC and the PMSU.

Monitoring time Time for monitoring send and receive process.

Response type Timing for writing received data.

Setup Item Description Command type

Send Receive Send& 
Receive

Wait 
(see 
note)

Flush 
(see 
note)

Open 
(see 
note)

Close 
(see 
note)

Command Send, Receive, 
Send&Receive, Wait∗, 
Flush∗, Open∗ or Close∗

--- --- --- --- --- --- ---

Repeat counter The number of times to
iterate the step (1 to 255)

O O O --- --- --- ---

Send message The contents set here are 
sent as a message.

O --- O --- --- --- ---

Receive 
message

The message that was 
actually received is com-
pared with the data set here.

--- O O --- --- --- ---

Matrix Selects the next process 
according to message 
expected to be received (up 
to 15 types).

--- O O --- --- --- ---

Retry count The number of times for 
retrying the command when 
some retry factor such as an 
error arises.

--- --- O --- --- --- ---

Send wait time Wait time for starting data 
sending for a Send 
command.

O --- O --- --- --- ---

With/Without 
Response Writ-
ing (operand 
addressing)

Designates whether to write 
received data.

--- O O --- --- --- ---

Next process Designates the next step to 
which control will go to when 
the system ends normally.

O O O O O O O

Error process Designates the next step to 
which control will go to when 
the system ends abnormally.

O O O --- --- --- ---
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The check code and the terminator can be replaced with each other.

Note With the C200HX/HG/HE, possible only when the C200HW-
COM@@-EV1 Communications Board is used.

2) Messages containing header and data length

• Input the constant in the header and terminator.

• Either the constant or variable can be input in the address and data. By
including variables in the address and data, the address or data can be
retrieved from the designated area of the I/O memory and the transmitted or
received data can be written in the designated area of the I/O memory.

Header Address Data Terminator Check code

Setup Item Meaning Data attributes

Constant Variable

Header Beginning of mes-
sage

O ---

Address Message destina-
tion

O O

Length Message length --- O

Data Message body O O

Check code Error check code --- O

Terminator End of message O ---

Content of the message
(Sending: Data to be sent, Receiving: Data expected to be received)
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3-1-2 Construction of Send/Receive
Outline of Construction The construction of send and receive messages with the protocol macro func-

tion is shown below.

CPU Unit PMSU

Internal process Buffer

Following 
PMCR 
instruction, 
designates 
execution 
sequence 
number for the 
PMSU.

Send Following send process (Send command, 
Send&Receive command), data from I/O 
memory is converted under the designated 
conversion formula and the send message is 
assembled and is transferred to the send 
buffer.

The send message moves to the 
transmission line via the send buffer.

Receive Following receive process (Receive 
command, Send&Receive command):
1. The data in the receive buffer is input, 
comparison with the expected message is 
executed, and switching of the next process 
takes place.
2. If there is a Response Write, the data will 
be written to I/O memory after being 
converted with the designated conversion for-
mula. 

Half-duplex: Data that is received from the 
transmission line when send process is not 
being performed will be saved in the receive 
buffer.
Full-duplex: All data received from the 
transmission line during sequence execution 
will be saved in the receive buffer.

CPU Unit PMSU

Sequence No. A

Send
pro-
cess

Receive 
process

Send message 
assembly

Comparison with 
expected message 
→ Next process 
switching

Process for 
writing to I/O 
memory

Receive buffer

Send buffer

To transmission line

From transmission line

Sends when the send process is executed.

Half-duplex: Receives when not performing send process.
Full-duplex: Receives throughout execution of the sequence.

PMCR

A
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Send Process 
(Send Command, 
Send & Receive 
Command)

If the Send command (or the Send&Receive command) is executed with a
certain step, the send message set by that step will be assembled and sent
from the send buffer as shown below. If a variable (reading variable) has been
integrated into the send message, the appropriate data will be read from I/O
memory and converted to the designated form according to the variable, and
the send message will be assembled.

Note When a send completion monitoring time has been set for send process and
the time is exceeded without sending a message, the step will end abnormally
and the system will move to the error process. Otherwise, the step will end
normally and move to the next process.

PMSU

From the 
CPU Unit

Data
(Address)
(Repeat 
counter)

Step

Send process 
execution

1. Read process:
Data/(Address)/(Repeat counter) designated by 
variable is read from memory address

2. Variable process:
Conversion to the format designated by the vari-
able
• No conversion
• Hexadecimal→ASCII conversion
 (ASCII→Hexadecimal conversion)

3. Assembly process:
Send message is assembled

Maximum send buffer

1,000 bytes max. (CS1)
256 bytes max. (C200HX/HG/HE)

Header Address Length Data Error check 
code

Terminator

Send message

Sent after the Send Waiting Time for a step

Header Address Length Data
Error 
check 
code

Terminator
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r

Receive Process 
(Receive Command, 
Send & Receive 
Command)

If, with a certain step, the Receive command (or the Send&Receive Com-
mand) is executed, the data will be taken out of the receive buffer and a com-
parison with the expected message will be made. If the data does not
correspond, the step will end abnormally and the system will move to the error
process. If the data does correspond and a variable (write variable) has been
integrated into the expected message, it will be converted to the format desig-
nated by the variable, and write process to I/O memory in the CPU Unit will be
performed. All processing for the step will be completed and the system will
move to the next process.

PMSU

Step
Receive 
process 
execution

1. Comparison process

Actually received message

Comparison (Goes to error 
process if unmatched.)

Set expected message

Note: Possible to have several (15 max.) expected mes-
sages (matrix).

2. Variable process:
Conversion to the format designated by the variable
• No conversion
• ASCII→Hexadecimal conversion
(Hexadecimal→ASCII conversion)

3. Write process:
Data written to I/O memory designated variable.

Note: The Write Timing will depend on the setting for 
the response type (scan mode, interrupt mode) in 
sequence attributes only if With/Without Response Writ- 
ing is set to Yes in the step attributes when the oper- 
ands are set.

To CPU Unit Data

4. Notification to the CPU Unit:
Completion of the sequence and Write notified by the Pro-
tocol Macro Execution Flag.

Note: When the operands are set and the response type 
is set to interrupt mode in sequence attributes, designation 
will be possible with the interrupt process.

Receive message

Header Address Length Data TerminatoError check 
code

Half-duplex: Receives when not executing send process.
Full-duplex: Receives all data during sequence execution.

Maximum 
receive buffer

1,000 bytes
 max.

Header Address Length Data Terminator
Error 
check 
code

Header Address Length Data Terminator
Error 
check 
code
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Send & Receive Process 
(Send & Receive 
Command)

The receive (Receive) process will start approximately 60 μs after the send
process is completed.

In general, when communications commands are sent as send messages and
responses are received as receive messages, Send&Receive will be exe-
cuted.

Note With the CS/CJ, there is a time-lag after send operations for the half-duplex
(refer to page 72).

Clear Process (Flush 
Command) for Receive 
Buffer (CS/CJ only)

By executing the Flush command, all the data in the receive buffer is cleared.
For example, this is used in the full-duplex mode before executing the receive
process, to clear data left in the receive buffer because of noise.

This command can also be used, for example, in full-duplex mode when a
communications error occurs. Without aborting, switch the step in Goto, exe-
cute the Flush command in the step, clear the receive buffer, and retry.

PMSU

Step
Send&Receive 
process com-
mand

Send process

Receive process

Approx. 60 μs later

Send buffer

Receive buffer

Send message

Receive message

Note: Retry can be designated with Send&Receive.

PMSU

Flush command 
execution

Clear
Receive buffer

Retry

Send&Receive

Step

Normal completion Error

Goto
Step

Flush
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Integration of Variables One of the characteristics of sending and receiving data with the protocol
macro function is the way that instructions (variables) for reading from and
writing to I/O memory in the CPU Unit can be integrated in the send and
receive messages themselves.

To designate which area of I/O memory is used for creating send messages
and which area of I/O memory is used for storing receive messages, the fol-
lowing three methods can be used.

1,2,3... 1. Operand Designation: Use the designated memory address with the oper-
ands for the PMCR instruction.

2. Direct Designation: Directly designate the I/O memory address.

3. Link Word Designation: Use the shared data area (link word) between the
CPU Unit and the PMSU.

Sending

Example: CS/CJ

CPU Unit

I/O memory

Sequence 
execution

PMSU

Sequence No. 001

Step 0

Send command

Send Header Address Data

Send message

Variables inside the send message 
determine which area of the I/O 
memory is used.

S
en

d 
ad

dr
es

s

S
en

d 
da

ta
  

PMCR

#0001

Hexadecimal ASCII conversion

Hexadecimal ASCII conversion

Check 
code Terminator

Receiving

Example: CS/CJ

CPU Unit

I/O memory

Sequence 
execution

PMSU

Sequence No. 001

Step 0
Receive 
command

Receive

Receive message

Variables inside the receive 
message determine which area 
of the I/O memory is written to

Header Address Data
Check 
code

C
om

pa
re

 a
dd

re
ss

R
ec

ei
ve

 d
at

a
PMCR

#0001

Terminator

Hexadecimal ASCII conversion

ASCII Hexadecimal conversion
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Designation Methods for Send/Receive Data Area

Note 1. CS/CJ only.

2. C200HX/HG/HE only.

Designation 
method

Function Symbol in message to be 
designated

Application

Operand 
designation (set 
within send/
receive 
message)

The I/O memory area is designated using the 
third (first word of send data storage area) and 
fourth (first word of receive data storage area) 
operands (second and third operands for 
C200HX/HG/HE) in the PMCR instruction of a 
ladder program within the send/receive 
message. Sending and receiving will be carried 
out using the designated I/O memory area. It is 
possible to set the system to either write or not 
write the receive data in the buffer area (having 
been converted under the designated 
conversion method) after each step using the 
With/Without Response Writing setting for step 
attributes. When the receive process is 
executed following a step command which has 
been set to With Response Write, the receive 
data in the receive buffer will generally be 
written to the CPU Unit’s I/O memory in one of 
the two ways shown below. (Set with the 
response type for sequence attributes. For 
details refer to page 79.)
1.Scan notification mode: With each CPU Unit 
scan, receive data is written to I/O memory. 
Since the CPU Unit refreshes with each scan, 
writing to the I/O memory area will not take 
place simultaneously with receive process and 
there will be a time-lag.
2. Interrupt notification mode: When data is 
received, an interrupt is executed at the CPU 
Unit and the receive data is immediately written 
to the designated I/O memory area. (Either the 
fixed number or the receive case number are 
possible for the interrupt program number)
Note: After the sequence has been completed, 
the data in the receive buffer will be read to I/O 
memory by the scan notification method.

With a PMCR instruction 
in a ladder program, the 
data area that is jointly 
used for the sequence 
can be set 
automatically. Using the 
interrupt function, 
high-response 
processing can be 
achieved.

Direct 
designation (set 
within send/
receive 
message)

The I/O memory address is set directly, in the 
send/receive message. Since the CPU Unit 
refreshes with each scan, writing to the I/O 
memory area will not take place simultaneously 
with receive process and there will be a
time-lag.

CIO@@@
WR@@@@ (note 1)
LR@@@@ (note 2)
HR@@@@
AR@@@@
DM@@@@@
EM@@@@@
@: Word number

Set when allocating a 
fixed data area and used 
separately within the 
step. When changing, it 
will be necessary to 
correct the step and 
resend.

Link word 
designation (set 
with sequence 
attributes)

A holding data shared area is designated for 
the CPU Unit and the PMSU. It is possible to 
set two link words, 1 and 2.
Link word 1: IN (receive data storage)

OUT (send data storage)
Link word 2: IN (receive data storage)

OUT (send data storage)
Designations are made under the I1, I2, l3, and 
l4. Since the CPU Unit refreshes with each 
scan, writing to the I/O memory area will not 
take place simultaneously with receive process 
and there will be a time-lag.

I1 (IN for link word 1)
O1 (OUT for link word 1)
I2 (IN for link word 2)
O2 (OUT for link word 2)

Set when allocating a 
fixed data area and used 
separately within the 
step. When changing, it 
will be necessary to 
correct the step and 
resend.

Word read: R(z)

3rd operand in PMCR
instruction (2nd operand 
for C200HX/HG/HE)
Designate word+ z word 

Word write: W(z)

4th operand in PMCR 
instruction (3rd operand 
for C200HX/HG/HE)
Designate word+ z word
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Using Operand-designated I/O Memory Area in a PMCR Instruction 
(Operand Designation)

Creation of send messages and storage of receive messages is performed
with the memory address designated by operands 3 and 4 (2 and 3 for the
C200HX/HG/HE) in the PMCR instruction.

CPU Unit

PMCR

I/O memory

3rd operand
4th operand

* 1

* 2

Send data

Receive data

*1: During PMCR execution.

Example: Reading variables

Example: (R (2), 4): The 4 bytes (2 words) from address D00102 
(D00100+2) will be read.

Send message

For reading

Writing variables
Example: (W (2), 4): The 4 bytes (2 words) from 
address D00202 (D00200+2) will be written

Receive message

For writing

PMSU

C1
C2

S
D

PMCR

DM00100
DM00200

+2

+2
D:D00200

D00202
D00203

D:D00100

D00102
D00103

*2: If the With/Without Response Type setting that is set 
for each step is Yes and the receive process is 
executed, the time required for the data to be 
reflected in I/O memory will depend on the response 
type setting (i.e., whether it is the Scan Notification 
Method, Interrupt Notification Method [fixed number], 
or Interrupt Notification Method [receive case 
number]).

Communications Port No.

Sequence No.
First word number of send data

First word number of receive data storage
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Direct Designation of I/O Memory Area Address

Creation of send messages and storage of receive messages is performed
with the I/O memory address designated directly.

Reading Variables

Example: (R (D00102), 4): The 4 bytes (2 words) starting from D00102 will be
read.

Writing Variables

Example: (W (D00202), 4): The 4 bytes (2 words) starting from D00202 will be
written.

Using a Shared Data (Link Word) Area for the CPU Unit and the PMSU 
(Link Word Designation)

Creation of send messages and storage of receive messages is performed
using the link word area.

Reading Variables

Example: (R (O1), 2): 2 bytes will be read from link word output area O1.

Writing Variables

Example: (W (I1), 2): 2 bytes will be written from link word input area I1.

CPU Unit

Direct designation to 
this address

I/O memory

*1

*2

Send data

Receive data

*1: During message sending

PMSU

*2: During message receiving 
The timing with which the 
data is reflected in I/O 
memory depends on the 
scan for the CPU Unit.

CPU Unit

Link word 1

I1
(Receive data)

O1
(Send data)

Link word 2

I2
(Receive data)

O2
(Send data)

Refresh

PMSU

Link word 1

I1
(Receive data)

O1
(Send data)

Link word 2

I2
(Receive data)

O2
(Send data)

IN

OUT

IN

OUT

Items to set:

Link word 1
IN: first word address (area classification 
and address), number of words (0 to 500) *
OUT: first word address (area classification 
and address), number of words (0 to 500) *
Link word 2
IN: first word address (area classification 
and address), number of words (0 to 500) *
OUT: first word address (area classification 
and address), number of words (0 to 500) *
*Settings of up to 500 words (CS/CJ) or 128 
words (C200HX/HG/HE) can be made for 
IN and OUT for both link words 1 and 2.
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Related Settings

Note Receive Process with Operand-designated Variables
When operand-designated variables are in the receive message, the receive
process will be performed as shown below.
When the receive process is executed, data in the receive buffer will be read,
and using that data as the receive message, the following process will be per-
formed.

Wait Process (Wait 
Command) 

When only using the Send/Receive/Send&Receive commands after
sequence execution has started, the progression of steps will be determined
by the results of each successive step (normal end/abnormal end). The pro-
gression cannot be stopped.

To stop the progression of steps during sequence processing, use the Wait
command (only possible with CS/CJ).

If the Wait command is issued during a step:

1,2,3... 1. When the wait-cancel soft-switch is turned OFF, the progress of the steps
will stop and the sequence will go into standby status.

If the wait-cancel soft-switch is turned ON in the ladder program, the stand-
by status will end and the sequence will go to the next process. During the
standby status, the Wait Flag will turn ON. 

Designation 
method

Send/receive message Step Sequence (shared for steps)

Operand 
designation

Integrate variables into address 
or data

With/Without Response Writing 
(when operand-designated 
variables are in the receive 
message)

Variable setting for number of 
iterations setting with the repeat 
counter

Response type (when 
operand-designated variables 
are in the receive message)

Direct designa-
tion

Integrate variables into address 
or data

Variable setting for number of 
iterations setting with the repeat 
counter

---

Link word desig-
nation

Integrate variables into address 
or data

Variable setting for number of 
iterations setting with the repeat 
counter

Link word

Process Response 
Write for step 

attributes

Response type for sequence attributes

With-
out

With Scan notification Interrupt notification 
(fixed number)

Interrupt notification 
(receive case number)

1. Comparison with 
expected message

Yes Yes --- --- ---

2. Conversion under the 
formula designated by 
variables

Yes Yes --- --- ---

3. Write to I/O memory No Yes Writes at scan time. Writes immediately after conversion.

Notification to CPU Unit Yes Yes Turns the PMCR Execution Flag OFF after writing and after sequence is 
completed.

--- Designates fixed inter-
ruption task (program) 
number and executes 
the interrupt process

Designates calculated 
interruption task 
(program) number and 
executes the interrupt 
process
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2. When the wait-cancel soft-switch is turned ON, the sequence will proceed
to the next process without going to standby.

Simultaneously, the wait-cancel soft-switch will be turned OFF.

Note 1. The wait-cancel switch is turned from OFF to ON using the SET instruction
in the ladder program. When setting (temporary manual setting) with the
Programming Console, the protocol macro standby may not be able to turn
the wait-cancel switch from ON to OFF because ON will be held for a mo-
ment while the key is depressed. 

2. If the receive buffer may become full during wait standby (e.g. with full-du-
plex), use in combination with flow control.

Step

Step

Step
On standby after Wait command

Wait-cancel switch 
OFF→ON

Step

Step

Wait-cancel switch

Wait-cancel Switch OFF

Step Step (wait) Step

By ladder program

By Wait command

Wait-cancel switch

ON

OFF

By Wait command

Wait Flag

ON
OFF

Standby status

Ladder process
Ladder program

Wait-cancel Switch ON
Step (wait)

By Wait command

Wait-cancel switch
ON

OFF

Wait Flag

ON

OFF

Ladder program

No standby status

No ladder process

Note: If the Wait command is executed while the 
wait-cancel switch is ON, the sequence will not 
wait but the Wait-cancel Flag will be turned ON.

(see note)
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3. Wait command can be used to set the system to proceed to the next step
after allowing the CPU Unit to complete processing, such as internal com-
putation.

If used in combination with a matrix, it is possible to set up the system so that
when certain data is received, the send/receive sequence will be put on
standby and computational processing (e.g. data processing) will be per-
formed at the CPU Unit before proceeding to the next communications pro-
cess.

Example Command

Data receive Step 1 (Receive)

Computation
processing Step 2 (Wait)

Standby

Data send Step 3 (Send)Computation
processing

General-
purpose 
device

Step No. 00

Send data

Matrix

Receive A Receive B Error

Step No. 01 Abort

Step No. 2

Standby (Wait)

To step No. 3

Computational proces-
sing (e.g. data proces-
sing) performed at the 
CPU Unit

Wait-cancel switch 
OFF→ON
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3-1-3 Transition Stage Between Steps
Following execution of a command within a step, the next process will switch
in the following way depending on the result of the send or receive process.

3-1-4 Setting Transmission Mode
With the protocol macro function, half-duplex mode or full-duplex mode can
be selected so as to match the transmission mode for the destination device.

Note 1. Half-duplex Mode: For communications between two devices, data can
only be sent one-way at a given time.

Process Conditions for error process Conditions for next process

Send Send not completed within send monitoring 
time.

Any condition not listed under “conditions for 
error process.”

Receive Receive 
message

The actual received message and the set 
expected message do not correspond.

Other errors with data communications. (For 
details, refer to 3-3-9 Next Process/Error Pro-
cess.)

Any condition not listed under “conditions for 
error process.”

Matrix Error with data communications Compares the actual received message with a 
maximum of 15 kinds of expected message, 
and depending on the contents, switches the 
next process as required.

Contents of error pro-
cess or next process

Goto ∗∗: Goes to a designated step.
Next: Goes to the next step.
End: Ends the sequence.
Abort: Aborts the step and ends the sequence.

Goto ∗∗: Goes to a designated step.
Next: Goes to the next step.
End: Ends the sequence.
Abort: Aborts the step and ends the sequence.

Step No. 00

Send A

Normal end
N (error process)

Y (next process)

To step No. n To step No. m

Step No. n

Send B

Receive C

End

N (error process)

Y (next process)

Abort

Step No. m

Send D

Receive E

Y (next step)

End

N (error process)

Abort

A B or A B
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2. Full-duplex Mode: For communications between two devices, data can be
sent both ways simultaneously.

In half-duplex mode, the receive buffer is cleared just before sequence ex-
ecution and just after completion of send operations (Send, Send&Receive
commands). Any data received before or during a send operation cannot
be received as data for the next receive operation.

Note 1. The full-duplex can be used with the RS-232C or the RS-422A/485 (1:1
and 4-wire type). It cannot be used with the RS-422A/485 (1:N or 2-wire
type).

2. Clearing of receive buffer is performed with the Flush command, and will
clear the buffer with the desired timing.

3. Although data received up until the completion of send operation will be
lost, it will still be reflected in the character trace.

A B

Transmission 
mode

Clear timing 
for receive 

buffer

Receive data Character 
trace

Timing chart (example)

Half-duplex Just before 
execution of 
communica-
tions sequence

Just after 
execution of 
Send 
command

Between 
completion of 
send operation 
and 
completion of 
receive 
operation, or 
between 
completion of 
send operation 
and just before 
execution of 
send operation

Everything 
during trace 
execution

Full-duplex 
(see note 1)

Only just before 
execution of 
communica-
tions sequence 
(see note 2)

Everything
during 
sequence 
execution

Everything 
during trace 
execution

Communica-
tions sequence

Receive buffer
cleared

Receive data

Character
trace

Receive Send Receive

(See note 3.)

Communica-
tions sequence

Receive buffer
cleared

Receive data

Character
trace

Receive Send Receive
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Note When performing send operation in half-duplex mode with the CS/CJ, there
will be a time-lag (refer to the table below) between completion of processing
for sending data and completion of the send operation. Therefore, if the
response of the destination device is fast and data is sent back in half-duplex
mode from the time of sending the data (communications commands, etc.) to
completing the send operation, the data received during that interval cannot
be received. If such a situation seems possible, use full-duplex mode. 

Time-lag

Send operation

Data transmission processing

Fast response

Data reception

Timing (see the table below) Data cannot be 
received during 
this time

Reception buffer cleared

t1 t2=150 μs

Baud rate (bps) Time-lag (μs)

1,200 1,116

2,400 578

4,800 288

9,600 144

19,200 73

38,400 36
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Note The time-lag is provided to ensure that when using in half-duplex/2-wire
mode, the receive operation will be performed after the last stop bit of the
send data has entered the circuit.

Transmission modes for the Protocol Macro are set in the following way.
m=D30000 + 100 x Unit No.

3-2 Sequence Attributes (Common to All Steps)
Set the sequence attributes as described in the following.

3-2-1 Setting

Half-duplex
CPU Unit PMSU

Receive buffer Data

Receive possible during 
execution of receive 
process.

Depending on 
receive process, 
used as receive 
message.

Comparison with 
expected message, 
switching for next 
process.

+

Writes to CPU Unit.

Full-duplex
CPU Unit PMSU

Data

All data received during 
sequence execution

Receive buffer

Depending on 
receive process, 
used as receive 
message.

Comparison with 
expected message, 
switching for next 
process.

+

Writes to CPU Unit.

Data received during sending will not be 
used as receive data. Data received when 
not sending will be sent to the receive 
buffer. This data can be extracted using 
the receive process.

All data received during sequence execution (includ-
ing data received when not executing the receive 
process) will be used as the receive message.

During the send process, which includes the Send 
command, Send&Receive and other commands, the 
receive process will continue and data will be sent to 
the receive buffer. Therefore, after the send process 
and other commands have been completed, this 
data can, using the receive process, be used as the 
receive message.

PLC Device Setting area Address Bits Contents

Port 1 Port 2

CS/CJ 
Series

Serial Communications 
Board

Allocated DM 
area

D32008 D32018 15 0: Half-duplex (default)
1: Full-duplex

Serial Communications 
Unit

Allocated DM 
area

m+8 m+18 15 0: Half-duplex (default)
1: Full-duplex

Setup Item Description

Transmission control 
parameter

X-on/X-off flow control, RTS/CTS flow control, modem 
control, delimiter control, or contention control

Link word Shared memory area between the PLC and the Board/
Unit.

Response type Timing for writing received data.

Monitoring time Time for monitoring send and receive process.
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3-2-2 CX-Protocol Setup Screen

For the details of setup method, refer to SECTION 7 Sequence Setting and
Editing.

3-2-3 Transmission Control Parameter
Set the transmission control parameters such as the flow control, RTS, CTS,
DTR, DSR, etc. The following five types of transmission control are sup-
ported. Set the same transmission control modes as for the external device to
be communicated with. Note that the modem control parameter can be desig-
nated together with other parameters.

Sequence name Send finish monitoring time, Tfs

Receive finish monitoring time, Tfr
Receive wait monitoring time, Tr

Response type
Transmission control mode

Link word addressing

Transmission 
control parameter

Function Usage

RTS/CTS flow 
control

Executes flow control by hardware 
using the RTS and CTS signals.

Set when the external device supports 
the RTS/CTS flow control.

Xon/Xoff flow control Executes flow control by software 
using Xon (11 hexadecimal) and Xoff 
(13 hexadecimal) codes.

Set when the external device supports 
the Xon/Xoff flow control.

Modem control Holds the DTR “ON” during execution 
of a PMCR instruction, and turns ON 
the RTS when data is sent.
Possible to turn the DTR signal ON or 
OFF at any timing using the Open or 
Close command for each step.
Once the DTR signal is turned ON 
using the Open command, it will 
remain ON until it is turned OFF using 
the Close command.
Furthermore, once the DTR signal is 
turned ON using the Open command, 
it will remain ON even after a 
sequence is completed and another 
sequence is started. Therefore, the 
DTR signal can be used for controlling 
more than one sequence. 

Set when the external device checks 
the DSR status. Must be used if the 
internal RS-422 port is to be used. 
Must be used also if an external 
RS-422/RS-485 converter is 
connected to RS-232C port.

Contention control Transmission control mode for getting 
the correct send in point-to-point 
contention communication.

Set when the external device supports 
contention control.

Delimiter control For sending or receiving a large
quantity of data, this procedure 
separates data into several frames 
with delimiters.

Set when the external device supports 
delimiter control.
76



Sequence Attributes (Common to All Steps) Section 3-2
Note Unless modem control is set, the DTR on the port of the PMSU cannot be
turned ON. When both modem control and RTS/CTS control are set, the DTR
complies with modem control, and the RTS and CTS comply with RTS/CTS
flow control.

Note 1. Note that the RTS/CTS flow control cannot be set at the same time as the
Xon/Xoff control.

2. When using a 2-wire connection for the RS-422A/485 port, use only mo-
dem control and do not select RTC/CTS control in the transmission control
parameters. 

3. With the CS/CJ protocol macro, each port is provided with a receive buffer
(2.5 Kbytes max.). When receiving large amounts of data or when the
communications sequence is set to the wait state, a large-capacity receive
buffer may be required. However, when the protocol macro function is
used, received data exceeding the receive buffer capacity will be overwrit-

Transmission control parameter Settings on the SYSMAC-PST

RTS/CTS flow control None: No RTS/CTS flow control
Send: RTS/CTS flow control only during 
sending
Receive: RTS/CTS flow control only 
during receiving
Send&Receive: RTS/CTS flow control 
during both sending and receiving

Xon/Xoff flow control None: No Xon/Xoff flow control
Send: Xon/Xoff flow control only during 
sending
Receive: Xon/Xoff flow control only during 
receiving
Send&Receive: Xon/Xoff flow control 
during both sending and receiving

Modem control Yes/No

Contention control No
Yes: Send request code; either control 
code or ASCII, hexadecimal

Delimiter control No
Yes: Send request code; either control 
code or ASCII, hexadecimal
Receive request code; either control code 
or ASCII, hexadecimal

CX-Protocol Window
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ten on the 2.5-Kbyte data already received. Therefore, be sure to set the
flow control if such a large data transmission is expected. 

3-2-4 Link Word Addressing
Use the following procedure to use the link word addressing for designating
transmission data storage locations.

Link Word Designation

Addressing Function Identification code in 
messages

Use

Link word 
addressing 

Designates an area on which data is shared 
between the PLC and the PMSU. Two sets of 
link words (link word 1 and link word 2) can be 
set as such areas.
Link Word 1: 

IN (for storing receive data)
OUT (for storing send data)

Link Word 2: 
IN (for storing receive data)
OUT (for storing send data)

Set these areas using the reserved words I1, 
I2, O1, or O2. Writing operation to the I/O 
memory will not be synchronized with data 
reception because these words are refreshed 
at each PLC scan, thus inducing some time-
lag. Directly addresses an I/O memory within a 
send or receive message.

I1 (IN of link word 1)
O1 (OUT of link word 1)
I2 (IN of link word 2)
O2 (OUT of link word 2)

This mode is used to assign 
a fixed data area com-
monly used by all steps in a 
sequence.
Changing link words 
requires modification and 
retransmission of the 
sequence.

IN

OUT

Size

Link 1

IN

OUT

Link 2

Link 1

Link 2

Area type

Area type

Area type

Area type

CPU Unit PMSU

Refresh
Starting address

Starting address

Starting address

Starting address

Size

Size

Size
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Area Type and Size

Example: Read and write part of data assigned in the above in a message.

3-2-5 Response Type
The response type will be valid only when there is an operand-designated
parameter in a receive message. The response type designates when to write
the receive data to the I/O memory designated by the fourth operand (for CS/
CJ) or third operand (for the C200HX/HG/HE) of the PMCR instruction and
how to notify this write process to the CPU Unit. One of the following three
methods can be used.

PLC CS/CJ C200HX/HG/HE

Area type and address subject to link 
word addressing

CIO: 0000 to 6143
WR: 000 to 511
HR: 000 to 511
AR: 000 to 511
DM: 00000 to 32767
EM: 00000 to 32767
Note: EM banks cannot 
be designated for link 
words.

CIO (see note): 000 to 
511
WR: 00 to 63
HR: 00 to 99
AR: 00 to 27
DM: 0000 to 6655
EM: 0000 to 6143
Note: CIO indicates I/O 
area, IR area, and SR 
area.

Number of link 
words (setting 
range)

I1 0 to 500 words 0 to 128 words

O1 0 to 500 words 0 to 128 words

I2 0 to 500 words 0 to 128 words

O2 0 to 500 words 0 to 128 words

Sum of I1+I2+O1+O2 
must be equal to or less 
than 500 words.

Sum of I1+I2+O1+O2 
must be equal to or less 
than 128 words.

(W (I1+3), 4)

20
words

OUT

IN

Link 1

CPU Unit

Link 1
OUT

IN

Refresh

Refresh

CIO0100

CIO0119

DM0100

30
words

PMSU Designation in a message

Send message

(R (O1+5), 2)

Receive message

5 words

3 words

CIO 105 is read and built in the data in a 
send message.

Data in receive message is written in 
DM 0103 to DM 0104.

DM0129

Settings (Allocation) with the CX-Protocol
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1,2,3... 1. Scan Notification Method

When response writing is 
set to “Yes” under step 
attribute setting

Writes the data in the receive buffer into the I/O memory when the data is
scanned (see note) for the CPU Unit after conversion. Turns OFF the PMCR 

Instruction Execution Flag after writing all the received data into the I/O mem-
ory and after the sequence has terminated.

When response writing is 
set to “No” under step 
attribute setting

Received data remains in the receive buffer without performing any process-
ing for the CPU Unit. Turns OFF the PMCR Instruction Execution Flag after
the sequence has terminated.

When sequence has 
terminated

Writes the data in the receive buffer into the I/O memory when the data is
scanned (see note) for the CPU Unit after conversion. 

Note With the scan notification method, write timing will vary as shown below
depending on the PMSU model.

2. Interrupt Notification Method: Fixed Number

Note With the CS, this method is applicable to the Serial Communications Board
and with the C200HX/HG/HE, it is applicable only to the Communications
Board. It cannot be used for the Serial Communications Unit for the CS/CJ.

When response writing is 
set to “Yes” under step 
attribute setting

Writes the data in the receive buffer into the I/O memory immediately after it is
converted according to the designated method. When all the data has been
written into the I/O memory, an interrupt task number (external interrupt task)
(for the CS) or a subroutine number (for the C200HX/HG/HE) will be desig-
nated and the interrupt task will be performed for the CPU Unit. Also, when all
the data has been written into the I/O memory and when the sequence has
terminated, the Protocol Macro Execution Flag will be turned OFF.

When response writing is 
set to “No” under step 
attribute setting

Interrupt process for the CPU Unit will take place when the notification is
received. The received data will remain in the receive buffer without perform-
ing any write process for the CPU Unit. The Protocol Macro Execution Flag
will be turned OFF after the sequence has terminated.

PMSU

Receive 
buffer

Half-duplex: Other than send process.
Full-duplex: During sequence execution.

Receive 
process

Conversion

Data is written during 
scanning (see note).

Turns OFF when writing is fin-
ished and sequence has termi-
nated.

Protocol Macro 
Execution Flag

I/O memory

Receive data

CPU Unit

PMCR

Model PLC Write timing

Serial Communications 
Unit

CS/CJ Cyclic Written when I/O is refreshed 
for the CPU Bus Unit.

Serial Communications 
Board

Written when I/O is refreshed 
for the CPU Inner Board.

Communications Board C200HX/HG/HE Cyclic Written when servicing is 
performed for the Communi-
cations Board. 
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Note With the CS-series (Serial Communications Board), received data cannot be
stored in the EM area using the interrupt notification. If this is attempted, a
protocol macro syntax error (A42410) will occur.

3. Interrupt Notification Method: Receive Case Number

Note With the CS, this method is applicable to the Serial Communications Board
and with the C200HX/HG/HE, it is applicable only to the Communications
Board. For the CS/CJ, it cannot be used for the Serial Communications Unit.

When response writing is 
set to “Yes” under step 
attribute setting

Writes the data in the receive buffer into the I/O memory immediately after it is
converted according to the designated method. When all the data has been
written into the I/O memory, the external interrupt task number (for the CS/CJ)
or the subroutine number (for the C200HX/HG/HE) will be calculated based
on the step number executed according to the following procedure and the
case number, and the interrupt task will then be performed for the CPU Unit.
Also, when all the data has been written into the I/O memory and when the
sequence has terminated, the Protocol Macro Execution Flag will be turned
OFF.

When response writing is 
set to “No” under step 
attribute setting

Interrupt process for the CPU Unit will take place when the notification is
received. Received data will remain in the receive buffer without performing
any write process for the CPU Unit. The Protocol Macro Execution Flag will be
turned OFF after the sequence has terminated.

Serial Communications Board
or Communications Board

Receive
buffer

Half-duplex: Other than send process.
Full-duplex: During sequence execution.

Conversion

Data is written immediately
after conversion.

Turns OFF when writing is fin-
ished and sequence has termi-
nated.

Protocol Macro
Execution Flag

I/O memory

Interrupt
process

Fixed interrupt task
(program) No.

After
writing

Received data

CPU Unit

PMCR

Receive
process
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Note With the CS-series (Serial Communications Board), received data cannot be
stored in the EM area using the interrupt notification. If this is attempted, a
protocol macro syntax error (A42410) will occur.

Example: When the step No. = 2 and the matrix case No. 
= 11 (hexadecimal):

Interrupt task (subroutine) No. = 2B (hexadecimal) = 43 (decimal)

Note With the CS/CJ, the interrupt task (external interrupt task) with the task num-
ber assigned according to calculation will be performed. With the C200HX/
HG/HE, the interrupt task (external interrupt task) with the subroutine number
(SBN to RET) assigned according to calculation will be performed.

Setting with the CX-Protocol

Note When an interrupt notification is used with the CS-series (Serial Communica-
tions Board), the protocol macro status area (within the interrupt data area)
will not be updated completely when the interrupt notification is received.
Therefore, read the receive data only after the external interrupt task condi-
tions have been satisfied in order to ensure concurrent data processing.
The PMCR instruction cannot be executed within the external interrupt task

Serial Communications Board
or Communications Board 

Receive 
buffer

Half-duplex: Other than Send process.
Full-duplex: During sequence execution.

Conversion

Data is written immediately 
after conversion.

Turns OFF when writing is fin-
ished and sequence has termi-
nated.

Protocol Macro 
Execution Flag

I/O memory

Interrupt 
process Fixed interrupt 

task (program) 
No.

After
writing

PMCR

CPU Unit

Received data

Receive 
process

Interrupt task number
(for CS/CJ) or
Subroutine number
(for C200HX/HG/HE)

XX (hexadecimal)
When using a matrix: Case num-
ber of the matrix

Otherwise: 0

Step number of the sequence that
was executed

=
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that has been started using the interrupt notification. An execution error will
occur.

3-2-6 Monitoring Time
Users designate the time for monitoring the send or receive process. The fol-
lowing types of monitor time can be designated. However, Ts (send wait time)
is omitted here because the value is set step by step.

Set the monitoring time by sequence only as described below in the shaded
area.

O: Available, ---: Not available

Note 1. When a retry count of Send&Receive is set for the step, the system repeats
the step up to the number of times of the retry count. If all retries fail or a
time-out occurs, the system executes the appropriate error process.

Monitoring time Description Command type

Send Receive Send & 
Receive

Receive wait 
monitoring time: 
Tr

Monitors the time from when the receive command of the step in the 
sequence is recognized (receive command execution) until the first 
byte (header) is received.
When receiving no data in the designated Tr (Note 1), the system 
executes the error process set in the step.

--- O O

Receive finish 
monitoring time: 
Tfr

Monitors the time from reception of the first byte to reception of the 
last byte of the data in the step in the sequence. When reception 
does not complete in the designated Tfr (or the terminator does not 
come) (Note 1), the system executes the error process set in the 
step (Note 2).

--- O O

Send finish 
monitoring time: 
Tfs

Monitors the time from transmission of the header to transmission of 
the last byte of the data. If the transmission does not end within this 
designated monitoring time (Note 1), the system will execute the 
error process set in the step.

O --- O

Send wait time: Ts Sets the time from when the send command of the step is recog-
nized until the first byte is sent. For example, when sending the data 
over an extension line through the modem, dialing may not be suc-
cessful unless there is a pause to input the telephone number after 
dialing 0.

O --- O

Receive only:

Send&
Receive:

Send only:
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2. Be sure to set both the receive wait monitor time Tr and receive finish mon-
itor time Tfr. With the CX-Protocol, it will not be possible to set just one of
these.

Setting with the CX-Protocol

3-3 Step Attributes

Set the sequence attributes as described below.

3-3-1 CX-Protocol Setup Screen

For the details of setup method, refer to 8-1 Step Setting.

Repeat counter

Command
Retry count

Send wait time
Send message

Receive message

With/Without
response writing

Next process

Error process
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3-3-2 Setting
Parameter Description Remark Command

Send Receive Send & 
Receive

Wait 
(see 
note)

Flush 
(see 
note)

Open 
(see 
note)

Close 
(see 
note)

Repeat 
counter

Sets the number of 
times that the step is 
repeated. The 
system increases the 
value of the repeat 
counter N at every 
step.

Incorporating a linear 
expression including 
the repeat counter N 
into the send or 
receive message 
allows users to freely 
change the destina-
tion of the message or 
the I/O memory to 
which the message is 
stored.

O O O --- --- --- ---

Command Sets one of the follow-
ing seven kinds of 
command:
Send: Sends data.
Receive: Receives 
data.
Send&Receive: 
Sends and receives 
data.
Wait (see note): 
Keeps the step on 
standby. (Until the 
Wait Clear switch is 
turned ON from the 
CPU Unit. Once the 
switch is turned ON, 
the step shifts to the 
next process.)
Flush (see note): 
Clears all the data 
within the receive 
buffer.
Open (see note): 
Turns ON the DTR 
signal at the desired 
timing. The DTR sig-
nal is held ON after 
the sequence has ter-
minated and after the 
port is re-enabled 
using the STUP 
instruction.
Close (see note): 
Turns OFF the DTR 
signal at the desired 
timing.
Note: Only for the CS/
CJ-series protocol 
macro.

When sending and 
receiving the data by 
consecutive turns, 
using the 
Send&Receive com-
mand allows users to 
set the steps effi-
ciently.
Since the retry count 
for an error can be 
set, the error process 
is described simply.
Use the Wait com-
mand when shifting to 
the next step after the 
CPU Units completes 
computation between 
steps (see note).
Use the Flush 
command when clear-
ing data within the 
receive buffer under 
the full-duplex mode 
(see note).
Use the Open or 
Close command 
when turning ON or 
OFF the DTR signal 
to match the control 
protocols of the 
external device under 
the modem control 
(see note).
Note: Only for the CS/
CJ-series protocol 
macro. 

--- --- --- --- --- --- ---

Retry count Valid only for 
Send&Receive com-
mand. The system 
executes the current 
step up to the desig-
nated times (0-9) 
when some retry fac-
tor such as an error 
occurs. If the retry 
factor still remains, 
control will go to the 
error process.

During retrying, the 
send wait time is 
ignored. Therefore, 
the send wait time 
has to be provided by 
an error process dur-
ing retrying. Likewise, 
a retry process has to 
be provided by an 
error process for 
Send or Receive 
command.

--- --- O --- --- --- ---
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O: Available, ---: Not available

Note The Open and Close commands turn the DTR signal ON or OFF under a con-
trol mode other than the modem control. The ON or OFF state will be retained
not only after the sequence has terminated but also when the protocol has
been changed through the STUP or port starting. 

Send wait 
time

Sets the wait time 
(Ts) as waiting time 
for data sending to 
start.

Set a send wait time 
when the communica-
tions partner cannot 
receive data immedi-
ately.

O --- O --- --- --- ---

Send 
message

Sets the send 
message when the 
command is Send or 
Send&Receive.

With the CX-Protocol, 
a send message 
name created in the 
send message list is 
referred to or a send 
message is created 
directly in this step.

O --- O --- --- --- ---

Receive 
message 
(including 
matrix)

Sets the expected 
receive message 
when the command is 
Receive or 
Send&Receive.
For details refer to 3-4 
Communication Mes-
sage Attributes.
When setting a matrix 
to switch the next 
process according to 
several expected 
receive messages, 
specify the matrix 
name from here.
For details refer to 3-5 
Creating Matrices.

With the CX-Protocol, 
a receive message 
name created in the 
receive message list 
is referred to or a 
receive message is 
created directly in this 
step. Or, a matrix 
name created in the 
matrix list is referred 
to. (The matrix 
cannot be created 
directly from the step.)

--- O O --- --- --- ---

With/With-
out 
Response 
Writing 
(operand 
address-
ing)

Sets whether received 
data is to be written. 
Valid only when the 
receive data are 
stored using the oper-
and addressing 
mode.

Setting this parameter 
to “available” always 
needs to designate 
the response type

--- O O --- --- --- ---

Next 
process

Sets the next transit 
step when the step 
ends normally.

End: Executes the 
step and ends the 
sequence.
Next: Executes the 
next step.
Goto∗∗: Executes the 
step designated by 
∗∗.
Abort: Aborts the step 
and ends the 
sequence.

O O O O O O O

Error 
process

Sets the next transit 
step when the step 
ends abnormally.

Same as above. O O O --- --- --- ---

Parameter Description Remark Command

Send Receive Send & 
Receive

Wait 
(see 
note)

Flush 
(see 
note)

Open 
(see 
note)

Close 
(see 
note)
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3-3-3 Repeat Counter
1,2,3... 1. Initial value designation

One of the following parameters can be set as the initial value in the corre-
sponding step of the repeat counter variable N.

Reset After the repeat counter variable N is reset to 0 when the step is started, the
step will be repeatedly executed by a designated number of times.

Hold When the step is started, the current value of the repeat counter variable will
be held as it is, and the step will be repeatedly executed by a designated num-
ber of times.

2. Number of iterations set

The number of iteration times to repeatedly execute the step can be desig-
nated by one of the followings:

• Setting constant 1 to 255.

• Using a word read R ( )

Example) R (1) The content (binary) of the low-order byte at the word of the third operand
(second operand for the C200HX/HG/HE) +1 of a PMCR instruction is desig-
nated as the number of iterations.

Example) R (DM0000) The content (binary) of the low-order byte in DM 0000 is designated as the
number of iterations.

Note How to designate word read

Note (∗1): C200HX/HG/HE only
(∗2): CS/CJ only

The content of the low-order byte at the start word + constant word is read as
binary data to indirectly designate the number of bytes.

Note When 0 is read by the repeat counter during the word read, the step will be
skipped (ignoring the next step setting) and control will shift to the next step
(+1).

How to designate 
a word

Symbol to be 
designated

Example

When constant=0 When constant=2

Operand 
designation

None Cannot be set. R(2)

Link word 
designation

O1,I1, O2, I2 R(O1) R(O1 + 2)

Direct designation CIO@@@, LR@@ 
(∗1), WR@@@@ 
(∗2), HR@@, 
AR@@, DM@@@@, 
EM@@@@:
Word#

R(DM0000) R(DM0000 + 2)

R (     )

Start word + constant
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Setting with the CX-Protocol

• While a step is executed for the number of times set in the repeat counter,
control is not shifted to the destination designated for the next process. After
the step is executed the designated number of times, the control shifts to the
designated destination for the next process.

• Use the repeat counter variable N for designating a send/receive message
address or data enables the following:

Example: If the same send message is to be sent to multiple N-connected external
Units,
include the repeat counter variable N in the send message address.

Example: If different addresses for different steps are to be designated to store receive
messages, include the repeat counter variable N in the data in the receive
message.

& (W(N+1),2) Two-byte receive data is converted from ASCII to hexadecimal and stored at
the address of the fourth operand (third operand for the C200HX/HG/HE) des-
ignated address + (repeat counter variable N + 1) word of a PMCR instruction.

Note The repeat counter variable N will be as follows depending on the initial value
setting.

(1) Reset (5 times), N = 0 to 4
(2) Hold (5 times), N= 4 to 8

For Hold, the repeat counter value updated in the previous process will be
used.
The set value and process value of the repeat counter in the above examples
are 0501 to 0505 for example (1) and 0501 to 0505 for example (2).

PMSU

PMSUCPU Unit
Receive message
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3-3-4 Commands
Set the Send, Receive, Send & Receive, Wait, Flush, Open, or Close com-
mand.

Send Sends a send message set in a step.

Receive Handles a receive message in a step or receive message in a matrix as an
expected message, and receives data (note 1).

Send&Receive After sending a send message set in a step, handles the receive message set
in a step or receive message in a matrix as an expected message, and
receives data (note 1).

Wait Keeps the step on standby until the Wait Clear switch changes from OFF to
ON. (See note 2.)

Flush Clears the data within the receive buffer. (See note 2.)

Open Turns ON the DTR signal. (See note 2.)

Close Turns OFF the DTR signal. (See note 2.)

Note 1. Compares an actually received message and set receive (expected) mes-
sage, and if they match, goes to the next process. If they do not match,
control is shifted to the error process for the receive message, and for the
matrix, to the next process designated with “Other” (other than the set re-
ceive message group.)

2. Only for the CS/CJ protocol macro.

3. Generally, when a command is sent and a response is received, set
Send&Receive.

4. Send&Receive allows retry to be designated. At retry, transmission wait
cannot be applied. If a transmission wait at retry is to be applied, divide the
retry into the Send step and Receive step.

5. Hold process ON (Open command) and process OFF (Close command) of
the DTR signal (only for the CS/CJ protocol macro).

The DTR signal will turn ON when a sequence execution is started. Exe-
cute the Close command to turn OFF the DTR signal at the desired timing.
Execute the Open command to turn ON the DTR signal again at the de-
sired timing. When the Open command is executed, the DTR signal will be
set to ON until the Close command is executed. This ON state will continue
even after one sequence is terminated and another sequence is started.

When the transmission control parameter is set to modem control for the
conventional protocol macro for the C200HX/HG/HE, the DTR signal will
turn ON when a sequence is started and will turn OFF when sequence ex-
ecution is completed. This setting has the following problems.

• When hanging up the phone in the middle of a sequence execution via a
modem, it will be necessary to send an escape code (for example: +++) and
an AT command (to cut the line) to the modem. However, hanging up the
phone can be performed more easily and reliably using electrical signals
(without requiring a modem monitor timer). 

Execution of 
Open/Close
command

Open
command

Close
command

Sequence Another sequence

DTR signal

Close
command

Open
command

Close
command
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With the CS/CJ protocol macro, the phone can now be hung up at the
desired timing by turning OFF the DTR signal.

• With the conventional protocol macro for the C200HX/HG/HE, the phone
line cannot be set to be active for more than one sequence. 
With the CS/CJ protocol macro, the DTR signal can be retained even after a
sequence has terminated, and can be applied in the following way.

1,2,3... 1. Make a call using the protocol macro from the PLC to a host computer
(Programming Device: CX-Programmer).

2. When the line is connected, change the serial communications mode from
protocol macro to host link using the STUP instruction. (DTR signal is re-
tained.)

3. Execute remote programming/monitoring from the Programming Device
side.

Note When set to modem control mode, the DTR signal will turn ON when the
sequence is started and will turn OFF when the sequence ends. If the DTR
signal is turned ON using the Open command under the modem control
mode, the DTR signal will remain ON even after the sequence has ended.

Personal computer

RS-232C
Modem Modem

RS-232C

1) Dial-up.

3) Remote programming/monitoring

2) Change the mode to host link 
using the STUP instruction.

Setup with the CX-Protocol

PLC
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3-3-5 Retry Count
When the retry count of the Send&Receive command is set, if a retry factor
among the above error factors occurs, (refer to the table of error factors on the
following page) the system will execute the Send&Receive command repeat-
edly. If this error factor still remains after the designated number of retry repe-
titions, the system will go to the error process.

When retrying, the system will send data regardless of the send wait time Ts.

Note To execute the retry process as an error process, it is necessary to set the
steps as follows. As seen in the following, the description of the error process
is more complicated than using Send&Receive commands and designating
the retry count.

Example: Retrying the same process 3 times.

Send&Receive

Executed to 
the number of 
times of the 
retry count?

Setting with the CX-Protocol
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Note When both the repeat counter N and the retry count is set, the counter N will
not be updated until the system executes the steps for the number of times of
the retry count. The counter N will be updated when the retry factor disap-
pears or the system has executed the steps for the number of times of the
retry count.

3-3-6 Send Wait Time
For the Send or Send&Receive command, set the wait time taken from the
corresponding step up to data transmission.

3-3-7 Send Message/Receive Message
Send Messages A send message name created in the send message list is referred to or a

send message is created directly in this step. For details about the contents of
send messages, refer to 3-4 Communication Message Attributes.

Receive Messages 
(Including Matrix)

A receive message name created in the receive message list is referred to or
a receive message is created directly in this step. For details about the con-
tents of send messages, refer to 3-4 Communication Message Attributes. 

Send&Receive

Executed 
to the number of 
times of the retry 

count?

Error
occurred?

(Normal end) (Abnormal end)

Error processNext process

N

N

N

Y

Y

Y

Executed 
to the number of 
times of the retry 

count?

Screen with the CX-Protocol
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A matrix name (indicated with brackets) created in the matrix list. is referred
to. For details about the contents of send messages, refer to the following 3-5
Creating Matrices.

3-3-8 With/Without Response Writing
Sets whether or not received data is written.

This setting is valid when the data in a receive message is designated with a
variable and the first word address is operand-designated.

If it is set to Yes, the data in the receive buffer will be written into the I/O mem-
ory according to the response type designated in the sequence attribute (scan
notification, interrupt notification: fixed number, or interrupt notification:
receive case number) and a notification of data reception will be issued to the
CPU Unit.

3-3-9 Next Process/Error Process
When a step is normally or abnormally terminated, set which step control it
will be shifted to.

When a matrix is designated as a receive message, the above setting is
invalid, and the next process designated with the matrix is valid.

Goto** After execution of the step, shift to the designated step ∗∗ (0 to 15).

Next After execution of the step, shift to the next (+1) step.

End After execution of the step, terminate the entire sequence including the step.

Abort If an error factor occurs during execution of the step, interrupt the execution of
the step and terminate the entire sequence including the step.

Setting with the CX-Protocol
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When one of the following error factors occurs, the step ends abnormally, and
then the system goes to the appropriate error process.

Note In case of the Wait, Flush, Open, or Close command, the error will not occur
during execution.

Command

Message

Normal end?

Error factor

Error processNext process

To be 
repeated?

N

Y

Y

N

Errors Command type When retry is 
designated.Send Receive Send & 

Receive

The Message that was received is not the same as the expected receive 
message.

--- O O Step is retried.

Monitoring time expired The data (or header) are not received within 
“receive wait monitoring time.”

--- O O

Data receiving is not finished within “receive 
finish monitoring time.”

--- O O

Data sending is not finished within “send 
finish monitoring time.”

O --- O

A transmission error occurs during data receiving. 
For the CS/CJ, an overrun/framing/parity error occurs for the transmis-
sion error occurrence status. (Words +8/+19) (bits 02 to 04 are set to 
“ON”)
For the C200HX/HG/HE, the Communication Error Flag 28304 or 28312 
is set to “ON.”

--- O O

An error is detected in error check code. --- O O

Received data size exceeds the area for the designated area during the 
writing of data to or reading of data from the CPU Unit.
For the CS/CJ, data read/write area error (error code 3) is stored in the 
error code (bits 00 to 03) indicating the port operating status 
(words +9/+19) of the protocol.
For the C200HX/HG/HE, data read/write are error (error code 3) is 
stored in the error code. (Word 256, bits 8 to 11 (port A) and bits 12 to 
15 (port B))

--- O O Step is not 
retried.
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3-4 Communication Message Attributes
The communication message contains six items: header, address, length,
data, error check code, and terminator.

Note The above six items can be eliminated in the following cases:
Sending: The header, the address, the length, the error check code, and the
terminator can be eliminated.
Receiving: If the terminator exists, the header, the address, the length, and
the error check code can be eliminated. If the data length is fixed, the termina-
tor can be eliminated as well.

Header Address Length Data Check code Terminator

Parameter Description Data attributes

Header Sets the data that indicates the beginning of the communications message 
frame. At reception, data from the header is received as the message.

Constant only

Address Sets the unit number or other information to be used as the message’s 
destination.

• The system identifies whether the receiving data is addressed to itself.
• When “Word writes” or “Wildcard” is set as a data attribute, the system

receives all the messages addressed to itself without identifying whether
it is addressed to itself (broadcast addressing).

• The message sending address can automatically be updated by using
the repeat counter. 

Constant (Reserved 
characters are not available.)
Variable

Length • Indicates the length (number of bytes) of a message. Based on the calcu-
lation method set at transmission (length size/data format), calculates
message length and appends the value before sending.

• When the message is received, the amount of data 
corresponding to this value for the length is taken from the actual
received data and processed as the receive message. (Checking of this
value is not supported by C200HX/HG/HE.)

Automatic variable

Data • For sending messages
Set the data to be sent.

• For receiving messages
Set the data expected to be received. When the data of the actually
received message frame is different from the designated data, the sys-
tem executes the error process.
The received data can be written to the I/O area of the CPU Unit.

Constant
Variable

Error check 
code

• At the send process, the check code of the send message frame is auto-
matically calculated according to the setup, and appended to the mes-
sage frame to be sent.

• At receive process, error checking that compares the check code
received with the check code locally calculated from the received data is
executed.

• When both check codes are different, the control will go to the error pro-
cess.

Automatic variable (LRC, 
LRC2*1, SUM, SUM1*1, 
SUM2, CRC-CCITT, CRC-16, 
or No-Check)
*1: Only for CS/CJ protocol 
macro

Terminator Marks the end of a message frame.

• When sending a message, the system will finish a frame of the message
sending after it sends the terminator. If the terminator is not set, the sys-
tem will finish the sending when it sends the data set at the end of the
send message.

• When receiving a message, the system will finish receiving when it
receives the terminator. If the terminator is not set, the system will finish
the receiving when it receives the data set at the end of the receive mes-
sage.

• If the number of bytes of data set at the end of the receive message is
“Wildcard,” the system will finish receiving when the buffer becomes full
(CS/CJ: 2,500 bytes, C200HX/HG/HE: 256 bytes). However, if flow con-
trol (X-on/X-off, RTS/CTS) is set, the system will send the X-off code
when the buffer is filled to 75% (CS/CJ: 2,000 bytes, C200HX/HG/HE:
200 bytes) and finishes receiving. 

Constant only
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3-4-1 CX-Protocol Setup Screen

For the details of setup method, refer to the SECTION 9 Setting and Editing
Messages and Matrix Lists.

Note After the creation of communication message, users can create steps by des-
ignating the message name.

3-4-2 Header
Indicates the beginning of a message. Only a constant can be designated.

Selects the message type (ASCII, hexadecimal, control code), and enters
data.

Example: Type: ASCII, data: @ (screen display: “@”)

3-4-3 Address
Designate the address when a message is subjected to 1:N communications.
A constant or variable can be designated. Using the repeat counter variable N
for the variable can change the address for each sending and receiving.

Select the address type (constant, variable), and enter data.

Example: Type: variable, conversion: none, data: (R(1),2) (screen display: (R(1),2))

3-4-4 Length
Sending (Common to C200HX/HG/HE and CS/CJ)

Upon sending, calculations are automatically performed for the message item
corresponding to the length itself, and adds the item. Unit: Number of bytes. It
is possible to set the range for the item to be calculated. 

Receiving Protocol Macro for C200HX/HG/HE

This length data is not checked upon reception.

Designate the length size (one byte, two bytes), data type (ASCII, binary)
according to the communications designation of the device at the communica-
tions partner.

Example: 1 byte, binary, initial value: 0 (screen display: (0) (1 Byte BIN))

Note The length calculation range is set in the Message Editor dialog.

Protocol Macro for CS/CJ

This length data is checked upon reception.

If there is no terminator designation, an amount of message items corre-
sponding to the length (number of bytes) set in the expected message will be

Message name (Note)

Header Terminator

Check code Length Address Data
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extracted from the receive buffer and processed as the receive message.
If there is a terminator designation, data up to the terminator will be received
as the receive message and a comparison will be made to check that the
length of this message matches the value for the length in the expected mes-
sage.

Note Even if there is no designation for the header, it is possible to take the mes-
sage item out of the receive buffer if the length or the terminator is designated,
and process it as the receive message.

Length designation for the CS/CJ operates in the following way.

Example: If the received message is <h>+<l>+(W(1),∗), the data size of (W(1),∗) will be
determined by the value of <l> in the expected message following <h>, and
the data will be received as the receive message.

Note A comparison error may occur as the result of an ASCII conversion error for
<l>.

Example: If the received message is <h>+<l>+(W(1),∗)+<t> and the range between <h>
and <t> has been recognized as the receive message, a comparison will be
made between the value of <l> in the expected message and the data size of
the actually received (W(1),∗).

Note A comparison error or a data size comparison error may occur as the result of
an ASCII conversion error for <l>.

3-4-5 Data
At sending, designate data to be sent. At reception, designate expected data.

A constant or variable can be designated. A constant and a variable can be
combined as a string.

Designating a variable allows the I/O memory word data to be used as part of
data (at sending: read, at reception: write). Furthermore, using the repeat
counter variable N for the variable allows data to be changed for each send
and receive.

Select the data type (constant, variable), and enter data.

Example: Type: Constant (ASCII), data: RX0
Type: Variable (hexadecimal), data: &(N,R (1))
Type: Constant (ASCII), data: 00

(Screen display: “RX0” + &(N,R(1)) + “00”)

Expected message Receive buffer

Reception

Message

Example: If the data part is 100 bytes, the following 
will be received as the receive message.

Header Address Length Data Error check 
code

Terminator

100 bytes

Header Address Length Data Error check 
code

Terminator
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3-4-6 Error Check Code
Designate the error check code when data is sent.
LRC, LRC2, CRC-CCITT, CRC-16, SUM (1-byte/2-byte), SUM1 (1-byte/ 2-
byte), and SUM2 (1-byte/2-byte) can be designated. As the data type, BIN or
ASCII can be selected. The data size, default, and swap between high byte
and low byte can be designated.

Example: Type: LRC, data type: ASCII, data size; 2 bytes, initial value: 0 (screen dis-
play): LRC (H parity) (0) (2 Byte ASCII)

Note 1. The error check code range is set in the Message Editor dialog.
2. SUM2, CRC-16, and swap between high byte and low byte are possible for

the C200HX/HG/HE only when the Communications Board is the
C200HW-COM@@-EV1. For the CS/CJ, they are possible with any PMSU,
and SUM1 (1 byte, 2 bytes) and LRC2 are also possible.

3-4-7 Terminator
With reception of this code, data reception is completed. (When data is
received without this code, data reception will be completed when the data
that corresponds to the length of the message set in the reception message
inside the step is received.)
With sending of this code, data sending is completed. (When data is sent
without this code, data sending is completed at the time when the last data is
sent.)
Only a constant can be designated.
Select the terminator type (ASCII, hexadecimal, control code) according to
the communications specification of the device of the communication partner,
and enter the data.

Example: Type: hexadecimal, data: 2A0D (screen display [2A0D])

Note Even if there is no designation for the header, it is possible to take the mes-
sage item out of the receive buffer if the length or the terminator is designated,
and process it as the receive message.

3-4-8 Message Item Data Attributes
Users can set the following constants or variables as message items.

Constant Can be set for the header, address, data, or terminator.

Variable Can be set for the address or data.
Variables read from and write to the I/O memory of PLC, and utilize repeat
counter variables.

1. Format
Designate in the form of (X, Y).
X: Effective address

Designates where to read from or write to in the I/O memory, the lin-
ear expression including N, or the wildcard. One of the following can
be used to designate items.

Constant Designating method Examples

ASCII data Designate between double quotation marks, 
as in “12345.”

“12345”

Hexadecimal data Designate between square brackets as in 
[5A2B].

[5A2B]

Control code Designate by selecting the special code from 
the list, such as CR, LF, or STX.

[OD] for CR
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a) Both the read/write options and the first word + (the linear expression
including N)

b) Linear expression including N.

c) Wildcard (∗)

Note Wildcard can be designated only in the receive message.

Y: Data size (CS/CJ: 1 to 1000, C200HX/HG/HE: 1 to 255)
Designates the number of bytes to read or to write, when the data are
not converted. (Designates 1 when reading the value of N.)
Designates the number of bytes on the transmission, when the data
are converted. The number of bytes on I/O memory are as follows.

One of the following can be used for designate items.

1,2,3... 1. Linear expression including N.
2. Wildcard (∗)

Note Wildcard can be designated only in the receive message.
3. Both the read option and first word + (the linear expression including N)

when using C200HX/HG/HE-series PLCs.
Note Reads bits 0 to 11 of the word as 3-digit BCD. When using CS/CJ-

series PLCs, the bits are read as binary data.
There are three types of variables as shown below. For each variable, users
can set the attribute which designates the direction (forward or reverse direc-
tion) to read or to write the data to be converted.

Note 1. ASCII Data Conversion, Hexadecimal Data Conversion:
When ASCII data conversion is performed, the designated data is read as
Hex (hexadecimal) data and each digit is converted to its ASCII code num-
ber. Consequently, the size of the data will be double that before conver-
sion.
When Hex data conversion is performed, the designated data is read as
ASCII data and each byte of the data is converted to a hexadecimal value.
Consequently, the size of the data will be half that before conversion.
The specifications for the conversion vary with the designated data, read/
write designations, and direction designations. For conversion examples,
refer to page 105.

Option Data size on the I/O memory

$ 
(Hexadecimal→ASCII)

& 
(ASCII→Hexadecimal)

R (Read from the PLC→Send) Y/2 bytes Y x 2 bytes

W (Receive→Write to the PLC) Y x 2 bytes Y/2 bytes

Variable Read/write direction Function

Forward Reverse Read Write

Unconverted variable (X, Y) ~ (X, Y) Y bytes of data from the address designated by X 
are processed without conversion.

Variable converted to 
ASCII

$(X, Y) $~ (X, Y) Y/2 bytes of hexadeci-
mal data from the 
address designated by 
X are converted to Y 
bytes of ASCII data.

Y bytes of hexadecimal 
data is converted into 
ASCII data equivalent to 
Y∗2 bytes before stor-
age with the address 
designated by X as the 
beginning.

Variable converted to 
hexadecimal

& (X, Y) &~ (X, Y) Y∗2 bytes of ASCII data 
from the address desig-
nated by X are con-
verted to Y bytes of 
hexadecimal data.

Y bytes of ASCII data is 
converted into hexadeci-
mal data equivalent to 
Y/2 bytes before storage 
with the address desig-
nated by X as the begin-
ning.
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Variable Format

Note 1. How to designate a word.

2. For CS/CJ.

3. For C200HX/HG/HE.

Note For converted variables:

When the frame format of instructions (commands) that the partner Unit can
translate is configured by ASCII code, the numeric hexadecimal data in the I/
O memory has to be converted to hexadecimal data by $( , ) before it is sent,
and the numeric ASCII data has to be converted to hexadecimal data by &( , )
before it is received.

When converting data (hexadecimal data) in the I/O memory into ASCII 
code before sending

Example: Convert a 6-digit numeric value (3 bytes in the I/O memory) for DM 0000 into
ASCII in the reverse direction

$~(R(DM0000), 2 )

X Y

Data size on the transmission path:

Effective address:
The first word + (The linear expression including N)

Read/ Write option
R: Read from the PLC
W: Write to the PLC

Conversion attribute
Blank: Unconverted
$: ASCll conversion
&: Hexadecimal conversion

Conversion direction
Blank: Forward direction
~: Reverse direction

or the linear expression
including N or the wildcard (*)

The linear expression including N or the wildcard (*) or indirect designation by
the Read option R( ): Reads from PLC.
(Reads bits 0 to 11 of word as 3-digit BCD when using C200HX/HG/HE-series PLCs,
or as binary when using CS/CJ-series PLCs.)

How to designate 
a word

Symbol to be 
designated

Example

When linear 
expression 

including N=0

When linear 
expression 

including N=2N+1

Operand 
designation

None Cannot be set. R(2N+1)

Link word 
designation

O1, I1, O2, I2 R(O1) R(O1+2N+1)

Direct designation CIO@@@, 
WR@@@@ 
(note 2), LR@@ 
(note 3), HR@@, 
AR@@, 
DM@@@@, 
EM@@@
@: Word #

R(DM0000) R(DM0000+2N+1)
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When converting the numeric data (ASCII data) from the external device 
into the hexadecimal data and receiving and writing it

Example: Converting a 5-digit numeric data (5 bytes in ASCII data) into hexadecimal,
and writing it from DM 0000 in the reverse direction.

Users can set the following contents on the X and Y of variable (X,Y).

2. Contents of X and Y

5 6

1 2

7 8DM0000

15 0

$~( , ) 35 36

"5" "6"

37 38 31 32

"1" "2""7" "8"On the
transmission path

How to designate:$ ~ (R (DM0000) 6)

Number of bytes in the transmission path
(after ASCII conversion)

Read from DM0000

Hexadecimal ASCII conversion

Reverse direction

1 2

5 0

3 4

0 0

DM0000

15 0

&~( , )31 32

"1" "2"

33 34 35

"5""3" "4" On the 
transmission path

How to designate: &~ (W (DM0000), 5)
Number of bytes in the transmission path 

Read from DM0000

ASCII Hexadecimal conversion

Reverse direction
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How to set X and Y Specification Example Items available

Send Receive

Address Data Address Data

How 
to 
set 
X

Reading/
writing 
the I/O 
memory

Word 
reading

Operand 
address-
ing

(R (1),1)
The system reads 
one byte from the 
third operand (for 
CS/CJ) or second 
operand (for 
C200HX/HG/HE) of 
the PMCR 
instruction + 1 
location to send it 
with no conversion.

O O O O

Link 
word 
address-
ing

$(R(O1+5),2)
The system reads 2 
bytes from the 5th 
word in the link 
word’s output area 
1to send it with 
conversion to ASCII 
form.

O O O O

Direct 
address-
ing

$(R(DM0000),3)
The system reads 3 
bytes from DM 0000 
to send it with con-
version to ASCII 
form.

O O O O

Reading/
writing 
the I/O 
memory

Word 
writing

Operand 
address-
ing

(W(1),1)
The system writes 
one byte of receive 
data to the (fourth 
operand of the 
PMCR instruction + 
1)th word (for CS/CJ) 
or the (third operand 
of the PMCR 
instruction +1)th 
word (for C200HX/
HG/HE) with no 
conversion.

--- O --- O

Link 
word 
address-
ing

&(W(I1+5),2)
The system writes 2 
bytes of receive data 
to the input area 1 of 
the link word’s 5th 
word with 
hexadecimal 
conversion.

--- O --- O

Direct 
address-
ing

&(W(LR0060),3)
The system writes 3 
bytes of receive data 
to LR0060 with 
conversion to 
hexadecimal form.

--- O --- O

R (z)

First word + (Lin-
ear expres-
sion includ-
ing N)

Read option

Read from the 
first word + 
(yN + x) word

W (z)   

First word + 
(Linear 
expression 
including N)

Write option
Read from the 
first word + 
(yN + x) word
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How 
to 
set 
X

Wildcard Can be set only in 
the address part or 
data part of the 
receive message.
• Setting the wildcard 

in the address part:
The system 
receives all the 
messages without 
checking the 
address data.

• Setting the wildcard 
in the data part:
The system 
receives all data 
without checking 
the received data.

With (∗, 2) 
designated in the 
address part, 2 bytes 
can be received from 
any address.
With (∗, 5) 
designated in the 
address part, 5 bytes 
can be received from 
any address.

--- O --- O

N (repeat counter) N (N, 1) repeat
counter value

O O O O

How 
to 
set 
Y

Linear expression including N 
(repeat counter)

$(R(1),2)
The system 
repeatedly reads 2 
bytes starting at 
word No. (third 
operand of the 
PMCR instruction + 
1) (for CS/CJ) or 
word No. (second 
operand of the 
PMCR instruction + 
1) (for C200HX/HG/
HE) to send as 
ASCII.

O O O O

Wildcard Can be set only in 
the data part of the 
receive message.
Setting the wildcard 
in the data part The 
system receives all 
the messages 
without checking the 
received data.
However, if x is a
linear expression 
including N, this 
setting is not 
possible. 

&(W(1),∗)
The system receives 
data from the fourth 
operand (for CS/CJ) 
or the third operand 
(for C200HX/HG/HE) 
of the PMCR instruc-
tion + 1 to store it 
with conversion to 
hexadecimal form 
regardless of the 
length.

--- O --- O

How to set X and Y Specification Example Items available

Send Receive

Address Data Address Data

yN + x

Constant. 
Sets the 
number of 
bytes 
(1-255).

Repeat counter 
value
Coefficient
(0-255).
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How 
to 
set 
Y

I/O Word 
read

Chan-
nel read

Operand 
designa-
tion

(∗,R(1)): Set in 
receive data.
Any receive data is 
received by the 
number of bytes of 
the contents word + 
1 word designated 
using the third oper-
and (for CS/CJ) or 
the second operand 
(for C200HX/HG/
HE).

O O O O

Link 
word

(R(1) , R(O1): Set in 
send data. Data is 
sent by the number 
of bytes of the 
contents of the first 
word at the link word 
output area 1 from 
word + 1 word 
designated with the 
third operand (for 
CS/CJ) or the sec-
ond operand (for 
C200HX/HG/HE) of 
a PMCR instruction.

O O O O

Direct (R (DM0000), 
R (DM0100)): Set in 
send data. Data 
starting from 
DM0000 and 
corresponding to the 
number of bytes set 
in DM0100 is sent.

O O O O

How to set X and Y Specification Example Items available

Send Receive

Address Data Address Data

R  (z)

First word 
+ (linear 
expression 
including
N)

Read option

The content of the 
low-order byte of 
the first word + (yN 
+ x) word is read as 
a binary value and 
handled as a byte.
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Examples of the Variable Reading from CPU Unit to PMSU.

Writing from PMSU to CPU Unit

Note “0” is stored in an empty bit in a word whose write data is less than 16 when
writing to the CPU Unit.

When the receive data has variable length, use the wildcard (∗).

 "x"

 "x"
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When converting to hexadecimal, convert data other than numerical data in the following way:
• The negative sign (–) is recognized as a minus value and the highest digit is

stored as F hexadecimal.

• The decimal point is ignored when the data is stored.

• Symbols and characters other than 0 to F are stored as 0 hexadecimal.

When converting from hexadecimal, convert data other than numerical data in the following way:
• The negative sign (–) is treated as a symbol and stored as 0 hexadecimal.

• The decimal point is ignored when the data is stored.

Symbols and characters other than 0 to F are stored as 0 hexadecimal.

Note Error Check Code

For protocol macros, the following 8 types of check code can be set:

Receive data string 
(Example)

Variable (ASCII to 
hexadecimal conversion)

After conversion

HEX: 2D 31 32 33 34 35
ASCII: –    1   2   3    4   5

& (W(DM000,6)

HEX: 31 32 33 2E 34 35
ASCII: 1   2    3   .     4   5

HEX: 31 2F 33 34 35 36
ASCII: 1   /     3   4   G   6

DM0000
DM0001

23 45
F0 01

DM0000
DM0001

23 45
00 01

DM0000
DM0001

34 06
00 10

Receive data string 
(Example)

Variable (ASCII to 
hexadecimal conversion)

After conversion

HEX: 2D 31 32 33 34 35
ASCII: –    1   2   3    4   5

&~ (W(DM000,6)

HEX: 31 32 33 2E 34 35
ASCII: 1   2    3   .     4   5

HEX: 31 2F 33 34 35 36
ASCII: 1   /     3   4   G   6

DM0000 
DM0001

01 23
45 00

DM0000 
DM0001

12 34
50 00

DM0000 
DM0001

10 34
06 00

Calculation 
method

Data type Reverse 
direction 

(see note 1)

Initial value

LRC (see note 
2)

BIN 1 byte Unavailable 0-255

ASCII 2 byte 
(see note 2)

Available
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Note 1. Swap between high byte and low byte of the error check code is possible
for CS/CJ, and is also possible for C200HX/HG/HE when the Communica-
tions Board is the C200HW-COM@@-EV1.

2. The host link (SYSMAC WAY) uses an error check code: LRC ASCII 2-byte
(sequential direction).

3. With CS/CJ protocol macro.

Calculation Examples

The following message items are used to calculate the check code when the
initial value is 0.

1,2,3... 1. LRC (Longitudinal Redundancy Check)

This mode calculates the exclusive OR (XOR) of the characters of a set of
data to create a check code. 

Sum 
(1 byte)

BIN 1 byte Unavailable 0-255

ASCII 2 byte Available

Sum
(2 bytes) 

BIN 2 byte Available 0-65535

ASCII 4 byte Available

Sum2 
(1 byte)

BIN 1 byte Unavailable 0-255

ASCII 2 byte Available

Sum2
(2 bytes)

BIN 2 byte Available 0-65535

ASCII 4 byte Available

CRC-CCITT BIN 2 byte Available ---

ASCII 4 byte Available

CRC-16 BIN 2 byte Available 0-65535

ASCII 4 byte Available

LRC2 (see 
note 3)

BIN 1 byte Unavailable 0-255

ASCII 2 byte Available

SUM1 (see 
note 3)
(1 byte)

BIN 1 byte Unavailable 0-255

ASCII 2 byte Available

SUM1 (see 
note 3)
(2 bytes)

BIN 2 byte Available 0-65535

ASCII 4 byte Available

Calculation 
method

Data type Reverse 
direction 

(see note 1)

Initial value

00           52           44           38           39

Calculation items
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Note LCR2 is the 2’s complement of the LCR calculation result.

2. SUM

This mode adds arithmetically the characters of a set of data to create a
check code. Users can designate either of the directions for storing the
SUM, as with variables.

Note SUM1 is the 1’s complement (bit reversal) of SUM.
SUM2 is the 2’s complement of SUM.

3. CRC (Cyclic Redundancy Check Code)

This mode regards the whole data as a bit string (message polynomial),
divides this string by the fixed constant (generative polynomial), and de-
fines the remainder as the check code.

LRC 2byte ASCII          00 52 44 38 39 31 37 0D

LRC 2byte ASCII          00 52 44 38 39 37 31 0D

LRC 1byte ASCII          00 52 44 38 39 17 0D

: Check Code

Initial value

XOR

XOR

XOR

XOR

1 byte

Calculation result

(1)

(2)

(3)

(4)

00 hexadecimal

52 hexadecimal

44 hexadecimal

38 hexadecimal

39 hexadecimal

17 hexadecimal

SUM (1 byte) ASCII 2byte         00 52 44 38 39 30 37 0D

: Check Code

~SUM (1 byte) ASCII 2byte       00 52 44 38 39 37 30 0D
~SUM (2 byte) ASCII 4byte       00 52 44 38 39 31 30 37 30 0D

SUM (2 byte) ASCII 4byte         00 52 44 38 39 30 31 30 37 0D

SUM (1 byte) BIN 1byte            00 52 44 38 39 07 0D

SUM (2 byte) BIN 2byte            00 52 44 38 39 01 07 0D

~SUM (2 byte) BIN 2byte          00 52 44 38 39 07 01 0D
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CRC detects errors better than the vertical parity or horizontal parity, and
is used widely in LANs, etc. (For example, the SYSMAC LINK uses CRC-
CCITT.)

Various kinds of CRC can be used. The calculation mode defined accord-
ing to the CCITT recommendation is called CRC-CCITT, where

X16+X12+X5+1 is used as the generative polynomial. (Incidentally, CRC-16

(X16+X15+X2+1) is also often used as a generating polynomial.)

Note Reverse direction is available. Default value can be set for the 
CRC-16

The generating function in the calculation mode of the CRC is uniquely de-
termined as CRC-CCITT or CRC-16. Data for each character of CRC-
CCITT is treated differently from that for CRC-16 as shown below. 

If a message with “n” characters, which is subject to check code calcula-
tion, is expressed as shown in the following table, the MSB (most signifi-
cant bit) and LSB (least significant bit) in every character for CRC-16 will
be reversed as shown in the following tables.

Note D: 0 or 1

CRC-CCITT

CRC-16

Therefore, algorithm for each one becomes as shown below.

• CRC-CCITT algorithm

C0 C1 --- Cn-1

D0(7) to D0(0) D1(7) to D1(0) --- Dn-1(7) to Dn-1(0)

C0 C1 --- Cn-1

D0(7) D0(6) to D0(0) D1(7) D1(6) to D1(0) --- Dn-1(7) Dn-1(6) to 
Dn-1(0)

C0 C1 --- Cn-1

D0(0) D0(1) to D0(7) D1(0) D1(1) to D1(7) --- Dn-1(0) Dn-1(1) to 
Dn-1(7)

CRT-CCITT 4byte ASCII 02 52 44 38 39 33 36 46 42 0D

: Check Code

CRT-CCITT 2byte BIN 02 52 44 38 39 36 FB 0D

CRT-16 4byte ASCII 02 52 44 38 39 42 46 46 41 0D

CRT-16 2byte BIN 02 52 44 38 39 BF FA 0D

XOR

Shift register
X16

X12

LSB
X5

Data input

MSB

The last value is determined 
as the check code.
109



Communication Message Attributes Section 3-4
• CRC-16 algorithm

3-4-9 Supplemental Notes on Message Setup
1,2,3... 1. Designating more than one constant or variable

To designate more than one constant or variable, use “+” as follows:

Example: Sending a command (“RX0” + word number + “00” (code number)) to deter-
mine the PV (process value) of the Temperature Controller.

“RX0” + $(N,1) + “00”

↓
A message “RX0N00” (N is the value of the repeat counter, 0-255) is sent.

N = 0: “RX0000”

N = 1: “RX0100”

N = 2: “RX0200”

2. Word writing for receive messages
For receive messages, the system needs to compare the “address part” of
the message frame that was received, confirm whether this part has the
self unit number or not, receive the data part if so, and store this “data part”
to the appropriate area on the PLC by “word writing.” 

• Designate the data needed for comparison such as an address using
a constant, variable with constant X, variable (word reading), wildcard,
etc. 

• Designate the data necessary to be stored to the area on the PLC us-
ing a “variable (word writing).”

Example: Comparing the address part (2 bytes long) and receiving the data part suc-
ceeding the address part to store in the I/O memory on the PLC.

Address Designation:

: $(R(1),2) When the received message is for the receiver (the received ad-
dress is the same as the address (1 byte long) set in the third operand (CS/
CJ) or second operand (C200HX/HG/HE) of the PMCR instruction + 1, and
converted to ASCII, the data part succeeding this address part will be re-
ceived.

Note The message to be compared (expected message) is word read (R
option).

 : (∗,2) Whichever unit address the destination of the receive message has,
the data part succeeding the address part is received.

Note For the address part, the wildcard (∗) can be used only on X.

Data Addressing:

: &(W(1), ∗) The data that was received is written to the fourth operand
(CS/CJ) or the third operand (C200HX/HG/HE) of the PMCR + 1 in hexa-
decimal regardless of the length.

Note To store the data that was received into the area on the PLC, use
word writing (W option) to designate.

X16 X15 X2

Data input
The last value is determined 
as the check code.

LSBMSB
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Communication Message Attributes Section 3-4
Example: Comparing some part of the receive data and storing the other part of the
data to the PLC area.
The system checks the command string “TX∗∗” in the data that were received,
and then stores the succeeding data to the area in the PLC.

Data Designation:

 “TX”+(∗,2)+&(W(1), ∗) When receiving the command TX, the system does
not compare the next 2 bytes of data, and stores the subsequent data in
hexadecimal regardless of the length.

• If the wildcard (∗) is set at the data size part of “variable (word write),” the
actual data size will be determined at one of the following times:

For the CS/CJ, when the message length reaches the maximum number
of bytes under PLC Setup (allocated DM area m+9, m+19).
For the C200HX/HG/HE, when the message length reaches 256 bytes with
no flow control, or when the message length reaches 200 bytes with flow
control.

When delimiting factors in the following data (terminator, constants) allow
data-size recognition.

Note Constants will be recognized as delimiters only up to 4 bytes. When
using wildcards (∗), always set a terminator.

• If the wildcards are set at the data sizes of consecutively designated “vari-
ables (words write)” (separated by “+”), only the first “variable (word write)”
is effective.
For example, (W(1), ∗)+(W(10), ∗) is equal to (W(1), ∗).

• If the wildcards are set at the data sizes of consecutively designated “vari-
ables (words write)” or “variables (words read)” (separated by “+”), only the
first “variable (word write)” is effective.
For example, (W(1), ∗)+(R(2), 8) is equal to (W(1), ∗).

• If “+”s separated by a constant or a check code of less than 5 bytes are des-
ignated between “variables (words write)” the data sizes of which are set as
wildcards, the constant or the check code is deemed a delimiter.

For example, if “12345ABC5678” is received while (W(1),
∗)+“ABC”+(W(10), ∗) is set, “12345” corresponds to (W(1), ∗) and “5678”
corresponds to (W(10), ∗).

• If “+”s separated by a constant or an error check code of more than 4 bytes
are designated between “variables (words write)” or “variables (words
read),” the data sizes of which are set as wildcards, only the first “variables
(words write)” is effective.
For example, if “12345ABCDE56789” is received while (W(5),
∗)+“ABCDE”+(R(2), 8) is set, “12345ABCDE56789” will correspond to
(W(5), ∗). The (R(2), 8) setting will be ignored.

• When there is an error check code <c> after a “variables (words write)” set
with a wildcard, the error check code will be calculated if the position of the
error check code itself can be located within the receive message. Such a
condition is satisfied at the following times. 

When the position of the error check code itself relative to the start can be
calculated.
For example: <h>+(W(2), 10)+<c> 

When the position relative to the delimiter (terminator, constant) following
the error check code can be calculated.
For example: <h>+(W(5), ∗)+<c>+<t>

<h>+(W(5), ∗)+<c>+“ABC”+<t>
<h>+(W(5), ∗)+<c>+“ABC”+(W(5), ∗)+<t>
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Creating Matrices Section 3-5
Note Only constants of less than 4 bytes will be recognized as delimiters.

As in the following examples, if the position of the error check code itself
within the receive message cannot be located, it will not be calculated. 

For example: <h>+(W(5), ∗)+<c>
<h>+(W(5), ∗)+<c>+(W(5), ∗)
<h>+(W(5), ∗)+<c>+“ABCDE”+(W(5), ∗)

3. Setting the header, error check code, and terminator

• For the header or terminator, various special codes such as @, CR, LF,
STX, or ETX are used according to the communications destination device.
Always set on the message the same header or terminator as the destina-
tion device.

• There are several different kinds of error check code such as SUM, LRC,
CRC-CCITT, that may be used by the communications partner. Make sure
that the error check code set in the message corresponds to that used by
the communications partner.

• Most external devices can send or receive only ASCII codes. In this case,
convert the hexadecimal code into ASCII before sending and convert
received data from ASCII to hexadecimal conversion before storage. Con-
sider the data format and reading/writing direction which allows sending/
receiving of the destination device, and convert it into a data format which
can be handled with the data conversion-available variable before sending
and receiving.

3-5 Creating Matrices
Matrices are set when more than one receive messages are expected to be
received or when users want to change next process for each receive mes-
sage.

Up to 15 types of message can be set in a matrix (case No.00 to14). In a
matrix, next processes such as End, Next, Goto∗∗, or Abort are set for each
one of the up to 15 types of receive (expected) message.

“Other” must also be set to enable processing when some message other
than the receive messages designated in the matrix is received.

Note The attribute by which the system compares the expected value with the actu-
ally received value in the matrix is not of data, but of messages.
If only “other” is set, a protocol data syntax error (error code: 4) will occur.

<t><c>Data<a><h> <t><c>Data<a><h>

<t><c>Data<a><h>

<t><c>Data<a><h>

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Receive
Received message

<h>: Header
<a>: Address
<c>: Error check code
<t>: Terminator

Other (must be set.)

Note: Maximum of 16 cases are possible including "Other."

Matrix

Next processReceive (expected) message
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Creating Matrices Section 3-5
Note Set the format for the messages in the matrix to be the same for all cases.
The matrix opens up messages under the frame configuration designated in
case number 00, and performs a comparison with all the cases in order from
case number 00 to case number 15.

Therefore, if there are differences in message formats between cases
because messages are opened up using the frame configuration of case
number 00, comparison results for frames with a different message format
from case number 00 will register a non-match, irrespective of the actually
received message.
However, with the CS/CJ, the following operation that combines length desig-
nation and matrix, will be possible. (Not possible with C200HX/HG/HE.) With
case number 00, the message is opened up using the length designation, and
is compared with case numbers 00 to n. Even if the message lengths for the
cases 00 to n are different, the comparison will be performed correctly. 

Example of Matrix

As an example, the following matrix is used:
Case No. 0: <h>+<l>+“W”+(W(1), ∗)
Case No. 1: <h>+<l>+“R”+(W(1), ∗)
Case No. 2: <h>+<l>+“C”+(W(1), ∗)
(<h>=@)
If “@5W01234” is received, it will match with case number 0. (W(1),
∗)=“01234.”
If “@8R01234567” is received, it will match with case number 1. (W(1),
∗)=“01234567.”
If “@3C012” is received, it will match with case number 2. (W(1), ∗)=“012.”

Note Error check code or terminator can be appended.

Example: Via the host link (SYSMAC WAY), change over the process according to the
response (PROGRAM/MONITOR/RUN mode) for the status read command.

Receive
Actually received message

Opens up message with case number 00 as standard

<h> <a> Data <c> <t>

<h> <a> Data <c> <t>

Comparison

<h> <a> Data <c> <t>

<h> <a> Data <c> <t>

<h> <a> Data <c> <t>

Case No. 00

Case No. 01

Case No. 14

15 max.

Case No. 00
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By using the matrix, identify the difference in the status in the response data
(section in the above), and change over the process according to the mode of
the PLC.

Matrix Example Change over the process according to the ACK, NAK reception.

In the following example, the entire message structure is omitted and only
data is indicated with “”.

* Issue an MS command.
Transmission message:

* Receive a response.
Matrix: Case No.00

Case No.01

Case No.02

"@"+"00"+"MS"+LRC+[2A0D]

"@"+"00"+"MS"+"00"+"00"+(*,*)+LRC+[2A0D]

"@"+"00"+"MS"+"00"+"02"+(*,*)+LRC+[2A0D]

"@"+"00"+"MS"+"00"+"03"+(*,*)+LRC+[2A0D]

Header
Address Host

link command

Program mode code
End code

Receive
(expected)

message
Next process
Go to 01

Monitor mode

RUN mode

Go to 02

Go to 03

Case No.03 Others

PMSU

Host link MS command Response PLC
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Note Set same header and same terminator for all the receive messages set by the
matrix. If headers or terminators are different by case number, the system
shall make a comparison for the received message based on the header and
the terminator (or the data length, if the terminator is unavailable) of a
received message set as case number 00. For example, therefore, if the
header of case number 00 is “@” and the header of case number 01 is
[02](STX), the system identifies that the comparison results in the unmatched
even if the header of actually received message is [02], because it is different
from the header “@” of case number 00

Send "ENQ"

Receive 
 "ACK"

Error

Next

Step No. 00

Send&Receive

Step No. 01

Send message Send wait: 1

Send&Receive

Matrix

Receive "Other" Receive "ACK" Receive "NAK"

Abort

Step No. 02 Goto

Send "EOT"

Send

No

Yes

End Abort

Normal 
completion

Step structure

Step No. Repeat 
counter

Command Retry Send 
wait

Send
message

Receive 
message

Response
type

Next 
process

Error
process

00 R/001 Send&Receive "ENQ" "ACK" Next Goto 00--- --- ---

01 R/001 Send&Receive

02 R/001 Send&Receive

---

---

Message Matrix

 "EOT" End Abort---

---

------

---1 s Goto 00

Matrix

Case No. Receive 
message

Next 
process

00 "ACK" Goto02

01

~

"NAK" Goto01

Abort15 Other

Set next processes (End, Next, Goto**, or Abort) 
for each one of the up to 15 types of receive 
message.

For "Other" case, set the next process to be 
executed when the message that was received is 
not equal to any of the expected messages.--- ---
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Examples of Standard System Protocols Section 3-6
3-6 Examples of Standard System Protocols

3-6-1 “Process Value Read” Sequence of the “Controller (E5_K Read)” 
Protocol

Level Item Contents of setting

Sequence Link word ---

Transmission control parameter Modem control

Response Type Scan

Receive wait monitoring time Tr 3s

Receive finish monitoring time Tfr 3s

Send finish monitoring time Tfs 3s

Step Step No. 00

Repeat counter RSET/001

Command Send&Receive

Retry counter 3

Send wait time ---

Send message SD(00)_1

Receive message RV(00)_1

With/Without response writing Yes

Next process End

Error process Abort

Send message 
SD(00)_1

Header <h> ”@”

Terminator <t> [2A0D]

Error check code <c> LRC (H parity) (0) (2-byte ASCII)

Length <I> ---

Address <a> $(R(1),2)

Message editing

Reception mes-
sage 
RV(00)_1

Header <h> ”@”

Terminator <t> [2A0D]

Error check code <c> LRC(H parity)(0) (2-byte ASCII)

Length<I> ---

Address<a> $(R(1),2)

Message editing

<h>+<a>+"1"+"00"+"0000"+<c>+<t>

Data

<h>+<a>+"1"+"00"+"00"+&(W(1),4)+<c>+<t>

 Data
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Examples of Standard System Protocols Section 3-6
3-6-2 “Modem Initialize (MD24FB10V)” Sequence of “Hayes Modem AT 
Commands” Protocol

Level Item Contents of setting

Sequence Link word ---

Transmission control parame-
ter

RTS/CTS flow (receive), modem control

Response type Scan

Receive wait monitoring time 
Tr

10s

Receive finish monitoring 
time Tfr

---

Send finish monitoring time 
Tfs

---

Step Step No. 00 01 02

Repeat counter RSET/001 RSET/001 RSET/001

Command Send&Receive Send&Receive Send&Receive

Retry counter 0 0 0

Send wait time --- 1s 1s

Send message MD24FB10V MD24FB10V MD24FB10V

Receive message <Initial-R1> <Initial-R2> <Initial-R3>

With/Without response writ-
ing

None None None

Next process Matrix Matrix Matrix

Error process Goto 1 Goto 2 Abort

Send 
message 
MD24FB10V

Header <h> ---

Terminator <t> CR

Error check code <c> ---

Length <I> ---

Address <a> ---

Message editing

Matrix 
<Initial-R1> 
<Initial-R2> 
<Initial-R3>

Case No. 00

Receive message RxD.0

Next process End

Receive
message 
RXD.0

Header <h> ---

Terminator <t> CR

Error check code <c> ---

Length <I> ---

Address <a> ---

Message editing

"ATE0V0X4\V2\N3%C0*C0\X1&M0"+"S26=10"+<t>

Data

"0" + <t>

Data
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Example of Communications Sequence Section 3-7
3-7 Example of Communications Sequence
Shown below is an example of sequence to read process values from a 8CH
type temperature controller (E5ZE):

3-7-1 Sequence Setup Content
Sequence No. 101

3-7-2 Step Setup Content
Create a process flow as follows:

Step No. 00

Normal The system sends the read command for a process value and waits the
response from the Temperature Controller. It converts the process value data
to hexadecimal codes and store them in I/O memory. It uses the repeat
counter to switch the PLC area, sends the read command for the next process
value until eight words of process values are read and stored in the PLC
areas.

Abnormal According to a set retry count (three times), the same step is repeatedly exe-
cuted up to three times automatically when any of the following errors occurs:

• The send finish monitoring time Tfs, the receive wait monitoring time Tr,
or the receive finish monitoring time Tfr has expired.

• A receiving communication error occurred (For CS/CJ, port 1: n+8 bit 15,
port 2: n+18 bit 15 is “ON”, n=1,900 (board), 1,500+25×Unit No. (unit).
For C200HX/HG/HE, port A: CIO28304 or port B: 28312 is “ON”).

• Wrong receive message.

• An error in the error check code.

Link word Transmission 
control mode

Response type Monitor time Tr Monitor time Tfr Monitor time Tfs

--- Modem control Scan mode 3 s 3 s 3 s

Receive the 
response

Send the read command 
for process value

Current value of Repeat 
Counter

N=8

End Abort

Send & Receive

Normal

Y

N

Error occurrence

Retry possible 
up to 3 times.
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Example of Communications Sequence Section 3-7
Step No. 00

3-7-3 Send and Receive Messages Creation 
The system can read the PV (process variable) of the designated word on the
temperature controller (E5ZE) by sending the “RX0N00” (N is the word num-
ber of the controller) command. Only one word of data can be read in one
time of data sending or receiving. When reading 8 words of data, it is neces-
sary to execute the Send&Receive command 8 times repeatedly. 

Send message

Example: A frame of read command for the process variable

Receive message

Example: A frame of the response to the read command for the process variable

Send Message Creation
• Designating the unit number as 2 characters (1 byte) beginning from the

third operand (second operand for C200HX/HG/HE) of the PMCR instruc-
tion + 1

Repeat 
counter

Command Retry count Send wait 
time

Send mes-
sage

Receive 
message

With/Without 
response writ-
ing

Next pro-
cess

Error pro-
cess

RSET/008 Send&
Receive

3 --- Refer to 
page 119, 
Send Mes-
sage Cre-
ation

Refer to 
page 120, 
Receive 
Message 
Creation

Yes End Abort

@ Unit R X FCSO Word O O *

Header Address Data Check code Terminator

@ Unit R X FCSEnd code Process variable *

Header Address Data Check code Terminator

3rd (2nd for C200HX/HG/HE) operand

3rd (2nd for C200HX/HG/HE) operand-designated word+1 word of the PMCR instruction
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• Designating the word number of the measured temperature as 1 digit of
the repeat counter N

As a result, create the send message as follows.

Receive Message Creation 
• When reading the data of the measured temperature from the word desig-

nated by the fourth operand (third operand for C200HX/HG/HE) of the
PMCR instruction + (2N + 1) without fixing the length.

Note N means the value of the repeat counter.

Create the receive message as follows.

$

*

4th operand
(3rd for C200HX/HG/HE)

Word set by 4th (3rd for C200HX/HG/HE) 
operand of PMCR instruction+2N+1

$

Means that the system reads the data between RX00
and the check code, converts the data from ASCII to
Hex, and writes the converted data to the address of
the fourth (third for C200HX/HG/HE) operand of the
PMCR instruction + (2N+1)
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Executing a Created Communications Sequence (CS/CJ) Section 3-8
3-7-4 Contents of Sequence
“Measuring temperature read” in sequence No. 101 of “Temp Controller
(E5ZE read) protocol.”

• Sequence attribute setting

• Step attribute setting

Step 00 (only)

• Presence of send/receive message

Send message name <SD(RX)_1>

Receive message name <RV(RX)_1>

3-8 Executing a Created Communications Sequence (CS/CJ)
This section describes how to execute the communications sequence
described so far using a CS/CJ PLC. It is necessary to transfer the protocol
that was created to the Serial Communications Board/Unit in advance. How-
ever, the previously mentioned communications sequence is registered in
sequence number 101 of the incorporated standard system protocol, so the
following describes the procedure for executing sequence number 101.

Note It is assumed that the standard protocol is under the initial status. When the
sequence is changed, for example, by the CX-Protocol, return to the original
sequence before execution.

Item Contents

Link word No setting

Transmission control parameter Modem control available

Response type Scan

Receive wait monitoring time (Tr) 3 s

Receive finish monitoring time (Tfr) 3 s

Send finish monitoring time (Tfs) 3 s

Item Contents

Repeat counter Repeat type: Reset

Counter: 8 (constant)

Command Send & Receive

No. of retries 3

Send wait time None

Send message Message name: SD (RX)_1

Receive message Message name: RV (RX)_1

With/Without Response Writing Yes

Next process End

Error process Abort

"@"+$(R(1),2)+"RX0"+$(N,1)+"00"+LRC(H parity)(0)(2 Byte ASCII)+[2A0D]

Header Address Data Check code Terminator

"@"+$(R(1),2)+"RX00"+&(W(2N+1),*)+LRC(H parity)(0)(2 Byte ASCII)+[2A0D]

Header Address Data Check code Terminator
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Executing a Created Communications Sequence (CS/CJ) Section 3-8
3-8-1 Device Connection
For example, a CS PLC, CS1W-SC41-V1 Serial Communications Board, and
E5ZE Temperature Controller are connected as follows.

Eight points of measured temperature are stored in DM 00101 to DM 00116.

3-8-2 Initial Setup
1,2,3... 1. Set the DIP switch on the Serial Communications Board.

2. Set the allocated DM area for the CS/CJ as follows:

Note Setting address for port 2 of the Board.

Standard settings:

Note For more information of the PLC setup area related to the protocol
macro function, refer to Appendix B PLC Setup and PMSU Settings.

Port 2 of Serial Com-
munications Board

8 channels

Temperature 
input

RS-485

CS1 CPU Unit + CS1W-SCB41-V1

OFF ON

2 4

Terminator switch

Wire switch

OFF: Without terminator ON: With terminator

2: 2-wire type 4: 4-wire type

Address 
(see note)

Set value Contents

D32010 0600 Treats the protocol macro as the communications mode 
and takes the standard communications conditions.

D32011 0000 Standard baud rate.

D32018 0000 Half-duplex

D32019 00C8 Maximum number of bytes for protocol macro send/
receive message: 200 bytes.

Start bit 1 bit

Data length 7 bits

Parity Even parity

Stop bit 2 bits

Baud rate 9,600 bps
122



Executing a Created Communications Sequence (CS/CJ) Section 3-8
3. Set the E5ZE Temperature Controller.

Set the unit number to “0” and baud rate to “9,600 bps.”

Note After changing the DIP switch’s setting, turn OFF and ON the power
supply once.

3-8-3 Creating Ladder Programs
The protocol is executed by the PMCR instruction of the PLC. For details
about the related auxiliary area and allocated data areas, refer to page 134.

PMCR Instruction Specifications:

• Function: Calls the send/receive sequence number registered in the
Serial Communications Board, and by executing the send/receive
sequence of that number, sends data to or receives data from a general-
purpose external device via port 1 or 2 of the Serial Communications
Board.

• Meaning of operands:

C: Control data

S: First word number of send data
Set the first word of the word area where data required for sending is
stored.

Switch Unit:
Used for setting 
the Unit number. 
Set to "0."

Switch Function:
Used for setting 
the switch function.

Switch Function

ON

OFF

Hardware mode
Not used (Must be OFF)

Connection of E5ZD-SDL Setting Indicator
Operation mode when the power is ON
Temperature unit (°C or °F)

Memory bank designation method
1: ON, 2: OFF (Set to 9600 bps)

PMCR

   C1

   C2

   S

   D

4 315 12 11 8 7 0

C2

15 0

Send/receive sequence 
No. 000 to 03E7 
hexadecimal (0 to 999)

Destination Unit address
Serial Communications Unit: Unit No.+10 hexadecimal
Serial Communications Board: E1 hexadecimal

Serial port number (Physical port)
1 Hexadecimal: port 1
2 Hexadecimal: port 2

Communications port number (internal logic port)
0 to 7 hexadecimal

C1
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Executing a Created Communications Sequence (CS/CJ) Section 3-8
Note When there is no send data, be sure to set to #0000. 

In S, the number of words, starting from S, that contain valid send data is
stored.

In S+1 onwards, the actual send data is stored.

D: First word number of storage area for receive data.

Set the first word of the word area in which the receive data is to be stored.

Note When there is no receive data, be sure to set to #0000.

In D, the number of valid word numbers from D+1 is stored.

In D+1 onwards, the initial data that was in the receive buffer before execution
of the send/receive sequence, and the received data is stored.

Note The function of the receive data storage area (the data stored in the area
starting with D and continuing for the number of words indicated in D) before
the PMCR instruction is executed, differs to the function of the area after-
wards.

Before execution of PMCR instruction

The receive data storage area functions as initial value data in the receive
buffer before execution of a send/receive sequence.

After execution of PMCR instruction

The received data storage area will be used to store data received with a
Receive operation (when With/Without Response Write is set to Yes).

• Flags

No. of send data 
words

Send data

.

.

.

S

S + 1

How many words are valid (including S)

Number of valid words

No. of valid words

Receive data

.

.

.

D

D + 1

How many words are valid (including D)

Number of valid words

Flag Label ON OFF

Error 
Flag

ER Turns ON upon instruction execution, if the Com-
munications Port Enabled Flag for the designated 
communications port (internal logic port) is OFF.
Turns ON if the designated serial port (physical 
port) is not in protocol macro mode.
Turns ON if the data in C1 or C2 is outside the 
range.

Remains OFF in any situation not indicated under 
“ON.”

Access 
Error 
Flag

AER Turns ON if an area in the send data and read 
data has been set to not allow read or write.
Turns ON if an area in the receive data has been 
set to prohibit writing.

Remains OFF in any situation not indicated under 
“ON.”
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• Data Contents

Note The EM area cannot be designated for the receive data with the interrupt noti-
fication function for the Serial Communications Board. If such a designation is
attempted, the Protocol Macro Syntax Error (A42410) will turn ON.

Contents of send/receive data word allocation to read the process value in
sequence No.101 of the standard system protocol “Temp Controller (E5ZE
read)” are as follows.

Read the process value and store the result in the designated address.

• Send data word assignment (third operand of PMCR instruction)

Area C1 C2 S D

CIO Area (I/O, etc.) 0000 to 6143

Work Area W000 to 511

Holding Area H000 to 511

Auxiliary Area A000 to 959 A448 to 959

Timer T0000 to 4095 ---

Counter C0000 to 4095 ---

DM Area D00000 to 32767

EM Area E00000 to 32767 See note.

EM Area (including 
bank designation)

En_00000 to 32767 (n=0 to C) See note.

Indirect DM/EM 
(binary)

@D00000 to 32767
@E00000 to 32767
@En_00000 to 32767 (n=0 to C)

See note.

Indirect DM/EM (BCD) ∗D00000 to 32767
∗E00000 to 32767
∗En_00000 to 32767 (n=0 to C)

See note.

Constants Refer to previous 
description.

0000 to 03E7 hexa-
decimal (0 to 999)

#0000 to FFFF
(binary data)

Data registers DR0 to 15 ---

Index Registers 
(Direct)

---

Index Registers 
(Indirect)

,IR0 to 15
–2048 to +2047,IR0 to 15
DR0 to 15 ,IR0 ,IR0 to 15
,IR0 to 15+(++)
,–(– –)IR0 to 15

See note.

Offset Contents (Data format) Data

+0 No. of send data words 
(hexadecimal 2-digit)

0002 (fixed)

+1 Unit No. (hexadecimal 2-
digit)

00 to 0F

No. of send data words

(Indeterminate) Unit No.

+0

+1

Send data 
starting address
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• Receive data word assignment (fourth operand of PMCR instruction)

Settings of the PMCR Instruction

Note Observe the following precautions when using the PMCR instruction.
• In the following cases, set the third operand of the PMCR instruction to

the constant (#0000):

Offset Contents (Data format) Data

+0 No. of receive data words 
(hexadecimal 2-digit)

0017

+1 CH0 Measuring temperature 
(rightmost 4-digit) (BCD 4-digit)

Differs depending on the 
temperature measuring model. 
Refer to the E5ZE Operation 
Manual

F denotes “–” (minus).

+2 CH0 Measuring temperature 
(leftmost 1-digit) (BCD 1-digit)

to to to

+15 CH7 Measuring temperature 
(rightmost 4-digit) (BCD 4-digit)

Differs depending on the 
temperature measuring model. 
Refer to the E5ZE Operation 
Manual.
F denotes “–” (minus).

+16 CH7 Measuring temperature 
(leftmost 1-digit) (BCD 1-digit)

No. of send data words

Measuring temperature (rightmost 4-digit)

Measuring temperature (leftmost 1-digit)

Measuring temperature (rightmost 4-digit)

Measuring temperature (leftmost 1-digit)

+0

+1

+2

+3

+4

Measuring temperature (rightmost 4-digit)

Measuring temperature (leftmost 1-digit)

+15

+16

~ .
.

~

Channel 0

Channel 1

Channel 7

Receive data 
storage address

[Send Data setting] [Receive Data Storage Location]

D00100

D00101

D00102 Data of temperature input 
channel 0 (measured 
temperature)

Data of temperature input 
channel 7 (measured 
temperature)

"17" means that the 16 
(17−1) words, D00101 to 
D00116, will be used as the 
receive area."2" means that the 1 (2−1) word, D00001, will 

be used as the send area.

For this sequence, set the unit numbers.
The protocol communicates with E5ZE with unit 
number 00 because the rightmost 2 digits are "00." D00115

D00116

#0011
Rightmost
4-digit

Rightmost
4-digit

Leftmost
1-digit

Leftmost
1-digit

Set the address for storing the data to be 
transmitted to the PMSU.

Set the address for storing the data to be 
returned from the PMSU. 
This example sets D00100 so that the mea-
surement data will be stored on and after 
D00101.

Set 0065 in hexadecimal because the 
sequence number of the measured value 
reading is 101.

Use communications port number 0 and serial 
port number 2, with a destination unit address 
E1:Inner (Serial Communications) Board.

Set, with the 2nd digit from the left, the port 
on which the protocol will be executed.
1: Port 1 (Upper port)
2: Port 2 (Lower port)

PMCR

   #02E1

   #0065

   D00000

   D00100

Execution 
start

191915
Protocol
Macro
Execution 
Flag

A20200
Commu-
nications
Port 
Enabled 
Flag

D00000

D00001

#0002

#0000
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• If an operand-designated reading variable is not used in the sequence
to be performed.

• If there is no send data word allocation when using the standard sys-
tem protocol.

• In the following cases, set the fourth operand of the PMCR instruction to
the constant (#0000) or to a dummy word.

• If an operand-designated writing variable is not used in the sequence
to be performed.

• If there is no receive data word allocation when using the standard sys-
tem protocol.

3-8-4 Operation
The following describes the system’s operation when executing the ladder
program shown in 3-8-3 Creating Ladder Programs.

1,2,3... 1. When executing a PMCR instruction, the system transmits the information
set in the operand of the PMCR instruction such as the starting sequence
number and communications data storage area, and turns ON the Protocol
Macro Execution Flag (191915).

2. The PMSU reads the communication sequence with the appropriate se-
quence number set in the PMCR instruction.

3. The system sends “RX0 Channel No. 00” as the command measuring the
temperature of the Temperature Controller’s designated channel to the unit
number (00) of the E5ZE Temperature Controller stored in DM0001.

4. The system receives “RX00” as the response from the Temperature Con-
troller (00 means the end code) from the E5ZE with unit number 00 to store
the next measured temperature into D00101 and D00102 through the PLC
scan.

5. The system increments the value of the repeat counter by 8 times repeat-
edly. Each time the repeat counter is incremented, the following contents
will be changed.

• The word number of the Temperature Controller designated by $(N,1)
in the send message changes in a range from 0 to 7.

@PMCR
   #02E1
   #0065
   #0000

   D00100 Set the constant (#0000) 
when transmitting no data.

Transmitting no data to the PSB

@PMCR
   #02E1
   #0065
   D0000
   #0000

Set the constant (#0000) 
when there is no receive 
data.

Storing no data to the data area on the PLC
127



Executing a Created Communications Sequence (C200HX/HG/HE) Section 3-9
• The DM area storing the measured temperature designated by
&(W(2N+1),*) in the receive message changes as follows:

D00101 → D00103 → D00105 → D00107 → D00109 → D00111 →
D00113 → D00115

6. When the system ends the execution of the sequence, the Protocol Macro
Execution Flag (191915) will turn OFF.

3-8-5 Confirming the Operation
When the process variable is not stored successfully, confirm the following
points.

• INNER continuation error.
• Confirm that the System Setup is set correctly.

• Bit 191914 (Step Error Processing Flag) is ON.
• Confirm that the System Setup is correct. (In particular, check that port

1 and port 2 are not designated conversely.)
• Confirm that the wiring is correct (refer to the CS/CJ-series Serial

Communications Boards and Serial Communications Unit Operation
Manual (W336) for the wiring method). 

• Confirm the communication rate, frame, and unit number of the E5ZE.
• No error, but data is not stored.

• Confirm that the RUN indicator of the E5ZE is lit. (For details, refer to
the E5ZE Operation Manual (H076).)

Note When trace operation is executed from the CX-Protocol, from that point, the
Serial Communications Board performs a trace on chronological data in the
send/receive message (up to 1,700 bytes). Using this, it is possible to confirm
what kind of messages are sent and received at each step. (For details about
traces, refer to SECTION 12 Tracing and Monitoring.)

3-9 Executing a Created Communications Sequence (C200HX/
HG/HE)

This section describes how to execute the communication sequence
described so far, using a C200HX/HG/HE PLC. It is necessary to transfer the
protocol that was created to the PMSU in advance. However, the previously
mentioned communication sequence is registered in sequence number 101 of
the incorporated standard system protocol, so the following describes the pro-
cedure for executing sequence number 101.

Note It is assumed that the standard protocol is under the initial status. When the
sequence is changed, for example, by the CX-Protocol, return to the original
sequence before execution.
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3-9-1 Device Connection
It is assumed as an example that a C200HX PLC, C200HW-COM06-EV1
Communications Board, and E5ZE Temperature Controller are connected as
follows.

Eight points of measured temperature are assumed to be stored to DM101 to
DM 116.

3-9-2 Initial Setup
1,2,3... 1. Set the DIP switch on the PMSU.

2. Set the PLC Setup of C200HX as follows:

Note Communications mode as the protocol macro function to set the
communications requirements as follows:

Standard setup contents

Note For more information of the PLC Setup area related to the protocol
macro function refer to Appendix B PLC Setup and PMSU Settings.

3. Set the E5ZE Temperature Controller.

Port A of the Communications Board

Temperature input
8 channels

C200HX PLC + C200HW-COM06-EV1

E5ZE
RS-485

Start bit 1 bit

Data length 7 bits

Parity Even parity

Stop bit 2 bits

Baud rate 9,600 bps

DM6555: #6000

The mode used by port A.

The communication requirement of port A 
0: Standard setup
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Set the unit number to “0” and baud rate to “9,600 bps.”

Note After changing the DIP switch settings, turn OFF and ON the power supply
once.

3-9-3 Creating Ladder Programs
The protocol is executed by the PMCR instruction of the PLC. For details
about related auxiliary area and data areas, refer to page 134.

• PMCR instruction specification

• Function: Calls the send/receive sequence number registered in the
PMSU, and executing the send/receive sequence of the corresponding
sending/reception sequence and sends/receives data to/from the gen-
eral-purpose external device through port A or B of the PMSU.

• Meaning of Operand:

C: Control data

S: Send data first word number

Set the first word at the data area where data required for setting is stored.

Switch Unit:
Used for setting 
the Unit number. 
Set to "0."

Switch Function:
Used for setting 
the switch function.

Switch Function

ON

OFF

Hardware mode
Not used (Must be OFF)

Connection of E5ZD-SDL Setting Indicator
Operation mode when the power is ON
Temperature unit (°C or °F)

Memory bank designation method
1: ON, 2: OFF (Set to 9,600 bps)

15 12 11 8 7 0

Send/receive sequence 
No. 000 to 999(BCD)

Port designation
1: Port A
2: Port B

PMCR

   C

   S

   D
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Note When no send data is found, be sure to set to #0000. Setting to another con-
stant or word generates an error (ER Flag 25503 is ON), and the PMCR
instruction is not executed.

Send data of the number of words that are valid at S and the following are
stored in S.

Actual send data is stored in S+1 and the following.

D: Receive data storage starting address number

Set the starting address at the data area where receive data is stored.

Note When no receive data is found, be sure to set a dummy word. Setting a con-
stant (#0000 to FFFF) generates an error (ER Flag 25503 is ON), and the
PMCR instruction is not executed.

Data is not written to the dummy word. It can be used for the others.

Receive data is not stored in D and the following.

The number of effective addresses is stored in D1–, D+ 1 and the following.

• Flag

• Data Contents

No. of send data 
words

Send data

.

.

.

S

S + 1

No. of words that are valid (including S)

Value ON OFF

ER(25503) • When *DM (Indirect) is designated, the DM
contents are not 6656 or higher or BCD.

• For D, the DM contents are not 6144 or higher
or BCD.

• When the instruction is executed or already in
execution.

• When neither 1 nor 2 is designated for the
port.

Other than the 
cases mentioned to 
the left.

Model C200HX/HG/HE

Operand C S D

Internal relay area 1 000-255 000-255 000-252

Internal relay area 2 256-511 256-511 256-511

Hold relay HR00-99 HR00-99 HR00-99

Auxiliary relay AR00-27 AR00-27 AR00-27

Link relay LR00-63 LR00-63 LR00-63

Timer/counter T/C000-511 T/C000-511 T/C000-511

Temporary relay --- --- ---

Data memory D0000-6655 D0000-6655 D0000-6143

No. of effective words

Receive data

.

.

.

D

D + 1

No. of words that are valid (including D)
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Contents of send/receive data word assignment to read the process value in
sequence No.101of the standard system protocol, “Temp Controller (E5ZE
read)” are as follows:

Read the process value and store the result in the designated address.

• Send data word assignment (Second operand of PMCR instruction)

• Receive data word assignment (Third operand of PMCR instruction)

Indirect data 
memory

*D0000-6655 *D0000-6655 *D0000-6655

Constant See the above. #0000-FFFF ---

Offset Contents (Data format) Data

+0 No. of send data words 
(BCD 4-digit)

0002 (fixed)

+1 Unit No. (hexadecimal 
2-digit)

00 to 0F

No. of send data words

(Indeterminate) Unit No.

+0

+1

Send data 
starting address

Offset Contents (Data format) Data

+0 No. of receive data words (BCD 
4-digit)

0017

+1 CH0 Measuring temperature 
(rightmost 4-digit) (BCD 4-digit)

Differs depending on the tempera-
ture measuring model. Refer to 
the E5ZE Operation Manual.

F denotes “–” (minus).
+2 CH0 Measuring temperature 

(leftmost 1-digit) (BCD 1-digit)

to to to

+15 CH7 Measuring temperature 
(rightmost 4-digit) (BCD 4-digit)

Differs depending on the tempera-
ture measuring model. Refer to 
the E5ZE Operation Manual.
F denotes “–” (minus).

+16 CH7 Measuring temperature 
(leftmost 1-digit) (BCD 1-digit)

No. of send data words

Measuring temperature (rightmost 4-digit)

Measuring temperature (leftmost 1-digit)

Measuring temperature (rightmost 4-digit)

Measuring temperature (leftmost 1-digit)

+0

+1

+2

+3

+4

Measuring temperature (rightmost 4-digit)

Measuring temperature (leftmost 1-digit)

+15

+16

~ .
.

~

Channel 0

Channel 1

Channel 7

Receive data 
storage address
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Settings of the PMCR Instruction

Note Observe the following precautions when using the PMCR instruction.

• If transmitting no data to the PMSU.

• If storing no data to the data area on the PLC.

3-9-4 Operation
The following describes the system’s operation when executing the ladder
program shown in 3-9-3 Creating Ladder Programs.

1,2,3... 1. When starting to execute a PMCR instruction, the system transmits the in-
formation set in the operand of the PMCR instruction such as the starting
sequence number and communications data storage area, and turns ON
the Port A Instruction Execution Flag (28908).

2. The PMSU reads the communication sequence with the appropriate se-
quence number set in the PMCR instruction.

3. The system sends “RX0 Channel No. 00” as the command measuring the
temperature of the Temperature Controller’s designated channel to the unit
number (00) of the E5ZE Temperature Controller stored in DM0001.

4. The system receives “RX00” as the response from the Temperature Con-
troller (00 means the end code) from the E5ZE with unit number 00 to store
the next measured temperature into DM0101 and DM0102 through the
PLC scan.

[Send Data setting]
[Receive Data Storage Location]

DM0100
DM0101
DM0102 Data of temperature input chan-

nel 0 (measured temperature)

Data of temperature input chan-
nel 7 (measured temperature)

"17" means that 17 words of 
DM0100 to DM116 are used as 
the receiving area.

"2" means that two words of DM0000 to 
DM0001 are used as the transmission area.

For this sequence, set the unit numbers here.
The protocol communicates with E5ZE with unit 
number 00 because the rightmost 2 digits are "00."

DM0115
DM0116

#0017
Rightmost 4-digit

Rightmost 4-digit

Leftmost 1-digit

Leftmost 1-digit

Set here the address for storing the data to 
be transmitted to the PMSU.

Set here the address for storing the data to 
be returned from the PMSU. 
this example sets DM0100 so that the data 
that were measured are stored on and after 
DM0101.

Set 101 on the rightmost 3 digits of this 
word because the sequence number of the 
measured value reading is 101.

Instruction 
Execution 
Flag
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5. The system increments the value of the repeat counter by 8 times repeat-
edly. Every time the repeat counter is incremented, the following contents
are changed.

• The word number of the Temperature Controller designated by $(N,1)
in the send message changes between 0 and 7.

• The DM area storing the measured temperature designated by
&(W(2N+1),*) in the receive message changes as follows:

DM0101 → DM0103 → DM0105 → DM0107 → DM0109 → DM0111 →
DM0113 → DM0115

6. When the system ends the execution of the sequence, the Port A Instruc-
tion Execution Flag (28908) will turn OFF.

3-9-5 Confirming the Operation
If the process variable is not stored successfully, confirm the following points.

• System error FAL9C.

• Confirm that the PLC’s Setup is set correctly.

• Bit 28909 (Port A Step Error Processing Flag) is ON.

• Confirm that the PLC’s Setup is correct. (Especially confirm whether
port A and port B are not designated conversely.)

• Confirm that the line distribution (Refer to the Communications Boards
Operation Manual (W304) to connect the line is correct). 

• Confirm the communication rate, frame, and unit number of the E5ZE.

• No error, but data are not stored.

• Confirm that the RUN indicator of E5ZE is lit. (For details, refer to the
E5ZE Operation Manual (H076).)

Note When trace operation is executed from the CX-Protocol, from that point, the
Serial Communications Board performs a trace on chronological data in the
send/receive message (up to 670 bytes). Using this, it is possible to confirm
what kind of messages is sent and received at each step. (For details about
traces, refer to SECTION 12 Tracing and Monitoring.)

3-10 Auxiliary Area and Allocated Data Areas
PMSU status (sequence and step execution status) are allocated to the fol-
lowing auxiliary area and data areas on the CPU Unit, and can be used from
the ladder program.

3-10-1 Special Auxiliary and Allocated Areas
The following table provides a list of the protocol macro related bits for the CS/
CJ Serial Communications Board/Unit and the C200HX/HG/HE Communica-
tions Board.
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n = 1500 + 25 × Unit No. (For the Serial Communications Unit only.)

Note A40207 (CPU Bus Unit Error Flag) is the representative bit.

Type Name CS Serial 
Communications Board

CS/CJ Serial 
Communications Unit

C200HX/HG/HE 
Communications Board

Contents

Word Bit Word Bit Word Bit

System 
error

PMSU 
Watchdog 
Timer Error

A424 00 A417 (CPU 
Bus Unit 
Error No. 
Flag)

00 to 15 
(For Unit 
No. 0 to 15) 
See note.

CIO 268

Communi-
cations 
Board error 
details area

System 
error

FAL9C 
error

00 1: Error

0: Normal

Inner Bus 
Error (Port 
recognition 
error)

01 None 01 1: Error

0: Normal

Protocol 
Data Error 
(Protocol 
data 
checksum 
error due to 
memory 
damage)

A424 09 None 02 1: Error

0: Normal

CIO 1901 00 n+1 00 1: Error

0: Normal

Protocol 
Macro 
Execution 
Error (At 
port 2 or B)

A424 10 None 11 1: Error
0: Normal

Protocol 
Macro 
Execution 
Error (At 
port 1 or A)

12 1: Error

0: Normal

System 
Setting 
Error

A424 08 None 13 to 15

15: System 
setting error

14: Error at 
port A
13: Error at 
port B

1: Error

0: Normal

CIO 1906 
or CIO 
1916

01 n+6/n+16 01

Type Name CS Serial 
Communica-
tions Board

CS/CJ Serial 
Communica-

tions Unit

Com-
mon

C200HX/HG/HE Communica-
tions Board

Contents

Allocation Area Special Auxiliary Area

Port 1 
word

Port 2 
word

Port 1 
word

Port 2 
word

Bit Port 
A 

word

Bit Port 
B 

word

Bit

Port 
Operation

Port Operating CIO 
1906

CIO 
1916

n+6 n+16 00 None None 1: Port operating

2: Port stopped

Restart Flag 
(each port)

A636 
Bit 01

A636 
Bit 02

A620 
+ Unit 
No. Bit 
01

A620 
+ Unit 
No. Bit 
02

CIO 
289

00 CIO 
289

01 0 to 1: Restart
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Protocol 
Macro

Protocol 
Macro Execu-
tion Flag 
(each port)

CIO 
1909

CIO 
1919

n+9 n+19 15 CIO 
289

08 CIO 
289

12 1: Protocol 
macro (sequence) 
executing
0: Protocol 
macro (sequence) 
abnormal 
execution

Protocol 
Macro Error 
Code (each 
port)

CIO 
1909

CIO 
1919

n+9 n+19 00 to 
03

CIO 
286

08 to 
11

CIO 
286

12 to 
15

0: No error

1: No protocol 
function 
(C200HX/HG/HE 
only)

2: Sequence No. 
error

3: Data read/data 
write area 
exceeded error

4: Protocol 
data syntax error

Type Name CS Serial 
Communica-
tions Board

CS/CJ Serial 
Communica-

tions Unit

Com-
mon

C200HX/HG/HE Communica-
tions Board

Contents

Allocation Area Special Auxiliary Area

Port 1 
word

Port 2 
word

Port 1 
word

Port 2 
word

Bit Port 
A 

word

Bit Port 
B 

word

Bit
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Sequence 
Monitor

Communica-
tion Sequence 
No. (each 
port)

CIO 
1910

CIO 
1920

n+10 n+20 00 to 
11

None None 000 to 03E7 
hexadecimal
(000 to 999)

Execution 
Completion 
Step No. 
(code) (each 
port)

CIO 
1911

CIO 
1921

n+11 n+21 08 to 
11

CIO 
287

04 to 
07

CIO 
288

04 to 
07

0 to F 
hexadecimal 
(0 to 15)

Execution 
Completion 
Step No. Stor-
age Flag 
(each port)

CIO 
1913

CIO 
1923

n+13 n+23 00 to 
15

None None 0 to 15 bits: 
Corresponds to 
step No. 0 to 15

Execution 
Completion 
Step Matrix 
Case No. 
(code) (each 
port)

CIO 
1911

CIO 
1921

n+11 n+21 00 to 
03

CIO 
287

00 to 
03

CIO 
288

00 to 
03

0 to F 
hexadecimal 
(0 to 15)

Execution 
Completion 
Matrix Case 
No. Storage 
Flag

CIO 
1912

CIO 
1922

n+12 n+22 00 to 
15

None None 0 to 15 bits: 
Corresponds to 
case No. 0 to 15

Execution 
Completion 
Storage Flag 
(each port)

None None None None None CIO 
287

15 CIO 
287

15 0: Nothing stored

1: Stored

Repeat 
Counter 
Present Value 
(each port)

CIO 
1914

CIO 
1924

n+14 n+24 00 to 
07

CIO 
284

00 to 
07

CIO 
285

00 to 
07

01 to FF 
hexadecimal

Repeat 
Counter Set 
Value (each 
port)

CIO 
1914

CIO 
1924

n+14 n+24 08 to 
15

None None 01 to FF 
hexadecimal

Sequence End 
Completion 
Flag (each 
port)

CIO 
1909

CIO 
1919

n+9 n+19 11 CIO 
289

10 CIO 
289

14 1: Sequence end 
completed
0: Sequence end 
not completed

Sequence 
Abort Comple-
tion Flag 
(each port)

CIO 
1909

CIO 
1919

n+9 n+19 10 CIO 
283

07 CIO 
283

15 1: Sequence abort 
completed
0: Sequence abort 
not completed

Step Error Step Error 
Processing 
Execution 
Flag (each 
port)

CIO 
1909

CIO 
1919

n+9 n+19 14 CIO 
289

09 CIO 
289

13 1: Step error 
processing com-
pleted

0: Step error 
processing not 
completed

Type Name CS Serial 
Communica-
tions Board

CS/CJ Serial 
Communica-

tions Unit

Com-
mon

C200HX/HG/HE Communica-
tions Board

Contents

Allocation Area Special Auxiliary Area

Port 1 
word

Port 2 
word

Port 1 
word

Port 2 
word

Bit Port 
A 

word

Bit Port 
B 

word

Bit
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Trace Trace Execu-
tion Flag 
(each port)

CIO 
1909

CIO 
1919

n+9 n+19 12 CIO 
286

00 CIO 
286

01 1: Executing

0: Stop

Continuous 
Trace Start/
Stop Switch 
(each port)

CIO 
1900 
Bit 01

CIO 
1900 
Bit 09

n 
bit 01

n 
bit 09

CIO 
289

02 CIO 
289

03 0 to 1: Start
1 to 0: Stop (Only 
used with CX-Pro-
tocol)

Short Trace 
Start/Stop 
Switch (each 
port)

CIO 
1900 
Bit 02

CIO 
1900 
Bit 10

n
bit 02

n
bit 10

CIO 
289

04 CIO 
289

05 0 to 1: Start
1 to 0: Stop (Only 
used with CX-Pro-
tocol)

Abort Forced Abort 
Switch (each 
port)

CIO 
1900

CIO 
1900

n n Port 1: 
03

Port 2: 
11

CIO 
289

11 CIO 
289

15 Set from 0 to 1 for 
forced abort 
(Depending on the 
timing, the opera-
tion may not abort 
and the sequence 
will complete.)

Forced Abort 
Generated 
Flag

CIO 
1909

CIO 
1919

n+9 n+19 13 None None 1: Forced abort 
executed

0: All other times

Wait Sequence 
Waiting Flag 
(each port)

CIO 
1909

CIO 
1919

n+9 n+19 09 None None 1: Sequence wait-
ing

2: Sequence not 
waiting

Wait Release 
Switch (each 
port)

CIO 
1900

CIO 
1900

n n Port 1: 
0

Port 2: 
8

None None 0 to 1: Wait 
release

Transfer 
control sig-
nal monitor

RTS Signal 
Status

CIO 
1907

CIO 
1917

n+7 n+17 03 None None 1: ON

0: OFF

CTS Signal 
Status

CIO 
1907

CIO 
1917

n+7 n+17 04 None None 1: ON

0: OFF

DSR Signal 
Status

CIO 
1907

CIO 
1917

n+7 n+17 06 None None 1: ON
0: OFF

DTR Signal 
Status

CIO 
1907

CIO 
1917

n+7 n+17 07 None None 1: ON

0: OFF

Local Node 
Reception 
Busy/Waiting 
to Receive

CIO 
1907

CIO 
1917

n+7 n+17 08 None None 1: Local node 
reception busy
0: Local node 
waiting to receive

Remote Node 
Reception 
Busy/Waiting 
to Receive

CIO 
1907

CIO 
1917

n+7 n+17 10 None None 1: Remote node 
reception busy
0: Remote node 
waiting to receive

Type Name CS Serial 
Communica-
tions Board

CS/CJ Serial 
Communica-

tions Unit

Com-
mon

C200HX/HG/HE Communica-
tions Board

Contents

Allocation Area Special Auxiliary Area

Port 1 
word

Port 2 
word

Port 1 
word

Port 2 
word

Bit Port 
A 

word

Bit Port 
B 

word

Bit
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Transfer 
Error Gen-
erated Sta-
tus (Port 
Communi-
cations 
Error)

No Error CIO 
1908

CIO 
1918

n+8 n+18 00 to 
15

CIO 
283

00 to 
03

0: No 
error

CIO 
283

08 to 
11

0: No 
error

All 0

Parity Error CIO 
1908

CIO 
1918

n+8 n+18 02 CIO 
283

00 to 
03

1: Par-
ity 
error

CIO 
283

08 to 
11

1: Par-
ity 
error

1: Parity error

0: Normal

Does not turn ON 
in C200HE/HX/
HG protocol 
macro mode

Framing Error CIO 
1908

CIO 
1918

n+8 n+18 03 CIO 
283

00 to 
03:

2: 
Fram-
ing 
error

CIO 
283

08 to 
11

2: 
Fram-
ing 
error

1: Framing error 
0: Normal

Does not turn ON 
in C200HE/HX/
HG protocol 
macro mode

Overrun Error CIO 
1908

CIO 
1918

n+8 n+18 04 CIO 
283

00 to 
03 
3: 
Over-
run 
error

CIO 
283

08 to 
11
3: 
Over-
run 
error

1: Overrun error

0: Normal
Does not turn ON 
in C200HE/HX/
HG protocol 
macro mode

Timeout Error CIO 
1908

CIO 
1918

n+8 n+18 05 CIO 
283

00 to 
03

5: 
Time-
out 
error

CIO 
283

08 to 
11

5: 
Time-
out 
error

1: Timeout error 
(Tls, Tfr, or Tr)

0: Normal 

Does not turn ON 
in C200HE/HX/
HG protocol 
macro mode

Command 
Error

CIO 
1908

CIO 
1918

n+8 n+18 06 CIO 
283

00 to 
03

7: 
Com-
mand 
error

CIO 
283

08 to 
11

7: 
Com-
mand 
error

1: Command error 
(reception data 
constant compari-
son does not 
agree)

0: No command 
error (Does not 
turn ON in 
C200HE/HX/HG 
protocol macro 
mode) 

FCS Check 
Error

CIO 
1908

CIO 
1918

n+8 n+18 07 CIO 
283

00 to 
03

4: 
FCS 
Check 
error

CIO 
283

08 to 
11

4: 
FCS 
Check 
error

1: FCS check 
error (check codes 
do not agree)
0: Normal (Does 
not turn ON in 
C200HE/HX/HG 
protocol macro 
mode)

Type Name CS Serial 
Communica-
tions Board

CS/CJ Serial 
Communica-

tions Unit

Com-
mon

C200HX/HG/HE Communica-
tions Board

Contents

Allocation Area Special Auxiliary Area

Port 1 
word

Port 2 
word

Port 1 
word

Port 2 
word

Bit Port 
A 

word

Bit Port 
B 

word

Bit
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3-10-2 Description of Each Area

Transfer 
Error Gen-
erated Sta-
tus (Port 
Communi-
cations 
Error)

Checksum 
Error

None None CIO 
283

00 to 
03

6: 
Check
sum 
error

CIO 
283

08 to 
11

6: 
Check
sum 
error

---

Transmis-
sion Error 
Gener-
ated Sta-
tus

Tr (Receive 
wait monitor-
ing time) 
Exceeded 
(each port)

CIO 
1908

CIO 
1918

n+8 n+18 12 None None 1: Exceeded

0: Normal

Tfr (Receive 
finish monitor-
ing time) 
Exceeded 
(each port)

CIO 
1908

CIO 
1918

n+8 n+18 13 None None 1: Exceeded

0: Normal

Tfs (Send fin-
ish monitoring 
time) 
Exceeded 
(each port)

CIO 
1908

CIO 
1918

n+8 n+18 14 None None 1: Exceeded
0: Normal

Max. No. of 
Retries (each 
port)

CIO 
1908

CIO 
1918

n+8 n+18 08 to 
11

None None No. of retries
0 to 9: 0 to 9 hexa-
decimal

Communica-
tions error 
(Communica-
tions port 
error)

CIO 
1908

CIO 
1918

n+8 n+18 15 CIO 
283

04 CIO 
283

12 1: Communica-
tions error
2: Normal

Type Name Address Details Timing

Initial-
ization

Set Reset

System 
error

PMSU Watchdog 
Time Error

CS/CJ: 

Board: A424, 
bit 00, 
Unit: A417, 
bits 00 to 15

C200HX/HG/HE: 
CIO 268, bit 00

CS/CJ and C200HX/HG/HE: Set to 
1 when the PMSU is damaged. 
Firmly re-secure the PMSU. If the 
error does not cancel, even after 
installing the PMSU on another CPU 
Unit, replace the PMSU.

At 
power 
ON 
(See 
note 
1.)

When 
error 
occurs

When 
power is 
turned ON 
again.

Inner Bus Error CS: A424 bit 01 
(Board only)

CS Board only: Set to 1 when an 
Inner Bus error occurs. Firmly re-
secure the PMSU. If the error does 
not cancel, even after installing the 
PMSU on another CPU Unit, replace 
the PMSU.

When 
error 
occurs

When 
power is 
turned ON 
again.

Type Name CS Serial 
Communica-
tions Board

CS/CJ Serial 
Communica-

tions Unit

Com-
mon

C200HX/HG/HE Communica-
tions Board

Contents

Allocation Area Special Auxiliary Area

Port 1 
word

Port 2 
word

Port 1 
word

Port 2 
word

Bit Port 
A 

word

Bit Port 
B 

word

Bit
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System 
error

Port Recognition 
Error

C200HX/HG/HE: 
CIO 268 bit 01

C200HX/HG/HE only: Set to 1 (ON) 
when a communications port error 
has occurred. Replace the PMSU.

At 
power 
ON 
(See 
note 
1.)

When 
error 
occurs

When 
power is 
turned ON 
again.

Protocol Data 
Error

CS/CJ: 
Board CIO 1901, 
Unit n+1 words, 
bit 00

Board only: A424 
bit 09
C200HX/HG/HE: 
CIO 268 bit 02

CS/CJ: Set to 1 (ON) when an error 
is detected in the Protocol data 
checksum. At the same time, for a 
Serial Communications Board, the 
ERR/ALM indicator on the CPU Unit 
will flash and the RDY indicator will 
flash at intervals of 1 s. Auxiliary 
Word A424, bit 09 will turn ON. For 
the Serial Communications Unit, the 
RDY or ERC indicators will light.

C200HX/HG/HE: Set to 1 (ON) 
when an error is detected in the Pro-
tocol data checksum. At the same 
time the ERR indicator on the CPU 
Unit or the RDY indicator will flash. 
CIO 268 bit 2 will turn ON.

Error is generated when the commu-
nications connector comes lose dur-
ing protocol data transmission or 
when the power to the PLC is OFF. 
Using CX-Protocol, resend the pro-
tocol data.

When 
error is 
occurs

Normal 
when 
protocol 
data is 
resent.

Protocol Macro 
Execution Error

CS: Board only 
A424 bit 10 (No 
Unit)

C200HX/HG/HE: 
CIO 268 bit 11 
(port B), bit 12 
(port A)

CS: Set to 1 (ON) when data read/
write area exceeded (error code 3) 
or protocol macro syntax error (error 
code 4).
C200HX/HG/HE: Set to 1 (ON) for 
any of the following: No protocol 
macro function (error code 1), 
sequence number error (error code 
2), data write area exceeded (error 
code 3), or protocol macro syntax 
error (error code 4).

When 
error 
occurs

When 
sequence 
starts

System Setting 
Error

CS/CJ: CIO 1906 
CIO 1916, n+6, 
n+16 bit 01, 
Board only, A424 
bit 08 (No Unit)

C200HX/HG/HE: 
CIO 268, bit 15

CS/CJ and C200HX/HG/HE: Set to 
1 (ON) when a PLC Setup error 
occurs in the DM Area. Change the 
system settings, and turn ON the 
power again, restart or auto-restart, 
or execute the STUP instruction 
(CS/CJ only). Those settings for 
which there is an error will return to 
the default settings.

When 
error 
occurs

At power 
ON (See 
note 1.)

Port 
operation

Port operating CS/CJ: CIO 
1906, CIO 1916, 
words n+6, 
N+16, bit 00
C200HX/HG/HE: 
None

CS/CJ only: The communications 
port’s serial communications mode 
is set to Protocol Macro. Set to 0 
(OFF) when a protocol data error 
occurs. Set to 1 (ON) in all other 
cases.

When 
error 
occurs

After pro-
tocol data 
is sent

Type Name Address Details Timing

Initial-
ization

Set Reset
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Port 
operation

Port 1/2 Serial 
Communications 
Port Setting 
Changes Flag 
(Port Restart 
Flag)

CS/CJ: Board 
A636, bit 01/02, 
Unit A620 + Unit 
No., bits 01/02

C200HX/HG/HE: 
CIO 289, bits 
00/01

CS/CJ and C200HX/HG/HE: The 
communications port is restarted 
when this flag goes from 0 to 1.

At 
power 
ON 
(See 
note 
1.)

User 
operation 
or STUP 
instruc-
tion exe-
cuted 

Setting 
changes 
com-
pleted or 
port 
restart 
completed

Protocol 
macro

Protocol Macro 
Execution Flag

CS/CJ: CIO 
1909, CIO 1919, 
n+9, n+19, bit 15
C200HX/HG/HE: 
CIO 289, bits 
08/12

CS/CJ and C200HX/HG/HE: Set to 
1 (ON) when the PMCR instruction 
(sequence) is executed. Returns to 
0 (OFF) if execution fails.

Set to 0 (OFF) after sequence is 
completed and all reception data 
has been written to I/O memory. Set 
to 0 (OFF) when sequence is com-
pleted (whether sequence is com-
pleted normally or using Abort). 
(See note 2.)

Instruc-
tion exe-
cuted

Instruc-
tion com-
pleted

Protocol Macro 
Error Code

CS/CJ: CIO 
1909, CIO 1919, 
n+9, n+19, bits 
00 to 03

C200HX/HG/HE: 
CIO 286, bits 08 
to 11 or 12 to 15

CS/CJ and C200HX/HG/HE: Error 
code contents and information are 
listed on page 147, Protocol Macro 
Error Codes.

When 
error 
occurs

When 
sequence 
starts

Sequence 
monitor

Communication 
Sequence No.

CS/CJ: CIO 1910 
CIO 1920, n+10, 
n+20, bits 
00 to 11

C200HX/HG/HE: 
None

CS/CJ only: The processing com-
munication sequence number will be 
set when the sequence execution 
starts.

It is also set when a Sequence Num-
ber Error occurs (error code 2).
It is cleared when STUP is executed 
or the PMSU is restarted.

When 
sequence 
starts

None

Execution 
Completion Step 
No. (code)

CS/CJ: CIO 1911 
CIO 1921, n+11, 
n+21, bits 
08 to 11

C200 HX/HG/HE: 
CIO 287 CIO 
288, bits 04 to 07

CS/CJ and C200HX/HG/HE: Sets 
step numbers 0 to 15 (0 to F hexa-
decimal) when execution is com-
pleted.

Cleared when either the sequence 
starts executing, STUP is executed, 
or the PMSU is restarted.

When 
step is 
executed

When 
sequence 
starts

Execution 
Completion Step 
No. Storage Flag

CS/CJ: CIO 1913 
CIO 1923, n+13, 
n+23, bits 
00 to 15

C200HX/HG/HE: 
None

CS/CJ only: Each bit corresponding 
to step numbers 0 to 15 (bits 00 to 
15) for which execution is complete, 
will be set to 1 (ON). Once a bit has 
been set it will remain set (ON) dur-
ing the sequence (and after comple-
tion), so bits corresponding to steps 
which have been executed will be 
set to 1 (ON) in order of execution.

Cleared when either the sequence 
starts executing, STUP is executed, 
or the PMSU is restarted.

When 
step is 
executed

When 
sequence 
starts

Type Name Address Details Timing

Initial-
ization

Set Reset
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Sequence 
monitor

Execution 
Completion 
Matrix Case No. 
(code)

CS/CJ: CIO 1911 
CIO 1921, n+11, 
n+21, bits 00 to 
03

C200HX/HG/HE: 
CIO 287 CIO 
288, bits 00 to 03

CS/CJ and C200HX/HG/HE: Recep-
tion matrix case numbers 0 to 15 (0 
to F hexadecimal) for which recep-
tion is completed will be set.

Cleared when either the sequence 
starts executing, STUP is executed, 
or the PMSU is restarted.

The Execution Completion Matrix 
Case Number is only stored when 
the matrix has been designated by 
the Receive/Send&Receive com-
mand. It will be cleared to 0 if there 
is no matrix or another command is 
executed.

At 
power 
ON 
(See 
note 
1.)

Matrix When 
sequence 
starts

Execution Com-
pletion Matrix 
Case No. Storage 
Flag

CS/CJ: CIO 1912 
CIO 1922, n+12, 
n+22, bits 00 to 
15

C200HX/HG/HE: 
None

CS/CJ only: Each bit corresponding 
to matrix case No. 0 to 15 (bits 00 to 
15) for which reception is complete, 
will be set to 1 (ON).

Cleared when either the sequence 
starts executing, STUP is executed, 
the PMSU is restarted, or step is 
executed.
After the matrix Receive command, 
either the WAIT command can be 
executed or the sequence com-
pleted and the matrix case number 
confirmed from the ladder program.

The corresponding bits for the 
stored case number will only be set 
to 1 (ON), for the Execution Comple-
tion Receive Number Storage Flag 
when the matrix has been desig-
nated by the Receive/Send&Receive 
command. It will be cleared to 0 if 
there is no matrix or another com-
mand is executed.

Matrix When 
sequence 
starts

Current Repeat 
Count

CS/CJ: CIO 1914 
CIO 1924, n+14, 
n+24, bits 00 to 
07

C200HX/HG/HE: 
CIO 284 CIO 
285, bits 00 to 07

CS/CJ and C200HX/HG/HE: Stores 
the repeat count value N.

Cleared when either the sequence 
starts executing, STUP is executed, 
the PMSU is restarted, or step is 
executed.
The current value N will differ 
according to the method for desig-
nating initial values.
Reset: After starting that step and 
setting N to 0, execute the set num-
ber of retries.
Hold: After starting that step set the 
number of retries while holding the 
value of N. (See note 3.)

When the 
repeat 
count is 
refreshed

When 
sequence 
starts

Type Name Address Details Timing

Initial-
ization

Set Reset
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Sequence 
monitor

Set Repeat Count CS/CJ: CIO 1914 
CIO 1924, n+14, 
n+24, bits 08 to 
15

C200HX/HG/HE: 
None

CS/CJ only: Stores the attempts 
(Set number of retries) that are 
made to execute that step.
Cleared when either the sequence 
starts executing, STUP is executed, 
the PMSU is restarted, or step is 
executed.

At 
power 
ON 
(See 
note 
1.)

When 
step starts

When 
sequence 
starts

Sequence End 
Completion Flag

CS/CJ: CIO 1909 
CIO 1919, n+9, 
n+19, bit 11
C200HX/HG/HE: 
CIO 289, bits 10/
14

CS/CJ and C200HX/HG/HE: Set to 
1 (ON) when sequence processing 
is completed or the sequence ends 
due to an error. (See note 4.)

When 
sequence 
ends

When 
sequence 
starts

Sequence Abort 
Completion Flag

CS/CJ: CIO 1909 
CIO 1919, n+9, 
n+19, bit 10

C200HX/HG/HE: 
CIO 283 CIO 
283, bits 07/15

CS/CJ and C200HX/HG/HE: Set to 
1 (ON) when sequence processing 
is completed or is aborted due to an 
error.
1: Sequence abort completed

0: Sequence abort not completed

When 
sequence 
is aborted

When 
sequence 
starts

Step error Step Error 
Processing Exe-
cution Flag

CS/CJ: 
CIO 1909, 
CIO 1919, n+9, 
n+19, bit 14

C200HX/HG/HE: 
CIO 289, bits 09/
13

CS/CJ and C200HX/HG/HE: Set to 
1 (ON) when step ends in an error. 
When processing ends normally 
after retries, it remains at 0.

1: Step ended in error
0: Step ended normally

When a 
reception 
compari-
son error 
occurs

When 
sequence 
starts

Trace Trace Execution 
Flag

CS/CJ: CIO 
1909, CIO 1919, 
n+9, n+19, bit 12
C200HX/HG/HE: 
CIO 286, bits 00/
01

CS/CJ and C200HX/HG/HE: Set to 
1 (ON) when send or receive mes-
sage time series data is being traced 
using CX-Protocol.

When 
trace 
starts

When 
trace is 
completed

Continuous Trace 
Start/Stop Flag

CS/CJ: CIO 
1900/CIO n, 
bits 01/09

C200HX/HG/HE: 
CIO 289, bits 02/
03

CS/CJ and C200HX/HG/HE: Turns 
from 0 to 1 when a continuous trace 
is started using CX-Protocol. Turns 
from 1 to 0 when the trace stops.

Using CX-
Protocol

Using CX-
Protocol

Shot Trace Start/
Stop Flag

CS/CJ: 
CIO 1900/CIO n, 
bits 02/10

C200HX/HG/HE: 
CIO 289, bits 04/
05

CS/CJ and C200HX/HG/HE: CX-
Protocol shot trace starts when it 
turns from 0 to 1. When the trace 
buffer is full, the PMSU is cleared.

(See note 5.)

Using CX-
Protocol

When 
shot trace 
is com-
pleted

Abort Forced Abort 
Flag

CS/CJ: 
CIO 1900/CIO  n, 
bits 03/11
C200HX/HG/HE: 
CIO 289, bits 11/
15

CS/CJ and C200HX/HG/HE: Turns 
from 0 to 1 when Protocol Macro 
processing stops. Depending on the 
timing, processing may be com-
pleted.

User set User set

Forced Abort 
Generated Flag

CS/CJ: 
CIO 1909, 
CIO 1919, n+9, 
n+19, bit 13
C200HX/HG/HE: 
None

CS/CJ only: Set to 1 (ON) when the 
Forced Abort Flag is used from the 
user program. When the Forced 
Abort Flag is set to ON when the 
sequence is in the final stages, the 
sequence will either end or be 
aborted. 

When 
Forced 
Abort is 
generated

When 
sequence 
starts

Type Name Address Details Timing

Initial-
ization

Set Reset
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Wait Sequence Wait-
ing Flag

CS/CJ: 
CIO 1909, 
CIO 1919, n+9, 
n+19, bit 09

C200HX/HG/HE: 
None

CS/CJ only: Set to 1 (ON) when the 
sequence is waiting due to the WAIT 
command being issued.
Wait status can be set from OFF to 
ON and move to the next step, by 
using the Wait Release Flag in the 
ladder program. (See note 6.)

At 
power 
ON 
(See 
note 
1.)

When the 
WAIT 
command 
is issued

Wait 
Release 
Flag is 
ON or 
When 
sequence 
starts

Wait Release 
Flag

CS/CJ: 
CIO 1900/CIO n, 
bits 00/08
C200HX/HG/HE: 
None

CS/CJ only: Set from 0 to 1 when 
the sequence WAIT command is 
released.

User set WAIT 
com-
mand 
completed

Transfer 
control sig-
nal monitor

Transfer Control 
Signal Monitor

CS/CJ: 
CIO 1907, 
CIO 1917, n+7, 
n+17, bits 03/04/
06/07
C200HX/HG/HE: 
None

CS/CJ only: Reads the status of the 
transfer control signals (DTR, DSR, 
CTS, RTS) for each port.

1: High, 0: Low

Reads 
status

Reads 
status

Remote Node 
Busy/Waiting to 
Receive

CS/CJ: 
CIO 1907, 
CIO 1917, n+7, 
n+17, bit 10

C200HX/HG/HE: 
None

CS/CJ only: Indicates the reception 
status of the remote note when the 
Xon/Xoff flow control and RTS/CTS 
flow control are set for the transmis-
sion control parameters. Xon/Xoff 
flow control clears the reception 
buffer when the sequence starts, so 
the remote node reception status is 
0.
1: Remote node busy (reception 
buffer is full, therefore reception no 
possible)
0: Remote node waiting (reception 
possible)

Reads 
status

When 
busy is 
released

Local Node Busy/
Waiting to 
Receive

CS/CJ: CIO 
1907, CIO 1917, 
n+7, n+17, bit 08

C200HX/HG/HE: 
None

CS/CJ only: Indicates the reception 
status of the local node (at the 
PMSU) when Receive is executed, 
when the Xon/Xoff flow control is set 
for the transmission control parame-
ters.

1: Local node busy (reception not 
possible as reception buffer is 4/5 = 
2 kbytes min.)

0: Local node waiting (reception 
possible as reception buffer is 1/5 = 
0.5 kbytes max.)

This area is cleared when the power 
is turned ON. It can also be cleared 
using the STUP instruction or Port 1/
Port 2 System Setting Changes Flag 
(Auxiliary Bit). The area is also 
cleared when the next sequence is 
executed.

Reads 
status

When 
busy is 
released

Type Name Address Details Timing

Initial-
ization

Set Reset
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Note 1. In the above table, only “at power ON” is shown, but the CPU Unit is
cleared in any of the following circumstances. At power ON, When the op-
erating mode is changed (From PROGRAM to RUN or MONITOR), when
the STUP instruction is executed, when the PMSU is reset, or when the
communications port is restarted. Each area can also be cleared after set-
ting, by using the timing methods shown in the reset column.

2. When the response type is set to “scan,” the Protocol Macro Execution
Flag will be set to 0 (OFF) when confirmation is received that the contents
of all reception data (with responses) has been written to I/O memory.

3. When the repeat count set value is set using word read R ( ), if 0 is read,
0 will be stored and that step will be skipped (the next processing setting
ignored) and forcefully moved to the next step (+1).

Transmission Error 
Generated Status

CS/CJ: CIO 
1908, CIO 1918, 
n+8, n+18, bits 
00 to 15

C200HX/HG/HE: 
CIO 283, bits 00 
to 03, 08 to 11

CS/CJ: When a transmission error 
occurs the corresponding flag is set 
to 1 (ON). Bits 00 to 14 are repre-
sented by bit 15. The cause of the 
error or the cause of Send&Receive 
command retries will be represented 
in bits 00 to 15. (See note 7.)

When communications retries are 
executed by the Protocol Macro, an 
error will be recorded in bits 00 to 
14, but Transmission Error Gener-
ated bit 15 will remain at 0 (OFF). 
Even if another error occurs during 
retries, the cause of the error will be 
held.
Bits 00 to 15 are cleared when either 
the sequence starts executing, 
STUP is executed, or the power is 
turned ON.

C200HX/HG/HE: When a transmis-
sion error occurs in a Protocol 
Macro, error codes 1, 2, 3 will be 
stored in bits 00 to 03 or bits 08 to 
11. Bit 07 is representative of bits 00 
to 03 and bit 15 is representative of 
bits 08 to 11. The cause of the error 
or the cause of Send&Receive com-
mand retries will be represented in 
bits 00 to 15.

When communications are restored 
by the Protocol Macro retries, error 
codes in bits 00 to 03 and bits 08 to 
11 will be cleared. Even if another 
error occurs during retries, the 
cause of the error will be held. Bits 
00 to 15 are cleared when either the 
sequence starts executing, the 
power is turned ON, or the PMSU is 
restarted.

At 
power 
ON 
(See 
note 
1.)

When an 
error 
occurs

When 
sequence 
starts

Type Name Address Details Timing

Initial-
ization

Set Reset
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4. This flag can be used to distinguish whether or not the sequence was com-
pleted normally, by leaving the setting at End (or for an error Abort), after
the sequence has been completed.
1: Sequence End Completion
0: Sequence End not Completed

5. When the trace function is executed from CX-Protocol, the CPU Unit uses
the Shot Trace Start/Stop Flag and the Continuous Trace Start/Stop Flag
for the Serial Communications Board and Unit. Do not create ladder pro-
grams which set these flags to ON.

6. Set the Wait Release Flag in the ladder program to turn from OFF to ON.
When the Force Set Key on the Programming Console is used, the flag will
be only ON while the key is being pressed, so it will not be possible to set
the protocol macro function from ON to OFF (clear) from the Programming
Console.

7. When an error in bits 00 to 14 cause an error in the Protocol Macro, the
Transmission Error Generated Flag (bit 15) will turn ON (1).

Protocol Macro Error Codes

CS/CJ

For the Serial Communications Board, when an error code 3 or 4 is recorded,
A42411 (Protocol Macro Syntax Error) will turn ON (1), the CPU Unit ERR/
ALM indicator will flash and a continuous error will be generated. For the
Serial Communications Unit, the ERC indicator will flash. All other error codes
are not used.

When an error occurs, the error code will be stored until the next sequence
starts. The error will be cleared when either the STUP instruction is executed,
the PMSU is restarted, or the next sequence is executed.)

Note To reset the cause of a continuous error when an error code 3 or 4 is gener-
ated for the Serial Communications Board, the error display will be cleared
after one of the following operations is performed.

• The next sequence is executed.

• The STUP instruction is executed.

• Restart.

• The CPU Unit is set to PROGRAM mode.

Code Error contents Protocol macro 
execution

0 No error Executed

1 No protocol macro function 
(C200HX/HG/HE only)

Not executed

2 Sequence number error:
The sequence number designated in the 
PMCR instruction does not exist in the 
PMSU.

Not executed 

3 Data write/read area exceeded error:
When data was written to or read from 
the CPU Unit, data exceeded the range of 
the designated data area.

Execute aborted after error 
occurs.

4 Protocol data syntax error:
During Protocol Macro execution, a code 
which could not be executed was found. 
(E.g.: There was a header after the 
terminator.)
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C200HX/HG/HE

When error codes 1,2,3, or 4 are recorded, CIO 268 bits 11/12 will turn ON (1)
(PMCR execution error), the CPU Unit ERR indicator will flash and a continu-
ous error will be generated. When an error occurs, the error code will be
stored until the next sequence starts.

The error will be cleared when either the STUP instruction is executed, the
PMSU is restarted, or the next sequence is executed. After removing the
cause of the error, it will also be necessary to perform an error resetting oper-
ation from a device such as a Programming Console.

Additional Notes and Precautions

Time Delay

When a half-duplex send operation is performed (CS/CJ only), there is a time
delay (see t1: Timing List below) between when the actual data transmission
processing is completed and the send operation is completed. If the response
from the remote device is early, that is, if the response is received in between
the time that the data is transmitted (using a communications command) and
when the send operation is completed, with the half-duplex system the data
received in this interval (the response) cannot be received. In this case, set to
the full-duplex system. If the wiring to the device uses a 2-wire RS-422A/485
system, both transmission data and reception data will be sent along the
same wires, so in order to separate the transmission paths to send and
receive, a timing of t2 = 150 μs will be necessary. Accordingly, if a 2-wire sys-
tem connection is used and a high-speed response device is connected so
that data is returned within t1 + t2, take measures to slow down the data
response from the remote device.

 

Timing List: t1

Baud rate (bps) Timing (unit: μs)

1,200 1,116

2,400 578

4,800 288

9,600 144

19,200 73

38,400 36

Send operation

Data transmission processing

Fast response

Data reception

Timing (see the table below) Data cannot be 
received during 
this time

Reception buffer cleared

t1 t2=150 μs
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Error Flags when Overrun Errors, Framing Errors, and Parity Errors are 
Detected (CS/CJ and C200HX/HG/HE)

When any of the above errors are detected in the protocol macro function, the
information on the status of the reception data error will be stored in the
reception buffer. Whether or not the appropriate error flag will turn ON
depends on the following conditions.

• When error information data is included in the data which matches the
reception expected message.

When the receive operation is performed, the reception buffer is searched
for a reception expected message, and if the data matches this, it will be
treated as reception data. If this reception data contains error information,
all the error flags will turn ON. In the following example,100 bytes of data
matching the reception expected message were received.

• When error information data is included in the data which does not match
the reception expected message.

If this data does not match the reception expected message and contains
error information, the data will be corrupted and the error flag status will not
change.

For trace information, all error information obtained from the reception buff-
er will be stored within the trace data capacity range (CS/CJ only). In the
following example, data which did not match the reception expected mes-
sage contained a parity error.

Reception Buffer (CS/CJ Only)

With the protocol macro function each port has a reception buffer of up to
2.5 kbytes. To receive a large volume of data at one time or when the trans-
mission sequence is waiting, use a reception buffer with a large capacity. If the
reception buffer is already full and data is received, data will exceed the 2.5
kbytes of capacity and will overwrite existing data in the buffer. For this rea-
son, always be sure to use the flow control setting.

With the full-duplex system, the reception buffer will be cleared immediately
before the sequence is executed. The reception buffer receives data while
both Send and Receive commands are being executed and the data is treated
as macro data.

100 bytes Error Flag ON

P: Parity Error

Corrupt

Error flags do not change
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Relationship between the Flow Control and the Maximum No. of Words 
of Reception/Transmission Data (CS/CJ Only)

One Serial Communications Board or Unit has a reception buffer of 2.5 bytes.
Flow control will be set to start at the point when the reception buffer contains
approximately 2 bytes of data, and flow control will be released when approxi-
mately 0.5 bytes of reception data have been processed.

Set the reception buffer so that it can receive a maximum of 2 kbytes of recep-
tion data at a given time, and by setting the Receive command to receive a
maximum of 1,000 bytes (03E8 hexadecimal) of transmission data at any
given time, it is possible to store data in units of 1,000 bytes (500 words) max-
imum.
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4-1 Applicable Range of the Protocol Macro Function

4-1-1 CS/CJ
Using the Protocol Support Tool allows users to create several communica-
tions sequence (or protocol) compatible with communications control modes
discussed in this section. However, they are not compatible with communica-
tions control modes such as the synchronous communication, frame synchro-
nous mode (HDLC: High-level Data Link Communications), etc.

• The maximum message length can be set to a desired value in a range
from 200 to 1,000 bytes based on the allocated DM area of the PMSU.
The default is 200 bytes. A message exceeding 1,000 bytes cannot be
sent or received.
When using a wildcard (*) for the data length, the maximum receive mes-
sage length will be the same as this length setting (200 to 1000 bytes).

• Data calculation functions are available only for the calculation of seven
kinds of error check codes, calculation of frame length for sending data,
and conversion between ASCII and hexadecimal data only. Other calcula-
tions or conversions will be handled by the ladder program, if necessary.

• The DTR signals can be turned ON or OFF under modem control.

• Data can be retrieved from the receive buffer as a receive message in the
length set in the expected receive message.

• When the transmission mode is half-duplex, data in the receive buffer will
be cleared right before a sequence is executed or send command is exe-
cuted.
When the transmission mode is full-duplex, data in the receive buffer will
be cleared only right before a sequence is executed.

• Maximum number of processes that can be branched according to
received data (sent command, etc.) is 15. If more branches are neces-
sary, use the ladder program.

Transmission mode Half-duplex or full-duplex

Synchronizing mode Start-step synchronization mode

Transmission control mode Contention mode (Point-to-point connection)
Polling selecting mode (Point-to-multi-point connection)
Modem control mode

Flow control mode Software flow: Xon/Xoff flow control
Hardware flow: RTS/CTS flow control

Delimiter control

Transmission error control 
mode

LRC, LRC2, CRC-CCITT, CRC-16, SUM, SUM1, SUM2

Message format Header + Address + Length + Data + Check Code + 
Terminator 
or
Header + Address + Length + Data + Terminator + Error 
Check Code
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4-1-2 C200HX/HG/HE
Using the Protocol Support Tool allows users to create several communica-
tions sequence (or protocol) compatible with communications control modes
discussed in this chapter. However, they are not compatible with communica-
tions control modes such as the full-duplex, the synchronous communication,
frame synchronous mode (HDLC: High-level Data Link Communications), etc.

Note It is valid only when the Communications Board is the C200HW-COM@@-
EV1.

• The message length must be 256 bytes or less. For a message whose
length is 257 bytes or more, the data exceeding 256 bytes cannot be sent
or received.

• Data calculation functions are available only for the calculation of five
kinds of error check codes, the frame length to be sent, and the numeral
data conversion between ASCII and hexadecimal data only. Other opera-
tions or conversions will be handled by the ladder program, if necessary.

• The signal line cannot be controlled optionally by any mode other than the
modem control and the RTS/CTS flow control.

• A process that determines the number of receiving bytes by using the
beginning data of a received frame is infeasible.

• The data in the buffer is cleared before the sequence execution and after
the receive command execution. Therefore, a process that reads bytes
one by one from the content of receive buffer cannot be used.

• Maximum number of processes that can be branched according to
received data (sent command etc.) is 15. If more branches are necessary,
use the ladder program.

Transmission mode Half-duplex

Synchronizing mode Start-step synchronization mode

Transmission control mode Contention mode (Point-to-point connection)
Polling selecting mode (Point-to-multi-point connection)
Modem control mode

Flow control mode Software flow: Xon/Xoff flow control
Hardware flow: RTS/CTS flow control

Delimiter control

Transmission error control 
mode

LRC, CRC-CCITT, CRC-16 (see note), SUM, SUM2 
(see note)

Message format Header + Address + Length + Data + Error Check 
Code + Terminator 
or
Header + Address + Length + Data + Terminator + 
Error Check Code (see note)
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4-2 Protocol Creation Process

4-2-1 Creating Communications Sequence Flowcharts
• Create the status transition chart of communications sequence.

Before creating a protocol by using the Protocol Support Tool, users are
recommended to first draw such a status transition charts to illustrate the
communications sequences with the communicating machine as shown
below as an example. Then, users can convert them to “sequences” and
“steps” editable by the Protocol Support Tool.

4-2-2 Disassembling into Sequences and Steps
• Disassembling the protocol into “sequences” and “steps” to be editable by

the Protocol Support Tool.

• Disassemble into sequences 
Take out a block from the above process as a “sequence” which is to
be started (or switched) by the ladder program.
For example, either “Read the process value of temperature controller”
or “Write the set value of temperature controller” becomes a “se-
quence.”

PLC

Send A

Send C

Retry, if not B.
End, if B.

Retry after one
minute, if not D.

End, if E

External device PLC

Send the read
command for
process value.

Send the write
command for a
set value.

Retry, if not
response
format.
End, if
response
format.

Retry, if not
response
format.
End, if
response

format.

Temperature
controller

Example:

•

•

•

•

•

•

•

•
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• Disassemble into steps
Disassemble sequences into squares (steps) as shown below:

Send

Send A

Normal
end

Error

Next
process

Error
process

Send&Receive

Send A

Receive
B

Error

Next
process

Error
process

Y

Receive

Receive
B

Error

Next
process

Error
process

Y

Y

Send&Receive (Matrix)

Send A

Matrix

Receive B Receive C Receive D Receive others Error

Next process Next process Next process Next process Error Process

Receive (Matrix)

Matrix

Receive B Receive C Receive D Receive Other Error

Next process Next process Next process Next process Error Process
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Example 1:

Send message

Send
&

Receive

Send data
Error

Receive
the
expected
message Abort

Next
Step No. 01

Step No. 00

Send escape
code

Send
&

Receive

Retry
three
times

Retry
count

Receive a
result code

Other
than 0,
or Error

Send
&

Receive

If 0

Abort

Abort

NextStep No. 02

Send disconnect
command

Retry
three
times

Retry
count

Receive a
result code

End
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Example 2:

When configuring the steps, the enough consideration is necessary not only
for the normal course (the process is completed in normal) but for the error
course (the process is terminated by error). The error courses are often set to
be aborted (intermittent process stop) all together. However, if the abort is set
as the simple “other than normal course,” the process stops there.
Add the description to switch from the error course to the normal course by
setting Next and Goto as much as possible if the error cause is predicted and
the process can be continued by the other steps even if the errors occur.
Besides, if the error causes are identified, the debug will be easy even when
the recovery is impossible by describing the steps. For example, for a device
such as a modem which returns the specific result codes, the result codes can
be set in the matrix in order to confirm the sent result codes and to ease the
error cause identification.

4-3 Transmission Control Mode Setup
The Protocol Macro function supports such transmission control modes as the
flow control (Xon/Xoff flow control by software and RTS/CTS flow control by
hardware), delimiter control, contention control, and modem control. Note that
the system cannot freely control the signal line through another mode.

Examples of their general use are as follows:

• The external device is compatible with the RTS/CTS flow control.
Select the RTS/CTS flow control.

• The external device is compatible with the Xon/Xoff flow control.
Select the Xon/Xoff flow control.

• The connection in one-to-n configuration is used for the external de-
vice.Select the modem control.

Step No.00

Send dial
command

Send dial
command

Retry three times
Retry count

Retry three times
Retry count

Send&
Receive

Send&
Receive

(Matrix)
Result code

(Matrix)
Result code

Receive 7,9 Receive 1,234 Receive 4,6,8, or others Error

END Abort Abort

END Abort Abort

Go to 01

Step No. 01

Receive 1,234 Receive 4,6,7,8,9,or others Error
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• The external device is a modem.
Select the modem control.

• The external device is a modem compatible with the RTS/CTS flow
control (or the Xon/Xoff flow control).
Select both the modem control and the RTS/CTS flow control (or the
Xon/Xoff flow control).

• The external device compatible with the RTS/CTS flow control (or the
Xon/Xoff flow control) is connected in 1:N configuration.
Select both the modem control and the RTS/CTS flow control (or the
Xon/Xoff flow control).

Note

The RTS/CTS flow control sets the CTS signal from the receiving terminal to
“OFF” to stop the data sending temporally when the receiving speed exceeds
the processing in a no-procedural communication. When the receiving pro-
cess finished, it sets the CTS signal to “ON” again to resume the sending.
This control is a kind of hardware flow control. The signal line of RS-232C
cable is used.

The Xon/Xoff flow control sends the Xoff (13H) signal from receiving termi-
nal to temporarily stop data sending when the receiving speed exceeds the
processing capacity in no-procedural communications. When the receiving
process becomes available, it sends the Xon (11H) signal to start the data
sending again. This is a kind of software flow controls. (However, the Xon and
the Xoff signals are control codes, therefore they might be included in the
sending data if it is binary. On the contrary, the Xon and the Xoff signals may
be mixed in the data. Thus, this control is not used for a binary data communi-
cations).

The modem control is a specific function to the Protocol Macro function.
It sets DTR signal to “ON” from the start of Protocol Macro execution through
the end.
It sets RTS signal to “ON” during the data sending.

The contention control is a data transmission mode which establishes a
data link from the data sending terminal before the communication. Since
mutually communicating terminals have equal priority, either terminal can
establish the link to send data anytime.

The delimiter control sends a delimiter, which has been set by the send
code, at the end of the send data if no terminator is defined for the send mes-
sage. At the next step, it does not send until it receives a delimiter, which has
been set by the receive code, from the communicating terminal.
If a terminal received a delimiter set by the receive code, it sends a delimiter
set by the send code and continues the data receiving.
When the received data exceeds 200 bytes (for the C200HX/HG/HE) or
exceeds the maximum receive bytes (for the CS/CJ) in the RTS/CTS flow
control, the Xon/Xoff flow control, or the delimiter control mode.

For the C200HX/HG/HE
The received data is 200 bytes maximum a step in the RTS/CTS flow control,
the Xon/Xoff flow control, or the delimiter control. If more than 200 bytes of
data are expected to be received, it will necessary to design the sequence to
receive them using multiple steps.

Example: When receiving 300 bytes.

Step No. Command Send 
message

Receive 
message

Next process

00 Send&
Receive

A command 200 bytes Next

01 Receive --- 100 bytes End
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For the CS/CJ

With the CS/CJ protocol, the maximum number of receive bytes per step is
1,000 bytes in the RTS/CTS flow control, Xon/Xoff flow control, or delimiter
control as in the case where these control modes are not specified. (The max-
imum number of bytes for the send/receive message handled by the protocol
macro can be set in a range from 200 to 1,000 bytes by setting the allocated
DM area for the PMSU.)

Note on the selection of the contention control mode 

When the contention control mode is set, the send request code is automati-
cally sent at the beginning of the sequence, the successive process has to be
set in the sequence.

• When the communicating partner does not have a priority. (Execute the
communications process after the receipt of partner’s receive permission
code)

• When the communicating partner has a priority. 
(Send the receive permission code if the received data is not the partner’s
receive permission code)

Step No. Command Send message Receive message Next process Error process

00 Receive --- Receive 
permission code

Next Goto00

01 Send&Receive Data send Data receive End Abort

Step No. Command Send message Receive message Next process Error process

00 Receive --- Receive permis-
sion code

Next Goto02

01 Send&Receive Data send Data receive End Abort

02 Send&Receive Receive permis-
sion code

Data receive Next Abort

03 Send Data send --- End Abort
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4-4 Ladder Programming Method

4-4-1 CS/CJ
• To avoid executing a PMCR instruction while another PMCR instruction is

being executed, the Communications Port Enabled Flag should be
switched from the normally open input condition to the normally closed
input condition.

• Perform the sequence execution result read process and the sequence
error termination process under the condition that the Protocol Macro
Execution Flag is cleared.

Note Before executing a PMCR instruction with the CS/CJ Series, ensure that the
serial communications mode for the communications port to be used is set to
protocol macro. If a PMCR instruction is executed with the port set to Host
Link (SYSWAY), messages that cannot be understood by the application will
be output from the serial communications port.

Example:

Example: The execution of the protocol Temperature Controller (E5@K Read
System) Sequence No. 000 (read process value) 

PMCR

DIFD (14)         A

Input condition 191915

191915

Sequence execution result reading process

A

Sequence error termination process

Protocol Macro Execution 
Flag (for port 2 of Serial 
Communications Board)

Communications 
Port Enabled Flag 
(Communications 

port 0)

A20200

CS1W-SCB41-V1 Serial Communications Board

Send data

Receive data

Maximum 32 Units

The Temperature Controller unit number is spe-
cified, the send data of the process value read 
command is sent, and the process value in the 
response is received in the specified word.

RS-422A/485

E5@K Temperature 
Controller 
 Unit No. 00

E5@K Temperature 
Controller
 Unit No. 01

E5@K Temperature 
Controller 
 Unit No. 31

Port 2
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• The Send/Receive Word Allocation Contents of the Sequence No.
000 (read process value)

• PMCR Instruction Operand Setting Contents
In this case, the Unit No. 03 E5@K process value is read, received and,
stored in DM 0201:

Offset Contents (data format) Data

+0 Number of send data words (4 digits 
hexadecimal)

0002 (fixed)

+1 Unit No. (2 digits BCD) 00 to 31

Offset Contents (data format) Data

+0 Number of receive data words 
(2 digits hexadecimal)

0002 

+1 Process value (4 digits BCD) Scaling (lower limit to upper 
limit)

Number of send data words

(Undefined) Unit No.

+0

+1

First word of 
send data

Number of receive data words
+0

+1

Receive data 
storage words

Process value

PMCR

#02E1

#0000

DM00100

DM00200

C1

C2

S

D

C: Control data

S: The first word number of the send data
S: D00100 15 0

D: The first word number of the receive data storage

D: D00200

C1
15 1211 87 43 0

20

00 03
00S: D00100

S+1: D00101
Number of send data words = 2
Unit No. = 03

15 0
D: D00200

D+1: D00201 Process value
Number of send data words = 2
Process value is stored (BCD 4-digit)

02

0 0 0 2

0 Hexadecimal: Communications port (Internal logic port No. 0)

2 Hexadecimal: Port 2

E1 Hexadecimal: Inner board
(Serial Communications Board)

0000 Hexadecimal: Sequence No. 000

C2
15 0
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• Example of the Ladder Program Creation
The following example shows that the protocol “Controller (E5_K read)”
Sequence No. 000 (“Process value read”) is executed by the PMCR
instruction and the read process value is transferred to another word at
the normal completion of the sequence.

Application of the Receive Data Storage Area before PMCR Execution

The receive buffer is cleared to 0 right before a communications sequence is
executed at the time of PMCR execution. Therefore, if a ladder program that
constantly reads the process data as shown in the following example is cre-
ated, the process value data will be momentarily cleared to 0 if data cannot be
read due to a reception error.

There is a function that reads and sets data from the I/O memory area of the
CPU Unit for a number of words of the first “m” in the receive area right before
the communications sequence is executed. This is done in order to hold the
received data when a reception error occurs. With this function, the process
value data will not be cleared to 0 and the data that existed just before recep-
tion failure can be retained.

   1Protocol Macro 
Execution Flag 
191915    0

   1

00100
   0

Sequence normal termination: 
Step Error Processing Execu-
tion Flag 191914

The process v
transf

Sequence error termination: 
Step Error Processing Execution 
Flag 191914

   FAL instruction is executed.

MOV (21)

   D00201

   D00300

FAL (06)             00

When the input condition 000000 is ON, the Commu-
nications Port Enabled Flag A20200 is turned OFF, 
and the Protocol Macro Execution Flag 191915 is 
turned OFF, the sequence No. 000 is executed at port 
2 of Serial Communications Board, and the process 
value is stored in D00201.

When the Protocol Macro Execution Flag 191915 is 
cleared from ON to OFF, 000100 changes from OFF 
to ON (remains unchanged to be ON during 1 cycle).

The process value received in D00201 is transferred 
to D00300 when 000100 is ON, Protocol Macro Exe-
cution Flag 191915 is turned OFF, and the Step Er-
ror Processing Execution Flag 191914 is turned 
OFF.

If the Step Error Processing Execution Flag 191914 is 
ON when 00100 is ON (sequence termination), the 
FAL instruction (Failure Alarm instruction) will be exe-
cuted as the sequence error termination.

   1 cycle

Sequence 
execution

Sequence 
termination

Sequence 
restart

   1

   0

   1

   0

191915

Protocol Macro 
Execution Flag

Communications 
Port Enabled Flag

A20200

PMCR

   #02E1

   #0000

   D00100

   D00200

191915

Step Error Processing 
Execution Flag

Step Error Processing 
Execution Flag

DIFD (14)   000100

If the Communications Port Execution Error Flag 
A21900 is ON, the FAL instruction will be executed.

FAL (06)             01

000100

000000
Input condition

191914191915

191914

A21900

alue in D00201 is 
erred to D00300.
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Specify the number of words of data to be retained in “m.” If set to 0 or 1, the
data received will not be retained and cleared to 0.

Example The following protocol sends or receives data once and constantly or periodi-
cally executes the PMCR instruction for reading the received data according
to the ladder program.

 

Functions of the Receive Data Storage Area
Use the receive data storage area according to the following procedure.

1,2,3... 1. The 250 words of the PMSU receive buffer of the PMSU is cleared to 0
right after the PMCR instruction is executed.

2. Before the communications sequence is executed, data (starting from
D+1) for the number of words (D value–1) in the I/O memory is overwritten
on the receive buffer (except at the beginning). The receive buffer consid-
ers this as the initial value and waits for the results of Receive processing.
The contents of the receive buffer that exceed the number of words for D
remain as the initial value of 0000 hexadecimal. (If the number of words is
specified to be 00, the whole area remains as the initial value of 0000 hexa-
decimal.

3. As the result of Receive processing, received data starting from the desig-
nated first (offset) word is stored in this receive buffer (except the begin-
ning). The stored data is compared with the expected message. If the
response is not written, the received data is kept in the receive buffer and
is not stored in the CPU Unit.

4. If the response is written, the received data (except at the beginning) in the
receive buffer will be stored in the I/O memory area (starting from D+1).
The number of words (including D itself) to the maximum position of the

Always ON 
Flag

Communications 
Port Enabled Flag

Protocol Macro 
Execution Flag Set

Receive 
buffer

Stores the value at 
the time of reception 
failure

When the receive area is not retained

Communications 
sequence

Receive buffer
Clear

Receive area
D+1 on

Reception
failure

Cleared value is stored.

When the receive area is retained

Communications 
sequence

Receive buffer
Clear

Receive area
D+1 on

Reception
failure

Set value is stored.

PMCR
C1
C2

S
D m

m words

D

Set
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Ladder Programming Method Section 4-4
stored data is stored in D. (The number of words within D is updated every
time data exceeding the maximum position is stored.)

5. The previous steps 3 and 4 are repeated until the protocol macro com-
pletes its operation.

Sequence Error Termination Process
If the End is set for the normal sequence termination and the Abort is set for
the error termination as follows, either the normal sequence termination or the
error termination can be identified by the Sequence End Termination Flag and
the Sequence Abort Termination Flag.

I/O memory
Number of words of this value

Set

I/O memory

Value changes.

This number of
words is stored to
update the value.

Overwrites the initial value

Response writing is designated.

CPU Unit

PMSU

Receive buffer Receive buffer

Right after PMCR
is executed

Internal processing to
clear the buffer

Receive data is
stored.

Storing starts from the
designated word.Receive

Overwrites the received data.

Offset

Received data

0000

0000

0000

0000

D

D+1

D+2

D+3

D+4

00 04 00
1234

5678

FFFF

AAAA

+2 5678 FFFF AAAA

00 00 00 00

1234

ABCD

55AA

----

1234

ABCD

55AA

0000

PMCR
C1

C2

S

D
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Ladder Programming Method Section 4-4
Note 1. The Step Error Processing Execution Flag is not a flag for the whole se-
quence, but a flag to determine whether the error process is executed at a
step in the sequence. Therefore, as in the above example 2, if the consec-

Sequence

Step No. 00

Error

Sequence error
termination

Abort

End

Abort

Error

Sequence error
termination

Step No. 01

Step No. 00

Step No. 01

End End

Abort

Error

Sequence error
termination

Step No. 02

Sequence normal
termination

Sequence normal
termination

Sequence

Example 1 Example 2

Error

1

0

1

0

1

0

1

0

1

0

1

0

Sequence Error Termination

Protocol Macro 
Execution Flag
190915

Sequence Abort 
Termination Flag
190910

Step Error Proces-
sing Execution 
Flag 190914

Sequence
execution

Sequence
termination

Sequence
restart

Sequence
execution

Sequence
termination

Sequence
restart

Error process at 
the step No. 00

Sequence Error Termination

Protocol Macro 
Execution Flag
190915

Sequence Abort 
Termination Flag
190910

Step Error Proces-
sing Execution 
Flag 190914

Example: Port 1 of the Serial Communications Board

1

0

1

0

1

0

1

0

1

0

1

0

Sequence Normal Termination Sequence Normal Termination

Protocol Macro 
Execution Flag
190915

execution termination restart

Sequence End 
Termination Flag
190911

Error process at 
the step No. 00

Step Error Proces-
sing Execution 
Flag 190914

Sequence
execution

Sequence
termination

Sequence
restart

Protocol Macro 
Execution Flag
190915

Sequence End 
Termination Flag
190911

Step Error Proces-
sing Execution 
Flag 190914

Sequence Sequence Sequence 
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Ladder Programming Method Section 4-4
utive step terminates normally after error process execution during the se-
quence (step No. 00), the Flag will remain unchanged at 1 (ON). Thus it
should be kept in mind that this Flag is not always useful as an error termi-
nation flag for the whole system.

2. Use the Forced Abort Flag while keeping the following points in mind:
A sequence under execution can be forced to stop by using the forced
abort switch. When the switch is changed from OFF to ON using the ladder
program or Programming Console, the protocol macro function changes
the Forced Abort Flag from OFF to ON and then changes the Protocol
Macro Execution Flag and the forced abort switch from ON to OFF.
Therefore, do not turn the forced abort switch from ON to OFF using the
ladder program or Programming Console.

4-4-2 C200HX/HG/HE
• The Instruction Execution Flag should be set to the normally closed input

condition in order to avoid another PMCR instruction execution during
PMCR instruction execution.

• Perform the sequence execution result read process and the sequence
error termination process under the condition that the Instruction Execu-
tion Flag has been cleared.

Example:

Example: Execution of the protocol name “Controller (E5_K read)” Sequence
No. 000 (“Process value read”)

PMCR

DIFD (14) A

Instruction Execution Flag
28908Input condition

28908

Sequence execution result reading process

A

Sequence error termination process

Communications Board

Send data

Receive data

Maximum 32 Units

The Temperature Controller unit number is spe-
cified, the send data of the process value read 
command is sent, and the process value in the 
response is received in the specified word.

RS-422A/485

E5@K Temperature 
Controller
Unit No. 00

E5@K Temperature 
Controller
Unit No. 01

E5@K Temperature 
Controller
Unit No. 31
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Ladder Programming Method Section 4-4
• The Send/Receive Word Allocation Contents of the Sequence No.
000 (“Process value read”)

• PMCR Instruction Operand Setting Contents
In this case, the Unit No. 03 E5@K process value is read, received and
stored in the DM 0201:

Offset Contents (data format) Data

+0 Number of send data 
words (4 digits BCD)

0002 (fixed)

+1 Unit No. (2 digits BCD) 00 to 31

Offset Contents (data format) Data

+0 Number of receive data 
words (4 digits BCD)

0002 

+1 Process value (4 digits 
BCD)

Scaling (lower limit to 
upper limit)

Number of send data words

(Undefined) Unit No.

+0

+1

First word of 
send data

Number of send data words
+0

+1

Receive data 
storage words

Process value

C: Control data

1: Port A

S: The first word number of the send data
S: DM0100

15 0

D: The first word number of the receive data storage

D: DM0200

PMCR

   #1000

   DM0100

   DM0200

C

S

D

C

15 12 11 8 7 4 3 0

0001

00 03
00S: DM0100

S+1: DM0101
Number of send data words = 2
Unit No. = 03

15 0
D: DM0200

D+1: DM0201

Process value

Number of send data words = 2
Process value is stored (BCD 4-digit)

02

0 0 0 2

000: Sequence No.
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Ladder Programming Method Section 4-4
• Example of the Ladder Program Creation
The following example shows that the protocol name “Controller (E5_K
read)” Sequence No. 000 (“Process value read”) is executed by the
PMCR instruction and the read process value is transferred to another
word at the normal completion of the sequence.

Sequence Error Termination Process

If the End is set for the normal sequence termination and the Abort is set for
the error termination as follows, either the normal sequence termination or the
error termination can be identified by the Sequence End Termination Flag and
the Sequence Abort Termination Flag.

1Instruction 
Execution Flag 
28908 0

1

00100
0

Sequence normal termination: 
Step Error Process Execution 
Flag 28909

The process v
is transf

Sequence error termination: 
Step Error Process Execu-
tion Flag 28909

FAL instruction is executed.

PMCR

#1000

DM0100

DM0200

28908
Instruction flag

00000
Input condition

DIFD (14)  00100

28908
Instruction flag

MOV (21)

DM0201

DM0300

28908 28909
Step error process execution flag

FAL (06) 00

28909
Step error process execution flag

When the input condition 00000 is ON and the 
Instruction Execution Flag 28908 is OFF, the 
sequence No. 000 is executed and the process 
value is stored in DM 0201.

The Instruction Execution Flag 28908 is cleared from 
ON to OFF, 00100 changes from OFF to ON 
(remains unchanged to be ON during 1 cycle).

If the Instruction Execution Flag is OFF and the Step 
Error Process Execution Flag 28909 is OFF when 
00100 is ON, the current received process value in 
DM 0201 will be transferred to DM 0300.

If the Step Error Process Execution Flag 28909 is 
ON when 00100 is ON (sequence termination), the 
FAL instruction (Failure Alarm instruction) will be 
executed as the sequence error termination.

1 cycle

Sequence 
execution

Sequence 
termination

Sequence 
restart

1

0

1

0

00100

alue in DM0201 
erred to DM0300.
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Sequence

Step No. 00

Error

Sequence error 
termination

Abort

End

Abort

Error

Sequence error 
termination

Step No. 01

Step No. 00

Step No. 01

End End

Abort

Error

Sequence error 
termination

Step No. 02

Sequence normal 
termination

Sequence normal 
termination

Sequence
Example 1 Example 2

Error

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

1

0

Sequence Normal Termination Sequence Normal Termination

Instruction 
Execution Flag
28908

Sequence
execution

Sequence
termination

Sequence
restart

Sequence End 
Termination Flag
28910

Error process at 
the step No. 00

Step Error Process 
Execution Flag 
28909

Sequence Error Termination

Instruction 
Execution Flag
28908

Sequence Abort 
Termination Flag
28910

Step Error Process 
Execution Flag 
28909

Sequence
execution

Sequence
termination

Sequence
restart

Sequence
execution

Sequence
termination

Sequence
restart

Sequence
execution

Sequence
termination

Sequence
restart

Error process at 
the step No. 00

Instruction 
Execution Flag
28908

Sequence End 
Termination Flag
28910

Step Error Process 
Execution Flag 
28909

Sequence Error Termination

Instruction 
Execution Flag
28908

Sequence Abort 
Termination Flag
28910

Step Error Process 
Execution Flag 
28909
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Note 1. The Step Error Process Flag is not a flag for the whole sequence, but a flag
to determine whether the error process is executed at a step in the se-
quence. Therefore, as in the previous example 2, if the consecutive step
terminates normally after the error process execution during the sequence
(Step No. 00), the Flag will remain unchanged at 1 (ON). Thus, it should
be kept in mine that this Flag is not always useful as the Error Termination
Flag for the whole system.

2. Use the Forced Abort Flag while keeping the following points in mind:
The Instruction Execution Flag will change from ON to OFF when the user
program changes the Forced Abort Flag from OFF to ON. Therefore, the
abort process will not be executed if the Forced Abort Flag in turned OFF
when the Instruction Execution Flag turns OFF. Set the Forced Abort Flag
to OFF after the minimum period [CPU Unit cycle time + 15 ms] of the ON
held. When the Instruction Execution Flag B-bit is the PMCR instruction
execution condition, the PMCR instruction will be executed during the
forced abort process and cause the FAL9C error. Therefore, execute the
PMCR instruction after the minimum period [CPU Unit cycle time + 15 ms]
after the Forced Abort Flag is changed from OFF to ON.

Example The Forced Abort Flag is turned ON, the 30 ms period is elapses, the Forced
Abort Flag is turned OFF, and simultaneously the PMCR instruction interlock
is released.

PMCR

00000
Input condition Flag

Forced Abort

28908
Execution Flag

Instruction

28911

TIMH

000

#0003

The condition
to allow the abort T000

A

A

T000
Forced
Abort Flag

A

28911

The condition to 
allow the abort

A

T000

Forced Abort Flag 
28911

Instruction 
execution flag 
28908

30 ms 1 cycle
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Calculation Method of Monitoring Time Section 4-5
4-5 Calculation Method of Monitoring Time
The calculation method of monitoring time for the operand addressing (with-
out response writing) is shown here. Referring to this calculation method, cal-
culate the monitor times for the operand addressing (with response writing),
link word addressing, and direct addressing. When actually setting the moni-
tor times as sequence data, be sure to provide sufficient allowance.

Number Function Time Required Description

1 PMCR instruction’s process time Depends on the Unit/Board being 
used.

Internal process time from the 
start of PMCR instruction to the 
end of the send data transfer

2 Send data conversion process 
time

Depends on number of conversion 
bytes

Time from the end of the send 
data conversion based on the 
specified conversion method to 
the start of the send data to the 
external device.

3 Send data transmission time Number of data characters x num-
ber bits in one character/ trans-
mission rate

Time required to the send data 
transmission to the external 
device. When designing, use 
double the calculated time 
because idle time exists between 
the send characters.

4 External device process time Depends on the external devices’ 
process

Time required by the external 
device to process according to the 
command from the PLC until the 
start of the send response data.

5 Received data transmission time Number of data characters x one 
character bit/ transmission rate

Time required to transmit the 
received data from the external 
device. When designing, use two 
to five times the calculated time 
because idle time exists between 
the receive characters.

PMCR #01E1

           D00000
           D01000

D0000

D1000

CPU Unit External device

Send data
conversion

process

PMCR
instruction
process

External
device

process

Received 
data writ-

ing

Received
data

conversion
process

2 3

7 6 5 4

1

Protocol Support
Board

#0001
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Calculation Method of Monitoring Time Section 4-5
Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, for the CS/CJ, the maximum values can be estimated
with the following calculation formula:
2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes
Reverse conversion: 5 μs, ASCII reverse conversion: 4 μs, hexadecimal
reverse conversion: 7 μs
(One-byte conversion time → No conversion: 1 μs, reverse conversion: 5 μs,
ASCII conversion: 10 μs, ASCII reverse conversion: 4 μs, hexadecimal con-
version: 7 μs, hexadecimal reverse conversion: 7 μs)
6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes
(One-byte conversion time → No conversion: 1 μs, reverse conversion: 4 μs
ASCII conversion: 8 μs, ASCII reverse conversion: 9 μs, hexadecimal conver-
sion: 17 μs, hexadecimal reverse conversion: 17 μs)

• Calculation Example of the Send Finish Monitoring Time, (Tfs)

The send finish monitoring time (Tfs) is set so as to perform monitoring from
the time the leading byte (start character) is sent to the time the last data byte
(end character) is sent. Therefore, in consideration of number 3 (send data
transmission time: number of data characters x number bits in one character/
transmission rate) in the table, the send finish monitoring time is Tfs > Number
of data characters x number of bits in one character x 2/transmission rate.

Example  @ + 5 + hexadecimal data of 5 words + CRC-CCITT (BIN) 2 bytes + CR = 15
characters (120 bits)

1 + 1 + 10 + 2 + 1 = 15

One character equals 12 bits under the following condition:

Start bit: 1 bit; Data: 8 bits; Parity: Yes; Stop Bit: 2 bits

Therefore, 15 x 2 = 180 bits

180/9,600 = 0.01875 seconds

In practice, however, it must be set to a value double the calculated time
because an idle time exists between characters sent from the PMSU as
shown below:

0.01875 x 2 = 0.0375 seconds

Since the unit of the monitoring time is in the range of from 0.01 seconds
(10 ms) to 99 minutes, users can set the Tfs to 0.04 seconds after which the
system executes the error process or the retry process.

• Example to Set Up the Receive Wait Monitoring Time (Tr)

The receive wait monitoring time (Tr) sets the monitoring time from the sys-
tem’s recognition of the received command in the applicable step and to the
receiving of the beginning one-byte (the start character). In the above table, it
refers to a total of 4+5 for the beginning character and it can be set in the
range where the following equation is satisfied:

The receive wait monitor time, Tr > 4+5 for the beginning character

6 Received data conversion process 
time

Depends on number of conversion 
bytes

Time required for the conversion 
of the received data from the 
external device based on the 
specified conversion method

7 Received data writing time One cycle time maximum Time required to finish the 
received data transfer to the I/O 
memory.

Number Function Time Required Description
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Operation Confirmation Section 4-6
When this time is up, the system executes the error process or the retry pro-
cess.

• The Receive Finish Monitoring Time (Tfr)

The receive finish monitoring time (Tfr), monitors the receiving time from the
receipt of the beginning one-byte (the start character) to the receipt of the last
one-byte data (the end character). In the above table, it refers to 5. As in the
case of the send finish monitor time, an idle time exists between receive char-
acters and depending on devices to be connected, the time varies. Therefore,
it is recommended that the time be set to two to five times of the calculated
time. It can be set in the following range:

The receive finish monitor time, Tfr > 5 x (2 to 5)

When this time is expired, the system executes the error process or the retry
process.

4-6 Operation Confirmation
“Tracing the Transmission Line” and “I/O Memory Monitor of the PLC” func-
tions are available with the Protocol Support Tool to confirm the operation of
the created protocol macro.

• Tracing the Transmission Line
Trace the transmission data and the control signals flowing on the trans-
mission line (RS-232C or RS-422A/485). With this function, users can
confirm the data and signals flowing on the transmission line, even if they
do not have the protocol analyzer.

PLC

Send message
@ 0 2 R
40 30 32 52

@   0   0
40 30 30

0 0 0 0 0 0 0

Receive message

Step No.
RTS

CTS

Personal Computer

External general-purpose device

Tracing the send/receive message or control 
signals that runs through the transmission line.

Trace display for send message, receive 
message, step number, and control signals.
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• I/O Memory Monitor of the PLC
Monitor or edit the I/O memory areas on the PLC. With this function,
users can set or edit the send data or receive data designated in the 3rd
and 4th operands of the PMCR instruction (2nd and 3rd operands for the
C200HX/HG/HE), monitor the receive data, and monitor the contents of
data in the auxiliary area.

When an error occurs while the ladder program is executed, users can search
for the cause of the error by checking various flags. Refer to 3-10 Auxiliary
Area and Allocated Data Areas.

PLC

Personal Computer

External general-purpose device

Displays I/O memory 
area of the PLC

210Address ---

0003
0004
0000

0000
0010
0020

0000 0002
0000
000003B6

B3B4
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Errors at the Protocol Execution Section 4-7
4-7 Errors at the Protocol Execution
When an error listed below occurs, take the appropriate action by referring to
the following table. Refer to the CS/CJ Series Serial Communications Board/
Serial Communications Unit Operation Manual (W336) and C200HX/HG/HE
Communication Boards Operation Manual (W304).

4-7-1 CS/CJ
Note For the Serial Communications Board:

m = DM32000 (words)
n = 1900 (words)

For the Serial Communications Unit:
m = DM30000 + 100 × unit number (words)
n = 1500 + 25 × unit number (words)

Problem Allocated data 
area

Cause Action

Serial 
communications 

mode setting

Indicator display Status 
information

Serial 
communications 
mode is not set to 
protocol macro.

--- --- Bits 12 to 15 
(serial 
communications 
mode) of 
allocated data 
area (n+5/n+15) 
are not 6 
hexadecimal.

Serial 
communications 
mode setting is 
wrong.

Set bits 11 to 08 
(serial 
communications 
mode) of m/m+10 
in the allocated 
DM are to 6 
hexadecimal 
(protocol macro).

Serial 
communications 
mode is set to 
protocol macro.

SD@/RD@, 
COM@ indicators 
are not lit. 
(Electrically not 
connected)

Although PMCR 
instruction is 
executed, bit 15 
(Protocol Macro 
Execution Flag) in 
the allocated data 
area (n+9/n+19) 
does not turn ON.

Bits 00 to 07 of the 
Communications 
Port Execution 
Error Flag (A219 
words) are set to 1 
(ON).

Either operand 
settings of the 
PMCR instruction 
are wrong or 
execution timing is 
not correct.

See table on 
page 180.

As a PMCR 
instruction 
execution 
condition, bit 15 
(Protocol Macro 
Execution Flag) in 
the allocated data 
area (n+9/n+19) is 
set to normally 
open.

Programming 
error

As a PMCR 
instruction 
execution 
condition, set bit 
15 (Protocol 
Macro Execution 
Flag) to normally 
closed.

ER Flag (one of 
the condition 
flags) is ON.

C1 data range of 
PMCR instruction 
is illegal; number 
of words in S or D 
data exceeds 250; 
or 
Communications 
Port Enabled Flag 
is OFF. 

Check if C1, S, 
and D operands of 
PMCR instruction 
are properly set.

AER Flag (one of 
the condition 
flags) is ON.

Access prohibit 
area is 
designated in S or 
D of PMCR 
instruction.

Check if S and D 
operands of 
PMCR instruction 
are properly set.
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Serial 
communications 
mode is set to 
protocol macro.

SD@/RD@, 
COM@ indicators 
are not lit. 
(Electrically not 
connected)

Although PMCR 
instruction is 
executed, bit 15 
(Protocol Macro 
Execution Flag) in 
the allocated data 
area (n+9/n+19) 
does not turn ON.

Bits 00 to 03 (error 
codes) in the 
allocated data 
area (n+9/n+19) 
are set to 2 
hexadecimal 
(sequence number 
error).

Sequence 
number 
designated in C2 
of PMCR instruc-
tion is set to a 
value other than 
000 to 3E7 
hexadecimal (000 
to 999 decimal).

Communications 
sequence number 
that does not exist 
in the protocol 
data is 
designated.

Set C2 of PMCR 
instruction to 0000 
to 03E7 
hexadecimal (000 
to 999 decimal)
Check if 
communications 
sequence number 
is correct.

Bits 00 to 03 (error 
codes) in the
allocated data 
area (n+9/n+19) 
are set to 3 
hexadecimal (data 
read/write range 
over error).

When storing or 
reading data from 
I/O area of CPU 
Unit, designated 
area range is 
exceeded.

Designate another 
area or reduce the 
send/receive data 
size.

Bits 00 to 03 (error 
codes) in the 
allocated data 
area (n+9/n+19) 
are set to 4 
hexadecimal 
(protocol data 
syntax error).

Protocol data in 
the PMSU is faulty.

Using the 
CX-Protocol, 
rewrite the 
protocol data.

Communications 
Port Enabled 
Flags (A20200 to 
A20207) are OFF 
(unable to exe-
cute)

SEND, RECV, 
CMND or other 
PMCR instruction 
is being executed 
using the same 
communications 
port number

Use another 
communications 
port not used for 
SEND, RECV, 
CMND, or other 
PMCR instruction 
being executed (by 
changing the set-
ting of C1 bits 12 
to 15) or wait until 
the port becomes
available.

As a PMCR 
instruction 
execution 
condition, the 
Communications 
Port Enabled Flag 
(A20200 to 
A20207) is set to 
normally closed.

Programming 
error

As a PMCR 
instruction 
execution 
condition, set the 
Communications 
Port Enabled Flag 
to normally open.

Bit 00 (port 
operation) in the 
allocated data 
area (n+6/n+16) is 
set to 0 (port stop)

Either protocol 
data is being 
transferred or 
SUM value error 
has occurred.

Wait until the 
protocol data 
transfer is com-
pleted or transfer 
the protocol data 
using the 
CX-Protocol.

Problem Allocated data 
area

Cause Action

Serial 
communications 

mode setting

Indicator display Status 
information
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Serial
communications 
mode is set to 
protocol macro.

SD@/RD@, 
COM@ indicators 
are not lit. 
(Electrically not 
connected)

Bit 15 (Protocol 
Macro Execution 
Flag) in the 
allocated data 
area (n+9/n+19) 
turns ON when 
PMCR instruction 
is executed. 
However, data 
cannot be properly 
sent or received.

Send processing 
is not executed.

Send wait time set 
for each step of 
the 
communications 
sequence is 
extremely long.

Using the 
CX-Protocol, 
check if the send 
wait time is prop-
erly set.

Bit 10 (destination 
busy receiving) in 
the allocated data 
area (n+7/n+17) is 
ON (destination 
busy).

RTS/CTS flow 
control of trans-
mission control 
parameter is set to 
Yes and the CTS 
signal from the 
destination does 
not turn ON.

Clear the busy 
state of the
destination so that 
the local CTS 
signal turns ON.

Bit 09 (Sequence 
Wait Flag) in the 
allocated data are 
(n+9/n+19) is ON 
(sequence wait).

Wait command 
cannot be cleared.

Review the 
program so that 
bits 00 and 08 
(wait clear switch) 
in the allocated 
data area (n 
words) turn from 
OFF to ON.

Bit 15 (Protocol 
Macro Execution 
Flag) in the 
allocated data 
area (n+9/n+19) 
turns ON 
momentarily or 
does not turn ON 
at all.

Bits 03 and 11 
(forced abort 
switch) in the 
allocated data (n) 
are set to the 
forced setting.

The forced abort 
switch is set to the 
forced setting.

Clear the forced 
abort switch 
setting.

SD@/RD@, 
COM@ indicators 
are lit. However, 
communications 
cannot be 
performed.

Bit 10 (Sequence 
Abort Termination 
Flag) in the 
protocol allocated 
data area (n+9/
n+19) is ON.

Sequence was 
subjected to abort 
termination.

Protocol macro 
data is not 
properly set.
System settings 
such as baud rate 
or frame format 
are different from 
those of the
destination.

Using the trans-
mission line trace 
function of the 
CX-Protocol, 
check if protocol 
data or system 
settings are cor-
rect.

Bit 15 (Protocol 
Macro Execution 
Flag) in the 
allocated data 
area (n+9/n+19) 
remains ON when 
PMCR instruction 
is executed 
without setting the 
monitor time for 
each sequence.

Sequence is being 
executed and 
cannot be 
terminated (data 
receiving state).

Protocol macro 
data is not 
properly set.

System settings 
such as baud rate 
or frame format 
are different from 
those of the 
destination device.

Using the 
transmission line 
trace function of 
the CX-Protocol, 
check if protocol 
data or system 
settings are cor-
rect.

Send data is being 
sent, but no 
response is 
received from the 
destination device.

Allocated data 
area (n+5/n+15) 
(system settings 
with port settings) 
are different from 
those of the 
destination device.

Bits do not match 
due to baud rate 
exceeding the 
permissible range, 
mismatching stop 
bits, etc.

Review the 
system settings.
Review the 
settings and 
program of the 
destination device 
(baud rate, frame 
format, etc.). 

Problem Allocated data 
area

Cause Action

Serial 
communications 

mode setting

Indicator display Status 
information
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Serial 
communications 
mode is set to 
protocol macro.

SD@/RD@, 
COM@ indicators 
are lit. However, 
communications 
cannot be 
performed.

Send data is being 
sent, but no 
response is 
received from the 
destination device.

Bit 15 
(transmission 
error) in the
 allocated data 
area (n+8/n+18) 
turns ON.

One of bits 0 to 14 
(errors) turns ON.

Cable connection 
is faulty.
Setting of the 
2-wire/4-wire 
selection switch on 
the port 2 of RS-
422A/485 does 
not match with the 
wiring.

Adapter 
(NT-AL001, etc.) 
wiring is faulty.

Check the cable 
connection.
Turn ON the 
terminating 
resistance 
(terminating resis-
tance ON/OFF 
switch) on the 
Board side and on 
the final 
destination device 
and turn OFF the 
terminating 
resistances of 
other destination 
devices.

SD@/RD@, 
COM@ indicators 
are not lit.

--- Hardware is faulty. Set bits 11 to 08 
(serial 
communications 
mode) in the allo-
cated DM are (m/
m+10) to F hexa-
decimal (cyclic 
test serial commu-
nications mode), 
connect the cycli-
cally wired con-
nectors, and 
execute the cyclic 
test (turn ON port 
1: bit 06 and port 
2: bit 14 of the n 
word).
Test status is 
reflected on n+9/
n+19.
If the test results 
show an error, 
replace the PMSU.

SD@/RD@, 
COM@ indicators 
are lit. However, 
communications 
cannot be per-
formed and com-
munications errors 
occur from time to 
time.

Transmission error 
occurs.

Bit 15 (transmis-
sion error) in the 
allocated data 
area (n+8/n+18) 
turns ON.
One of bits 0 to 14 
(errors) turns ON.

System settings 
such as baud rate 
or frame format 
are different from 
those of the desti-
nation device.

Bits do not match 
due to baud rate 
exceeding the per-
missible range, 
mismatching stop 
bits, etc.

Review the 
system settings.
Review the 
settings and 
program of the 
destination device 
(baud rate, frame 
format, etc.). 

Allocated data 
area (n+5/n+15) 
(system settings 
with port settings) 
are different from 
those of the desti-
nation device.

Problem Allocated data 
area

Cause Action

Serial 
communications 

mode setting

Indicator display Status 
information
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Serial 
communications 
mode is set to 
protocol macro.

SD@/RD@, 
COM@ indicators 
are lit. However, 
communications 
cannot be per-
formed and com-
munications errors 
occur from time to 
time.

Data is received 
according to the 
transmission line 
trace of the CX-
Protocol. However, 
the protocol macro 
does not recog-
nize data recep-
tion.

--- Received data is 
discarded during 
the time lag 
between the data 
transmission com-
pletion and the 
Send processing 
completion 
because the 
response from the 
destination device 
was received too 
early under the 
half-duplex 
setting.

Change to the 
full-duplex setting.

Responses from 
the destination 
device are occa-
sionally not 
received. How-
ever, response is 
received when 
retry processing is 
conducted.

--- Data sending tim-
ing is too early for 
the destination 
device to receive 
data.

Set or extend the 
send wait time 
(time until send 
data is actually 
sent out) set for 
each step.

Transmission 
error occurs 
occasionally.

Bit 15 
(transmission 
error) in the 
allocated data 
area (n+8/n+18) 
turns ON.

One of bits 0 to 14 
(errors) turns ON.

Cable connection 
is faulty.

Terminating resis-
tance on 
RS-422A/485 port 
is not set properly.

Adapter 
(NT-AL001, etc.) 
wiring is faulty or 
its terminating 
resistance setting 
is wrong.

Check the cable 
connection.

Turn ON the termi-
nating resistance 
(terminating resis-
tance ON/OFF 
switch) on the 
Board side and on 
the final destina-
tion device and 
turn OFF the ter-
minating resis-
tances of other 
destination 
devices.

Communications 
error frequently 
occurs due to 
noise.

Change the cable 
to twisted-pair 
shielded cables.
Separate the 
cables from power 
lines.
Check the possi-
ble environmental 
noise.

Both RDY and 
ERC (ERR/ALM) 
flash.

--- Bit 00 (protocol 
data error) in the 
allocated data 
area (n+1) is ON.

Error in the proto-
col macro data 
SUM value.

Using the 
CX-Protocol, 
transfer correct 
protocol data.

Serial 
communications 
mode is set to 
protocol macro.

RDY is lit and ERC 
(ERR/ALM) 
flashes.

--- Bits 00 to 03 (port 
operation error 
code) in the allo-
cated data area 
(n+9/n+19) are not 
set to 0 hexadeci-
mal. 

Protocol macro 
detected an error 
to stop operation.

Refer to page 181.

Problem Allocated data 
area

Cause Action

Serial 
communications 

mode setting

Indicator display Status 
information
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Note To enable changes in the system settings, reset the power supply and restart
the PMSU, restart the ports, or execute the STUP instruction.

Countermeasures for Errors Displayed as Network Communications Termination Codes 
(A203 to A210)

Network communications termination code Description Action

Bits 08 to 15 Bits 00 to 07

02 hexadecimal 02 hexadecimal PMSU that correspond to the 
unit number address does 
not exist.

Check if the PMCR 
instruction (C1: communica-
tions port number) desig-
nates another PMSU or 
serial port (physical port).

04 hexadecimal 01 hexadecimal Designated service is not 
supported.

Check if the PMCR 
instruction (C1: communica-
tions port number) desig-
nates another PMSU or 
serial port (physical port).

Check if the serial communi-
cations mode of the serial 
port designated in C1 is set 
to protocol macro. (Set the 
serial communications mode 
to protocol macro.)

02 hexadecimal 05 hexadecimal Response has not been 
returned from the destination 
device and the monitor time 
has timed out.

Check if the serial communi-
cations mode of the serial 
port designated in C1 is set 
to protocol macro. (Set the 
serial communications mode 
to protocol macro.)

11 hexadecimal 06 hexadecimal No corresponding 
communications sequence 
number

A number not registered in 
the PMCR instruction (C2: 
communications sequence 
number) has been 
designated.

Using the CX-Protocol, 
register the communications 
sequence.

22 hexadecimal 01 hexadecimal Impossible to execute 
because protocol macro is 
being executed.

An attempt is made to 
execute the PMCR
instruction while protocol 
macro is being executed.

Change the bit 15 (Protocol 
Macro Execution Flag) in the 
allocated data area (n+9/
n+19) to normally closed and 
modify the ladder program to 
execute the PMCR 
instruction.

24 hexadecimal 01 hexadecimal There is no registered table. One of the following;

• Protocol macro (communi-
cations sequence) data 
has not been registered.

• Protocol macro (communi-
cations sequence) data is 
being registered (trans-
ferred).

• Protocol macro (communi-
cations sequence) data 
has SUM value error.

Using the CX-Protocol, 
transfer correct protocol 
macro (communications 
sequence) data.
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Countermeasures for Bits 00 to 03 of Protocol Macro Error Codes (n+9/n+19)

Error code Indicator Description Cause Action

0 hexadecimal Normal --- ---

1 hexadecimal Reserved for the 
system

--- ---

2 hexadecimal No indication Sequence number 
error

A number not 
registered in the 
PMCR instruction 
(C2: communications 
sequence number) 
has been designated.

• Correct the 
communications 
sequence number.

• Using the 
CX-Protocol, 
register the 
designated 
sequence number.

3 hexadecimal ERC flashes and ERR/
ALM flashes.

Data read/write range 
over error

When storing or 
reading data from the 
CPU Unit, designated 
area range is 
exceeded.

In case of operand 
addressing:
Check the contents 
designated in S and D 
operands of PMCR 
instruction.
In case of link word/
direct addressing:
Using the CX-Protocol, 
check the designated 
range.
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4 hexadecimal ERC flashes and 
ERR/ALM flashes.

Protocol data syntax 
error

Some codes could not 
be executed during 
protocol execution.

Check and correct the 
following items:

• Total of the areas 
(O1, O2, I1, and I2) 
designated by the 
link word exceeded 
500 words.

• The same area 
designated by the 
link word was used 
for ports 1 and 2.

• Writing was desig-
nated for the param-
eter designation.

• EM area read/write 
was designated for 
the interrupt notifica-
tion. (Only for the 
Serial Communica-
tions Board)

• Interrupt notification 
was designated for 
the Unit. (Only for 
the Serial Communi-
cations Unit)

• More than 30 write 
attributes were set 
for one message.

• Send/receive 
message length was 
set to 0 bytes.

• Send/receive 
message length 
exceeded the 
maximum send/
receive bytes.

• Message was not 
registered for the 
matrix reception.

• Both the RTS/CTS 
flow control and Xon/
Xoff control were 
designated as 
transmission control.

Error code Indicator Description Cause Action
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4-7-2 C200HX/HG/HE
Problem Cause Action

PMSU does 
not operate.

The RDY indicator turns OFF. PMSU is abnormal Replace the PMSU and 
reconnect the power.

System error 
FAL9C 
occurred.

26800 is ON PMSU is abnormal. Replace the PMSU and 
reconnect the power.

26801 is ON and the RDY indicator 
turns OFF.

This error occurs when the RS-232C 
port is not recognized when the power 
is turned ON due to abnormal 
hardware.

Replace the PMSU and 
reconnect the power.

26802 is ON PMSU protocol data is abnormal. Rewrite the protocol 
data by using the 
Protocol Support Tool.

System errors 
FAL9C and 
FAL9B 
occurred

26815 is ON and the RDY indicator 
flashes.

• The PMSU system setting 
(DM 6550 to DM 6559) has incorrect 
setting values.
If 26813 is ON, the port B has a 
problem.

• The PMSU does not support the 
protocol macro function.

• Check the PMSU 
system setting con-
tents of the problem 
port and restart the 
system.

• Use a PMSU which 
supports the protocol 
macro function.

System error 
FAL9C 
occurred when 
the PMCR 
instruction is 
executed.

26811 is ON (Port B) or 26812 is ON 
(Port A).

The protocol macro error (PMCR 
instruction relating error) occurred. 
The details are registered as error 
codes.

Take necessary actions 
in accordance with the 
error codes.

Instruction 
Execution Flag 
is not set to 
ON. 28908 is 
Port A. 28912 
is Port B.

Error codes
28608 to 11 (Port A)
28612 to 15 (Port B)

Error code: 1 • The PMSU system (DM 6550 to DM 
6559) is not set to the protocol 
macro mode.

• The PMSU does not support the 
protocol macro function.

• Check the PMSU sys-
tem setting contents of 
the problem port.

• Use the PMSU which 
supports the protocol 
macro function.

Error code: 2 The sequence number is not present. Reset the first operand 
of the PMCR instruc-
tion. Otherwise, transfer 
the sequence number to 
the PMSU.

Error code: 3 The received data overflowed when 
writing it in the I/O memory.

Specify another area. 
Otherwise, reduce the 
receive data size.

Error code: 4 The PMSU data error. Rewrite the protocol 
data by using the 
Protocol Support Tool.
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4-8 Communications Response Time Performance
The response performance of communications with the external devices using
PMCR instruction, which varies according to the definition of the Protocol
Macro, is divided in the following four modes:

• Use the event (operand addressing) areas

• Use the interrupt mode for the response type

• Use the link word area

• Use the direct addressing

Problem Cause Action

The data send/
receive is not 
well executed 
despite the 
PMCR instruc-
tion execution.
The Instruc-
tion Execution 
Flag is ON. 
28908 is Port 
A. 28912 is 
Port B

28909 is ON (Port A) or 28913 is ON 
(Port B).

The step is executed the error pro-
cess during the sequence because 
the receive message does not match 
with the expected receive message.

Search the error cause 
and add the appropriate 
process.

28304 is ON (Port A) or 28312 is ON 
(Port B).

The communications error occurred 
during the message receive.

Confirm the 
communications 
route to the 
connected devices.

Communica-
tions with the 
connected 
devices is 
impossible.

28304 is ON (Port A) or 28312 is ON 
(Port B).

This error occurred due to an abnor-
mal communications route to the con-
nected devices or by a 
communications condition setting fail-
ure. The details are registered as 
error codes.
28300 to 03 (Port A)
28608 to 11 (Port B)

• Restart the problem 
port or initialize each 
relay by executing the 
RXD and PMCR 
instructions.

• Confirm the communi-
cations route.

• Check the communica-
tions condition setting.

PMCR instruc-
tions are not 
executed.

ER Flag (25503) is ON. This error occurs by the instruction 
operand setting failure.

Check the instruction 
operand.
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The previous four modes are different in data transmission mode between the
CPU Unit and the Board/Unit. There are three kinds of data transfer modes
from the CPU Unit to the Board/Unit, while there are four kinds of data transfer
modes from the Board/Unit to the CPU Unit. The communications response
time varies according to the combination of those modes.

4-8-1 CS/CJ
• Communications Response Time Using the Event (Operand Addressing)

Area
Illustrated below is the data flow when the communications area
addressed by the third and the fourth operand of the PMCR instruction is
used:

The communications response time is the total time from 1 to 7 in the above
figure.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes
Reverse conversion: 5 μs, ASCII reverse conversion: 4 μs, hexadecimal
reverse conversion: 7 μs
(One-byte conversion time → No conversion: 1 μs, reverse conversion: 5 μs,
ASCII conversion: 10 μs, ASCII reverse conversion: 4 μs, hexadecimal con-
version: 7 μs, hexadecimal reverse conversion: 7 μs)
6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes
(One-byte conversion time → No conversion: 1 μs, reverse conversion: 4 μs
ASCII conversion: 8 μs, ASCII reverse conversion: 9 μs, hexadecimal conver-
sion: 17 μs, hexadecimal reverse conversion: 17 μs)

Number Function Time Required Description

1 PMCR instruction 
process time

15 ms + two-cycle time 
maximum

The internal process time from the 
start of PMCR instruction to the end 
of the data transfer to the Board/Unit.

2 Send data conversion 
process time

Depends on the number 
of conversion bytes

The time required for the send data 
conversion based on the specified 
conversion mode which finishes at 
the start of data sending to the 
external device.

3 Send data transmission 
time

Number of data 
characters x 
one-character 
bit/ transmission rate

The time required for the send data 
transmission to the external device.
(Use double the calculated time 
because idle time exists between 
send characters.)

4 External device process 
time

Depends on the external 
device process

The time required for the external 
device process according to the 
PLC’s command which finishes by 
the start of the response data 
sending.

5 Received data transmis-
sion time

Number of data 
characters x 
one-character 
bit/ transmission rate

The time required for the received 
data transmission from the external 
device.
(Use two to five times the calculated 
time because idle time exists 
between the receive characters.)

6 Received data 
conversion process time

Depends on the number 
of conversion bytes

The time required for the received 
data conversion from the external 
device based on the specified 
conversion mode which finishes at 
the end of data transfer

7 Received data writing 
process time

Board: One-cycle time 
maximum
Unit: Two-cycle time 
maximum

The time required to finish received 
data transfer to I/O memory.
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• Communications Response Performance Using the Interrupt Notification
Mode
Illustrated below is the data flow when the event area (operand address-
ing) is used and the response type is the interrupt mode. The interrupt
notification mode is only available with the Serial Communications Board.

The communications response time is the total time from 1 to 7 in the above
figure.
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Note 1. When interrupt notifications are issued consecutively, a time lag of 2 ms
will occur between notifications. A time lag of 2 ms is provided between in-
terrupt notifications issued consecutively through the ports 1 and 2. 

2. Although the data conversion process times of 2 and 6 vary according to
the PLC operation status, the maximum values can roughly be estimated
by the following calculation formula:
2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes
Reverse conversion: 5 μs, ASCII reverse conversion: 4 μs, hexadecimal re-
verse conversion: 7 μs
(One-byte conversion time → No conversion: 1 μs, reverse conversion:
5 μs, ASCII conversion: 10 μs, ASCII reverse conversion: 4 μs, hexadeci-
mal conversion: 7 μs, hexadecimal reverse conversion: 7 μs)
6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes
(One-byte conversion time → No conversion: 1 μs, reverse conversion:
4 μs ASCII conversion: 8 μs, ASCII reverse conversion: 9 μs, hexadecimal
conversion: 17 μs, hexadecimal reverse conversion: 17 μs)

Number Function Time Required Description

1 PMCR instruction 
process time

15 ms + two-cycle time 
maximum

The time from the start of PMCR 
instruction to the end of the data 
transfer to the Board.

2 Send data conversion 
process time

Depends on the number 
of conversion bytes

The time required for the send data 
conversion based on the specified 
conversion mode which finishes at 
the start of data sending to the 
external device.

3 Send data transmission 
time

Number of data 
characters x 
one-character 
bit/ transmission rate

The time required for the send data 
transmission to the external device.
(Use double the calculated time 
because an idle time exists between 
send characters.)

4 External device process 
time

Depends on the external 
device process

The time required for the external 
device process according to the 
PLC’s command which finishes by 
the start of the response data 
sending.

5 Received data 
transmission time

Number of data 
characters x 
one-character 
bit/ transmission rate

The time required for the received 
data transmission from the external 
device.
(Use two to five times the calculated 
time because idle time exists 
between the receive characters.)

6 Received data 
conversion process time

Depends on the number 
of conversion bytes

The time required for the received 
data conversion from the external 
device based on the specified 
conversion mode which finishes at 
the end of data transfer.

7 Board interrupt process 
time

About 50 μs
(+0 to 2 ms) (see note) 

The time from the response interrupt 
notification to the end of the received 
data transfer to I/O memory.
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• Communications Response Performance Using the Link Word Area
Illustrated below is the data flow when the link word area is used for the
communications data storing area:

The communications response time is the total time from 1 to 8 in the above
figure.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes
Reverse conversion: 5 μs, ASCII reverse conversion: 4 μs, hexadecimal
reverse conversion: 7 μs
(One-byte conversion time → No conversion: 1 μs, reverse conversion: 5 μs,
ASCII conversion: 10 μs, ASCII reverse conversion: 4 μs, hexadecimal con-
version: 7 μs, hexadecimal reverse conversion: 7 μs)
6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes
(One-byte conversion time → No conversion: 1 μs, reverse conversion: 4 μs
ASCII conversion: 8 μs, ASCII reverse conversion: 9 μs, hexadecimal conver-
sion: 17 μs, hexadecimal reverse conversion: 17 μs)

Number Function Time Required Description

1 PMCR instruction execut-
ing notification process 
time

15 ms + two-cycle time 
maximum

The time from the start of PMCR 
instruction to the end of the 
instruction notification to the PMSU.

2 Send data notification 
process time

Board: One-cycle time 
maximum
Unit: Two-cycle time max-
imum

The time required for the data 
transfer based on the PMSU 
request. 

3 Send data conversion 
process time

Depends on the number 
of conversion bytes

The time required for the data 
conversion based on the specified 
conversion mode which finishes at 
the start of data sending to the 
external device.

4 Send data transmission 
time

Number of data 
characters x 
one-character 
bit/ transmission rate

The time required for the data 
transmission to the external device.
(Use double the calculated time 
because idle time exists between 
send characters.)

5 External device process 
time

Depends on the external 
device process

The time required for the external 
device process according to the 
PLC’s command which finishes by 
the start of the response data 
sending.

6 Received data transmis-
sion time

Number of data 
characters x 
one-character 
bit/ transmission rate

The time required for the receive 
data transmission from the external 
device.
(Use two to five times the calculated 
time because idle time exists 
between the receive characters.)

7 Received data 
conversion process time

Depends on the number 
of conversion bytes

The time required for the receive 
data conversion from the external 
device based on the specified 
conversion mode which finishes at 
the end of data.

8 Received data writing 
process time

Board: One-cycle time 
maximum
Unit: Two-cycle time 
maximum

The time required for the received 
data transfer to I/O memory.
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• Communications Response Time Using the Direct Addressing
Illustrated below is the data flow when the direct addressing is used:

The communications response time is the total time from 1 to 8 in the above
figure. The functions 2 and 3 are repeated by the number of variables of the
direct addressing of the send message while 7 and 8 are repeated by those of
the receive message.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes
Reverse conversion: 5 μs, ASCII reverse conversion: 4 μs, hexadecimal
reverse conversion: 7 μs
(One-byte conversion time → No conversion: 1 μs, reverse conversion: 5 μs,
ASCII conversion: 10 μs, ASCII reverse conversion: 4 μs, hexadecimal con-
version: 7 μs, hexadecimal reverse conversion: 7 μs)
6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes
(One-byte conversion time → No conversion: 1 μs, reverse conversion: 4 μs
ASCII conversion: 8 μs, ASCII reverse conversion: 9 μs, hexadecimal conver-
sion: 17 μs, hexadecimal reverse conversion: 17 μs)

Number Function Time Required Description

1 PMCR instruction executing 
notification process time

15 ms + two-cycle time 
maximum

The time from the start of 
PMCR instruction to the end 
of the instruction notification 
to the PMSU.

2 Send data notification pro-
cess time

Board: One-cycle time 
maximum
Unit: Two-cycle time 
maximum

The time required for the 
send data transfer based on 
the PMSU request. 

3 Send data conversion pro-
cess time

Depends on the number of 
conversion bytes

The time required for the sent 
data conversion based on the 
specified conversion mode 
which finishes at the start of 
data sending to the external 
device.

4 Send data transmission time Number of data characters 
x one-character 
bit/ transmission rate

The time required for the data 
transmission to the external 
device.
(Use double the calculated 
time because idle time exists 
between send characters.)

5 External device process time Depends on the external 
device process

The time required for the 
external device process 
according to the PLC’s 
command which finishes by 
the start of the response data 
sending.

6 Received data transmission 
time

Number of data characters 
x one-character 
bit/ transmission rate

The time required for the 
received data transmission 
from the external device.
(Use two to five times the 
calculated time because idle 
time exists between the 
receive characters.)

7 Received data conversion 
process time

Depends on the number of 
conversion bytes

The time required for the 
received data conversion 
from the external device 
based on the specified 
conversion mode which
finishes at the end of data.

8 Received data writing 
process time

Board: One-cycle time 
maximum
Unit: Two-cycle time 
maximum

The time required for the 
received data transfer to I/O 
memory.
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• The Overhead at 1:N Connection
When the link word area or the direct addressing area is used, the send
data is transferred from the CPU Unit at every step, therefore time will be
required before the actual start of the data sending as follows:

• When the link word area is used: The total time of 2 + 3 in the
above figure (the link word)

• When the direct addressing is used: The total time of 2 + 3 in the 
above figure 
(the direct addressing)

These times are not required if the event (operand addressing) area is used,
because the beginning of sequence only in the send data is transferred from
the PLC’s CPU Unit.

4-8-2 C200HX/HG/HE
• Communications Response Time Using the Event (Operand Addressing)

Area
Illustrated below is the data flow when the communications area
addressed by the second and the third operand of the PMCR instruction
is used:

The communications response time is the total time from 1 to 7 in the above
figure.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10,000 μs + one-byte conversion
time x number of conversion bytes
(one-byte conversion time → No conversion: 15 μs, ASCII conversion: 40 μs,
hexadecimal conversion: 55 μs)
6: The receive data conversion process time = 100 μs + one-byte conversion
time x number of conversion bytes (one-byte conversion time→No conver-
sion: 15 μs, ASCII conversion: 30 μs, hexadecimal conversion: 15 μs)

Number Function Time Required Description

1 PMCR instruction pro-
cess time

About 40 to 70 μs The time from the start of PMCR 
instruction to the end of the data 
transfer

2 Send data conversion 
process time

Depends on the number 
of conversion bytes

The time required for the send data 
conversion based on the specified 
conversion mode which finishes at 
the start of data sending to the 
external device.

3 Send data transmission 
time

Number of data 
characters x 
one-character 
bit/ transmission rate

The time required for the send data 
transmission to the external device.
(Use double the calculated time 
because idle time exists between 
send characters.)

4 External device process 
time

Depends on the external 
device process

The time required for the external 
device process according to the 
PLC’s command which finishes by 
the start of the response data 
sending.

5 Received data transmis-
sion time

Number of data 
characters x 
one-character 
bit/ transmission rate

The time required for the received 
data transmission from the external 
device.
(Use two to five times the calculated 
time because idle time exists 
between the receive characters.)

6 Received data conversion 
process time

Depends on the number 
of conversion bytes

The time required for the received 
data conversion from the external 
device based on the specified 
conversion mode which finishes at 
the end of data transfer

7 Received data writing 
process time

One-cycle time maximum The time required to finish received 
data transfer to I/O memory.
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• Communications Response Performance Using the Interrupt Notification
Mode
Illustrated below is the data flow when the event area (operand address-
ing) is used and the response type is the interrupt mode:

The communications response time is total time from 1 to 7 in the above fig-
ure.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10,000 μs + one-byte conversion
time x number of conversion bytes
(One-byte conversion time→No conversion: 15 μs, ASCII conversion: 40 μs,
hexadecimal conversion: 55 μs)
6: The received data conversion process time = 100 μs + one-byte conversion
time x number of conversion bytes
(one-byte conversion time→No conversion: 15 μs, ASCII conversion: 30 μs,
hexadecimal conversion: 15 μs)

Number Function Time Required Description

1 PMCR instruction 
process time

About 40 to 70 μs The time from the start of PMCR 
instruction to the end of the data 
transfer.

2 Send data conversion 
process time

Depends on the number 
of conversion bytes

The time required for the send data 
conversion based on the specified 
conversion mode which finishes at 
the start of data sending to the exter-
nal device.

3 Send data transmission 
time

Number of data 
characters x 
one-character
bit/ transmission rate

The time required for the send data 
transmission to the external device.
(Use double the calculated time 
because idle time exists between 
send characters.)

4 External device process 
time

Depends on the external 
device process

The time required for the external 
device process according to the 
PLC’s command which finishes by 
the start of the response data send-
ing.

5 Received data 
transmission time

Number of data 
characters x 
one-character
bit/ transmission rate

The time required for the received 
data transmission from the external 
device.
(Use two to five times the calculated 
time because idle time exists 
between the receive characters.)

6 Received data 
conversion process time

Depends on the number 
of conversion bytes

The time required for the received 
data conversion from the external 
device based on the specified con-
version mode which finishes at the 
end of data transfer.

7 PMSU interrupt process 
time

About 50 μs The time from start of response 
interrupt notification to the end of the 
received data transfer to 
I/O memory.
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• Communications Response Performance Using the Link Word Area
Illustrated below is the data flow when the link word area is used for the
communications data storing area:

The communications response time is the total time from 1 to 8 in the above
figure.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10,000 μs + one-byte conversion
time x number of conversion bytes
(one-byte conversion time→No conversion: 15 μs, ASCII conversion: 40 μs,
hexadecimal conversion: 55 μs)
6: The receive data conversion process time = 100 μs + one-byte conversion
time x number of conversion bytes
(one-byte conversion time→No conversion: 15 μs, ASCII conversion: 30 μs,
hexadecimal conversion: 15 μs)

Number Function Time Required Description

1 PMCR instruction 
executing notification 
process time

About 40 μs The time from the start of PMCR 
instruction to the end of the 
instruction notification to the PMSU.

2 Send data notification 
process time

One-cycle time maximum The time required for the data trans-
fer based on the PMSU request. 

3 Send data conversion 
process time

Depends on the number 
of conversion bytes

The time required for the data 
conversion based on the specified 
conversion mode which finishes at 
the start of data sending to the 
external device.

4 Send data transmission 
time

Number of data charac-
ters x one-character bit/ 
transmission rate

The time required for the data 
transmission to the external device.
(Use double the calculated time 
because idle time exists between 
send characters.)

5 External device process 
time

Depends on the external 
device process

The time required for the external 
device process according to the 
PLC’s command which finishes by 
the start of the response data 
sending.

6 Received data transmis-
sion time

Number of data charac-
ters x one-character bit/ 
transmission rate

The time required for the receive 
data transmission from the external 
device.
(Use two to five times the calculated 
time because idle time exists 
between the receive characters.)

7 Received data conversion 
process time

Depends on the number 
of conversion bytes

The time required for the receive 
data conversion from the external 
device based on the specified 
conversion mode which finishes at 
the end of data.

8 Received data writing 
process time

One-cycle time maximum The time required for the received 
data transfer to I/O memory.
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• Communications Response Time Using the Direct Addressing
Illustrated below is the data flow when the direct addressing is used:

The communications response time is the total time from 1 to 8 in the above
figure. The functions 2 and 3 are repeated by the number of variables of the
direct addressing of the send message while 7 and 8 are repeated by those of
the receive message.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10,000 μs + one-byte conversion
time x number of conversion bytes
(one-byte conversion time→No conversion: 15 μs, ASCII conversion: 40 μs,
hexadecimal conversion: 55 μs)
6: The receive data conversion process time = 100 μs + one-byte conversion
time x number of conversion bytes
(one-byte conversion time→No conversion: 15 μs, ASCII conversion: 30 μs,
hexadecimal conversion: 15 μs)

Number Function Time Required Description

1 PMCR instruction executing 
notification process time

About 40 μs The time from the start of 
PMCR instruction to the end 
of the instruction notification 
to the PMSU.

2 Send data notification 
process time

One-cycle time maximum The time required for the 
send data transfer based on 
the PMSU request. 

3 Send data conversion 
process time

Depends on the number of 
conversion bytes

The time required for the sent 
data conversion based on the 
specified conversion mode 
which finishes at the start of 
data sending to the external 
device.

4 Send data transmission time Number of data characters x 
one-character bit/ transmis-
sion rate

The time required for the data 
transmission to the external 
device.
(Use double the calculated 
time because idle time exists 
between send characters.)

5 External device process time Depends on the external 
device process

The time required for the 
external device process 
according to the PLC’s 
command which finishes by 
the start of the response data 
sending.

6 Received data transmission 
time

Number of data characters x 
one-character bit/ transmis-
sion rate

The time required for the 
received data transmission 
from the external device.
(Use two to five times the 
calculated time because idle 
time exists between the 
receive characters.)

7 Received data conversion 
process time

Depends on the number of 
conversion bytes

The time required for the 
received data conversion 
from the external device 
based on the specified 
conversion mode which 
finishes at the end of data.

8 Received data writing 
process time

One-cycle time maximum The time required for the 
received data transfer to I/O 
memory.
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• The Overhead at 1:N Connection
When the link word area or the direct addressing area is used, the send
data is transferred from the CPU Unit at every step, therefore time is
required before the actual start of the data sending as follows:

• When the link word area is used: The total time of 2 + 3 in the
above figure (the link word)

• When the direct addressing is used: The total time of 2 + 3 in the 
above figure 
(the direct addressing)

These times are not required if the event (operand addressing) area is used,
because the beginning of sequence only in the send data is transferred from
the PLC’s CPU Unit.

4-9 Cycle Time Performance
When using the protocol macro function with the PMSU, the cycle time for the
CPU Unit of the CS/CJ will vary within the ranges shown below. In order to fix
the cycle time, using the fixed cycle time function at the CPU Unit, set a fixed
cycle time based on the value for the maximum variation time. 

• Serial Communications Board
Minimum variation time = 0.25 ms (common processing time)
Maximum variation time = 0.25 ms + 0.001 ms × maximum number of
words of send/receive data (0 to 500 words) + 1.3 ms

• Serial Communications Unit
Minimum variation time (per Unit) = 0.25 ms (common processing time)
Maximum variation time (per Unit) = 0.25 ms + 0.001 ms × maximum
number of words of send/receive data (0 to 500 words)
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SECTION 5
Object Creation

This section describes how to create objects, such as projects, protocols, sequences, steps, messages, and matrices.
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Creating Projects and Protocols Section 5-1
5-1 Creating Projects and Protocols

5-1-1 Creating a New Project
Use the following procedure to create a new project.

Create a new project following the steps 1 and 2 below if the CX-Protocol has
been started from the Windows Start Menu, or by right-clicking a Serial Com-
munications Board/Unit in the I/O Table Window opened from the CX-Pro-
grammer and selecting Start Special Application – Start Only from the pop-
up menu.

Steps 1 and 2 will not be required if the CX-Protocol has been started by
selecting Start Special Application – Start with Settings Inherited from the
pop-up menu.

A new project will be automatically created and the Device Type setting and
online/offline status will be inherited from the CX-Programmer. 

1,2,3... 1. Select New from the File Menu or left-click the New Button from the tool-
bar. Alternatively, a new project is created by pressing the Ctrl+N Keys.

2. The following window will be displayed. Select the device type and network
type.

For details of settings, refer to 10-2 Communications Settings between
Personal Computer and PLC.
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Creating Projects and Protocols Section 5-1
3. The following project window will be displayed when the device type is se-
lected.

Each new project is given a default name “PSW@,” which is displayed in
the title bar, and may be changed prior to saving the project.

5-1-2 Creating a New Protocol
Use the following procedure to create a new protocol in the protocol list.

1,2,3... 1. Double-click the Project Icon in the project workspace and select and
highlight the protocol list. Alternatively, the protocol list is highlighted by
left-clicking or double-clicking the Protocol List Icon in the project window.

2. Select Create by right-clicking the Protocol List Icon in the project work-
space. Alternatively, point to Create from the pop-up menu in the project
window and select Protocol or select Protocol from the Protocol Menu.
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3. Select the protocol type by left-clicking the CS/CJ Protocol Icon or the
C200HX/HG/HE Protocol Icon according to the protocol type.

5-1-3 Renaming a Protocol
The new protocol under the default name New Protocol will be displayed
in the project window. Use the following procedure to rename the protocol.

1,2,3... 1. Left-click the Protocol Name in the project window, or select the Protocol
Name and press the Enter Key. The current protocol name will become an
editable field.

2. Input the new protocol name and press the Enter Key. The new protocol
name must not exceed 30 characters.
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5-1-4 Setting the Protocol Sequence Number Range
Use the following procedure to specify the sequence numbers that are used
by the specified protocol within a range between 000 and 999. The range of
sequence numbers used by system protocols cannot be changed.

1,2,3... 1. Left-click the Start Sequence associated with the protocol in the protocol
list. Alternatively, select the Start Sequence and press the Enter Key. The
current start sequence will become an editable field.

2. Input the starting number and press the Enter Key.

3. Input the end number and press the Enter Key.

Input the value within a range between 000 and 999 into the Start Se-
quence or End Sequence Fields for the associated protocol.

5-1-5 Setting the Board and Unit
Set the PMSU, through which protocols are transferred online to the PLC.

1,2,3... 1. Left-click the Target. Once the online connection is enabled, the names of
the PMSU actually mounted will be displayed.

Note If the project has not been used online yet, SCB (Not Fitted) for the
Serial Communications Board and No Unit [Unit No.] for the Serial
Communications Unit will be displayed.

2. Select the Board/Unit from the drop-down list. If the PLC is CS/CJ, select
SCB for the Serial Communications Board and specify the unit number for
each Serial Communications Unit (SCU [ ]). If the PLC is the C200HX/
C200HG/C200HE, select the Communications Board.

Example: The Serial Communications Unit with unit number 0 is selected
online for the CS/CJ.
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5-2 Creating Sequences and Steps
5-2-1 Creating a New Sequence

Use the following procedure to create a new sequence in the protocol.

1,2,3... 1. Double-click the Protocol List Icon in the project workspace and select
and highlight the protocol where the new sequence is to be created. Alter-
natively, left-click or double-click the CS/CJ Protocol Icon or C200HX/
C200HG/C200HE Protocol Icon in the project window according to the
protocol type.

2. Select Sequence by right-clicking the Protocol Icon in the project work-
space. Alternatively, select the Create from the pop-up menu in the project
window or select Sequence from the Protocol Menu.

3. The new protocol with the default name New Sequence will be displayed
in the protocol.

Note For details of each input item, refer to SECTION 7 Sequence Setting and Edit-
ing.

5-2-2 Creating a New Step
Use the following procedure to create a new step in the sequence.

1,2,3... 1. Double-click the Protocol Icon in the project workspace and select and
highlight the sequence where the new step is created. Alternatively, dou-
ble-click the Sequence Icon in the project window. 

2. Right-click on the sequence icon in the project workspace or in the project
window, point at New in the pop-up menu, and select Step. The step can
also be selected from the Protocol Menu. The new step will be added to
the list.
208



Creating Messages and Matrices Section 5-3
Note For details of each input item, refer to SECTION 8 Step Setting and Editing.

5-3 Creating Messages and Matrices

5-3-1 Creating a New Message
Use either of the following procedures to create a new message.

1,2,3... 1. Right-click the Send Message or Receive Message Field in the step list,
and select New Message from the pop-up menu, when the Message Ed-
itor Dialog Box will be displayed. Specify each input item and order in the
dialog box.

2. Create the new message in the message list independently from the steps
and input each item in either of the following method.

a) Input the data for each item field beginning with the header. Specify
and input the order and items of the data in the data field.

b) Display the Message Editor Dialog Box from the data field. Specify
and input the order and items of the order in the dialog box.

Creating a New Message in Send Message or Receive Message Field for a Step 
Use the following procedure to create a new message for a step.

1,2,3... 1. Right-click the Send Message or Receive Message Field for a step and
select New Message from pop-up menu.

2. The Message Editor Menu Dialog Box will be displayed. Input the mes-
sage name in the Name Field.

3. Create the message as appropriate. Refer to 9-1 Creating Messages for
details on how to construct a message.

4. Left-click the OK Button to accept the settings. Click the Cancel Button to
leave the settings unchanged.
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Creating a New Message from the Message List
Use the following procedure to create a new message from the message list.

1,2,3... 1. Double-click the Protocol Icon in the project workspace and select and
highlight the receive message or send message list. Alternatively, double-
click the Receive Message List Icon or Send Message List Icon in the
project window.

2. Select the send message or receive message references by right-clicking
the Send Message List Icon in the project workspace. Alternatively, select
the Create from the pop-up menu in the project window and select the
send message or receive message references or select the send message
or receive message references from the Protocol Menu.

3. Left-click Data and left-click the Enter Button or press the Enter Key. The
Message Editor Menu Dialog Box will be displayed. For details of how to
create a message, refer to 9-1 Creating Messages.

5-3-2 Creating a New Matrix
Use the following procedure to create a new matrix.

1,2,3... 1. Left-click the Protocol Icon in the project workspace and select and high-
light the Matrix List. Alternatively, double-click the Matrix List Icon in the
project window.

2. Right-click either the Matrix List in the project workspace or right-click the
project window, select Create from the pop-up menu, and select Matrix.
Matrix can also be selected from the Protocol Menu.

Note A new matrix cannot be created from any step. Create it in the matrix list.

Creating a New Case for a Matrix
Use the following procedure to create a new message in a matrix.

1,2,3... 1. Left-click the Matrix List Icon in the project workspace and select and
highlight the matrix, for which a new case is created. Alternatively, double-
click the Matrix Icon in the project window.

2. Select Matrix Case by right-clicking the matrix position in the project work-
space. Alternatively, select the Create from the pop-up menu and select
Matrix or select Matrix from the Protocol Menu.
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5-4 System Protocol Display and Editing

5-4-1 Displaying System Protocols
System protocols are available for communications with OMRON’s Units,
such as the Temperature Controller, Panel Meter, Bar-code Reader, and
Modem. By clicking the System Tab on the bottom of the project workspace,
the system protocol list will be displayed. By double-clicking the Project Icon
in the project workspace and double-clicking the Protocol List Icon, the pro-
tocol list will be displayed in the project window. Alternatively, the protocol list
will be displayed by double-clicking the Protocol List Icon in the project win-
dow.

Note The system protocol varies with the System. The contents of the protocol
cannot be edited directly or displayed on screen in the right pane.

The contents can be edited or displayed by copying the system protocol to a
user defined protocol, but the protocol type changes to User once pasted into
a new protocol list. A sequence as well as a system protocol can be copied.

5-4-2 Copying System Protocols or Sequences
Use the following procedure to copy system protocols.

Copying and Pasting All the Protocols in the List to New Project

1,2,3... 1. Select New from the File Menu or left-click the New Icon from the toolbar
and create a new project.

2. Left-click the System Tab on the bottom of the project workspace, select
the protocol list icon in the project workspace, and press the Ctrl+C Keys
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or right-click and select Copy from the pop-up menu. Alternatively, select
Copy from the Edit Menu.

3. Left-click the Project Tab on the bottom of the project workspace. After
left-clicking the Project Icon, press the Ctrl+V Keys or left-click the Paste
Icon or right-click and select the Paste Button from the pop-up menu in the
project window or select Paste from the Edit Menu. The protocols will be
copied to the new project.

Copying and Pasting Selected Protocol(s) to New Project

1,2,3... 1. Select New from the File Menu or left-click the New Button from the toolbar
and create a new project.

2. Left-click the System Tab on the bottom of the project workspace, select
the Protocol List Icon in the project workspace, and select the protocol to
be copied in the project window. More than one protocol can be selected
by pressing the Shift Key and selecting another protocol to extend the se-
lection, or by pressing the Ctrl Key and selecting another protocol to add
to the selection.

3. Press the Ctrl+C Keys or left-click the Copy Icon and select Copy from the
pop-up menu. Alternatively, select Copy from the Edit Menu.

4. After selecting the new project and selecting the Protocol List Icon to be
pasted into the project workspace, press the Ctrl+V Keys or left-click the
Paste Icon or right-click and select Paste from the pop-up menu or select
Paste from the Edit Menu. The system protocol or system protocols se-
lected will be copied to the protocol list in the new project.

Copying and Pasting a Sequence to a Specified Protocol

1,2,3... 1. Select New from the File Menu or left-click the New Button from the toolbar
and create a new project.

2. Left-click the System Tab on the bottom of the project workspace and se-
lect the sequence.

3. Press the Ctrl+C Keys or left-click the Copy Icon or right-click and select
Copy from the pop-up menu. Alternatively, select Copy from the Edit
Menu.

4. Select the Protocol Icon of the destination and press the Ctrl+V Keys or
left-click the Paste Icon or right-click and select Paste from the pop-up
menu. Alternatively, select Paste from the Edit Menu. The selected se-
quence will be placed at the end of the protocol. Send or receive messages
will not be copied together with the sequence.

Note Standard system protocol sequences cannot be pasted into an C200HX/HG/
HE protocol.
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SECTION 6
Project and Protocol Editing

This section describes details of the editing of projects and protocols.

6-1 Editing Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214
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6-1 Editing Projects
A project consists of a protocol list, trace list, and PLC. The protocol list
includes all the protocols in the project. A protocol consists of sequences. The
PLC is in control of the system setup and the tracing of send and receive mes-
sages. The trace list is data of trace results added to the project. The CX-Pro-
tocol uses each project as a single file for the control and management of the
protocols, trace list, and PLC.
Refer to 10-1 PLC System Configuration for details of the PLC. Refer to 12-1
Tracing Transmission Lines for details of the trace.

Note Keep the following in mind before using a floppy disk.

• Be sure to copy the project files in the floppy disk to the hard disk before
using the project files.

• Do not save project files directly to the floppy disk. Save the project files in
the hard disk first. Then use an appropriate Windows program, such as
the Explorer, to copy the project files to the floppy disk.

• Do not eject the floppy disk from the disk drive while the projects in the
floppy disk are in use.

• If a message is displayed advising the user that the disk is full while over-
writing the projects, it means that the floppy disk does not have adequate
space and the project files cannot be saved. If this happens, be sure to
save the project files in the hard disk.

6-1-1 Adding Information to a Project
Use the following procedure to add information to a project.

1,2,3... 1. Right-click the project name in the project workspace and select Proper-
ties from the pop-up menu. The Properties Dialog Box will be displayed.

2. Input the information on the project and left-click the Apply Button. Left-
click the Cancel Button to leave the settings unchanged.

6-1-2 Opening a Project
Use the following procedure to open an existing project.

1,2,3... 1. Select Open from the File Menu or left-click the Open Icon from the toolbar
or press the Ctrl+O Keys.

2. The Open Dialog Box will be displayed.
Select the project from the list in the dialog box. The project file *.psw will
be displayed as a default project file. If any other type of file is required, se-
lect it from the File of Type drop-down list.
The following types of files are available. If opening any file other than
project files, refer to 11-3 Importing Protocol Data from PST/PSS Files.
The CX-Protocol project file is created by the CX-Protocol, the PST project
file is created by the SYSMAC-PST, and the PSS files are created by DOS
Protocol Support Software.

File type Contents File 
extension

Read Write

CX-Protocol project file Project file created by the CX-Protocol *.psw ❍ ❍

PST project file Project file created by the 
SYSMAC-PST

*.psw ❍ ×

PSS system setup file Setup data file of communications ports 
A and B of PSS communications board

*.pts ❍ ×

PSS protocol file File with PSS protocol data only *.pt1 ❍ ×
PSS trace data file File with PSS or SYSMAC-PST trace 

data only
*.ptr ❍ ×
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To change the current folder for another one, select the folder from File
Look in in the drop-down list.

3. Left-click the Open Button or double-click the selected project. The project
will open. Left-click the Cancel Button to leave the settings unchanged.

Note The icons on the right-hand side in the File Look in Field have the following
functions.

• By left-clicking the Up One Level Icon, the folder one level higher is
opened.

• By left-clicking the Create New Folder Icon, the new folder is created in
the current folder.

• By left-clicking the List Icon, the folder name and the file names in the
current folder are listed on screen.

• By left-clicking the Details Icon, the folder name and the names, sizes,
types, and last-modified dates of the files in the current folder will be dis-
played.

6-1-3 Opening Project Windows
The CX-Protocol makes it possible to open more than one project window.

After opening a new window, it is possible to display the projects currently
opened in other windows and other projects can be displayed in the new win-
dow.

To add a new project window for the projects currently opened, select New
Window from the Window Menu. The new project window will be displayed
on the front side and each of the previous project windows will be placed
behind. Each window is given a unique identifier.

6-1-4 Overwriting and Renaming a Project
Use the following procedure to overwrite a project.

1,2,3... 1. Select Save from the File Menu or left-click the Save Icon from the toolbar,
or select Save from the pop-up menu after right-clicking the Project Icon
or pressing the Ctrl+S Keys.

2. The project will be saved under the present project name.

When saving a new project in this method, the Save as Dialog Box will be
displayed with the default file name, “PSW@.” Change the default name to
an appropriate name.

Note Input the project name in the File name Field of the Save as Dialog Box.

6-1-5 Saving a Project
To save an existing project under a different project name or save a new
project under a new name, right-click the Project Icon and select Save as
from the pop-up menu.

Use the following procedure to save the project under a different name.

1,2,3... 1. Select Save as from the File Menu or right-click the Project Icon and se-
lect Save as from the pop-up menu. The Save as Dialog Box will be dis-
played on screen.

2. To change the current folder for another one, select the folder from File
Save in in the drop-down list. Then change the Save as type Field to CX-
Protocol project file (*.psw).
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Input the project name in the File name Field. To overwrite a project, select
the project from the list.

3. Left-click the Save Button or press the Enter Key. Left-click the Cancel
Button to close the Save as Dialog Box without saving the project.

6-1-6 Closing a Project
To close a currently open project, select Close from the File Menu or left-click
the Close Button from the project window. Closing a project will require confir-
mation if the project has not been saved since its last edit. Select Yes Button
to save the project.

6-2 Editing Protocols

6-2-1 Displaying a Protocol List
Use either of the following procedures to display a protocol list for the current
project.

• By double-clicking the Project Icon in the project workspace and double-
clicking the Protocol List Icon, the protocol list will be displayed in the
project window.

• By double-clicking the Protocol List Icon in the project window, all the
protocols in the protocol list will be displayed on screen.

6-2-2 Renaming a Protocol in the List
Use the following procedure to rename a registered protocol.

Note System protocol names cannot be changed.

1,2,3... 1. Left-click the Protocol Name setting in the protocol list or select the Pro-
tocol Name setting. Press the Enter Key. 

2. The current protocol name will become an editable field. Input the new pro-
tocol name and press the Enter Key. The new protocol name must not ex-
ceed 30 characters.

Note Once a protocol has been deleted it cannot be recovered.

6-2-3 Deleting a Protocol from the List
Use the following procedure to delete a protocol.

Note System protocols cannot be deleted.

1,2,3... 1. Left-click the icon of the protocol to be deleted from the protocol list. More
than one protocol can be selected by pressing the Shift Key and selecting
another protocol to extend the selection, or by pressing the Ctrl Key and
selecting another protocol to add to the selection.

2. Left-click the Delete Icon from the toolbar or press the Delete Key or left-
click the Cut Icon from the toolbar or press the Ctrl+X Keys to delete the
protocol. The project can be deleted by right-clicking and selecting Delete
from the pop-up menu.

Note Once a protocol has been deleted it cannot be recovered.
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6-2-4 Copying a Protocol
Use the following procedure to copy a protocol.

Note System protocols can be copied, but the protocol type will change to User
once pasted into a new protocol list.

1,2,3... 1. Left-click the icon of the protocol to be copied from the protocol list. More
than one protocol can be selected by pressing the Shift Key and selecting
another protocol to extend the selection, or by pressing the Ctrl Key and
selecting another protocol to add to the selection.

2. Left-click the Copy Icon from the toolbar or press the Ctrl+C Keys. Alter-
natively, right-click and select Copy from the pop-up menu or select Copy
from the Edit Menu.

3. Display a protocol in the project window so that the copied protocol or pro-
tocols can be pasted into the protocol.

4. Left-click the Paste Icon from the toolbar or press the Ctrl+V Keys. Alter-
natively, right-click and select Paste from the pop-up menu or select Paste
from the Edit Menu. The pasted protocols will be placed at the end of the
protocol list.
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7-1 Setting Sequences. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220

7-1-1 Sequence Setting Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220

7-1-2 Setting Sequences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220

7-2 Editing Sequences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

7-2-1 Displaying a Sequence List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

7-2-2 Renaming Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

7-2-3 Changing an Existing Sequence Number. . . . . . . . . . . . . . . . . . . . . 227

7-2-4 Copying/Pasting Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227

7-2-5 Deleting Sequences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
219



Setting Sequences Section 7-1
7-1 Setting Sequences
7-1-1 Sequence Setting Screen

Refer to 3-2 Sequence Attributes (Common to All Steps) for details on setting.

7-1-2 Setting Sequences
Settings that can be made for sequences using the CX-Protocol are shown in
the following table.

Note 1. WR is only for the CS/CJ.

Sequence name

Link word setting

Transmission control method

Response type

Receive wait time Tr

Receive finish time Tfr

Send finish time Tfs

Attribute Content

Link Word Link 1 IN IN Area None, CIO, WR*1, LR*2, HR, AR, DM, EM.

Address Refer to Link Word Designation in the following 
section.Length

OUT OUT Area None, CIO, WR*1, LR*2, HR, AR, DM, EM.

Address Refer to Link Word Designation in the following 
section.Length

Link 2 IN IN Area None, CIO, WR*1, LR*2, HR, AR, DM, EM.

Address Refer to Link Word Designation in the following 
section.Length

OUT OUT Area None, CIO, WR*1, LR*2, HR, AR, DM, EM.

Address Refer to Link Word Designation in the following 
section.Length

Transmission 
Control

RTS/CTS None, Send, Receive, Send & Receive

Xon/Xoff None, Send, Receive, Send & Receive

Modem Select With/without using the check box.

Contention Send Request 
Code

Code, ASCII, hexadecimal

Delimiters Delimiter Send 
Code

Code, ASCII, hexadecimal

Delimiter 
Receive Code

Code, ASCII, hexadecimal

Response Type Scan*3, Interrupt: Fixed #, Interrupt: Receive Case #

Timer Tr Value 00 to 99

Timer Unit 0.01s, 0.1s, 1s, 1 min

Timer Tfr Value 00 to 99

Timer Unit 0.01s, 0.1s, 1s, 1 min

Timer Tfs Value 00 to 99

Timer Unit 0.01s, 0.1s, 1s, 1 min
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2. LR is only for the C200HX/HG/HE.

3. Default setting for the CX-Protocol.

Link Word Designation Designate the data area shared between the PLC and Board/Unit. This set-
ting is made for every sequence (common to steps).

When using the Link Channel Designation for designating the storage areas
for send/receive data, the code numbers (I1, I2, O1, O2) designated here will
be used.

1,2,3... 1. Left-click the Link Word Field of the sequence and then left-click the Enter
Button or press the Enter Key.
The Link Channel Information Dialog Box will be displayed.

Perform Link 1 setting according to the following procedure. Follow the same
procedure for the Link 2.

2. Select an appropriate area (CIO, WR, LR, HR, AR, DM) from the IN Area
drop-down list in the Link 1 Field. Select None if setting is not required.

3. Input the first word address of the IN Area of Link 1 in the Addr Field.

4. Input the number of words of the IN Area of Link 1 into the Len Field.

5. Set the area type, beginning address, and length for the OUT Area accord-
ing to the same procedure.

6. Either press the OK Button to accept the setting or press the Cancel But-
ton to leave the settings unchanged.

The areas and setting ranges that can be used for link words are shown in
the following list.

Note 1. CIO indicates the I/O area, IR area, and AR area.

2. EM bank cannot be used for link words.

PLC model CS-series C200HX/HG/HE

Area and 
address that can 
be used for link 
word setting

CIO: 0000 to 6143
WR: 000 to 511
HR: 000 to 511
AR: 000 to 959
DM: 00000 to 32767
EM (note 2): 00000 to 32767

CIO (note 1): 000 to 511
LR: 00 to 63
HR: 00 to 99
AR: 00 to 27
DM: 0000 to 6655
EM (note 2): 0000 to 6143

Ranges 
of link 
words

I1 0 to 500 0 to 128

O1 0 to 500 0 to 128

I2 0 to 500 0 to 128

O2 0 to 500 0 to 128

The sum of I1+O1+I2+02 
must be equal to or less than 
500 words.

The sum of I1+O1+I2+02 
must be equal to or less than 
128 words.
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Setting Transmission 
Control Method

Set the same transmission control method as that designated by the external
device (communications partner).
The transmission control method can be set to more than one method (for
example, RTS/CTS flow control and modem control).

1,2,3... 1. Left-click the Control Field of the sequence and then left-click the Enter
Button or press the Enter Key.
The Transmission Control Dialog Box will be displayed.

2. Set the parameters in the Transmission Control Dialog Box.
3. Left-click the OK Button to accept the settings or left-click the Cancel But-

ton to leave the settings unchanged. If any of the following settings are
made, “Set” will be displayed in the Control Field of the sequence.

RTS/CTS Flow Control

Data can be transmitted through the RTS/CTS flow control. Select an RTS/
CTS control method from the drop-down list.
If the RTS/CTS Field is set to None, RTS/CTS flow control will not be per-
formed.
If the RTS/CTS Field is set to Send, RTS/CTS flow control will be performed
only when sending.
If the RTS/CTS Field is set to Receive, RTS/CTS flow control will be per-
formed only when receiving.
If the RTS/CTS Field is set to Send & Receive, RTS/CTS flow control will be
performed for both send and receive processing.
222



Setting Sequences Section 7-1
Xon/Xoff Flow Control
Data can be transmitted through the Xon/Xoff flow control. Select an Xon/Xoff
control method from the drop-down list: None, Send, Receive and
Send & Receive are available.

If the Xon/Xoff Field is set to None, Xon/Xoff flow control will not be per-
formed.

If the Xon/Xoff Field is set to Send, Xon/Xoff flow control will be performed
only when sending.

If the Xon/Xoff Field is set to Receive, Xon/Xoff flow control will be performed
only when receiving.

If the Xon/Xoff Field is set to Send & Receive, Xon/Xoff flow control will be
performed for both send and receive processing.

Note If both the RTS/CTS flow control and Xon/Xoff control are set for the CS/CJ
Series, a Protocol Macro Syntax Error will be displayed when protocol
macro is executed.

Modem Control
Data can be transmitted through the modem control. Left-click the Modem
check box to either enable or disable the modem control. 

If the Modem check box is not checked, modem control will not be performed.
If the Modem check box is checked, modem control will be performed.

Contention Control
Data can be transmitted under the contention control. Left-click the Conten-
tion check box to either enable or disable contention control.

If the Contention check box is not checked, contention control will not be per-
formed.

If the Contention check box is checked, contention control will be performed.
This means that in order to obtain the right to send, a Send Request Code
must be transmitted.
A send request code can be specified in Code, ASCII or Hexadecimal. Select
a code from the Contention Send Request Code drop-down list. Select one
from Code, ASCII, or HEX.

[Code]

1,2,3... 1. Select Code from the drop-down list.

2. Left-click the Edit Button. The Code Entry Dialog Box will be displayed.

3. Select Special Code. Up to four special codes may be entered. Select the
codes from the drop-down list and left-click the Insert Button to input the
code(s) indicated.
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Note Five or more special codes cannot be input. Left-click the Clear But-
ton to clear all the special codes and input them again from the be-
ginning. Left-click the Delete Button to delete the special code where
the cursor is located. Left-click the << or >> Button to move the cur-
sor position.

4. Press the OK Button to accept the settings or press the Cancel Button to
leave the settings unchanged.

[ASCII]

1,2,3... 1. Select ASCII from the drop-down list.

2. Type in ASCII characters (up to four characters) in the right field.

[Hexadecimal]

1,2,3... 1. Select HEX from the drop-down list.

2. Left-click the Edit Button.
The HEX Entry Dialog Box will be displayed.

3. Select a button that corresponds to one digit of the hexadecimal digit. Up
to eight digits may be entered. They will be displayed at the top of the dia-
log box. (If the 9th digit is entered, the 1st digit will be deleted.)

Note Left-click the CLR Button to clear all the special codes. After clearing
all the special codes, input them again from the beginning. Left-click
the DEL Button to delete the special code where the cursor is locat-
ed.

4. Left-click the Enter Button to accept the settings or the Cancel Button to
leave the settings unchanged.

Delimiters

Data can be transmitted through the delimiter control. Left-click the Delimit-
ers check box to either enable or disable the delimiter control.

If the Delimiters check box is not checked, delimiter control will not be per-
formed.

If the Delimiters check box is checked, the delimiter control will be performed.

The delimiter set in the send and receive code can be designated in Code,
ASCII, or Hexadecimal. Select one of them from the Delimiter Send Code or
Delimiter Receive Code drop-down list. The input methods for the Code,
ASCII, and Hexadecimal are the same as for the contention control.

Response Type Use the following procedure to set the timing for writing received data in the I/
O memory (designated by the fourth operand of the PMCR instruction for the
CS/CJ and by the third operand of the PMCR instruction for the C200HX/HG/
HE) and also to set the method for notifying the setting to the PLC.

This setting will be valid only when the write area is designated by the oper-
and of the PMCR instruction and when the setting of the with/without
response writing is set to Yes. 

The notification types include Scan, Interrupt: Fixed # (See note.) and Inter-
rupt: Receive Case # (See note.).

Note With the CS, the Interrupt : Fixed # and the Interrupt: Receive Case # are
applicable to the Serial Communications Board and with the C200HX/HG/HE,
they are applicable only to the Communications Board. They cannot be used
for the Serial Communications Unit for the CS/CJ.
224



Setting Sequences Section 7-1
1,2,3... 1. Left-click the Response Field of the sequence and then left-click the Enter
Button or press the Enter Key.
The Response Type Dialog Box will be displayed.

2. Select one of the notification types: Scan, Interrupt mode: Fixed # or In-
terrupt mode: Receive Case #. When the Interrupt mode: Fixed # But-
ton is left-clicked, designate the external interrupt task number for the CS/
CJ or the interrupt subroutine number for the C200HX/HG/HE in a range
from 0 to 255.

3. Left-click the OK Button to accept the settings or the Cancel Button to
leave the settings unchanged.

Scan Mode
The data in the receive buffer is written in the I/O memory (after conversion)
when scanned by the CPU Unit. Refer to 3-2 Sequence Attributes (Common
to All Steps) for the writing timing.

Interrupt Mode: Fixed No. (See note.)
The data in the receive buffer is written in the I/O memory immediately after it
is converted in the designated conversion method. After the received data is
completely written in the I/O memory, designate the external interrupt task
number for the CS or the interrupt subroutine number for the C200HX/HG/HE
in a range from 0 to 255 to execute the interrupt processing for the CPU Unit.

Interrupt Mode: Receive Case No. (See note.)
The data in the receive buffer is written in the I/O memory immediately after it
is converted in the designated conversion method. After the received data is
completely written in the I/O memory, the external interrupt task number for
the CS or the subroutine number for the C200HX/HG/HE is calculated based
on the step number and the receive case number executed according to the
following procedure to execute the interrupt processing for the CPU Unit. The
interrupt task number or subroutine number (0 to 255) will be automatically
calculated depending on the execution status of the Communications Board.

Note These modes are valid only with the Serial Communications Board for the CS
and with the Communications Board for the C200HX/HG/HE. The modes can-
not be used with the Serial Communications Unit for the CS/CJ. (If used, a
protocol data error will occur when the sequence is executed.) 

Setting Monitor Times 
(Tr, Tfr, Tfs)

The following procedure can be used to set monitor times for transmission
processing.

Note The receive wait time (Ts) is set for every step. Refer to SECTION 8 Step Set-
ting and Editing.
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1,2,3... 1. Left-click the Timer Tr, Timer Tfr, or Timer Tfs Field and then left-click the
Enter Button or press the Enter Key. 
The Timer (Tr/Tfr/Tfs) Dialog Box will be displayed. 
The following shows a dialog box for the receive wait time (Tr).

2. For receive wait time (Tr), set in the Value Field a monitor time (0 to 99)
from recognition of a receive command to reception of the first byte of data.
For receive finish time (Tfr), set in the Value Field a monitor time (0 to 99)
from reception of the first byte of the data to the last byte of the data.
For send finish time (Tfs), set in the Value Field a monitor time (0 to 99)
from the transmission of the first byte of the data to the last byte of the data.

3. Set a time unit in the Time Unit Field.

4. Select the OK Button to accept the settings or the Cancel Button to leave
the settings unchanged.

Note The receive wait time (Tr) and receive finish time (Tfr) cannot be set
alone.

Monitor Time Ranges
The following table lists the units and ranges of monitor times that can be set.

Note Monitoring will not be performed if “00” is input as the value.

7-2 Editing Sequences
7-2-1 Displaying a Sequence List

Use one of the following procedures to display a sequence list within a proto-
col.

• Double-click the Protocol List Icon in the project workspace and then
left-click the protocol to display the sequence list in the project window.

• Double-click the Protocol Icon that includes the desired sequence to dis-
play all the sequences within the protocol.

7-2-2 Renaming Sequences
Use the following procedure to rename a sequence that has been registered.

Note Sequences belonging to the System type protocols cannot be renamed.

1,2,3... 1. Left-click an appropriate Communication Sequence or select an appro-
priate Communication Sequence and press the Enter Key. The current
sequence name will become editable.

2. Type in a new name for the sequence and press the Enter Key. It is possi-
ble to select and overwrite a portion of the current sequence name. The
new sequence name may not exceed 30 characters.

Values Time unit

00 to 99 0.01 s (10 ms)

00 to 99 0.1 s (100 ms)

00 to 99 1 s

00 to 99 1 m
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7-2-3 Changing an Existing Sequence Number
1,2,3... 1. Left-click the # Field within the sequence or select the # Field and press

the Enter Key. The current sequence number will become editable.

2. Type in a new sequence number and press the Enter Key. It is possible to
select and overwrite a portion of the current sequence number. The new
sequence number must be within the Start Sequence and End Sequence
and also different from those currently used.

7-2-4 Copying/Pasting Sequences
Sequences can be copied between protocols or within a protocol. Use the fol-
lowing procedure to copy a sequence.

1,2,3... 1. Select a sequence to be copied. More than one sequence can be selected
by pressing the Shift Key and selecting another sequence to extend the
selection or by pressing the Ctrl Key and selecting another sequence to
add to the selection.

2. Select the Copy Icon from the toolbar or press the Ctrl+C Keys. Alterna-
tively, right-click to display the pop-up menu and select Copy from the
menu. It can also be selected from the Edit Menu.

3. Select a protocol or display the sequence list in the project window where
the copied sequence is pasted.

4. Select the Paste Icon from the toolbar or press Ctrl+V Keys. Alternatively,
right-click to display the pop-up menu and select Paste from the menu. It
can also be selected from the Edit Menu.
The pasted sequences inherit the sequence numbers that existed before
being copied. If the sequence number already exists or if the number is
outside the sequence number range, the next available sequence number
will be newly given to the pasted sequence.

7-2-5 Deleting Sequences
Use the following procedure to delete a sequence.

Note Sequences belonging to the System protocols cannot be deleted.

1,2,3... 1. Select a sequence to be deleted. More than one sequence can be selected
by pressing the Shift Key and selecting another sequence to extend the
selection or by pressing the Ctrl Key and selecting another sequence to
add to the selection.

2. Left-click the Delete Icon on the toolbar or press the Delete Key. Alterna-
tively, right-click, and select Delete from the pop-up menu. It can also be
selected from the Edit Menu. A sequence can also be deleted by selecting
the Cut Icon on the toolbar or pressing the Ctrl+X Keys. It can also be se-
lected from the Edit Menu. Alternatively, right-click to display the pop-up
menu and select Cut from the menu. 
To undo the last delete action processed using the Cut operation, left-click
the Paste Icon on the toolbar or press the Ctrl+V Keys. Alternatively, right-
click to display the edit pop-up menu and select Paste. The pasted se-
quences inherit the sequence numbers existed before being cut. If the se-
quence number already exists or if the number is outside the sequence
number range, the next available sequence number will be newly given to
the pasted sequence.
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SECTION 8
Step Setting and Editing

This section describes details of the setting and editing of steps.
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8-1 Step Setting
This section describes procedure for setting steps with the CX-Protocol.

8-1-1 Step Setting Screen
For details about settings, refer to 3-3 Step Attributes.

8-1-2 Setting the Attributes
The following table shows step attributes that can be set using the CX-Proto-
col.

Note 1. Default settings with the CX-Protocol.

2. For the CS/CJ protocol macro.

Message Repeat Counter Set the number of times the step is to be repeated. The count can be set by
entering a constant (1 to 255) or by designating the address of a word. When
a constant is set in the repeat counter, the value of counter N will be incre-
mented whenever the step is executed. The Type includes Reset and Hold
and the Counter includes Constant or Channel.

1,2,3... 1. Left-click the Repeat Counter Field and then left-click the Enter Button or
press the Enter Key.
The Repeat Counter Information Dialog Box will be displayed.

Message repeat counter

Command

Retry count

Send wait time

Send message

Receive message

With/Without 
response writing

Next process

Error process

Attribute Content

Repeat Type Reset / Hold (Reserve)

Counter Constant (1 to 255)

Channel (word)

Command Send, Receive, Send & Receive, Open*2, Close*2, 
Flush*2, Wait*2

Retry 0 to 9

Send Wait Time (Ts) Value 00 to 99

Time Unit 0.01s, 0.1s, 1s, 1 min

Send Message Refer to 9-1 Creating Messages.

Receive Message Refer to 9-1 Creating Messages.

Response Yes*1, No

Next End*1, Next, Goto, Abort

Error End, Next, Goto, Abort*1
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2. Set the initial value for the repeat counter N in the Type drop-down list.

If the Reset is selected, the step is executed the designated number of
times after the value of counter N will be initialized to 0.

If the Hold is selected, the step will be executed the designated number of
times while retaining the current value of the counter N.

3. To designate a repeat counter, select the Constant Button and enter the
number of times (1 to 255) the step is to be repeated in the Constant Field.

To designate a word (channel) to be read, select the Channel Button and
select the Edit... Button to set the word address.
The Channel Dialog Box will be displayed.

Select the address type (Channel, I1, I2, O1, O2, or Operand) from the
drop-down list.
If Channel is selected as the address type, select an area (CIO, WR (CS/
CJ only), LR (C200HX/HG/HE only), HR, AR, DM or EMxx) from the Area
drop-down list.
Input a value in the Channel #.

Note If EMxx is selected from the Area drop-down list, be sure to input a
bank number in the EM Bank # Field. The maximum value that can
be input in the EM Bank # Field varies depending on the PLC used.

The parameters for the Primary Expression (yN+x) Fields define the
channel offset. Input the parameter x.

Change the settings as necessary, provided in the following, and select the
OK Button to accept the settings from the Channel Dialog Box, or the Can-
cel Button to leave the settings unchanged.

4. Select the OK Button to accept the settings from the Channel Dialog Box
or the Cancel Button to leave the settings unchanged.

Command Set one of the following commands for step execution.

Send

Sends the send messages set in the step.

Receive

Receives the receive messages that were set in the step or messages that
were sent based on the receive matrix.

Send & Receive

After sending the send messages that were set in the step, receives the
receive messages that are set in the step and the messages that were sent
based on the receive matrix.
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Open (for CS/CJ protocol macro)

Turns ON the DTR signal.

Close (for CS/CJ protocol macro)

Turns OFF the DTR signal.

Flush (for CS/CJ protocol macro)

Clears the data within the receive buffer.

Wait (for CS/CJ protocol macro)

Sets to a standby state in the step and keeps that state until the Wait Clear
switch turns from OFF to ON.

The following table lists the items that can be set for each command.

1,2,3... 1. Left-click the Command Field.

2. Left-click an appropriate command on the drop-down list.

Setting item Command

Send Receive Send & 
Receive

Open Close Flush Wait

Sequence Transmission 
control

Yes Yes Yes --- --- --- ---

Link words Yes Yes Yes --- --- --- ---

Receive wait 
time: Tr

--- Yes Yes --- --- --- ---

Receive finish 
time: Tfr

--- Yes Yes --- --- --- ---

Send finish 
time: Tfs

Yes --- Yes --- --- --- ---

Response 
Type

--- Yes Yes --- --- --- ---

Step Repeat 
counter

Yes Yes Yes No No No No

Retry count No No Yes No No No No

Send wait time Yes No Yes No No No No

Send mes-
sages

Yes No Yes No No No No

Receive mes-
sages

No Yes Yes No No No No

With/Without 
response writ-
ing

Yes Yes Yes No No No No

Next process Yes Yes Yes Yes Yes Yes Yes

Error process Yes Yes Yes No No No No

Example: CS/CJ
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Retry Count The retry can only be set when the command is set to Send&Receive. When
the retry occurs, the current step will be executed again. If the retry occurs
again after the step is repeated the number of designated times, a processing
error will occur.

Effective retry factor: 0 to 9 (0: Retry will not be executed.)

Retry Factors • The send finish time has been reached.

• The receive wait time has been reached.

• The receive finish time has been reached.

• A transmission error occurred during receive processing.

For the CS/CJ: Transmission error of the following address causes a retry.

• Serial Communications Board: Bit 15 of word 1908 or 1918

• Serial Communications Unit: Bit 15 of word n+8 or n+18 (n = 1500 +
25 x Unit No.)

For the C200HX/HG/HE: The bit 04 of word 283 or bit 12 (communications
error) of word 283 causes a retry. 

• A message, excepting the message set in receive messages, is received.

• An error occurred in the Error Check code.

Note For retries, send processing is executed regardless of the wait time.

1,2,3... 1. Left-click on the Retry Field or select the Retry Field and press the Enter
Key.

2. Input the number of retries (0 to 9) and press the Enter Key.

Send Wait Time: Ts Sets the time to be waited until a send message is sent for send processing.
The accuracy of the Ts is 10 ms maximum.

The send wait time setting range is from 0 to 99 (0: No wait time). The setting
unit can be selected from the following four units.

Note When 00 is set as the value, waiting will not occur.

1,2,3... 1. Left-click the Send Wait setting for the step and then left-click the Enter
Button or press the Enter Key.
The Transmission Wait Time (Ts) Dialog Box will be displayed.

2. Enter a value for the wait time in the Value Field.

3. Enter a time unit in the Time Unit Field.

4. Select the OK Button to accept the settings or the Cancel Button to leave
the settings unchanged.

Time unit Value

10 ms (0.01 s) 00 to 99

100 ms (0.1 s) 00 to 99

1 s 00 to 99

1 min 00 to 99
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Setting the Send /Receive Message

Send/Receive Message 
and Receive Matrix

If a send message, receive message, or receive matrix has already been cre-
ated in the send/receive message list or the receive matrix list, a message or
receive matrix can be selected from the Send/Receive Message Field of the
step.

Use the following procedure to select a send message reference for the step. 

1,2,3... 1. Left-click on the Send Message or Receive Message Field.

2. Left-click a desired send message name, receive message name, or re-
ceive matrix on the drop-down list.

Note Select the receive matrix from the Receive Message Field. The receive
matrix name is indicated with brackets (< >).

Creating Send/Receive 
Messages

A send message or receive message can be newly created in the Send Mes-
sage/Receive Message Field of the step even when the messages are not
created in the send message/receive message list.
Use the following procedure to create a send message or receive message.

1,2,3... 1. Right-click the Send Message or Receive Message Field of the step to
display a pop-up menu. Select New Message from the menu.

2. The Message Editor Dialog Box will be displayed. Input a message name
in the Name Field.

3. Refer to 9-1 Creating Messages for creating messages.

4. Left-click the OK Button to accept the settings or left-click the Cancel But-
ton to leave the settings unchanged.

Note The receive matrix cannot be newly created or monitored in the Receive Mes-
sage Field of the step. It can be created or monitored only in the receive
matrix list.

Editing Send/Receive 
Message in Send/Receive 
Field

The send message or receive message can be edited in the Send Message/
Receive Message Field of the step.

Use the following procedure to edit the messages.

1,2,3... 1. Right-click the Send Message or Receive Message Field of the step to
display a pop-up menu. Select Edit Message from the menu.

2. The Message Editor Dialog Box will be displayed. Refer to 9-1 Creating
Messages for editing messages.

3. Left-click the OK Button to accept the settings or left-click the Cancel But-
ton to leave the settings unchanged.

Example: 
Setting screen for a receive message
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With/Without Response 
Writing

Sets whether received data is to be stored in the I/O memory area of the PLC.
This setting is valid only when received data is stored by the fourth operand
(for the CS/CJ-series) or third operand (for the C200HX/HG/HE) of the PMCR
instruction.

• Response: Yes
Received data is stored in the I/O memory area of the PLC. A response
type must be set in the sequence list attributes.

• Response: No
Received data is Read-only (not stored in the I/O memory).

1,2,3... 1. Left-click the Response Field of the step.

2. Left-click either Yes or No on the drop-down list.

Next Process Use the following procedure to set the next step to be executed.

If a receive matrix is set for the receive message, control will be passed to the
next step based on the next process set in the receive matrix.

The following four processes can be set.

1,2,3... 1. Left-click the Next Process Field of the step and left-click the Enter Button
or press the Enter Key.
The Next Process Dialog Box will be displayed.

2. Select Next Process from the Jump Field. When Goto is selected, input a
step number in the empty field.

Next process Processing details

Goto ** When this step is terminated, control will be passed to the step 
number designated in **.

Next When this step is terminated, the next step will be executed.

End When this step is terminated, the sequence will be terminated.

Abort When this step is terminated, the step will be aborted and the 
sequence will be terminated.
235



Step Editing Section 8-2
3. Select the OK Button to accept the settings or the Cancel Button to leave
the settings unchanged.

Error Process When the step is terminated abnormally, use the following procedure to set
the next step to be executed. When a step is terminated normally, control will
be passed to the next step according to the next process settings.

If a receive matrix is set in a receive message, control will be passed to the
next step according to the setting that determines the error processing in the
event of abnormal termination.

The following four processes can be set.

1,2,3... 1. Left-click the Error Process Field of the step and then left-click the Enter
Button or press the Enter Key.
The Error Process Dialog Box will be displayed. The display is the same
as the one for the next process.

2. Select Next Process from the Jump Field. When Goto is selected, input a
step number in the empty field.

3. Select the OK Button to accept the settings or the Cancel Button to leave
the settings unchanged.

8-2 Step Editing

8-2-1 Displaying the Step List
Use one of the following procedures to display the step of the sequence.

• Double-click the Protocol Icon in the project workspace and then left-
click a desired sequence for displaying the step. The step will be dis-
played in the project window. 

• Double-click the Sequence Icon that includes the step in the project win-
dow to display the step list that contains all the steps within the sequence.

8-2-2 Moving the Steps
The order of steps can be changed by moving the selected step. Use the fol-
lowing icons to reorder the steps.

Note Steps within the System protocols cannot be edited.

1,2,3... 1. Select a step and use the Up Icon on the toolbar to move up the step by
level. It can also be moved by selecting the Move from the pop-up menu
that can be displayed by right-clicking.

2. Select a step and use the Down Icon on the toolbar to move down the step
by level. It can also be moved by selecting the Move from the pop-up menu
that can be displayed by right-clicking.

3. Select a step and use the Top Icon on the toolbar to move the step to the
top level. It can also be moved by selecting the Move from the pop-up
menu that can be displayed by right-clicking.

Error process Processing details

Goto ** When this step is abnormally terminated, control will be passed to 
the step number designated in **.

Next When this step is abnormally terminated, the next step will be exe-
cuted.

End When this step is abnormally terminated, the sequence will be ter-
minated.

Abort When this step is abnormally terminated, the step will be aborted 
and the sequence will be terminated.
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4. Select a step and use the Bottom Icon on the toolbar to move the step to
the bottom level. It can also be moved by selecting the Move from the pop-
up menu that can be displayed by right-clicking.

8-2-3 Deleting the Steps
Use the following procedure to delete the steps.

Note Steps within the System protocols cannot be deleted.

1,2,3... 1. Left-click the icon of the step to be deleted. More than one step can be se-
lected by pressing the Shift Key and selecting another step to extend the
selection or by pressing the Ctrl Key and selecting another step to add to
the selection.

2. Left-click the Delete Icon on the toolbar or press the Delete Key. Alterna-
tively, right-click and select Delete from the pop-up menu. Delete can also
be selected from the Edit Menu. The step can also be deleted by left-click-
ing the Cut Icon on the toolbar or by pressing the Ctrl+X Keys. Alternative-
ly, right-click to display the pop-up menu and select Cut from the menu.
Cut can also be selected from the Edit Menu. 
When canceling the last deletion using Cut, left-click the Paste Icon on the
toolbar or press the Ctrl+V Keys. Alternatively, right-click to display the
pop-up menu and select Paste from the menu. Paste can also be selected
from the Edit Menu. 
The pasted step will be positioned at the end of the sequence and the next
step number available will be given to that step.
If another object is copied or cut during the above procedure, the originally
cut object will be lost.

Note Once a step has been deleted, it cannot be recovered.

8-2-4 Copying the Steps
Use the following procedure to copy the steps within the step field or between
the sequences.

1,2,3... 1. Left-click the icon of the step to be copied. More than one step can be se-
lected by pressing the Shift Key and selecting another step to extend the
selection or by pressing the Ctrl Key and selecting another step to add to
the selection.

2. Left-click the Copy Icon on the toolbar or press the Ctrl+C Keys. 
Alternatively, right-click to display the pop-up menu and select Copy from
the menu. It can also be selected from the Edit Menu. 

3. Select the sequence or display in the project window the step list where the
copied step is to be pasted.

4. Left-click the Paste Icon on the toolbar or press the Ctrl+V Keys. Alterna-
tively, right-click to display the pop-up menu and select Paste from the
menu. It can also be selected from the Edit Menu. The pasted step will be
positioned at the end of the sequence and the next step number available
will be given to that step.
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Setting and Editing Messages and Matrix Lists

This section describes details of the setting and editing of messages and matrix lists.
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9-1 Creating Messages

9-1-1 Creating a New Message
Use either of the following procedures to create a new message.

1,2,3... 1. Right-click the Send Message or Receive Message Field in the step list,
and select New Message from the pop-up menu, when the Message Ed-
itor Dialog Box will be displayed. Specify each input item and order in the
dialog box.

2. Create the new message in the message list independently from the steps
and input each item in either of the following method.

a) Input the data for each item field beginning with the header. Specify
and input the order and items of the data in the data field.

b) Display the Message Editor Dialog Box from the data field. Specify
and input the order and items of the order in the dialog box.

Creating a New Message in Send Message or Receive Message Field for a Step 
Use the following procedure to create a new message for a step.

1,2,3... 1. Right-click the Send Message or Receive Message Field for a step and
select New Message from pop-up menu.

2. The Message Editor Menu Dialog Box will be displayed. Input the mes-
sage name in the Name Field.

3. Create the message as appropriate. Refer to 9-1 Creating Messages for
details on how to construct a message.

4. Left-click the OK Button to accept the settings. Click the Cancel Button to
leave the settings unchanged.

Creating a New Message from the Message List
Use the following procedure to create a new message from the message list.

1,2,3... 1. Double-click the Protocol Icon in the project workspace and select and
highlight the receive message or send message list. Alternatively, double-
click the Receive Message List Icon or Send Message List Icon in the
project window.
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2. Select the send message or receive message references by right-clicking
the Send Message List Icon in the project workspace. Alternatively, select
the Create from the pop-up menu in the project window and select the
send message or receive message references or select the send message
or receive message references from the Protocol Menu.

3. Left-click Data and left-click the Enter Button or press the Enter Key. The
Message Editor Menu Dialog Box will be displayed. For details of how to
create a message, refer to 9-1 Creating Messages.

9-1-2 Message Setting Screen
For details about message settings, refer to 3-4 Communication Message
Attributes.

9-1-3 Contents of Messages
The settings that can be made for messages using the CX-Protocol are
shown in the following table.

Note *1: For the CS/CJ protocol macro only.

Use either one of the following procedures to create a message.

Header Address Length Data Check code Terminator

Message name Header Terminator Error check code Length Address Data

Attribute Content

Header <h> Type None, Code, ASCII, Hexadecimal

Data One of Code, ASCII, or Hexadecimal

Terminator <t> Type None, Code, ASCII, Hexadecimal

Data One of ASCII, Hexadecimal, or Variable

Check Code <c> Type None, LRC, LRC2*1, CRC-CCITT, CRC-16, SUM (1 byte), SUM (2 bytes), 
SUM1 (1 byte)*1, SUM1 (2 bytes)*1, SUM2 (1 byte), SUM2 (2 bytes)

Default 0 to 255 if Type is 1 byte; 0 to 65535 if Type is 2 bytes

Conversion Reverse Order

Data Type: Binary, ASCII

Length <l> Type None, 1 byte, 2 bytes

Default 0 to 255 if Type is 1 byte; 0 to 65535 if Type is 2 bytes

Conversion Binary, ASCII

Address <a> Type None, Constant, ASCII, Constant Hexadecimal, Variable, Variable ASCII, 
Variable Hexadecimal, Variable (Reverse), Variable ASCII (Reverse), Variable 
Hexadecimal (Reverse)

Data One of ASCII, Hexadecimal, or Variable

Data Message Order Order setting: <h>, <t>, <c>, <l>, <a>

Type/data Data (code, ASCII, Hexadecimal, Variables)
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• Set each attribute (header, terminator, error check code, address) using
its respective setting screen and display the Message Editor Dialog Box
from the Data Field to edit the message.
Data can be created only in the Message Editor Dialog Box.

• Display the Message Editor Dialog Box from the Data Field, and perform
all the settings (header, terminator, error check code, address) from there,
before editing.

Header <h> Use the following procedure to set the header (data that indicates the begin-
ning of the message). Select one of the following data types: ASCII, Hexadec-
imal, or Code.

1,2,3... 1. Left-click the Header <h> Field and then left-click the Enter Button or
press the Enter Key. The Header <h> Dialog Box will be displayed.

Select a header type from the Type drop-down list (refer to Code, ASCII,
and Hexadecimal in the following section) and set the Data Field.

This dialog box can also be displayed by left-clicking the Data Field and
then left-clicking the Enter Button or pressing the Enter Key to display the
Message Editor Dialog Box, where the Header <h> Dialog Box can be
displayed by left-clicking the Edit Button in the Header <h> Field.

2. Left-click the OK Button to accept the settings or the Cancel Button to
leave the settings unchanged.

None

If None is selected from the Type drop-down list, no data will be set to a
header.

Code

1,2,3... 1. Select Code from the Type drop-down list.

2. Left-click the Edit Button. The Code Entry Dialog Box will be displayed.

Example: <h>+<a>+----+<c>+<t> Edit the following order using the dialog box.

Input data from this dialog box.
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3. Select Special Code. Up to four special codes may be entered. Select the
codes from the drop-down list and left-click the Insert Button to input the
code indicated.

Note Five or more special codes cannot be input. Left-click the Clear But-
ton to clear all the special codes and input them again from the be-
ginning. Left-click the Delete Button to delete the special code where
the cursor is located. Left-click the << or >> Button to move the cur-
sor position.

4. Left-click the OK Button to accept the special codes entered or the Cancel
Button to leave the settings unchanged.
The input code that is set will be displayed in the Data Field of the Header
<h> Dialog Box.

ASCII

1,2,3... 1. Select ASCII from the Type drop-down list.

2. Input ASCII characters (maximum of 4 characters) in the Data Field. The
input ASCII characters will be displayed with a prefix “[” and suffix “]” in the
message header field. For example, if “@” is input, “[@]” will be displayed.

Hexadecimal

1,2,3... 1. Select HEX from the Type drop-down list.

2. Left-click the Edit Button. The Hex Entry Dialog Box will be displayed.
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3. Input the required hexadecimal value by left-clicking the button for each
digit of that value. Up to eight digits may be entered, and they are displayed
at the top of the dialog box. (If a ninth digit is entered, the first digit will be
deleted.)

Note Left-click the CLR Button to clear all codes and start again. Left-click
the DEL Button to delete the last code entered.

4. Left-click the Enter Button to accept the settings or the Cancel Button to
leave the settings unchanged.
The input code confirmed by left-clicking the Enter Button will be displayed
in the Data Field of the Header <h> Dialog Box.
The input code will be displayed with a prefix “[” and suffix “]” in the data
field. For example, if 2A0D is input, “[2A0D]” will be displayed.

Terminator <t> Use the following procedure to set the terminator (data that indicates the end
of the message). Select one of the following data types: ASCII, Hexadecimal,
or Code.

1,2,3... 1. Left-click the Terminator <t> Field and then left-click the Enter Button or
press the Enter Key. The Message Terminator <t> Dialog Box will be dis-
played.
The dialog box can also be displayed from the Message Editor Dialog
Box. (Refer to the previous Header <h> section.)
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Select a terminator type from the Type drop-down list and set the Data
Field. (For inputting the Code, ASCII, or Hexadecimal, refer to the previous
Header <h> section.)

2. Left-click the OK Button to accept the settings or the Cancel Button to
leave the settings unchanged.

Check Code <c> Use the following procedure to designate an error check code calculation

method. The check code types LRC, LRC2*1, CRC-CCITT, CRC-16, SUM (1

byte), SUM (2 bytes), SUM1 (1 byte)*1, SUM1 (2 bytes)*1, SUM2 (1 byte), and
SUM2 (2 bytes) are available. Data types available are binary and ASCII. Ini-
tial values and conversion directions can be designated.

Note Only for the CS/CJ protocol macro.

1,2,3... 1. Left-click the Check code <c> Field and then left-click the Enter Button or
press the Enter Key. The Message Check Code <c> Dialog Box will be
displayed.
The dialog box can also be displayed from the Message Editor Dialog
Box. (Refer to the previous Header <h> section.)

Select a check code type from the Type drop-down list. 
 For LRC, LRC2, CRC-16, SUM (1 byte/2 bytes), SUM1 (1 byte/2 bytes),
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and SUM2 (1 byte/2 bytes), all fields of the dialog box become active. For
CRC-CCITT, the Conversion Field becomes active.

2. Input values in the Default Field.
For LRC, LRC2, CRC-16, SUM (1 byte), SUM1 (1 byte), and SUM2 (1
byte), enter a default value from 0 to 255. For SUM (2 bytes), SUM1 (2
bytes), SUM2 (2 bytes), CRC-16, enter a default value from 0 to 65535.

3. Select the Reverse Order check box to set the reverse check code.

4. For all types other than None, set BIN or ASCII in the Data Type Field.
For LRC, LRC2, SUM (1 byte), SUM1 (1 byte), and SUM2 (1 byte), BIN in-
dicates binary data (1 byte) and ASCII indicates ASCII data (2 bytes).
For CRC-CCITT, CRC-16, SUM (2 bytes), SUM1 (2 bytes), and SUM2 (2
bytes), BIN indicates binary data (2 bytes) and ASCII indicates ASCII data
(4 bytes).

5. Left-click the OK Button to accept the settings or the Cancel Button to
leave the settings unchanged.
The display in the Check Code Field will be as shown below.

Note Set the calculation range of the error check code <c> in the Data
Field of the Message Editor Dialog Box.

Length <l> Use the following procedure to set the length (the number of bytes of the mes-
sage). The data length is automatically calculated in send processing accord-
ing to the Length <l> setting in a frame. The length <l> data will be added
when data is sent. The Length types of 1 byte or 2 bytes are available and the
Conversion types of BIN or ASCII are available.

1,2,3... 1. Left-click the Length <l> Field for a message and then left-click the Enter
Button or press the Enter Key. The Message Length <l> Dialog Box will
be displayed. The dialog box can also be displayed from the Message Ed-
itor Dialog Box. (Refer to the previous descriptions for the Header <h>.)

Select a length type from the Size drop-down list. For 1 Byte, the length is
set to one byte. For 2 Bytes, the length is set to two bytes.

2. Enter the length in the Default Field. The range is 0 to 255 for 1 Byte or 0
to 65535 for 2 Bytes.

Example

Check code

Default

Data type (BIN or ASCII)

LRC (horizontal parity) (0) (2 Byte ASCII)
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3. Select the BIN conversion type or ASCII conversion type from the Conver-
sion Field.

4. Left-click the OK Button to accept the settings or the Cancel Button to
leave the settings unchanged.
Note The display in the Length Field will be as shown below.

Note Set the calculation range in the Data Field of the Message Editor Di-
alog Box.

Address <a> Use the following procedure to set the address. The address types are as
shown in the following table.

1,2,3... 1. Left-click the Address <a> Field and then left-click the Enter Button or
press the Enter Key. The Message Address <a> Dialog Box will be dis-
played. The dialog box can also be displayed from the Message Editor Di-
alog Box. (Refer to the previous descriptions for the header <h>.)

Select an address type from the Type drop-down list.

2. For Constant ASCII, enter characters in the Data Field.

Example
(0) (1Byte BIN)

Conversion type

Size

Default value

Type Drop-down list item Default format

Constants Constant ASCII

Constant hexadecimal [ ]

Variables Variable (1,1)

Variables Variable ASCII (with ASCII conversion) $(1,1)

Variables Variable hexadecimal (with hexadecimal conversion) &(1,1)

Variables Variable (reverse) ~(1,1)

Variables Variable ASCII (with reverse conversion) $~(1,1)

Variables Variable hexadecimal (with reverse conversion) &~(1,1)
247



Creating Messages Section 9-1
For Constant HEX, left-click the HEX Button to enter hexadecimal values
into the Data Field.

Note For the input methods, refer to the previous descriptions for the head-
er <h>.)

For the Variable types, left-click the Variable and Length Buttons to com-
pose variables (X, Y). The Channel Dialog Box will be displayed.
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Setting of Variables

Setting Channel Dialog Box

a) Select Read R ( ), Write W ( ), yN+x, or * in the Type Field.

b) If Read R ( ) or Write ( ) is selected in the Type Field, select an variable
(Channel, I1, I2, O1, O2, or Operand) from the Address drop-down
list in the Data Field. If Channel is selected, select an area code (CIO,
WR, LR, HR, AR, DM or EMxx) from the Area drop-down list. Set a
value in the Channel # Field.

+

Linear expres-
sion including N

Note 1. Area codes for word designation
CIO: I/O relay, internal auxiliary relay, and special auxiliary relay
WR: Internal auxiliary relay (For CS/CJ only)
LR: Link relay (For C200HX/HG/HE only)
HR: Holding relay
AR: Auxiliary memory relay
DM: Data memory
EM: EM area

2. Cannot be selected in the address setting or send message.

3. Cannot be selected in the send message.

Editing Length (Y)
Type: R ( )
Type: yN+x
Type: * (see note 2) 

Variable

(Word unit)
Type: R ( ), W ( ) (see note 3)

Address:

Type: yN+x
For CS/CJ
y=0 to 1000
x=0 to 1000
For C200HX/HG/HE
y=0 to 255
x=0 to 255

Type: * (see note 3)

Example
Direct designation: R (CIO 0000+N+1)
Link word designation: R (I1+2N+1)

(Byte unit)

yN+x

Designate y and x
For CS/CJ

y=0 to 1000 
x=0 to 1000

When selecting 
words: Designate 
the area (CIO, LR, 
HR, AR, DM, EM) 
(see note 1) and the 
word.

No designation 
when I1, I2, O1, or 
O2 is selected.

No designation 
when an operand is 
selected.

For C200HX/HG/HE

y=0 to 255
x=0 to 255

X, Y

Data

Top address
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c) Designate an offset from the top word (designated in the above Data
Field) in the Primary Expression (yN+x) Field. Input y and x.

d) Press the OK Button to confirm the Channel Dialog Box or Cancel
Button to cancel the process.

Note If the EMxx option is selected from the Area drop-down list, be sure
to input the bank number (0 to18 hex) in the EM Bank # Field. The
maximum number of the EM bank that can be designated in the EM
Bank # Field depends on the selected PLC.

!Caution If you attempt to access EM banks 0D to 18 hex from any Unit other than the
CJ1W-SCU22/32/42, a Data read/data write area exceeded error will occur in
the protocol status. (This will occur even if EM banks 0D to 18 hex are sup-
ported by the CPU Unit.)

3. Press the OK Button to confirm the setting or Cancel Button to cancel the
process.

Address Setting Examples

Variable (Left-click the button.) Length (Left-click the button.)
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Data Use the following procedure to edit the message.

1,2,3... 1. Enter a message name.

2. Retrieve each item already set and reorder them.

Note If data has not been input into any of the items (header <h>, address
<a>, check code <c>, or terminator <t>), left-click the Edit Button of
each field to display a data input dialog box and to enter data.
If data has been input in any one of these items, the Insert Button for
each one of them will become active.

3. Set the data.
Combine the following to designate the data using the Message Data
drop-down list.

4. Set the error check code and length calculation range (items). Items sub-
ject to calculation are shown in the following color in the Data Field. 

Set as length calculation: Red
Set as check code calculation: Blue
Set as length and check code calculation: Purple

Example: Edit the following in this dialog box.

<h>+<a>+••••••+<c>+<t>

Input data from this dialog box.

Hexadecimal, ASCII, Code, Variable

ASCII data

Example: "RX0"+&(N,1)+"00"

Variable
ASCII data
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Use the following procedure to edit messages and to enter data.

1,2,3... 1. Left-click the Data Field for a message and then left-click the Enter Button
or press the Enter Key. The Message Editor Dialog Box will be displayed.
Using this dialog box, create data and edit messages.

2. Enter a message name in the Name Field.

3. Left-click the Insert Button on each field to insert data for each item. Mes-
sage elements will be displayed from left to right in the screen field.

a) Left-click the Insert Button in the order of insertion. This item selected
with the Insert Button will be inserted prior to the highlighted item. Use
the << or >> Button to move the cursor to left or right.
The header <h> can be inserted only at the beginning of a message. 
For deleting an item, move the cursor using the << or >> Button until it
is over the item to be deleted and then left-click Delete.

Note a) <h>, <t>, <c>, <l>, or <a> can be deleted from the message con-
figuration, not from the data. It can be inserted again by left-click-
ing the Insert Button.

b) As for <h>, <t>, <c>, <l>, and <a>, only one item can be positioned
in one message.

A header can be inserted into a message by left-clicking the Insert
Button on the Header Field. If a header already exists in a message or
if the cursor is not at the beginning of the message, this button cannot
be used.
If a header is to be inserted or if it needs to be modified, left-click the
Edit Button to display the Header <h> Dialog Box and then enter or
edit the header.

A terminator can be inserted into a message by left-clicking the Insert
Button on the Terminator Field. If a terminator already exists in a mes-
sage, this button cannot be used.
A terminator can be inserted before the check code unless there is
data after the check code. If a terminator is to be inserted or if it needs
to be modified, left-click the Edit Button to display the Terminator <t>
Dialog Box and then enter or edit the terminator.

A check code can be inserted into a message by left-clicking the Insert
Button on the Check Code Field. If a check code already exists or if
an attempt is made to insert the check code before the header, this
button cannot be used.
If a check code is to be inserted or if it needs to be modified, left-click
the Edit Button to display the Check Code <c> Dialog Box and then
enter or edit the check code.

An address can be inserted into a message by left-clicking the Insert
Button on the Address Field. If an address already exists or if an at-
tempt is made to insert the address before the header or after the ter-
minator, this button cannot be used.
If an address is to be inserted or if it needs to be modified, left-click the
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Edit Button to display the Address <a> Dialog Box and then enter or
edit the address.

A length can be inserted into a message by left-clicking the Insert But-
ton on the Length Field. If a length already exists or if an attempt is
made to insert the length before the header or after the terminator, this
button cannot be used.
If an address is to be inserted or if it needs to be modified, left-click the
Edit Button to display the Length <l> Dialog Box and then enter or edit
the length.

b) Create or insert data items of a message in the Message Data Field.
Using the << or >> Button, move the cursor to a place where data
items are to be inserted. 

• Select one of the items from the drop-down list in the Message Data
Field.

• When either the Constant Hex or Constant Code is selected, left-
click the Edit Button to display the HEX Entry or Code Entry Dialog
Box. Using the dialog box, enter data and left-click the Insert to insert
hexadecimal numbers or code in the message.

Note For the input methods, refer to the previous descriptions for the
Header <h>. In the Message Data Field, up to 48 units of hexadeci-
mal can be input.

• When ASCII is selected, input ASCII characters in the right field and
then left-click the Insert Button to insert the data in the message.

• When Variable is selected, left-click the Edit Button to display the Mes-
sage Variable Dialog Box. Left-click the Insert Button to insert the
variable in the message. (For the input methods, refer to the previous
descriptions for the address <a>.)

Note Message data cannot be inserted before the header or after the terminator.

Check Code and Length 
Ranges

If the check code or length is designated for a message, its range can be des-
ignated in the Length <l> or Check Code <c> Field.
Use the following procedure to designate the ranges.

1,2,3... 1. Left-click the Up Button or Down Button to designate the beginning or end
item (in the order of 1, 2, 3, etc. from the left of a message) of the range.
The display color of the designated item changes.
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For example, when changing the check code from “3” to “5,” the display will
change as shown below. 

Press the OK Button to confirm the message data or press the Cancel But-
ton to leave the settings unchanged. Input message will be displayed on
the Data Field.

9-2 Matrix Creation
Use the procedures described in the following paragraphs to set a matrix
when more than one received message is expected and the next process is to
be changed for each receive message.

9-2-1 Creating a New Matrix
Use the following procedure to create a new matrix.

1,2,3... 1. Double-click the Matrix List Icon on the project workspace or project win-
dow.

2. Right-click the Matrix List on the project workspace or right-click in the
project window to display a pop-up menu. Point at Create on the pop-up
menu and select Matrix. Create can also be selected from the Protocol
Menu.

9-2-2 Creating a New Matrix Case
Use the following procedure to create a new matrix case in a matrix.

1,2,3... 1. Double-click the Matrix Icon on the project window. 

2. Right-click in the project window to display a pop-up menu. Point at the
Create on the pop-up menu and select Matrix. Create can also be select-
ed from the Protocol Menu.

The character color changes from black to blue.
254



Message and Matrix Editing Section 9-3
9-2-3 Editing a Message in the Matrix Case
Use the following procedure to set a receive message.

1,2,3... 1. Double-click the Matrix Icon on the project window.

2. Left-click the Receive Message Field on the Matrix Case.

3. When setting an existing receive message, left-click a desired receive
message on the drop-down list.
When creating a new receive message, right-click the Receive Message
Field and then left-click New Message.
When editing a set receive message, right-click the Receive Message
Field and then left-click Edit Message.

9-2-4 Defining the Next Matrix Case Process
Use the following procedure to edit the next process.

1,2,3... 1. Double-click the Matrix Icon on the project window.

2. Left-click the Next Process Field on the Matrix Case and then left-click
the Enter Button or press the Enter Key.
The Next Process Dialog Box will be displayed.

3. Select Next Process on the Jump Field. If Goto is selected, enter a se-
quence step number that will be referred to.

4. Left-click the OK Button to confirm the setting or Cancel Button to cancel
the process.

9-3 Message and Matrix Editing

9-3-1 Displaying Messages within the Protocol
Use the following procedure to display all the messages within the protocol.

1,2,3... 1. Left-click the protocol in the project workspace to highlight the protocol or
double-click the Protocol Icons containing a sequence in the project win-
dow.

2. Double-click the Send Message List Icon or Receive Message List Icon
on the project window to display all the messages contained in the mes-
sage list.

9-3-2 Renaming a Message
Use the following procedure to rename a message in the send or receive
message lists. Messages belonging to System protocols cannot be changed.

1,2,3... 1. Left-click the Message Name Field to be renamed from the message list.
Alternatively, select Message Name and press the Enter Key.

2. Type in a new name for the message and press the Enter Key. The new
message name must not exceed 10 characters.

Note The name given to a send message cannot be used for the receive message
within a protocol.
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9-3-3 Copying a Message
Use the following procedure to copy a message within a protocol or between
protocols.

Note Messages within the System protocols can be copied, but the message
becomes editable once pasted into a message list in a User category proto-
col.

1,2,3... 1. Select the icon of the message to be copied, either from the send message
list or the receive message list. More than one message can be selected
by pressing the Shift Key and selecting another message to extend the se-
lection or by pressing the Ctrl Key and selecting another message to add
to the selection.

2. Left-click the Copy Icon on the toolbar or press the Ctrl+C Keys. Alterna-
tively, right-click to display a pop-up menu and then select Copy in the pop-
up menu. It can also be selected from the Edit Menu.

3. Left-click the Message List Icon in the project workspace or display the
message in the project window and designate the destination where the
message is to be pasted.

4. Left-click the Paste Icon on the toolbar or press the Ctrl + V Keys. Alterna-
tively, right-click to display a pop-up menu and then select Paste in the
pop-up menu. Paste can also be selected from the Edit Menu. The pasted
message will be positioned at the end of the corresponding message list.

Note Make sure that another Copy or Cut operation does not take place
during this procedure as this deletes the original copy.

9-3-4 Deleting a Message
Use the following procedure to delete messages. Messages within the Sys-
tem protocols cannot be deleted.

1,2,3... 1. Select the icon of the message to be deleted, either from the send mes-
sage list or the receive message list. More than one message can be se-
lected by pressing the Shift Key and selecting another message to extend
the selection or by pressing the Ctrl Key and selecting another message
to add to the selection.

2. Left-click the Delete Icon on the toolbar or press the Delete Key. Another
method is to right-click and select Delete from the pop-up menu. Delete
can also be selected from the Edit Menu.
Alternatively, left-click the Cut Button on the toolbar or press the Ctrl+X
Keys. Right-click to display a pop-up menu and then select Delete in the
pop-up menu.
Left-click the Paste Icon from the toolbar or press the Ctrl+V Keys to re-
trieve the last delete action using the Cut operation. The pasted message
will be positioned at the end of the corresponding message list.

Note Once a message has been deleted, it cannot be recovered.

9-3-5 Displaying the Matrix within the Protocol
Use the same procedure as described in 9-3-1 Displaying Messages within
the Protocol.
256



Message and Matrix Editing Section 9-3
9-3-6 Displaying the Matrix Case within the Matrix
Use the following procedure to display the matrix case within the matrix.

1,2,3... 1. Left-click the protocol list in the project workspace to display all the proto-
cols in the project window.

2. Left-click the Protocol Icon that contains the matrix list.

3. Double-click the Matrix List Icon to display the matrix in the project win-
dow.

4. Double-click the Matrix Icon to display each matrix case in the project win-
dow.

9-3-7 Copying the Matrix Case
Use the following procedure to copy a matrix case in the matrix or between
matrices.

1,2,3... 1. Left-click the Matrix Case Icon to be copied. More than one case can be
selected by pressing the Shift Key and selecting another case to extend
the selection or by pressing the Ctrl Key and selecting another case to add
to the selection.

2. Left-click the Copy Icon on the toolbar or press the Ctrl+C Keys. Alterna-
tively, right-click to display a pop-up menu and then select Copy in the pop-
up menu. Copy can also be selected from the Edit Menu.

3. Select a matrix case or display in the project window and designate the
destination where the matrix case is to be pasted.

4. Left-click the Paste Icon on the toolbar or press the Ctrl+V Keys. Alterna-
tively, right-click to display a pop-up menu and then select Paste in the
pop-up menu. Paste can also be selected from the Edit Menu. The pasted
matrix case will be positioned at the end of the matrix case list except the
case number 15.

9-3-8 Moving the Matrix Case
Move the selected matrix case to change the order of matrix cases. Use the
following icons to change the order of matrix cases. (The matrix case list
belonging to the System protocols cannot be edited.)

Select a matrix case and press the Up Icon on the toolbar to move up the
selected matrix case by one. It can also be selected by right-clicking to display
the pop-up menu and then selecting Move from the menu list.

Select a matrix case and press the Down Icon on the toolbar to move down
the selected matrix case by one. It can also be selected by right-clicking to
display the pop-up menu and then selecting Move from the menu list.

Select the matrix case and press the Top Icon on the toolbar to move the
matrix case to the case number 00 position. It can also be selected by right-
clicking to display the pop-up menu and then selecting Move from the menu
list.
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SECTION 10
Communications PLC Setup and Online Connections
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10-1 PLC System Configuration
Left-click the PLC Icon before making the following settings.

1,2,3... 1. PLC model, communications between the personal computer and PLC,
and Board and Unit settings.

2. Left-click the required PMSU Icon (Board/Unit) before performing the trace
memory 1 (A), trace memory 2 (B), communications port 1 (A), or commu-
nications port 2 (B) settings.

Note Use icons in parentheses if the C200HX/HG/HE is used.

10-1-1 Outline of Operation
The following operations are possible by right-clicking the PLC Icon in the
PLC Menu, toolbar, or project workspace (i.e., the left pane of the window)
and selecting the items from the pop-up menu that is displayed.

• Settings for communications between the personal computer and PLC.

• PLC online connections and changes in PLC operating mode.

• Reading and displaying protocol data from the Boards and Units.

• PMSU communications setting data transfer and trace memory starting
and reading.

• I/O table creation, PLC I/O memory monitoring and editing, and error log
display.

PLC icon

PLC model

Communications between 
personal computer and 
PLC

Board icon

Unit 0 icon

Unit F icon

PLC memory

I/O table

Error log
: Set by users.

Trace memory 1 (A)/2 (B)

Communications port 1 (A)/2 (B)

Starts tracing/reading

Board communications 
port settings

Trace memory 1/2

Communications port 1/2 Unit 0 communications 
port settings

Trace memory 1/2

PLC I/O memory monitoring/editing

I/O table creation/editing

PLC error log display

Starts tracing/reading

Communications port 1/2 Unit F communications 
port settings

Starts tracing/reading

Note   Those in brackets are for the C200HX/HG/HE. 
Units 0 to F are for the CS/CJ.

: Monitor
260



Communications Settings between Personal Computer and PLC Section 10-2
10-2 Communications Settings between Personal Computer 
and PLC

10-2-1 Outline of Connection Methods
The following three methods are available for PLC connections for online com-
munications.

Direct Connections to PLC for Online Communications
The following shows how the personal computer can be connected directly for
online communications with the PLC using the toolbus or host link.

Connections to PLC via Network for Online Communications
The following shows how the personal computer can be connected online to a
PLC on the network via another PLC that is connected to the personal com-
puter using the toolbus or host link.

Note This type of connection is not supported for an NJ-series CPU Unit.

Connections to PLC via Modem for Online Communications
The following shows how the personal computer can be connected online to a
PLC via a telephone line using a modem. The PLC connected to via a modem
can also be used as a gateway for online connection to other PLCs on the net-
work. For settings, refer to 10-4 Modem Connections.

Note This type of connection is not supported for an NJ-series CPU Unit.

Connections to PLC through built-in 
port for online communications

Connecting to PLC through Serial Communica-
tions Board or Unit

CPU Unit

Host Link

Serial Communications Board or Unit

CPU Unit

CX-Protocol CX-Protocol

Tool Bus, Host Link, 
or USB
NJ-series CPU Unit: USB or Ethernet

CX-Protocol

Gateway

Network

Toolbus or Host Link

CX-Protocol
Telephone line

Toolbus or Host Link

Modem
Modem

Toolbus or Host Link
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10-2-2 Direct Connections to PLC for Online Communications
Setting PLC Model Use the following procedure to set the PLC model.

1,2,3... 1. Right-click the PLC Icon and select Edit PC-PLC Comms Settings from
the pop-up menu, or select Edit PC-PLC Comms Setting from the PLC
Menu.

2. Select the PLC Series from the Device Type drop-down list.

3. Left-click the Settings Button to enter the setting.
262



Communications Settings between Personal Computer and PLC Section 10-2
Communications Settings

1,2,3... 1. After you set the model of the CPU Unit in the above procedure, select the
network type from the Network Type drop-down list. In this example, SYS-
MAC WAY is selected.

2. Left-click the Settings... Button on the right-hand side. The Network Set-
ting Dialog Box will be displayed.
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3. Left-click the Driver Tab in order to change the communications condi-
tions. The name of port, baud rate, data length, parity, and number of stop
bits can be set.

Note The communications conditions must coincide with those in the PLC
Setup of the CPU Unit. For details, refer to the Operation Manual of
the PLC.

4. Left-click the OK Button.

Note With the C200HX/HG/HE, the baud rate cannot be set to 1,200 bps
for connections using the toolbus.

10-2-3 Connections to PLC on Network via Online Communications
Outline By making simple settings with the CX-Protocol, it is possible for the personal

computer to connect online to a PLC on the network via another PLC that is
directly connected to the personal computer.

The following explains the settings required for the personal computer to com-
municate with a PLC on the network.

These settings make available all online functions (e.g., protocol transfer,
communications port setting transfer, and tracing) for the control of PMSU
mounted to the PLC on the network.
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Settings The following system example shows how to make the settings required to
connect the personal computer to a PLC on the network.

The CX-Protocol connects the personal computer online to a PLC (PLC100 in
this example) on the network through another PLC (PLC000 in this example),
that has been registered with the project by using the CX-Protocol.

Note This type of connection is not supported for an NJ-series CPU Unit.

1,2,3... 1. In this example, a new project is created for the PLC100, which is a CS1G/
CJ1G type. Left-click New in the File Menu or left-click the New Icon on
the toolbar.

2. Make settings in the Change PLC and the Network Settings [Toolbus]
Dialog Boxes as shown below.

3. Click the OK Button.

CX-Protocol

Toolbus or Host Link
Network 
Example: Controller Link

Gateway
Device name: PLC000
Device type: CS1H
Node address: 0

Device name: PLC100
Device type: CS1G
Node address: 1

Settings 
for 
PLC100

Select Toolbus 
or Host Link.

By left-clicking this button, the Network Settings 
dialog box will be displayed as shown below.
265



Communications Settings between Personal Computer and PLC Section 10-2
4. Left-click CX-Net in the Tool Menu.

1

Set to 0 for local network communications.

Set the node address to 1.

Increase the response monitor time if the time elapses 
before the establishment of network connections.

Use the default value normally. If communications are made over 
two or more networks, set the value to the shorter frame length.
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5. Select Add Device from the Project Menu. Make settings for Network
Type and Network Settings as shown below.

Adding 
PLC000

Set the node address to 0.

Set to 0 for local network communications.
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6. Close the CX-Net (CX-Programmer). Right-click the PLC Icon in the
project workspace and select Change from the pop-up menu. Alternative-
ly, select Edit from the Edit Menu.

7. Change the Network Type in the Change PLC Dialog Box to PLC000.

By making the above settings, PLC000 becomes the gateway for communica-
tions with PLC100. To make an online connection, right-click PLC100 in the
project workspace and select Connect to PLC, or select Connect to PLC
from the PLC Menu. 

Note CX-Net (PLC Network Configuration Tool) is used for performing construction,
debugging, and applications for OMRON PLC networks. It is used for the fol-
lowing:

• Connecting a PLC to a network

• Routing table settings

• Data link table settings

• Network Support Board (NSB) settings

• Communications Unit software switch settings

For details about CX-Net, refer to Section 13 PLC Network Configuration Tool
in the SYSMAC WS02-CXPC1 CX-Programmer Operation Manual (W344).

10-3 Online Connections and Mode Changes
10-3-1 Online Connection Method

Use the following procedure for online connections.

1,2,3... 1. Right-click the PLC Icon and select Connect to PLC from the pop-up
menu, or select Connect to PLC from the PLC Menu. 

2. When the establishment of online connections is successful, the PLC
mode (RUN, PROGRAM, or MONITOR) will be displayed next to the PLC
Icon in the project workspace (i.e., the left pane of the window).

Changing 
Settings 
for PLC100

Settings are 
made via PLC000
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If the establishment of online connections is unsuccessful, the following
screen will be displayed. Check the communications settings.

Note When the NJ-series Controller is configured as follows, online connection
may not be possible.

• The Do not use Option is selected for FINS/UDP in the FINS Settings of
the Built-in EtherNet/IP Port Settings, that is located under Configura-
tions and Setup - Controller Setup on the Sysmac Studio.

• The Do not use Option is selected for FINS/TCP in the FINS Settings of
the Built-in EtherNet/IP Port Settings, that is located under Configura-
tions and Setup - Controller Setup on the Sysmac Studio.

• The Use Option is selected for Packet Filter in the TCP/IP Settings of
the Built-in EtherNet/IP Port Settings, that is located under Configura-
tions and Setup - Contoller Setup on the Sysmac Studio.

For details on Packet Filter settings, refer to Packet Filter in the NJ/NX-series
CPU Unit Built-in EtherNet/IP Port User’s Manual (Cat. No. W506).

Note The personal computer and PLC must be connected to each other for online
communications before the following items are performed.

• Transfer of communications port setting data from PMSU (Data transfer
from PLC to personal computer)

• Transfer of communications port setting data to PMSU (Data transfer from
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• Transfer of protocol data to PMSU (Data transfer from personal computer
to PLC)

• Transfer of protocol list data from PMSU (Data transfer from PLC to per-
sonal computer)

• Start, stop, and transfer of tracing data (Data transfer from PLC to per-
sonal computer)

• I/O table creation
• I/O memory display/editing
• Error log display

!Caution Online connection of the CX-Protocol cannot be made to a PLC which is con-
nected online to SYSMAC-CPT or SYSMAC-PST. Simultaneous online con-
nections cannot be made regardless of whether there is only one personal
computer (i.e.: the communications port is the same) or there are several per-
sonal computers (i.e.: the communications ports are separate). Therefore,
when SYSMAC-CPT or SYSMAC-PST is running and connected online to a
PLC, it must be made offline before making online connection to the CX-Pro-
tocol. Similarly, when the CX-Protocol is connected online to a PLC, it must be
switched to offline before making online connection to SYSMAC-CPT or SYS-
MAC-PST.

10-3-2 Changing to Offline
Use the following procedure to set the CX-Protocol from online (i.e., PRO-
GRAM, MONITOR, or RUN mode) to offline.
Right-click the PLC Icon and select Disconnect from PLC from the pop-up
menu, or select Disconnect from PLC from the PLC Menu.

10-3-3 PLC Operating Mode Changes
Before transferring protocol data or communications port setting data, be sure
to set the PLC to PROGRAM mode by using the following procedure.
Right-click the PLC Icon, select Operating mode, and select PROGRAM
mode. Alternatively, select Operating mode from the PLC Menu and select
the PROGRAM mode.

!Caution Confirm that no adverse effect will occur in the system before changing the
operating mode of the CPU Unit. Not doing so may result in an unexpected
operation.

10-4 Modem Connections
10-4-1 Outline

Online connection can be made to a remote PLC via telephone line using
modems.

Note This type of connection is not supported for an NJ-series CPU Unit.

Personal computer 
(CX-Protocol)

Modem

Modem for per-
sonal computer

Modem

Modem for PLC

Telephone line

The modem can be connected to the 
PLC's peripheral port, built-in host link 
port, or PMSU.

PLC
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The setting procedures required to make connections to a remote PLC using
modems are shown below.

Make the settings so that the following conditions are satisfied.
• Baud rate: Set the same baud rate for the PLC communications port and

the personal computer communications port.
• Serial communications mode: host link (SYSMAC WAY) or toolbus
• Communications conditions:

When serial communications mode is set to host link:
Data length: 7 bits
Parity: even
Stop bits: 2 bits

When serial communications mode is set to toolbus:
Data length: 8 bits
Parity: none
Stop bits: 1 bit

Settings at the PLC side
   Setting the modem at the PLC side
Connecting the PLC to the modem
Making settings for the PLC connections port 

Settings at the personal computer (CX-Protocol) side
Setting the modem at the personal computer side 

(made in Windows)
Connecting the personal computer to the modem
Making settings for the CX-Protocol (includes set-

ting the telephone number)

Online connection

10-4-2 Settings at the PLC Side
Modem Settings Make settings for the modem to be connected to the PLC using personal com-

puter communications software (terminal software). Before performing the
operations given below, connect a personal computer to the modem.
As an example, the operating method will be explained for OMRON’s
ME5614E modem.

1,2,3... 1. Turn ON the power supply for the modem.
2. Start the personal computer communications software.
3. Set the baud rate and communications format for the communications soft-

ware in the following way.
• Set the same baud rate as that of the PLC.
• Set the communications format to one of the following:
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Parity: even
Stop bit: 2 bits

When serial communications mode is toolbus:
Data length: 8 bits
Parity: none
Stop bit: 1 bit

Note When the above settings are made and communications are per-
formed, OMRON’s ME5614E Modem will automatically recognize
and record the settings. If a modem without this feature is used,
make the above settings using AT commands.

4. Make settings for the modem by sending AT commands as shown below.

Example: for ME5614E

• The “[Enter]” indicates where the Enter Key should be pressed. 

• The “ok” means that the modem has accepted the command.

Meanings of AT Commands and S Registers Used in the Previous 
Example

Command Setting item Settings

AT&F Return to factory setting ---

AT%C0 Data compression setting No data compression

AT\N3 Error correction setting V.42 auto-reliable mode

AT&K3 Flow control Available
For C200HX/HG/HE, set to 0 
(not available)

ATS0=1 Automatic reception Available (for 1 call)

ATS30=60 Abort timer (ex. 1 minute)

ATX4 Baud rate display Baud rate display, busy, dial 
tone detection

ATE0 Command echo Not available

AT&D0 DTR signal control Constantly ON

AT&Y1 Setting at power ON Load setting for profile 1 at 
power ON

AT&W1 Storage of present value area 
contents in non-volatile memory

Stored as profile 1

AT&F [Enter]

ok

AT%C0\N3&K3S0=1S30=60X4E0&D0&Y1 [Enter]

ok

AT&W1 [Enter]

ok
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Connecting the PLC to the 
Modem

After the modem settings have been completed, connect the PLC to the
modem.

Connect the PLC to the modem referring to the example below.

Connecting to the Host Link Port or PMSU

Connecting to the Peripheral Port

Connect a peripheral interface cable (for IBM PC/AT or compatible) to the
peripheral port of the PLC, and connect the other end of the cable to a cable
connected to the modem. For details on peripheral interface cables, refer to 1-
4 System Configuration.

Settings for PLC 
Connections Port

Communications conditions settings for the PLC port to be connected to the
modem are made on a PLC Programming Device (CX-Programmer or per-
sonal computer). After the settings have been made, direct online connection
is made between the Programming Device and the PLC, and the settings are
transferred.

As an example, the setting procedure for a CS/CJ-series PLC, using a CX-
Programmer, is shown below. For details, refer to the CX-Programmer Opera-
tion Manual.

Modem

Connector hood FG

CS/CJ

RTS

CTS

FG

SD

RD

SG

DSR

DTR

4

5

1

2

3

7

6

20

Connector hood FG

RTS

CTS

FG

SD

RD

SG

DSR

DTR

4

5

1

2

3

9

7

8

D-sub 25-pin (male)

Programming Device

D-sub 9-pin (male)

Modem

Connector hood FG

RTS

CTS

FG

SD

RD

SG

DSR

DTR

4

5

1

2

3

7

6

20

Connector hood FG

RTS

CTS

FG

SD

RD

SG

DSR

DTR

4

5

1

2

3

9

7

8

Peripheral interface cable (for
IBM PC/AT or compatible)

Create a connection cable.

PLCModem
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Connecting the Built-in Host Link Port to the Modem

Settings for the host link port are performed in the PLC Settings Window of
the CX-Programmer, as shown below. Set the serial communications mode to
Host Link or ToolBus. With the CS/CJ Series, when making connections
with the toolbus, connections cannot be made via the modem using automatic
recognition of the baud rate. Connections must be made using the toolbus
settings in the PLC system settings.
Set pin 5 of the DIP switch on the front side of the CS/CJ-series CPU Unit to
OFF (to follow the PLC system settings) and set the serial communications
mode for the RS-232C port in the PLC Settings to ToolBus.

Connecting the Peripheral Port to the Modem

Settings for the peripheral port are made in the PLC Settings Window of the
CX-Programmer. The setting method is the same as for the host link port
above. Set the serial communications mode to Host Link or Toolbus. When
making connections with the toolbus for the CS/CJ Series, connections can-
not be made via the modem using automatic recognition of the baud rate.
Connections must be made using the toolbus settings in the PLC system set-
tings.
Set pin 4 of the DIP switch on the front side of the CS/CJ-series CPU Unit to
ON (to follow the PLC system settings) and set the serial communications
mode for the peripheral port in the PLC Settings to ToolBus.

Note With the C200HX/HG/HE, there is no automatic recognition function for the
baud rate. 

Select baud rate.
Set to a baud rate less 
than the maximum baud 
rate for the modem.

Set to 7,2,E if in host link mode, and to 
8,1,N if in toolbus mode.
These settings refer to the data length, 
the number of stop bits and the parity 
(E=even, N=none).

Select ToolBus or Host 
Link.

Select custom settings to 
allow setting the baud rate.
274



Modem Connections Section 10-4
Connecting the PMSU (Ports 1, 2) to the Modem

Settings for the communications port of the PMSU are made in the I/O Table
Window of the CX-Programmer. Set the serial communications mode to Host
Link.
It is also possible to make the settings for the PMSU communications port and
transfer them using the CX-Protocol. In Communications Port Settings
Edit, set the Mode in the Communications Port Settings Dialog Box of the
PMSU to Host link. For details refer to 10-6 PMSU Communications Port Set-
tings and 10-7 Transfer of Communications Port Setting Data to PLC.

Note Toolbus connection is not supported by the PMSU.

Transferring the Settings

After the communications conditions for the port have been set, transfer the
settings to the PLC. Make direct online connection to the PLC to be connected
to the modem and transfer the settings in the following way.

Using the CX-Programmer:

• In the PLC Settings Window, select Options/Transfer to PLC.

• In the I/O Table Window, select Options/Transfer to PLC.

Using the CX-Protocol:

• For details refer to 10-6 PMSU Communications Port Settings and 10-7
Transfer of Communications Port Setting Data to PLC.

10-4-3 Settings at the Personal Computer
Modem Settings This section explains how to make the settings for the modem to be con-

nected to the personal computer. As an example, the setting procedure for the
OMRON Modems (ME5614E, ME5614C) are given.

ME5614E

1,2,3... 1. Connect the modem to COM1 or COM 2 of the personal computer using a
straight cable.

2. Turn ON the power supply for the personal computer.
Windows will recognize the modem and the Wizard will be displayed.

3. Make settings according to the instructions given by the Wizard.

On completion of the above, the modem can be used from the personal com-
puter.

ME5614C

1,2,3... 1. Insert the modem card in the PLC card slot.

2. Turn ON the power supply for the personal computer.
Windows will recognize the modem and the Wizard will be displayed.

3. Make settings according to the instructions given by the Wizard.

On completion of the above, the modem can be used from the personal com-
puter.
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Connecting the Personal 
Computer to the Modem

Connect the personal computer (CX-Protocol) to the modem using the
modem’s RS-232C cable.

CX-Protocol Settings

1,2,3... 1. Display the Change PLC Dialog Box with the CX-Protocol.

2. Select SYSMAC WAY (host link) or Toolbus from the Network Type se-
lection box.

3. Left-click the Settings... Button to the right of the Network Type selection
box. The Network Setting Dialog Box will be displayed.

4. Specify the PLC to be connected to in the Network Tab.

• When making connections to a PLC that is connected directly to the
modem, set Network to “0” and Node to “0” (default settings).

• When making connections from a PLC directly connected to a tele-
phone to another PLC on the network, make the appropriate settings
for the network address and the node address. For details of network
communications, refer to 10-2 Communications Settings between Per-
sonal Computer and PLC.
276



Modem Connections Section 10-4
5. Left-click the Modem Tab, and make settings for the modem driver, the
present address, and the destination telephone number.

Use the following procedure to make settings for the modem and the
present address.

6. Left-click the Configure... Button to the right of the Modem selection box.
The following screen, which is used to set the properties for the modem,
will be displayed.

Select the driver for the modem. Left-click here to dis-
play the dialog box re
ferred to in step 7.

Left-click here to dis-
play the dialog box 
referred to in step 11.
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7. Left-click the General Tab and set the baud rate for communications be-
tween the personal computer and the modem.

8. Left-click the Connection Tab and set the communications conditions.

Set the baud rate for commu-
nications between the personal 
computer and the modem.
This setting should be the 
same as that for the commu-
nications port of the PLC.

Communications conditions settings

•   For host link connections:
7 bits, even, 2 stop bits

•   For toolbus connections:
8 bits, no parity, 1 stop bit
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Note These dialog boxes take priority in making the settings for the modem. The
settings made in the Driver Tab of the Network Setting Dialog Box (see step
5 above) will be ignored if they are different.

9. Left-click the Advanced Button.
The Advanced Connection Settings Dialog Box will be displayed.

10. Make settings for error control and flow control. Make the settings as fol-
lows.

• Use Error Control: Only select Compress data

• Use Flow Control: Select Hardware (RTS/CTS)

• After the settings have been made, double-click the OK Button to re-
turn the Network Setting Dialog Box.

11. Open Location Information Dialog Box from the Phone and Modem Op-
tions in the Control Panel, and set the information for the modem to be con-
nected to the CX-Protocol. Make the appropriate settings for the types of
modem and telephone line.

On completion of the above, the settings for the personal computer are made.

10-4-4 Online Connection
When online connection operations are performed from the CX-Protocol,
autodial will be executed, and connection to the remote PLC will be made via
the modem.

10-5 I/O Table Creation
When mounting the CS/CJ-series Serial Communications Unit to the Back-
plane for the first time, use the following procedure to create an I/O table.

Note This operation is not supported for an NJ-series CPU Unit.

10-5-1 I/O Table
Note When the Serial Communications Unit is mounted to the PLC for the first time

and the CPU Unit is turned ON, the ERR/ALM indicator of the CPU Unit will
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flash. When online connections are established, an error log window will be
displayed. Ignore the PLC Errors Window and use the following procedure to
create an I/O table.

When the I/O table is created, the ERR/ALM indicator will turn OFF. Close the
PLC Errors Window.

1,2,3... 1. Connect the personal computer to the PLC for online communications.

2. Set the PLC to PROGRAM mode.

3. Right-click the PLC Icon and select I/O table from the pop-up menu. 

4. Select Create from the Option Menu. 

5. After creating the I/O table, set CX-Protocol offline once and then return to
online status. This enables the Serial Communications Unit information to
be read by CX-Protocol.

For details of I/O table functions, refer to CX-Programmer Operation Man-
ual.

10-6 PMSU Communications Port Settings
Use the following procedure for the PMSU communications port settings.

1,2,3... 1. Double-click the PLC Icon in the project workspace (left pane).
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2. In the project window (right pane), double-click the PMSU Icon for which
the communications port settings are to be made. Alternatively, left-click
the PMSU Icon in the project workspace (left pane).

3. Double-click the Communications Port Icon, or right-click the Communi-
cations Port Icon and select Edit Communications Port Settings from
the pop-up menu. Alternatively, left-click the Communications Port Icon
and select Edit Communications Port Settings from the PLC Menu. The
Communications Port Settings Dialog Box will be displayed with Port 
1/2 if the CS/CJ is used and Port A/B if the C200HX/HG/HE is used.
These Dialog Boxes are the same in appearance. 
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4. Set the Communication Method Field to Protocol Macro.

5. If the standard communications conditions are used, leave the Standard
Comms Format check box in the Communication Field as is.

If the communications conditions are changed, turn OFF the check mark
of the check box and set the baud rate, data length, parity, and number of
stop bits.

6. Left-click the OK Button to enter the settings. Left-click the Cancel Button
to leave the settings unchanged.

Note If the PLC is CS/CJ and the Communication Method Field is set to Protocol
Macro, a communications baud rate higher than that designated by the proto-
col macro specifications (38,400 bps max.) can be set. However, if this setting
is actually made, a PLC Setup error will occur, and the CS/CJ will operate at
the default baud rate of 9,600 bps.

10-7 Transfer of Communications Port Setting Data to PLC

10-7-1 Transfer of Communications Port Setting Data to PLC
Use the following procedure to transfer the data on the communications port
settings in the PMSU to the PLC.

1,2,3... 1. Connect the personal computer to the PLC for online communications.

2. Set the PLC to PROGRAM mode.

3. Left-click the PMSU Icon for the corresponding communications port or
left-click the desired Communications Port Icon. If a PMSU Icon is select-
ed, data on the settings of both communications ports will be transferred.
If a Communications Port Icon is selected, the settings for that commu-
nications port will be transferred.
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4. Left-click the Download Communications Port Setting Icon from the
toolbar, or right-click and select Download Communications Port Set-
ting from the pop-up menu. Alternatively, select Download Communica-
tions Port Setting from the PLC Menu after selecting the desired
communications port.

5. On completion of the transfer, the message Communications port set-
ting download completed will be displayed. Left-click the OK Button.

!Caution Confirm that no adverse effect will occur in the system before changing the
operating mode of the CPU Unit. Not doing so may result in an unexpected
operation.

!Caution Confirm that no adverse effect will occur in the system before transferring the
communications port A/B settings to the Protocol Macro Support Unit
(PMSU). Not doing so may result in an unexpected operation.

10-7-2 Reading Communications Port Setting Data from PLC
Use the following procedure to read the data on the communications port set-
tings in the PMSU from the PLC.

1,2,3... 1. Connect the personal computer to the PLC for online communications.

2. Set the PLC to PROGRAM mode.

3. Left-click the PMSU Icon for the corresponding communications port or
left-click the desired communications port. If a PMSU Icon is selected, data
on the settings of both communications ports will be read. If a communica-
tions port is selected, the settings in the corresponding communications
port will be read.

4. Left-click the Upload Communications Port Setting Icon from the tool-
bar, or right-click and select Upload Communications Port Setting from
the pop-up menu. Alternatively, select Upload Communications Port
Setting from the PLC Menu after selecting the communications port.

5. On completion of the transfer, the message Communications port set-
tings upload completed. will be displayed. Left-click the OK Button.

Note Use the above procedures to read and write data from and to the following
areas of the CPU Unit.

• CS/CJ
Board: D32000 to D32009 (port 1) and D32010 to D32019 (port 2)
Unit: m to m + 9 (port 1) and m + 10 to m + 19 (port 2)
[m = D 30000 + 100 x Unit No.] (Unit No. 0 to F (15))

• C200HX/HG/HE
PLC Setup data in DM 6550 to DM 6654 (port B) and DM 6555 to DM
6559 (port A)
Data can be read and written from and to the above areas with a Pro-
gramming Device of the PLC or the PLC memory window of CX-Protocol.
Refer to 12-2 Outline of PLC Memory Window for details.
283



Transfer of Communications Port Setting Data to PLC Section 10-7
284



SECTION 11
Protocol Data Transferring and Printing

This section describes details of the transferring, converting, and printing of protocol data.

11-1 Transferring and Reading Protocol Data between the Computer and PMSU  286
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11-1 Transferring and Reading Protocol Data between the 
Computer and PMSU 

11-1-1 Transferring Data from the Computer to the PMSU

!Caution Confirm safety at the destination node before transferring a protocol to
another node or editing the I/O area. Doing either of these without confirming
safety may result in injury.

!Caution Confirm that no adverse effect will occur in the system before changing the
operating mode of the CPU Unit. Not doing so may result in an unexpected
operation.

!Caution Check the user protocol for proper execution before actually running it in the
Unit. Not checking the protocol may result in an unexpected operation.

Use the following procedure to download protocols to the PMSU from the
computer.

1,2,3... 1. Connect to the PLC online and set the PLC operating mode to Program
mode.

2. Double-click the Protocol List Icon in the project workspace (left pane) to
list the protocols in the project window (right pane).

3. Select a protocol to download. More than one protocol can be selected by
pressing the Shift Key and selecting another protocol to extend the selec-
tion or by pressing the Ctrl Key and selecting another protocol to add to
the selection.
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4. Select Download Protocols from the Protocol Menu or left-click the
Download Protocol Icon on the toolbar.
The Protocol Compile/Download Dialog Box will be displayed.

Note Transfer a protocol to the PMSU only after selecting a protocol.

5. Prior to download, a password can be applied to protect the protocol. Se-
lect the Protocol password protection check box to enable password
protection. Enter a password in the Password Field (up to eight charac-
ters). Enter the password in the Confirm Field. 

6. When adding a source code, select Include Source Information. If the
source code is not to be added, the amount of data transferred to the
PMSU will be small, but the protocol data that is read to the personal com-
puter when performing read (PLC to computer) will vary. Refer to the note
on page 291.

7. Left-click the Compile Button. Errors or alarms that occurred during com-
piling will be displayed in the output window (bottom left of the screen).

8. When the compile is normally completed, the Download Button will be-
come active. Left-click this button. Transfer status will be displayed on the
indicator. Press the Download Cancel Button to stop transfer processing.

9. When the transfer is completed, the message Download Completed OK
will be displayed. Left-click the OK Button.

10. Close the Protocol Compile/Download Dialog Box.

11-1-2 Displaying Protocol Data within the PMSU
Use the following procedure to display protocol data within the PMSU.

1,2,3... 1. Connect to the PLC online.

2. Double-click the PLC Icon.
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3. Left-click the PMSU Icon in the project workspace (left pane) or in the
project window (right pane), and then right-click to display a pop-up menu.
Select Upload Protocol List from the pop-up menu.

The trace, communications port, and protocol list will be displayed in the
Project Window.

11-1-3 Transferring Protocol Data from the PMSU to the Computer
Use the following procedure to upload protocol data to the computer from the
PMSU.

1,2,3... 1. Connect to the PLC online.

2. Double-click the PLC Icon.

3. Left-click the PMSU Icon in the project workspace (left pane) or in the
project window (right pane) and then right-click to display a pop-up menu.
Alternatively, select Upload Protocol from the pop-up menu or left-click
the Upload Protocol Icon.

If protocol data is transferred with the password protection, input a pass-
word prior to uploading protocol data.

A message indicating that protocol data is being transferred and the
progress will be displayed on the status bar.

When transfer is completed, the message Decompiler Compiled OK will
be displayed. Left-click the OK Button.
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The transferred protocol data will be displayed in the project workspace
(left pane) with date and time of the transfer displayed after Uploaded Pro-
tocols.

Comparing Protocols in Boards/Units with Protocols in Projects
This function compares the protocols in one Board or Unit with the protocols
in a project. It is also possible to compare the protocols of multiple Boards or
Units at the same time with the protocols in the project. 

Use the following procedure to compare the protocols.

1,2,3... 1. Connect online to the PLC. 

2. Double-click the Protocol List Icon  in the Project Workspace on the left.

The protocols will be displayed in the Project Workspace on the right. 

3. Specify the protocols to compare with the protocols in the Board or Unit.
When selecting more than one protocol, hold down the Shift Key to select
a range or hold down the Ctrl Key to add protocols. 
It is also possible to select more than one Board/Unit at the same time.

Note Select all of the protocols in the Board/Unit being compared. If the
number of protocols does not match the number selected, the com-
parison will fail. 

4. Select Protocols - Compare Protocols from the menu bar, or click the

Protocol Comparison Icon  in the toolbar. The Protocol Compile/Com-

pare Dialog Box will be displayed. 
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Note Perform the operation to compare protocols in the Board/Unit only af-
ter selecting the protocols. 

5. If the source code was also transferred with the protocols the last time the
protocols were transferred to the Board/Unit, select the Include Source In-
formation Option. 

6. Click the Compile Button. Errors, warnings, and other information during
compilation will be displayed in the Output Window at the lower left. 

7. If compilation ends normally, the Compare Button will be enabled. Click
the Compare Button. The protocols will be read from the Board/Unit for
comparison. An indicator will be displayed in the status bar while the data
is being read. The comparison can be canceled at this time by clicking the
Stop U/L Button. 

8. When the comparison ends, the Compare Result Dialog Box will be dis-
played. 

The possible causes for a comparison to fail are given in the following table. 

Cause Correction

The option to include the source code was 
selected, but the source code is not 
included with the protocols in the Board/
Unit. 

Clear the option to include the source 
code and repeat the procedure from 
step 6. 

The option to include the source code was 
not selected, but the source code is 
included with the protocols in the Board/
Unit.

Select the option to include the source 
code and repeat the procedure from 
step 6. 
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Note If the source code is not included with the protocol data and the data format of
each message item is set to the constant control code/ASCII format, that por-
tion will be displayed as follows:

00 Hexadecimal to 1F Hexadecimal (Control Code)
Example:

00 Hexadecimal to NUL
1F Hexadecimal to US

20 Hexadecimal to 7E Hexadecimal (ASCII Format)
Example:

“@” to “@”
[31] to “1”

7F Hexadecimal (Control Code)
Example:

[7F] to DEL
DEL to DEL

80 Hexadecimal to FF Hexadecimal (Hexadecimal Format)
Example:

[80] to [80]
[FF] to [80]

11-2 Printing Protocols
Each protocol can be printed with the following contents.

1,2,3... 1. Sequence number, sequence name, each sequence settings.
2. Settings of all the steps (in table format)

The number of protocols selected in step 3 
does not agree with the number of proto-
cols in the Board/Unit. 

Perform the procedure in 11-1-2 Dis-
playing Protocol Data within the PMSU 
and check to see if the number of pro-
tocols is the same. 

The names of the protocols selected in step 
3 do not agree with names of the protocols 
in the Board/Unit.

Perform the procedure in 11-1-2 Dis-
playing Protocol Data within the PMSU 
and check to see if the names of proto-
cols are the same. 

The sequences, steps, or messages in the 
protocols are different. 

Perform the procedure in 11-1-3 Trans-
ferring Protocol Data from the PMSU to 
the Computer and check the 
sequences, steps, and messages in 
the protocols. 

Cause Correction

Item With source code Without source code

Protocol name Same as when transferring 
from computer to PLC.

Same as when transferring from 
computer to PLC.

Sequence name Same as when transferring 
from computer to PLC.

Allocated automatically.
 (NewSequence 1, 
NewSequence 2, etc.)

Send message 
name

Same as when transferring 
from computer to PLC.

Allocated automatically. 
(SD(0)_1, SD(1)_1, etc.)

Receive message 
name

Same as when transferring 
from computer to PLC.

Allocated automatically. 
(RV(2)_1, RV(3)_1, etc.)

Matrix name Same as when transferring 
from computer to PLC.

Allocated automatically. 
(Matrix, Matrix 1 etc.)

Constraint 
attributes in the 
message

Same as when transferring 
from computer to PLC.

Allocated automatically. 
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3. Send/receive message name and message settings.
4. Matrix name and contents of the matrix case.

11-2-1 Setting the Printer
Set the printer settings using the Print Setup Dialog Box. With the CX-Proto-
col, use the following procedure.

1,2,3... 1. Select Print Setup from the File Menu.
2. The Print Setup Dialog Box will be displayed. Select a printer from the

Name drop-down list. Use the Properties Button to set the printer.
3. Select a paper size from the Paper drop-down list in the Base Field.
4. Select a paper feed method from the Paper Source drop-down list.
5. Select either Port or Land in the Paper Field.
6. Left-click the OK Button to confirm the settings or the Cancel Button to

leave the settings unchanged.
For further details about the printer settings, refer to the instruction manual of
the printer.

11-2-2 Printing a Protocol
Use the following procedure to print a protocol.

1,2,3... 1. Double-click the Protocol List Icon to list the protocols in the project win-
dow (right pane).

2. Select a protocol to print. More than one protocol can be selected for print-
ing by pressing the Shift Key and selecting another protocol to extend the
selection or by pressing the Ctrl Key and selecting another protocol to add
to the selection.

3. Printout images of protocols can be previewed by right-clicking and select-
ing Print, then Print Preview from the pop-up menu. The preview window
will be displayed and the desired protocol can be previewed. The selection
can also be made from the File Menu. The following functions are avail-
able.

• Press the Next Page Button or Prev Page Button to navigate through
the pages of the print-out.

• Press the Two Page Button to view two pages of the print-out at once.
This button will then change to the One Page Button to revert back.

• Press the Zoom In Button and the Zoom Out Button to zoom in and
out of the print-out.

• Press the Close Button to close the dialog box.
• Press the Print Button from the toolbar to display the Print Dialog Box.

After designating the printer name, printing range, number of copies, left-
click the OK Button to print the data. 

4. Alternatively, right-click to display a pop-up menu and select Print from the
Print Menu or left-click the Print Icon on the toolbar. Print can also be se-
lected from the File Menu.

5. The Print Dialog Box will be displayed. Set the printer name, printing
range, and number of copies. Press the OK Button to print the data.

6. Printing will start.

Printout example of protocol data is as shown below.
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Note Message data may extend beyond the printing frame depending on its length.
If this happens, select Print Setup from the File Menu and change the print-
ing setting to landscape or change the printer type.

11-3 Importing Protocol Data from PST/PSS Files
With the CX-Protocol, SYSMAC-PST and PSS (DOS version) file data can be
imported. However, the imported PSS files cannot be edited with the CX-Pro-
tocol. Copy the data into the project and then edit the data. (Copying is only
possible for PST project files and PSS protocol files.)

The following files can be imported.

Use the following procedure to import a SYSMAC-PST project file.

1,2,3... 1. Select Open from the File Menu or left-click the Open Icon on the toolbar.
Alternatively, the file can be opened by pressing the Ctrl+O Keys.

2. The Open Dialog Box will be displayed.
Select a SYSMAC-PST project file from the list in the Open Dialog Box.

3. Left-click the Open Button or double left-click the selected project to con-
vert the SYSMAC-PST project file into one that can be edited with the CX-
Protocol. The message, Convert old file will be displayed. Left-click the
OK Button.

4. If there is no setting for PLC model in the SYSMAC-PST project file to be
imported, set applicable PLC model and communications settings. Left-
click the OK Button. The data can be edited with the CX-Protocol. The pro-

Type of PSS files Description File extension

PST project files SYSMAC-PST projects *.psw

PSS system setting files PMSU communications 
port (A, B) setting data

*.pts

PSS protocol files Only PSS protocol data *.pt1

PSS trace data files Only PSS or SYSMAC-
PST trace data

*.ptr
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tocol attribute will change to C200HX/HG/HE. Refer to 11-4 CS/CJ Proto-
col and C200HX/HG/HE Protocol for protocol attributes.

Note When Save is left-clicked to save the imported file, it will be saved as a CX-
Protocol file. Once it is saved, the file cannot be read with the SYSMAC-PST.
Therefore, if the file needs to be saved as a SYSMAC-PST file, select Save
As and enter a different name.
When Save is selected, a confirmation dialog box will be displayed. Left-click
the OK Button if the data can be overwritten.

Use the following procedure to import data from a PSS file.

1,2,3... 1. Select Open from the File Menu or left-click the Open Icon on the toolbar.
Alternatively, the file can be opened by pressing the Ctrl+O Keys.

2. The Open Dialog Box will be displayed.
Select a file type from the Type of File drop-down list box.

3. Select a PSS file from the list in the Open Dialog Box. The current folder
can be modified by selecting another folder from the Look in drop-down
list.

4. Left-click the Open Button or double-click the selected file to open the file.
The contents of the PSS file will be displayed in the project window (right
pane).

Note 1. This data cannot be edited with the CX-Protocol. Copy it once and paste it
into another project window to edit the data.

2. The data imported from the PSS system setting file cannot be copied to
the communications port for the CX-Protocol.
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11-4 CS/CJ Protocol and C200HX/HG/HE Protocol
The protocol macro for the CS/CJ-series PLCs is called the “CS/CJ Protocol”
and the protocol macro for the C200HX/HG/HE PLCs is called the “C200HX/
HG/HE Protocol.” With the CX-Protocol, the C200HX/HG/HE Protocol created
with the SYSMAC-PST can be downloaded to a CS/CJ PMSU so that it can
be used with the CS/CJ. In this case, the I/O memory area will be converted to
one for the CS-series. In the same manner, the CS-series Protocol can be
downloaded so that it can be used with a C200HX/HG/HE PSB.
With the CX-Protocol, either the CS/CJ Protocol or C200HX/HG/HE Protocol
can be selected when creating a new project file.
Since the commands and I/O memory area designation are different between
the CS/CJ Protocol and C200HX/HG/HE Protocol, observe the following pre-
cautions when downloading the protocol.
The standard system protocol of the CX-Protocol is provided with the CS/CJ
Protocol.

11-4-1 Downloading the Protocol
Transferring C200HX/HG/
HE Protocol 
to CS/CJ (CS/CJ Protocol) 
PMSU

The C200HX/HG/HE Protocol can be transferred to the Serial Communica-
tions Board/Unit for CS/CJ by setting the PLC model to the CS/CJ Series, and
setting the target for the protocol to the CS/CJ Serial Communications Board/
Unit.
The I/O memory area will be converted to one for the CS/CJ. Refer to the fol-
lowing section for further details about conversion.
If C200HX/HG/HE Protocol is used as CS/CJ Protocol, there will be limitations
in the use of EM (expanded data memory). It is recommended that CS/CJ
Protocol be used from the start.

Transferring CS/CJ 
Protocol to 
C200HX/HG/HE PMSU

The CS/CJ Protocol can be transferred to the Communications Board for
C200HX/HG/HE by setting the PLC model to the C200HX/HG/HE, and setting
the target for the protocol to the Communications Board.
The I/O memory area will be converted to one for the C200HX/HG/HE. Refer
to the following section for further details about conversion.
If CS/CJ Protocol is used as C200HX/HG/HE Protocol, there will be limitations
in the use of commands and I/O memory area. It is recommended that
C200HX/HG/HE Protocol be used from the start.

11-4-2 Converting the I/O Memory Area
The I/O memory area will be converted as shown below when the CS/CJ Pro-
tocol is converted into the C200HX/HG/HE Protocol or vice versa.

When converting the CS/CJ Protocol into the C200HX/HG/HE Protocol, the
commands (Wait, Flush, Open, or Close) and the check codes (LRC2, SUM1
(1 byte/2 bytes)) used exclusively for the CS/CJ Protocol will cause errors dur-
ing compilation. Therefore, create a protocol without using them. 

If the I/O memory area extends beyond that for the C200HX/HG/HE, an error
will occur. If so, correct the protocol.

CS/CJ Protocol C200HX/HG/HE Protocol

H (Holding relay) HR (Holding relay)

W (Internal auxiliary relay) LR (Link relay)

A (Special auxiliary relay) AR (Auxiliary memory relay)

D (Data memory) DM (Data memory)

E (Expanded data memory) EM (Expanded data memory)
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11-4-3 Converting C200HX/HG/HE Protocol into CS/CJ Protocol
Download the C200HX/HG/HE Protocol with source code to the CS/CJ PMSU
and upload the protocol to change its attributes to those for the CS/CJ Proto-
col.

CX-Protocol

Download Protocol
with source code.

PMSU

CPU UnitUpload to change to the CS/CJ Protocol.
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SECTION 12
Tracing and Monitoring

This section describes details of PLC memory area monitoring and the transmission line tracing.
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12-1 Tracing Transmission Lines
Transmission or reception data and signals of a maximum of 670 characters
that the Board or Unit exchanges with external devices can be traced if the
PLC is the C200HX/HG/HE. Transmission or reception data and signals of a
maximum of 1,700 characters can be traced if the PLC is the CS/CJ.

By tracing the transmission or reception data and signals, the contents of
each message transmitted or received per step can be checked and com-
pared with the preset sequence. The results of tracing can be saved as data
in project files or printed.

The following types of data can be traced.

CS/CJ Tracing Screen

Data type Display

Send message Character strings Send and receive messages 
of a maximum of 670 
characters (with 
C200HX/HG/HE) and a 
maximum of 1,700 characters 
(with CS/CJ)

Hexadecimal data

Receive message Character strings

Hexadecimal data

Sequence No. 0 to 999 (CS/CJ only)

Step No. 0 to 15

Control signal ON/OFF transitions of RTS, CTS, DTR, and DSR signals

Communications 
error (CS/CJ only)

Parity error (P), framing error (F), and overrun error (O)
298



Tracing Transmission Lines Section 12-1
C200HX/HG/HE Tracing Screen

• Transmission or reception data and signals are traced from left to right
starting from the leftmost point.

• The figures at the top row represent 10-byte units.

• The send message is shown above and the receive message below. Both
send and receive messages are in ASCII statements followed by hexa-
decimal data.

• The step number is displayed. If the PLC is the C200HX/HG/HE, the letter
“e” or “f” will be displayed in the step number.

• The RTS, CTS, DTR, and DSR signals are indicated in red above the dot-
ted baseline and in blue below the dotted baseline.

• In addition to the above tracing items, the trace number, execution
sequence number, and communications error will be displayed if the PLC
is the CS/CJ. The trace number changes with the change of the sequence
number.
If a communications error occurs, the screen will display the letter “P,” “F,”
or “O.”

Note 1. The ON or OFF state of the control signal is not sampled correctly. Use the
state result for reference only.
The sampling of the ON or OFF states of the RTS, CTS, DTR, and DSR
signals starts when the transmission or reception of a single character of
data has been completed. Changes in signals without transmission or re-
ception data or changes in signals while a single character is being trans-
mitted or received are not sampled.
The ON or OFF state of the CTS or DSR signal may differ depending on
whether the transmission has been completed or not.

2. Provided that the PLC is the CS/CJ, the screen will display “---” as both the
sequence number and step number when a message is received before
the execution of the sequence.

3. If the PLC model is the CS/CJ, the displayed position of the sequence or
step number may shift forward or backwards or “---” may be displayed in-
stead when transmission and reception data and signals are traced at a
baud rate of 19,200 bps or higher. This is due to the data collection perfor-
mance of the tracing function.

12-1-1 Tracing Method
The following two tracing methods are available.

Continuous Traces The trace is executed until stopped. When the PMSU trace buffer becomes
full during tracing, data will be discarded starting from the oldest data.
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One-shot Traces The trace is terminated when the trace buffer becomes full. The entire trace
data from the start of trace remains in the PMSU trace buffer.

12-1-2 Trace-related Bits
Trace-related flags are listed in the following table.
n = 1500 + 25 × Unit No. (words)

CS/CJ

C200HX/HG/HE

12-1-3 Starting and Stopping a Trace
Use the following procedure to start and stop a trace.

1,2,3... 1. Connect the PLC for online communications and set the PLC to Monitor
mode.

2. Double-click the PLC Icon.

3. Either left-click the PMSU Icon of the communications port to be traced in
the project workspace (left pane) or double-click the PMSU Icon in the
project window (right pane).

4. Left-click the Trace 1 or Trace 2 for the CS/CJ and Trace A or Trace B for
the C200HX/HG/HE to select a desired item. Right-click to display a pop-
up Menu and point to Start Trace and select Continuous Trace or One-
shot Trace from the submenu. Alternatively, left-click the Start Continu-
ous Trace Icon or Start One-shot Trace Icon on the toolbar. It can also
be selected from the PLC Menu. 

Tracing conditions of the Communications Board will be displayed on the
Status Field. Once the trace is started, Performing Continuous Trace or
Performing One-shot Trace will be displayed. When the trace is stopped,
Trace Stop will be displayed.

5. To stop tracing, left-click the Trace 1 or Trace 2 for the CS/CJ and Trace
A or Trace B for the C200HX/HG/HE to select a desired item. Right-click
to display a pop-up menu and select Stop Trace from the pop-up menu.
Alternatively, left-click the Stop Trace Icon on the toolbar. It can also be
selected from the PLC Menu.

Flag Port Effective address State

Continuous 
Trade Start/Stop 
Bit

Port 1 190001
Word n bit 01

The continuous trace starts on the rising edge and the trace is 
terminated on the falling edge.
This bit is invalid during one-shot traces.Port 2 190009

Word n bit 09

One-shot Trace 
Start/Stop Bit

Port 1 190002
Word n bit 02

The one-shot trace starts on the rising edge and is terminated 
on the falling edge. This bit is invalid during continuous traces.

Port 2 190010
Word n bit 10

Trace Execution/
Completion Flag

Port 1 190912 
Word n+9 bit 12

ON: Continuous or one-shot trace being executed.
OFF: One-shot trace is stopped by a full buffer when One-shot 
Trace Start/Stop Bit is still ON.Port 2 191912 

Word n+19 bit 12

Flag Port Effective address State

Continuous 
Trade Start/Stop 
Bit

Port A 28902 The continuous trace starts on the rising edge and the trace is 
terminated on the falling edge.

This bit is invalid during one-shot traces.Port B 28903

One-shot Trace 
Start/Stop Bit

Port A 28904 The one-shot trace starts on the rising edge and is terminated 
on the falling edge. This bit is invalid during continuous traces.Port B 28905

Trace Execution/
Completion Flag

Port A 28600 ON: Continuous or one-shot trace being executed.
OFF: One-shot trace is stopped by a full buffer when One-shot 
Trace Start/Stop Bit is still ON.Port B 28601
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12-1-4 Reading Trace Data from PMSU
The trade data in the buffer of the PMSU can be uploaded to the project by
using the following procedure.

1,2,3... 1. Connect the PLC for online communications and set the PLC to Monitor
mode or Program mode.

2. Double-click the PLC Icon.

3. Left-click the PMSU Icon for the communications port to be traced in the
project workspace (i.e., the left pane of the window) or double-click the
PMSU Icon in the project window (i.e., the right pane).

4. Left-click and select the Trace 1 or Trace 2 Icon if the PLC is the CS/CJ or
Trace A or Trace B Icon if the PLC is the C200HX/HG/HE. Right-click and
select Trace transfer (PLC to personal computer) from the pop-up
menu. Alternatively, left-click the Trace transfer (PLC to personal com-
puter) from the toolbar or select the same item from the PLC Menu.

The selected trace data will be displayed. Use the scroll bar on the bottom
of the window in order to scroll the trace data left and right.

12-1-5 Adding and Saving Trace Data to Project File
An uploaded trace can be added to and saved as part of a project by using the
following procedure.

1,2,3... 1. Upload the trace from the PMSU as described in 12-1-4 Reading Trace
Data from PMSU.

2. The trace will be displayed and automatically added to the project.

3. Select Save or Save As from the File Menu and save it as project file
(*.psw).

Use the following procedure to add information to the properties of the trace.

1,2,3... 1. Right-click in the field where the trace is displayed. Select Properties from
the pop-up menu. The Trace Properties Dialog Box be displayed.

2. Input the information on the trace and left-click the OK Button. Left-click the
Cancel Button to close the dialog box without saving the information.

12-1-6 Retrieving Trace Data
Trace data can be retrieved from project files or from trace data files.

Retrieving Trace Data from Trace List of Project
Use the following procedure to retrieve trace data from the trace list in a
project file.

1,2,3... 1. Left-click the Project Icon to show the trace list.

2. Left-click the Trace List Icon.

3. Double-click the desired trace within the trace list.

Retrieving Existing PSS Trace Data Files
Use the following procedure to open an existing PSS trace data file. The trace
data retrieved from the file cannot be added to projects.

1,2,3... 1. Select Open from the File Menu or click on the Open Icon from the toolbar.

2. The Open Dialog Box will be displayed.
Check that the Files of type Field is preset to PSSDOS Trace Files
(*.ptr). The current folder can be changed by selecting another folder from
the Look in drop-down list.

3. Left-click the Open Button or double-click the selected trace data file to
open the trace. In order to close the Open Dialog Box without the trace
data file opened, left-click the Cancel Button.
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12-1-7 Printing Trace Data
Traces can be printed directly from the CX-Protocol. Use the following proce-
dure to print a trace.

1,2,3... 1. Double-click the Trace List Icon to list the traces in the project window
(i.e., the right pane).

2. Double-click on a trace to display it.
3. If desired, the trace can be previewed by selecting Print Preview from the

File Menu. The preview window will be displayed.
• Select the Next Page Button or Prev Page Button to navigate through

the pages of the printout. 
• Select the Two Page Button to view two pages of the printout at once.

This button will change to the One Page Button to revert back.
• Select the Zoom In Button or Zoom Out Button to zoom the printout

image in or out.
• Select the Close Button to close the dialog box.
• The Print Dialog Box will be displayed by selecting the Print Button.

Designate the printer name, print range, and number of copies and
left-click the OK Button to print the trace.

4. Select Print from the File Menu or left-click the Print Icon from the toolbar.
5. The Print Dialog Box will be displayed. Designate the printer name, print

range, and number of copies and left-click the OK Button to print the trace.
6. The printing of the trace will start. The following is an example printout of

a trace.

12-2 Outline of PLC Memory Window
12-2-1 PLC Memory Window and PLC Data Table

The PLC memory window is used for displaying and editing I/O memory data,
such as bit, timer/counter, and DM data.
The table-type window called the PLC data table, which has a list of data clas-
sified according to I/O memory area, will be displayed in the PLC memory
window.
If the PLC is connected online, the I/O memory data of the PLC can be moni-
tored. Furthermore, I/O memory data edited in the PLC memory window can
be transferred to the PLC. The Board and Unit system settings can be per-
formed and the data can be transferred to the PLC.

Note This window is not supported for an NJ-series CPU Unit.
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Note 1. Do not monitor EM area used for file memory. If monitoring is performed
for this area, it will become impossible to display any present values.

2. Each I/O memory area varies with the PLC or CPU model. For details, refer
to the Operation Manual of the PLC in use.

3. All I/O memory data that can be transferred varies with the PLC mode. For
details, refer to 12-5 I/O Memory Transfer and Comparison.

12-2-2 Main Functions
The I/O memory window has the following main functions.

• I/O memory display

• I/O memory editing

• I/O memory monitor

• I/O memory data transfer (personal computer to PLC and vice versa)

• I/O memory data comparison

12-2-3 List of Areas
The following table shows a list of I/O memory areas that can be displayed or
edited in the PLC memory window. The abbreviations in the table are used in
the PLC memory window.

Note The above areas are listed in the order of display in the data area workspace
located in the I/O memory window. All I/O memory areas displayed vary with
the PLC model or CPU model.

12-2-4 Starting and Quitting PLC Memory Window
Starting PLC Memory Window and Displaying PLC Data Table

1,2,3... 1. Right-click the PLC Icon and select Memory from the pop-up menu or from
the PLC Menu.

CS/CJ C200HX/HG/HE

CIO: I/O Area, Work Area, Data Link 
Area, CPU Bus Area, Special I/O Unit 
Area, Inner Board Area, SYSMAC BUS 
Area, I/O Link Area, C200H Special I/O 
Unit Area, and CompoBus/D Area

IR: I/O Area and AR Area

A: Auxiliary Area AR: AR Area

T: Timer Area LR: LR Area

C: Counter Area HR: HR Area

IR: IR Area TC: Timer/Counter Area

DR: DR Area DM: DM Area

D: DM Area EM: EM Area

TK: Task Flat Area ---

H: HR Area ---

W: Work Area ---

E: EM Area ---
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The following initial screen will be displayed.

2. Double-click the name of the desired area in the data area workspace.

The PLC data table will be displayed. The following example is the PLC
data table of the CIO area of the CS/CJ Series.

Quitting PLC Memory 
Window

Select Exit from the File Menu in the PLC memory window. The PLC memory
window will close.

Data Area Workspace
• The area displayed will depend on the 

PLC model and CPU Unit type.
• For more details about area names, 

refer to the area names list.
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12-2-5 Changing Display and Input Formats
The display and input formats are selectable per I/O memory area in the fol-
lowing methods, provided that the PLC data table is active.

Selecting from Menu Select Display from the View Menu.

Selecting from Pop-up 
Menu

Right-click a cell in the PLC data table and select the display format from the
pop-up menu.

Selecting from Toolbar Left-click the icon on the toolbar.

Note The default data display format in the PLC data table can be changed by
selecting the new default data display format from the Display Tab in Prefer-
ences in the Display Menu.

Text
Hexadecimal
Floating point
Signed decimal
Decimal
Binary coded decimal
Binary
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12-2-6 PLC Memory Window Settings
Properties, such as the default data display format and monitor refresh cycle
of the PLC memory window can be changed.

Displaying Properties Dialog Box

1,2,3... 1. Select Preferences from the View Menu.

2. Left-click the buttons of the items to be set.

3. Left-click the OK Button to enter the settings. The details of tab settings are
explained below.

Settings in Display Tab Use the following procedure to set the default data display format in the PLC
data table.

1,2,3... 1. Select the Display Tab from the Properties - For New Windows Dialog
Box. The above window will be displayed.

2. Select the default word and bit display formats. It is also possible to change
the font.
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Settings in Monitoring Tab Use the following procedure to set the monitor update interval.

1,2,3... 1. Select the Monitoring Tab from the Properties - For New Windows Dia-
log Box.

2. Set the refresh period and unit and left-click the OK Button.

Settings in General Tab
1,2,3... 1. Select the General Tab from the Properties - For New Windows Dialog

Box.
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Automatically resize column widths: The column widths will be auto-
matically adjusted according to the window size of the PLC data table.

Prompt before closing an active monitor window: A prompt message
will be displayed when closing the window being monitored.

Beep on invalid input: An alarm is sounded when an inappropriate input
is made.

Fast window update: Makes the renewal speed for display data faster.

Note If the Fast window update setting is enabled, the speed at which
data is renewed will increase but the display may flicker.

2. Select the function and left-click the OK Button.

Settings in File Tab Use the following procedure to edit the comment. The file name and comment
will be displayed when I/O memory data is saved in the file by selecting Save
to File from the File Menu.

1,2,3... 1. Select the File Tab from the Property - For New Windows Dialog Box.

2. Enter comments in the Comment Field.

3. Click the OK Button.

Note With the CX-Protocol, the Delete Button is not available in the File property.

The comment input when saving 
the data will be displayed. This 
comment can be edited from this 
screen.
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12-3 I/O Memory Display and Editing
12-3-1 Displaying I/O Memory

1,2,3... 1. Double-click the name of the area to be displayed in the data area work-
space. The data table will be displayed.

The following example is the data memory area of the CS/CJ Series.

Note These operations are not supported for an NJ-series CPU Unit.

12-3-2 Editing I/O Memory Data
Editing Data

1,2,3... 1. Left-click the cell of the address to be edited in the PLC data window. Mul-
tiple cells, lines, or rows can be selected.

2. Input or edit the data according to the display format.

The PLC data table can be displayed and edited offline or online. The edited
data can be transferred to a PLC that is connected online so that the data in
the PLC will be changed. Refer to 12-5 I/O Memory Transfer and Comparison
if the edited data needs to be transferred to the PLC.

Note The cells corresponding to read-only areas (e.g. parts of SR area), are dis-
played in gray. Editing cannot be performed in gray cells.

Data Storage I/O memory data can be stored using either of the following methods.

• Saving in project: Select Save in Project from File Menu.

Data Area Workspace
• The area displayed will depend on the 

PLC model and CPU Unit type.
• For more details about area names, 

refer to the 12-2-3 List of Areas.
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• Saving as a different file (.MEM file): Select Save to File from File Menu.

Saving in Project

1,2,3... 1. Select Save in project from the File Menu in I/O memory window.
The Save Dialog Box will be displayed.

A comment can be entered in File Comment, if required.
2. Select the area to be saved. Left-click the OK Button to start saving the ar-

ea.

Note When deleting PLC data in project, select Properties from the Display Menu
and perform the deletion from the File Tab.

Saving as Different File (.MEM File)

1,2,3... 1. Select Save to File from the File Menu in the PLC memory window.
The Save Dialog Box will be displayed.

2. Select the area to be saved and left-click the OK Button.
The Save Dialog Box will be displayed.

3. Set the file name and location where the file is to be saved. Left-click the
Save Button to start saving the data.

12-3-3 Writing Same Data to Successive Addresses
Use the following procedure to write the same data to the designated cell,
line, or row.

The area presently 
open is displayed.
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Writing Same Data to 
Designated Line

As an example, the procedure for writing FFFF (hexadecimal) into D0030 is
given.

1,2,3... 1. Select and highlight the cell. In the following example, row D0030 is select-
ed and highlighted. Drag the cursor to the left to select the entire line.

2. Select Fill Data Area from the Grid Menu.

The Fill Memory Area Dialog Box will be displayed.

Note In this example, the Fill Range settings should not be changed.

3. Select the input format and enter the Value Field. In this example, Hexa-
decimal is selected and FFFF is entered.

4. Left-click the Fill Button.
The data set in step 3 will be written to the cell designated in step 1.
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Writing Same Data to 
Whole Bit Areas or 
Display Areas

Use the following procedure to write the same data to the whole data table
currently opened or the displayed range of the data table (i.e., the range dis-
played in the window).

1,2,3... 1. Select Fill Data Area from the Grid Menu.
The Fill Memory Area Dialog Box will be displayed.

2. Make the area, Fill Range, Value, and Status Value settings.

3. Left-click the Fill Button.

12-4 I/O Memory Monitor
While the PLC is connected online, the I/O memory status per area of the
PLC can be monitored. The value displayed on screen varies with the I/O
memory status of the PLC.

Note This operation is not supported for an NJ-series CPU Unit.

Note 1. Do not monitor EM area used for file memory. If monitoring is performed
for this area, it will become impossible to display any present values.

2. When in MONITOR or RUN mode, only data in the data in the data mem-
ory area (D) and extended data memory area (E) can be transferred to the
PLC.

Select the areas where the 
same data is written.

By selecting All, the same 
data will be written to all 
the selected areas.

By selecting Visible area 
only, the same data will 
be written to the range of 
the above areas displayed 
in the PLC data table.
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12-4-1 Monitoring Whole I/O Memory
1,2,3... 1. Connect the PLC online. This step can be taken after step 2 if desired.

2. Double-click the name of the area to be displayed in the data area work-
space and display the PLC data table. Multiple areas can be monitored si-
multaneously.

3. Right-click a cell in the PLC data table and select Monitor from the Online
Menu.

The following dialog box will be displayed.

4. Select the area to be monitored and left-click the Monitor Button.
The displayed range of the selected area in the PLC data window will be
monitored.
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Example: Data Memory Monitor Screen

Note If monitoring is performed, the data read from the PLC will be over-
written with the edited data displayed on the screen. For this reason,
if there is edited data in the PLC data table, a save confirmation mes-
sage will be displayed when monitoring is executed.

12-4-2 Address Monitor
The address or I/O name can be designated in the address monitor table to
monitor the data. This function is convenient in the following cases.

• Monitoring the data in bits or words of multiple areas in a single table for
the purpose of debugging.

• Monitoring the data in bits or words that are not adjacent in the same area
(e.g., the data in D00001 and D1000).

1,2,3... 1. Left-click the Address Tab in the data area workspace.

1. Click here

2. Double-click here
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2. Double-click Monitor.
The following Address Monitor table will be displayed.

3. Input the address or variable and press the Enter Key.
The data in the designated bits or words will be displayed.

Example:

Note Set the monitor refreshing cycle in the Monitor Tab by selecting Preferences
in the View Menu.

Force-set/reset in Address 
Monitor

Select the address to be force-set/reset, and from the Address Menu, select
Set or Reset as required from the Force Status Menu. Alternatively, the
Force Status Menu can be selected from the pop-up menu displayed by right-
clicking. Similarly, when clearing, select Clear.

Changing Present Values 
in Address Monitor 

Select the address for which the present value is to be changed and from the
Address Menu select Set Value. Alternatively, Set Value can be selected
from the pop-up menu displayed by right-clicking.
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• For word addresses, after specifying the data format (binary, BCD, deci-
mal, signed decimal, hexadecimal), enter the new value in the Word
Value Field.

• For contact addresses, specify “ON” or “OFF” in the Bit Value Field. 

12-4-3 Finding Force-set or Force-reset Bits
Use the following procedure to find and display the force-set or force-reset
bits.

1,2,3... 1. Click the Address Tab in the data area workspace.

1. Click here

2. Double-click here
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2. Double-click Forced Status.
• The search operation will start.
• The following window will be displayed on completion of the search op-

eration.

• If Refresh is selected from the Force Status Menu, the search oper-
ation will be performed again, and the bits that have been force-set/re-
set will be displayed.

12-5 I/O Memory Transfer and Comparison
The following description provides information on how to transfer edited data
from the PLC data table to the PLC, transfer data from the PLC to the PLC
data table, and compare data in the PLC with data edited in the PLC data
table.

Note This operation is not supported for an NJ-series CPU Unit.

!WARNING Confirm safety before transferring the I/O memory area state to the CIO area
of the PLC using the PLC memory window function of the CX-Protocol. Not
doing so may cause malfunction in devices connected to the I/O Units regard-
less of the operating mode of the CPU Unit.

!Caution Confirm that no adverse effect will occur in the system before transferring data
to the PLC. Not doing so may result in an unexpected operation.

!Caution Confirm that the PLC is connected online before transferring or comparing the
data. Not doing so may result in an unexpected operation.

!Caution Confirm that no adverse effect will occur in the system before changing the
present value of any word in memory. Not doing so may result in an unex-
pected operation.

!Caution Confirm that no adverse effect will occur in the system before force-setting/
force-resetting any bit in memory. Not doing so may result in an unexpected
operation.

12-5-1 Precautions for Transfer of Data to PLC
The following tables list the available PLC modes and I/O memory areas for
data transfer to the PLC.
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Note Before changing the operating mode, make sure that the change will not affect
the installation.

12-5-2 Data Transfer
Connect the PLC online before transferring I/O memory data.

Downloading (Personal 
Computer to PLC)

Use the following procedure to transfer the data of the PLC data table from the
personal computer to the PLC.

1,2,3... 1. In the data area workspace, display the PLC data table by double-clicking
the name of the area to be downloaded. When downloading part of the
PLC data table, specify the range of the area to be downloaded.
The range can also be specified in step 2.

2. Right-click a cell in the PLC data table and select Transfer To PLC via On-
line from the pop-up menu or from the Online Menu in the PLC memory
window.

3. Set the area and the range of the area to be transferred.

4. Click the Download Button.
Transfer of the data will start.

Uploading (Personal 
Computer from PLC)

Use the following procedure to transfer the data of the PLC data table from the
PLC to the personal computer.

1,2,3... 1. Open the PLC data table of the area to be uploaded. In order to designate
the range to be uploaded, highlight the range.

I/O memory Operating mode

PROGRAM MONITOR RUN

Data memory (D), extended 
data memory (E)

Transfer sup-
ported

Transfer sup-
ported

Transfer not 
supported

All other memory areas Transfer sup-
ported

Transfer not 
supported

Transfer not 
supported

Setting the range to be downloaded:

All: Everything in the areas selected 
in the box above, will be transferred.
Selection: The range of data set in 
step 1 (PLC data table) in one area, 
will be transferred to the PLC.
Range setting: Specify an address 
and a transfer range for the areas 
selected in the box above. The data 
in that range will be transferred to 
the PLC.
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2. Right-click a cell in the PLC data table and select Transfer From PLC via
Online from the pop-up menu or from the Online Menu in the PLC mem-
ory window.

3. Set the area and the range of the area to be transferred.

4. Left-click the Upload Button.
Transfer of the data will start.

12-5-3 Comparison with Data in PLC
Use the following procedure to compare the data of the PLC data table with
the data in the PLC after connecting the PLC online.

1,2,3... 1. Open the PLC data table in the area to be compared. To designate the
range to be compared, highlight the range.

2. Right-click a cell in the PLC data table and select Compare with PLC via
Online from the pop-up menu or from the Online Menu in the PLC mem-
ory window.

3. Set the area and the range of the area to be transferred.

The area currently open is displayed.
Check the area to be transferred.

Designate the range of the area to be 
transferred.

All: All data of the selected area.

Visible area only: The range of data cur-
rently displayed in the window.
Only if the range is selected in step 1, 
Selection is available.

The area currently open is displayed.
Check the area to be transferred.

Designate the range of the area to be transferred.
All: All data of the selected area.
Visible area only: The range of data currently 
displayed in the window.

Selection will be available only if the range is 
selected in step 1.
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4. Left-click the Compare Button.
The comparison of the data will start. One of the following messages will
be displayed according to the comparison result.

Data Coincident

Data Not Coincident

By left-clicking the Yes Button, the address of the data in the PLC will be
displayed in parentheses.

Yes No

When there is data that is not coinci-
dent, the data for the PLC side will be 
displayed in parentheses.
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SECTION 13
Error and Error Log Display

This section describes details of the displaying of errors and the error log.
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Current Error and Error Log Display
This section provides information on functions that display or clear the current
errors and error log. These functions are available only when the PLC is con-
nected online.

The errors and error log are displayed in the error log window. A message can
be displayed in the PLC Errors Window by executing the MSG instruction.

Note These operations are not supported for an NJ-series CPU Unit.

Displaying Errors

1,2,3... 1. Connect the PLC online.

2. Right-click the PLC Icon and select Error Log from the pop-up menu or
from the PLC Menu.

• The following Errors Tab will be displayed in the PLC Errors Window.

• All the errors currently resulting are displayed in the Errors Tab in the
PLC Errors Window.

• The display of errors will be automatically refreshed whenever a new
error occurs.

• Each error is displayed with its error type (i.e., fatal error or non-fatal
error).

• The following errors will be displayed if they result.

Fatal Errors (in Order of Priority)
Memory Error
I/O Bus Error
Unit/Rack Number Duplication Error
Inner Board Fatal Error
I/O Points Over
I/O Setting Error
Program Error
Cycle Time Over
FALS Error
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Non-fatal Errors (in Order of Priority)
FAL Error
Interrupt Input Unit Error
Basic I/O Error
PLC Setup Error
I/O Table Verification Error
Inner Board Nonfatal Error
CPU Bus Unit Error
Special I/O Unit Error
SYSMAC BUS Error
Battery Error
CPU Bus Unit Setup Error
Special I/O Unit Setup Error

Note It is possible to display the PLC Errors Window whenever an error
occurs. Furthermore, it is possible keep displaying the PLC Errors
Window on top or keep displaying the clock of the PLC on the status
bar of the error log window. For details, refer to page 326, Setting
PLC Errors Window Conditions.

3. Whenever an error is displayed, remedy the error.

4. Left-click the Clear All Button and delete the error display.

Note If a memory error has resulted, the error display will not disappear
when the Clear All Button is left-clicked in step 3. Instead, the follow-
ing dialog box will be displayed.

• Left-click Yes to clear all memory areas of the CPU Unit. The memory
areas will be initialized.

• Left-click No to clear the error display only. The memory areas will not
be initialized.
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Displaying the Error Log Use the following procedure to display the log of errors that have resulted.

Left-click the Error Log Tab in the error log window.
The following error log will be displayed.

• The items of errors displayed in the Error Log Tab are the same as
those in the Errors Tab. Refer to the previous subsection for details.

• Left-click the Clear All Button. The error log will be cleared.

• A maximum of 20 errors can be recorded in the error log. If the 21st
error results, the oldest recorded error will be deleted.

Note When in CPU Standby (fatal error), errors will not be displayed in the errors in
progress or error log. Errors can be determined if the POWER indicator on the
Power Supply Unit is lit and the RUN and ERR/ALM indicators on the CS/CJ/
CP-series CPU Unit are not lit.

Non-fatal error

Fatal error
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Displaying Messages Use the following procedure to display messages by executing the MSG
instruction.

Double-click the Messages Tab in the PLC Errors Window.
The following Messages Tab will be displayed.

• Message numbers and message texts are displayed.

• Up to eight messages are displayed.

• Messages selected are cleared by left-clicking the Clear Button.

• All the messages displayed are cleared by left-clicking the Clear All
Button.

Note 1. Control codes other than ASCII will be displayed with a space.

2. Two-byte code can be displayed.

3. Messages designated by FAL or FALS instructions cannot be displayed.
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Setting PLC Errors 
Window Conditions

Use the following procedure to set PLC Errors Window conditions.

Opening the Option Dialog Box

Select Settings via Option Menu from the PLC Errors Window.

General Tab Settings

1,2,3... 1. Select General Tab from the Settings Dialog Box.

The above screen will be displayed.

• Always On Top will always display the error log window on top.

• Activate when Error detected will automatically display the PLC Er-
rors Window that is open with the PLC connected online but located
behind other windows or minimized on top when an error is detected.
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Error Log Tab Settings

Select the Error Log Tab from the Setting Dialog Box.

• Update Error Log Entries Automatically will automatically refresh
the error log.

• Hide Error Log Time Column will hide the time display of the error
log.

• Hide Error Log Date Column will hide the date display of the error
log.
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Clock Tab Settings

Select the Clock Tab from the Settings Dialog Box.
The following screen will be displayed.

• Monitor the PLC Clock will monitor and display the PLC clock on the
bottom right of the PLC Errors Window as shown below.
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SECTION 14
Troubleshooting

This section lists the error messages and describes their causes and remedies.
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Error Messages
The following error messages are listed alphabetically.

Error Message/Symptom Cause Action

A Aborting compare. PMSU is not 
valid for any of the selected pro-
tocols. 

The target PMSU for all the selected 
protocols is not valid. 

Set a suitable target PMSU.

Aborting download. PMSU is 
not valid for any of the selected 
protocols.

The target specified within all 
selected protocols is not valid.

Change the Target setting to a valid PMSU.

Address is larger than the 
selected data area size.

Effective starting address out of per-
mitted range for a selected area.

Change the effective starting address so it 
is within range demonstrated by the error 
message.

Another application has locked 
access to the PLC.

Cannot complete the operation.

Another application has locked 
access to the PLC or CX-Protocol 
has not become the condition to gain 
the access rights of the PLC.

Release the access rights of the PLC from 
Another application.

Disconnect from the PLC and then connect 
to the PLC again.

C Can not select O1 or O2 when 
variable type is write.

The address O1 or O2 has been 
selected for a Write channel type. 
This is not permitted.

Select a different address for a Write chan-
nel type.

Cannot accept a negative num-
ber in this field.

A negative number has been 
entered.

Enter a positive number.

Cannot download Protocol(s) to 
the PMSU: Too large 
Protocol size: xxx 
PMSU Memory Size: yyy

The protocol data selected for down-
load to the PMSU is in excess of the 
capacity of the PMSU.

Ensure the Include Source Information 
option is not set and try again.

Cannot edit PC – PLC comms 
settings while CX-Net is open

Attempting to change PLC settings 
which CX-Net is active.

Close CX-Net and retry.

Cannot open/create another 
project. The maximum number 
of projects are already open.

The current CX-Protocol session has 
the maximum number of projects 
open.

Close one or more projects and try again.

Cannot perform trace operation 
using PMSU configuration.

The selected port is not correctly set 
up for Protocol Macro operation.

Set the port setting to Protocol Macro 
mode for the selected port.

Cannot proceed – connected to 
Wrong PLC...

The connected PLC does not match 
the PLC settings.

Select a different PLC.

Cannot set a repeat count of 
zero.

The Repeat count specified is invalid. Enter a valid value.

Channel number is larger than 
the selected data area size...

A Channel Number has been entered 
for the Repeat Counter that is outside 
the range for the selected Channel 
area.

Enter a valid Channel Number.

Check Code <c> defined in 
message but no check code 
area selected.

A Check Code <c> entry has been 
made in the Message Data dialog, 
but the check code has not been 
specified for an appropriate entry.

Specify a Check code area to an entry.

Combination of address and 
length extend beyond the 
selected data area.

Attempting to specify a Length or an 
effective address that is larger than 
the data area.

Enter valid data.

Communications Port Settings 
download failed.

Communications have failed. Retry the connection or cancel the dialog 
and check the PC to PLC communications 
settings.

Compare Error. Communications have failed. Check the connection to the PLC and try 
again. 

Contention Send Request Code 
not valid.

The Contention Send Request Code 
has been selected but not entered.

Enter the Contention Send Request.

CX-Server failed to initialize. CX-Protocol could not initialize the 
communications driver CX-Server 
and cannot function properly.

Exit the application and try again. If the fail-
ure continues, reboot the computer and try 
again. If the failure persists, reinstall CX-
Protocol.
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D Delimiter send code not valid/ 
Delimiter receive code not valid.

The Delimiter Send Request Code or 
Delimiter Receive Request Code has 
been selected but not entered.

Enter the Delimiter Send Request or 
Delimiter Receive Request code.

E End Sequence number must be 
greater than the Start 
Sequence.

The sequence end value must be 
greater than the sequence start 
value.

Enter a sequence end value greater than 
the sequence start value.

Error displaying the Data Moni-
tor.

An error has occurred with the 
CX-Server communications driver.

Reinstall CX-Server.

Error displaying the Error Log. An error has occurred with the 
CX-Server communications driver.

Reinstall CX-Server.

Error displaying the IO Table. An error has occurred with the 
CX-Server communications driver.

Reinstall CX-Server.

Error occurred during the 
upload of Trace data from the 
PMSU.

A communications error occurred 
while uploading the trace data.

Retry the upload operation.

Attempting to upload a trace without 
the expected response from the 
PMSU.

Check the connections and try again.

Error: Could not run the com-
piler for target...

The protocol data selected for down-
load could not be compiled prior to 
download.

Check the connections and PMSU settings 
and try again.

Error: No valid compiler for tar-
get...

The protocol data selected for down-
load could not be compiled prior to 
download because of no compiler 
module in the application folder.

Install CX-Protocol and try again.

Expression constant/factor 
value is outside the permitted 
range...

A primary expression constant/coeffi-
cient in variable has been entered 
exceeding allowed value.

Enter a valid expression constant/coeffi-
cient demonstrated by the error message.

F Failed to connect to the PLC. Communications have failed. Retry the connection or cancel the dialog 
and check the PC to PLC communications 
settings.

Failed to create the Data Moni-
tor OCX...

An error has occurred with the 
CX-Server communications driver.

Reinstall CX-Server.

Failed to create the Error Log 
OCX...

An error has occurred with the 
CX-Server communications driver.

Reinstall CX-Server.

Failed to create the IO Table 
OCX...

An error has occurred with the 
CX-Server communications driver.

Reinstall CX-Server.

Failed to gain the access rights 
of the PLC.

Attempting to download to protected 
PLC without sufficient access privi-
lege.

Release access right by using CX-Pro-
grammer.

Another application has locked 
access to the PLC or CX-Protocol 
has not become the condition to gain 
the access rights of the PLC.

Release the access rights of the PLC from 
Another application.
Disconnect from the PLC and then connect 
to the PLC again.

Failed to load help contents. The help file associated with 
CX-Protocol is missing from the 
application folder.

Locate the help file and move back to appli-
cation folder. If the help file cannot be 
found, reinstall CX-Protocol.

Failed to open communications 
with the PLC. The device may 
be busy.

Communications have failed. Shut down any other application that may 
be accessing the PLC or switch them 
offline.

Failed to Open the CX-Server 
project file

Connection has failed. Reboot the computer and try again.

Failed to release the access 
rights of the PLC.

Attempting to upload to protected 
PLC without sufficient access privi-
lege.

Obtain the correct password or select a dif-
ferent PLC.

Failed to save the CX-Server 
project file

Connection has failed. Reboot the computer and try again.

G Goto number is too large. The GOTO setting is invalid. Enter a valid value.

Error Message/Symptom Cause Action
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I Incorrect object code specifica-
tion ... on unit ...

CX-Protocol does not support con-
nected Protocol Macro specification 
or CX-Protocol does not recognize 
the PMSU.

Try a different PMSU or establish connec-
tion with PLC again.

Interrupt number is larger than 
the maximum allowed value...

Interrupt Address longer than the 
maximum.

Change the Interrupt Address so it is within 
the permissible range demonstrated by the 
error message.

Invalid constant data – Setting 
message address type to 
NONE.

Constant ASCII or Constant selected 
for Address <a> but no valid data 
entered.

Specify valid constant type and enter valid 
data again.

L Length <l> defined in message 
but no length area selected.

A Length <l> entry has been made in 
the Message Data dialog, but the 
length has not been specified for an 
appropriate entry.

Specify a Length area to an entry.

Length is larger than the maxi-
mum allowed values...

Link Channel Address length longer 
than the maximum of 128 words.

Change the Length so it is within the per-
missible range demonstrated by the error 
message.

M Maximum items within message 
data is 96.

Too many items have been supplied 
to the message data.

Reconfigure the message data so the 
items limit is not exceeded.

Maximum number of communi-
cation sequences already cre-
ated.

The protocol limit of sequences has 
been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future. For 
instance, move sequences to another pro-
tocol.

Maximum number of protocols 
already created.

The project limit of protocols has 
been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future.

Maximum of 300 messages per 
protocol.

The protocol limit of Send/Receive 
messages has been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future. For 
instance, create a new protocol for the 
additional messages.

N Name already in use! Choose 
another name or ESC to cancel 
edit.

A name has been supplied to a set-
ting which is identical for an existing 
setting.

Specify a different name in the specified 
protocol.

No sequence numbers avail-
able within this protocol.

The protocol limit of sequences has 
been reached.

If required, reconfigure the project to 
ensure the problem is not encountered in 
the future. For instance, move sequences 
to another protocol.

No sequence numbers avail-
able within this protocol...

The sequence start and sequence 
end of a protocol does not permit the 
addition of new sequences.

Increase the range of the sequence start 
and sequence end for the protocol and try 
again. Increase the sequence end first.

No valid header data – setting 
header data type to NONE.

Header <h> dialog has been selected 
but no valid data entered.

Enter valid data.

No valid terminator data – set-
ting terminator data type to 
NONE.

Terminator <t> dialog has been 
selected but no valid data entered.

Enter valid data.

O One or more of the PMSUs are 
not fitted to the currently 
selected PLC. Not all selected 
communications port settings 
will be downloaded.

The scope of the download port set-
tings command includes one or more 
PMSUs that are not fitted.

Clear the error message. CX-Protocol will 
continue and download port settings to the 
PMSUs that are fitted.

One or more of the PMSUs are 
not fitted to the currently 
selected PLC. Not all selected 
communications port settings 
will be uploaded.

The scope of the upload port settings 
command includes one or more 
PMSUs that are not fitted.

Clear the error message. CX-Protocol will 
continue and upload port settings to the 
PMSUs that are fitted.

Error Message/Symptom Cause Action
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O Only 100 Matrices are allowed. The protocol limit of matrices has 
been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future. For 
instance, create a new protocol for the 
additional matrices.

Only 16 Steps are allowed. The limit of steps for a sequence has 
been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future. For 
instance, move steps to another sequence.

P PMSU does not support Proto-
col Macro. Download cannot 
proceed.

The selected PMSU does not support 
the Protocol Macro function.

Try a different PMSU.

PMSU does not support Proto-
col Macro. Upload cannot pro-
ceed.

The selected PMSU does not support 
the Protocol Macro function or 
CX-Protocol does not recognize the 
PMSU.

Try a different PMSU or establish connec-
tion with PLC again.

PMSU ... is not fitted to the cur-
rently selected PLC.

Not all selected Protocols will 
be compared. 

An attempt was made to compare 
protocols for a target PMSU that is 
not mounted. 

Remove the protocol for which a non-
mounted target PMSU is mounted from the 
protocols to be compared.

PMSU ... is not fitted to the cur-
rently selected PLC. 

Not all selected Protocols will 
be downloaded.

One or more of the selected proto-
cols contains a target PMSU not fit-
ted to the PLC.

Continue with the download, but ensure 
the target setting for associated PMSUs 
are correct.

Protocol compare failed. Communications have failed. Try again. 

Protocol list upload failed. Communications have failed. Retry operation.

Protocol upload/download 
failed.

Communications have failed. Retry operation.

Protocol.spp was not found. The file protocol.spp is not in applica-
tion folder.

Locate protocol.spp and move back to 
application folder. If protocol.spp cannot be 
found, reinstall CX-Protocol.

....psw was not found. An attempt was made to open file 
project.psw from the Recently Used 
File List from the File Menu, but 
project.psw no longer exists in that 
folder.

Locate and open project.psw. 

R Repeat count is larger than the 
maximum allowed value...

A value greater than 255 has been 
entered for the Repeat Counter con-
stant.

Enter a valid value demonstrated by the 
error message.

S Sequence End Number out of 
range because a sequence 
exists with a greater sequence 
number.

The sequence end value is invalid. Enter valid data for the Seq End setting.

Setting the Start Sequence to 
this value will cause the 
Sequence to exceed its maxi-
mum limit...

The sequence start value is invalid. Reduce the sequence value or reduce the 
sequence range.

T Target for protocol ... must be 
set.

A target must exist for a protocol. Specify a target PMSU for the protocol.

Total number of IN and OUT 
channels, for Link Channel 
Areas 1 and 2 combined, 
should be ...

The total length is beyond the limit. Change the starting address and/or the 
Length so that they are within the permitted 
range as demonstrated by the error mes-
sage.

The CX-Server project file is 
invalid, cannot proceed.

Connection has failed. Reboot the computer and try again.

The Length must be between 1 
and 256.

The Length specified is out of range. Enter a valid value.

The PLC must be in PRO-
GRAM mode to download the 
Protocol to the PMSU...

Attempting to download protocols to 
the PMSU while in “Run” mode or 
“Monitor” mode.

Select the Yes Button to switch the PLC to 
“Program” mode.

Error Message/Symptom Cause Action
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T The PMSU Protocol password 
has not been correctly entered. 
The PMSU transfer cannot pro-
ceed.

The protocol in the PMSU has a 
password assigned to it. An incorrect 
password has been entered.

To upload the protocol from the PMSU or to 
download a new protocol to the PMSU, 
type in the correct password.

The PMSU contains no protocol 
data.

Uploading a protocol list from a 
PMSU that contains no protocols.

Download protocols to the PMSU.

The PMSU does not support 
the PMCR instruction.

The selected PMSU does not support 
the Protocol Macro function.

Try a different PMSU.

The PMSU has a Sum Check 
Error. The transfer cannot pro-
ceed.

The selected PMSU has a sum check 
error. The upload of protocols or pro-
tocol list cannot proceed.

Download protocols to PMSU to clear sum 
check error and try again.

The PMSU has a Sum Check 
Error. The Protocol download 
will proceed anyway.

The selected PMSU has a sum check 
error.

Proceed with the download to clear the 
error.

The PMSU protocol password 
has not been entered. The 
PMSU transfer cannot proceed.

The user cancelled the password 
entry.

Retry the operation and enter the correct 
password.

The Unit Number must be 
between 0 and 31.

The Unit Number specified is out of 
range.

Enter a valid value.

The communications port set-
tings for this port are currently 
being changed by another 
device...

A Programming Console may be 
accessing the PLC.

Check the new port settings and try again.

The following list of item(s) have 
references to the selected 
object which you tried to Delete 
/ Cut. Remove all references 
first.

Attempting to remove a matrix or 
message from the project that is 
referred to by steps within the project.

Check the message or matrix references 
within each step that refers to each mes-
sage/matrix. If desired, remove the step 
and try again.

The maximum length must be 
between 200 and 1000 bytes.

The specified communications port 
setting is out of range.

Enter a valid value.

The PLC must be in PRO-
GRAM mode to download the 
communications port settings.

An attempt was made to download 
the communications port settings to 
the PMSU while the PLC was set to a 
mode other than PROGRAM mode.

Change the operating mode of the PLC to 
PROGRAM mode.

The sequence number is 
already in use by .....

The sequence number specified is 
the same as another sequence.

Specify a sequence number not used by 
the other sequences in the protocol.

The sequence number must be 
in the range xxx to yyy inclu-
sive...

The sequence number is out of 
range.

Increase the range of the sequence by 
changing the sequence start or end num-
bers for the protocol. Increase the 
sequence end first.

There is no Communications 
Trace in progress on this port.

Attempting to stop a trace before it 
has started for the selected port.

Start a new trace. Check connections.

There is no Trace data available 
for the specified Port.

Attempting to access trace data for a 
port that has no trace data.

Start a new trace for that port.

This protocol cannot be found 
and cannot be downloaded to 
the PMSU.

Object code temporary file is corrupt. Try compiling/downloading again.

This protocol file is of zero 
length and cannot be down-
loaded to the PMSU.

Object code temporary file is corrupt. Try compiling/downloading again.

Transfer failed. Communications have failed. Check the connections and try again.

Error Message/Symptom Cause Action
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Errors

Error Messages in Output Window

U Unable to complete protocol 
compare. 

Communications have failed. Check the connection to the PLC and try 
again.

Unable to complete protocol 
upload.

Communications have failed. Check PLC connections and try again.

Unable to establish communica-
tions to the PMSU ...

Communications have failed. Check the PMSU installation and try again 
as demonstrated by the error message.

Unable to establish communica-
tions to the selected PLC...

Communications have failed. Check connections and baud rate setting.

Unable to register PLC 
Devices ...

Communications have failed. Retry the connection or cancel the dialog 
and check the PC to PLC communications 
settings.

Unexpected file format An attempt was made to open a file 
that cannot be opened with the 
CX-Protocol.

Check that the file format is one that can be 
opened with the CX-Protocol.

W Warning ... ? ... The selected 
PLC does not support the Pro-
tocol Macro function. Connec-
tion to the device from CX-
Protocol will not be allowed.

A PLC has been selected that does 
not support Protocol Macro function.

Select a different PLC.

Symptom Cause Action

PLC Error light. C200HX/HG/HE: If FAL code is 9C, 
Communication Board error occurs. 
CS/CJ: If A40208 is ON, Inner Board 
error occurs.

C200HX/HG/HE: check 268CH value 
by referring page 140 in this manual. 
CS/CJ: check A424CH value by 
referring page 140 in this manual.

PMSU RDY light flashing. PMSU Error. Confirm downloaded protocol and 
download again.

Unexpected delay transferring proto-
cols to or from the PMSU.

Either: more data is being transferred 
than was expected; communications 
have failed; slow performance com-
puter.

Disconnect the cable to stop the trans-
fer.

Unable to find a file to open from the 
Open dialog.

The Open dialog is not displaying the 
correct folder and/or file type.

Check the folder name described in the 
Look in: field is the right folder. Check 
the file type described in the Files of 
type: field.

Start, Stop and Upload Trace opera-
tions disabled on buttons menu.

The PLC is offline or the PMSU trace is 
not selected.

Re-establish PLC communications or 
select the PMSU Trace Port.

Error/Warning in Output Window Description

E1001: ... Total Link Channels out of range... The Link Channel setting is invalid.

E1005: No data in message. A message contains no data.

E1006: Check code <c> after Terminator <t> not supported 
on this unit.

The target unit does not support message data that 
includes a Check Code <c> after a Terminator <t>.

E1007: Check code <c> ~LRC not supported on this unit. The target unit does not support message data that 
includes a ~LRC Check Code <c>.

E1008: Check code <c> ~CCITT not supported on this unit. The target unit does not support message data that 
includes a ~CCITT Check Code <c>.

E1009: Check code <c> CRC16 not supported on this unit. The target unit does not support message data that 
includes a CRC16 Check Code <c>.

E1010: Check code <c> ~SUM (1 byte) not supported on 
this unit.

The target unit does not support message data that 
includes a ~SUM (1-byte) Check Code <c>.

E1011: Check code <c> ~SUM (2 bytes) not supported on 
this unit.

The target unit does not support message data that 
includes a SUM (2-byte) Check Code <c>.

E1012: Check code <c> SUM2 (1 byte) not supported on 
this unit.

The target unit does not support message data that 
includes a SUM2 (1-byte) Check Code <c>.

Error Message/Symptom Cause Action
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E1013: Check code <c> SUM2 (2 bytes) not supported on 
this unit.

The target unit does not support message data that 
includes a SUM2 (2-byte) Check Code <c>.

E1014: Overlap in sequence range with protocol... A sequence’s start and end settings conflict with another 
protocol which is being compiled.

E1022: Communication Sequence contains no step data. A sequence exists but has no steps.

E1026: Step contains invalid command. Invalid command setting in step

E1035: Link Channel out of range. Alpha protocols only error. The Link Channel setting is out 
of range.

E1037: Repeat Counter contains invalid channel. Alpha protocols only error. The Repeat Counter contains a 
channel out of range.

E1042: Length part primary expression constant out of 
range.

Alpha protocols only error. Part of the Length primary 
expression is out of range.

E1043: Object code too large... The amount of data to be downloaded is too large.

E1044: Matrix Goto out of range. The GOTO setting within a matrix is out of range.

E1045: Matrix next statement out of range. The Next setting within a matrix is used by the last step in a 
communication sequence.

E1048: Protocol contains no message data. A protocol contains no message data.

E1049: Protocol contains no communication sequences. A protocol contains no sequences.

E1050: Step contains invalid message/matrix reference A message has not been specified in a step requiring a 
message. 

E1051: PLC xxx CPUyy does not support EM banks. Information including EM data areas has been supplied for 
download to a PLC which does not support EM data areas.

E1052: PLC xxx CPUyy supports zz EM banks. Information including EM data areas has been supplied for 
download to a PLC which supports EM data areas but 
exceeds number of EM bank.

E1053: Link Word IN1 is not defined or invalid. Link channel I1 is specified in message but not specified in 
Link channel information or invalid setting in Link channel 
information.

E1054: Link Word OUT1 is not defined or invalid. Link channel O1 is specified in message but not specified in 
Link channel information or invalid setting in Link channel 
information.

E1055: Link Word IN2 is not defined or invalid. Link channel I2 is specified in message but not specified in 
Link channel information or invalid setting in Link channel 
information.

E1056: Link Word OUT2 is not defined or invalid. Link channel O2 is specified in message but not specified in 
Link channel information or invalid setting in Link channel 
information.

E1058: Area xxx Channel yyy out of range ... Channel address is out of range for target PLC.

E1060: Check code <c> LRC2 not supported on this unit. CS/CJ protocols only error. The Check Code type is invalid 
for PSB.

E1061: Check code <c> SUM1 (1byte) not supported on 
this unit.

CS/CJ protocols only error. The Check Code type is invalid 
for PSB.

E1062: Check code <c> SUM1 (2 byte) not supported on 
this unit.

CS/CJ protocols only error. The Check Code type is invalid 
for PSB.

E1063: Header <h> found after Terminator <t>. Error by protocol imported from PSS. PSS allows to create 
the message prohibited by CX-Protocol.

E1064: Header <h> not at the start of the message. Error by protocol imported from PSS. PSS allows to create 
the message prohibited by CX-Protocol.

E1065: Terminator <t> not at the end of the message / 
before check code <c>

Error by protocol imported from PSS. PSS allows to create 
the message prohibited by CX-Protocol.

W0006: Protocol will be converted. A CS/CJ protocol will be downloaded to a C200HX/HG/HE 
PLC, or a C200HX/HG/HE protocol will be downloaded to a 
CS/CJ PLC.

Error/Warning in Output Window Description
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SECTION 15
Help

This section describes the online help services.
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Help Section 15
Help by Topic
Procedures for using the CX-Protocol and protocol macro functions can be
verified using the online help. Use either one of the following procedures to
access the online help.

Using the Help Tab

The desired help screen can be displayed by left-clicking the Help Menu.

Using the Help Icon

Left-click the Help Icon on the toolbar or press the F1 Key to display a help
screen for an item (element) on the screen.

CX-Protocol Version Use the following procedure to find out the version of CX-Protocol.

1,2,3... 1. Select About CX-Protocol... from the Help Menu or left-click the About
Icon on the toolbar.

2. The About CX-Protocol dialog will be displayed. This dialog provides the
CX-Protocol copyright and version number.
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Appendix A
Creating the Protocol Applications

Communication between PLCs via Modems: Example
In this appendix, a protocol is created which initiates communications between PLCs via a telephone line using
modems. The connection structure and the flow of the protocol creation procedure are as shown below:

Connection Structure

Protocol Creation Procedure

PLC PLC

Modem Modem

Public line

Transmission rate: 2400 bps

Creating the status transition 
chart of communications 

sequence.

Disassembling of the process 
contents into the sequences 
and the steps editable by the 

CX-Protocol

Configuring of the communication 
messages contents.

Setting the transmission control 
mode

Setting the monitor time

Describing the ladder program
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Creating the Status Transition Chart of Communications 
Sequence
When the data sending and receiving between PLCs are conducted via a telephone line using modems, the
outline of the communications sequences is as shown below:

Note Information about the AT commands to be sent to the modem i.e. the initialization command, dial com-
mand, escape code sending, line disconnection command, etc. and result codes (response) is
described in the manual of the modem in use. The modem used in this example is MD24FB10V (made
by OMRON). AT commands and result codes supported by the modem are listed in the following tables.

PLC PLC
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List of Commands Used in this Example

List of Result Codes

Disassembling of the Process Contents into the Sequences and 
the Steps Editable by the CX-Protocol
First, the above communications sequences are disassembled into the following sequences by the process
block.

Sequence No. 000: Modem initialization
001: Dial operation
002: Send message/Receive data, switch modes, line disconnection 

Then, the steps are configured for each sequence.

AT command Setting item Settings

Modem initialization 
ATE0V0X4\V2\N3%CO*CO\X1

Command echo Not available

Result code display format Numerical 

Speed display when connection has 
been completed

Available

Busy, dial tone detection Available

Display of error corrections and com-
pressed data when connection has 
been completed

Available

MNP setting Available (auto reliable mode)

MNP class Class 4

V.42 compression, error setting Not available

Flow control between terminal modems Not available

DTR signal control Always ON

Escape code +

Dial command ATDT dial number Dial class Tone

Escape signal code transmission +++ Mode selection Online mode to escape mode

Line off command ATH0 Line off

Numerical format Character format Content

0 OK Properly ended

1 CONNECT Connection completed

2 RING Signal receive detection

3 NO CARRIER Line off

4 ERROR Command error

5 CONNECT 1200 Connection to 1,200 bps

6 NO DIAL TONE No-dial-tone detection

7 BUSY Busy detection

8 NO ANSWER No answer detection

9 HAND SET IN USE Busy

234 CONNECT 2400/REL4 Connection to 2400 MNP class
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Sequence No. 000: Modem Initialization
Step No. 00

Normal
The system sends the modem initialization command and waits the result code from the modem. Since there is
more than one result code, the following matrix is set:

0: End for the normal end of the initialization. 

4: This is a command error. The cause will be a wrong setup for the initialization command. The abort
and the correct setup for the initialization command are necessary.

Other: Abort.

Note Even though the next process of “4” (command error) is same with that of “Other,” it is set as a separate
matrix case. This is because the checking of the matrix number from the flag at an error occurrence
allows the confirmation of the error cause and easier debugging.

Abnormal
By the setting of the retry count (three times), the system automatically retries the same step up to three times
at the following error occurrences:

• The send finish monitoring time Tfs, the receive wait monitoring time Tr, or the receive finish monitoring
time Tfr is up.

• A transmission error (CIO28304 or 28312 is ON) occurs upon receiving.

• Wrong receive message 

• An error occurs in the error check code 

If the initialization fails even after the maximum three retry times, it will be handled by the error process.

An error at this stage may be caused by wrong PLC Setup or wrong wiring, in which case it cannot be handled
by the step description. Therefore, the abort is set for this error process.

Sequence No. 000: Modem Initialization

Note The partner machine creates similar steps and executes the initialization of the local modem.

(Matrix) 
Result code

Receive 4 or others

Send initialization command

Receive 0

END Abort Abort

Error

Step No. 00

Retry three times  
retry count

Step 
No.

Repeat 
counter

Command Retry 
count

Send 
wait

Send 
message

Receive message Response 
type

Next 
process

Error 
process

00 R/001 Send&Receive 3 --- Initialization 
Command

0 End --- --- Abort

4 Abort

Other Abort
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Sequence No. 001: Dial Operation

Normal
When the modem is initialized, the system dials the telephone number and secures the communication line
with the partner PLC. Besides the line connection completion “1 (CONNECT),” there are several result codes
for the dial command. For example, 7 (BUSY) is the connection failure because of the busy line. In this case, if
the other step (to redial after one minute) is configured by designating its step number with “goto,” the
sequence execution will not be aborted but can be continued.

(Matrix)

(Matrix)

(Matrix)

Send&Receive

Receive 7 or 9 Receive 1 or 234 Receive 4, 6, 8, or others Error

Receive 7 or 9 Receive 1 or 234 Receive 4, 6, 8, or others Error

Receive 1 or 234 Receive 4, 6, 7, 8, 9, or others Error

1 (CONNECT): Line connection completion..........................................End

4 (ERROR): Command error ............................ .............Abort

Confirm the contents of the dial command setup

6 (NO DIALTONE): No dialtone detected ..........................................Abort

Confirm the dial type (tone or pulse)

7 (BUSY): Connection failure for the busy line.

Redial after one minute ..........................................Goto01

8 (NO ANSWER): No answer tone detected ..........................................Abort

Confirm if the partner modem is receivable.

9 (HAND SET IN USE): Connection failure for the telephone calling.

Redial after one minute ..........................................Goto01

234 (CONNECT 2400/REL4): Line connection completion..........................................End

Others: Abort
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Note In the second and later retry process executions, the send wait time is ignored. Therefore, another step
01 is created whose send wait time is one minute when the result code is 7 (BUSY). Thus the retry pro-
cess should not be set within a process that requires the send wait time.

Abnormal
Errors other than that caused by the matrix may be caused by wrong modem’s transmission rate or abnormal
line status. Since a step description cannot avoid these errors, it is necessary to abort and to confirm the trans-
mission rate and line condition when the communication fails, even in the third retry. 

Sequence No. 001: Dial Operation

Step 
No.

Repeat 
counter

Command Retry 
count

Send 
wait

Send 
message

Receive message Response 
type

Next 
process

Error 
process

00 R/001 Send&Receive 3 --- Dial number 1 End --- --- Abort

4 Abort

6 Abort

7 Goto01

8 Abort

9 Goto01

234 End

Other Abort

01 R/001 Send&Receive 3 One 
minute

Dial number 1 End --- --- Abort

4 Abort

6 Abort

7 Goto02

8 Abort

9 Goto02

234 End

Other Abort

02 R/001 Send&Receive 3 One 
minute

Dial number 1 End --- --- Abort

4 Abort

6 Abort

7 Goto01

8 Abort

9 Goto01

234 End

Other Abort
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Send OK Message Sending/Data Receiving, Mode Switch, Line
Disconnection (Sequence No. 002) 

Normal
When the connection with the communications partner is established, the system sends the message (Sen-
dOK) and waits the data from the partner machine. The communications partner sends four words of data
stored in DM 0100 to DM 0104 after the receipt of the “SendOK” message.

When the system receives the four words of data, it writes them from DM 0200, and sends the escape code
(+++) after the end of reception. Then, it switches the escape mode to receive the AT command from the online
mode and sends the line disconnection command.

Abnormal
Most errors here are presumed to be a time-up error of the monitoring time, receiving error on the transmis-
sion, wrong message reception, or error check code error. For these errors, the retry process is set to three
times. If another error occurs, the system will abort and check the modem’s transmission rate and line condi-
tion.

Send line 
disconnection command
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Following are configurations of both steps:

(The sequence configuration of the sending PLC)

Sequence No. 002: Message Sending, Data Receiving, Mode Switch, and Line Disconnection

(The sequence configuration of the receiving PLC.)

Sequence No. 000: Message Receiving and Data Sending

Configuring the Communication Messages Contents
For the communications messages setup, the send and receive data storing mode and the message format
must be set up. 

Send and Receive Data Storing Mode
There are four kinds of send and receive data storing modes as follows:

• Constant addressing

• Operand addressing (with/without response type)

• Link word addressing

• Direct addressing

In this example, each mode is differentiated according to the characteristics of communications data as follows:

Message Format
In the modem control procedure, communications are performed with an instruction (AT command) from a ter-
minal (the PLC in this example) and the modem’s response (result code) to the instruction. Since AT com-
mands and result codes consist of a character string delimited by CR and CR/LF, the message format is as
follows:
Data + Terminator (CR or CR/LF)

Note The header, the address, the length, and the error check code are not set.

Step 
No.

Repeat 
counter

Command Retry 
count

Send 
wait

Send message Receive 
message

Response 
type

Next 
process

Error 
process

00 R/001 Send&Receive 3 --- SendOK Writing from 
DM0200 (W(1), 
8)

--- Next Abort

01 R/001 Send&Receive 3 --- Escape code 0 (result code) --- Next Abort

02 R/001 Send&Receive 3 --- Line disconnec-
tion command

8 (result code) --- End Abort

Step 
No.

Repeat 
counter

Command Retry 
count

Send 
wait

Send message Receive 
message

Response 
type

Next 
process

Error 
process

00 R/001 Receive 3 --- --- SendOK --- Next Abort

01 R/005 Send 3 --- Contents of four 
words starting 
from DM0101 
(R(1), 8)

--- --- End Abort

Communications data Feature Storing method

Initialization command It is directly set up in the message because there is no 
need for change during use of the same modem.

Constant addressing

Dial command It is desirable to be dynamically set up for a possible 
change in accordance with the environment.

Operand addressing

Send data (SendOK) It is directly set up in the message because there is no 
need for change.

Constant addressing

Five words of send data It is desirable to be dynamically set up for a possible 
change in accordance with the environment.

Operand addressing

Five words of receive data

Receive result code It is directly set up in the message because there no need 
for change during use of the same modem.

Constant addressing
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Constant Addressing
In the constant addressing communications message, CR or CR/LF will be set at the end of the initialization
command, send data (SendOK), receive result code, etc. 

Example of the Initialization Command Setting:

Example of the Send Data (SendOK) Setting:

Example of the Result Code Setting:

Operand Addressing
For the operand addressing communications data, the communications data must be stored in the area set by
the PMCR instruction after PMCR instruction designation (both the first word numbers of the send data storing
and the received data storing) are determined. The configuration of the operand addressing communications
data used in this example is as follows:

Example of the Dial Command Setting:

• The send message content to be described in the step numbers 00 to 02 of the sequence number 001 for
the PLC which sends SendOK message.

• Actual data sent and stored in the addressed word.

ATEOV0X4\V2\N3%CO*CO\X1+CR or CR/LF

AT command Terminator

SENDOK+CR or CR/LF

SENDOK
(Message)

Terminator

1+CR or CR/LF

Result code Terminator

(R(1), 16) + CR or CR/LF

Number of bytes 
to be sent

Terminator

The first word to be sent (CH (DM0010)+1CH addressed by 
the second operand of the PMCR instruction)

Read option (non-conversion, forward direction)

DM0010
0009
9

DM0011
4154
AT

DM0012
4454
DT

DM0013
3033
03

DM0014
2D30
−0

DM0015
3132
12

DM0016
332D
3−

DM0017
3435
45

DM0018
3637
67

Set in the first word is the total number of words of the data to be sent
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Example of the Setting for Four-word Receive Data Stored in DM 0201 to DM 0204:

• The received message described in the step number 00 of the sequence number 002 for the PLC which
sent the SendOK message.

• The received data actually written in the addressed word.

Example of Setting for Four Words Data Sending (DM 0101 to DM 0104):

• The send message described in the step number 01 of the sequence number 000 for the PLC which
receives SendOK message.

• The send data content to be actually stored in the addressed word.

Setting the Transmission Control Mode
“Modem Control” is designated as the transmission control mode for the one-to-one communications between
PLCs via modems. The modem control mode is held by the instructions from terminals (PLCs) and the
modems’ responses to the instructions. Those instructions (AT commands) and the responses (result codes)
consist of a character string delimited by delimiters, CR and CR/LF. 

For the modem control, the RTS/CTS flow control or the Xon/Xoff flow control can be set as a flow control.
However, these flow controls are not set in this example because the communication messages are short.

Note 1. For the details of the setup method for the transmission control modes, refer to 3-2 Sequence At-
tributes (Common to All Steps).

(W(1),8) + CR or CR/LF

Number of received bytes
Terminator

The first word received (CH (DM0200)+1CH addressed by 
the third operand of the PMCR instruction)

Read option (non-conversion, forward direction writing)

DM0200
0005

DM0201
3130
10

DM0202
3135
15

DM0203
3230
20

DM0204
3532
52

Number of words to be received (set automatically)

5

(R(1),8) + CR or CR/LF

Number of bytes
to be sent

Terminator

The first word to be sent (CH (DM0100)+1CH addressed by 
the second operand of the PMCR instruction)

Read option (non-conversion, forward direction)

DM0100
0005

DM0101
3130
10

DM0102
3135
15

DM0103
3230
20

DM0104
3532
52

Set the total number of words of the data to be sent

5

348



Creating the Protocol Applications Appendix A
2. The protocol is created by the Hayes-compatible AT mode in this example. The AT mode and V.25bis
mode are also available for modem control.

Setting Monitoring Time
If the monitor time (send finish monitoring time: Tfs, receive wait monitoring time: Tr, and receive finish monitor-
ing time: Tfr) has been set, the error will be detected and the process can be switched to the error process or
the retry process immediately before the step finishes (in the send or receive step) when the send or receive
process is not executed within the monitor time.

If used in the combination with the retry process, the step can be re-executed without any description of the
error process and protocol or the ladder program description can remarkably be simplified when the following
retry factors occur.

• The send finish monitoring time Tfs, receive wait time Tr, or receive finish monitoring time Tfr is up.

• A transmission error (CS/CJ: bit 15 in word 1908/1918/n+8/n+18 is ON, C200HX/HG/HE: 28304 or 28312
is ON) occurs upon reception.

• The received message is different from the one that was setup.

• An error occurs with the error check code.

In this example, the monitoring time is set as shown below. For the calculation method of the monitoring time,
refer to 4-5 Calculation Method of Monitoring Time.

1. The retry count can be set only for steps in which Send&Receive command is set.

2. If both the repeat counter and the retry count are set, the counter will not increment while the step is
being retried by the retry count number. When the retry factor is resolved or the step is executed by
the retry count number, the counter will increment. 

Tr Tfr
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Creating the Ladder Program
The ladder program to execute the created protocol is described and transferred to the PLC. An example of the
ladder program is shown below: 

CS/CJ

Port 2 Instruction
Execution Flag

Communications Port
Enable Flag

Send initialization command

Communications port No.7, serial port No.2,
destination unit address E1: Inner Board
Sequence No.100

Constant

Constant

Constant

Send the dial number

The first word of the send data

Communications port No.7, serial port No.2,
destination unit address E1: Inner Board
Sequence No.101

Constant

Communication data

The first word of the received data stored

Communications port No.7, serial port No.2,
destination unit address E1: Inner Board
Sequence No.102

Communications Port
Enable Flag

Communications Port
Enable Flag

DIFU (013)

000100

PMCR

#72E1

#0064

#0000

#0000

RSET

000100

SET

000101

PMCR

#72E1

#0065

DM00010

#0000

RSET

000101

SET

000102

PMCR

#72E1

#0066

#0000

DM00200

RSET

000102

000000

191915 A20207000100

000000 191915 A20207

000000 191915 A20207
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C200HX/HG/HE

Constant

Dummy word

Constant

Send initialization command

Execute sequence No. 000 by using Port A

Send the dial number

Execute sequence No. 001 by using Port A

The first word number of the send data

Communication data

Execute sequence No. 002 by using Port A

The first word of the received data stored

Dummy word

Port A Instruction
Execution Flag

DIFU (013)

00100

PMCR

#1000

#0000

DM000

RSET

00100

SET

00101

PMCR

#1001

DM0010

DM0000

RSET

00101

SET

00102

PMCR

#1002

#0000

DM0200

RSET

00102

00000

2890800100

00101 28908

00102 28908
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Appendix B
PLC Setup and PMSU Settings

PMSU System Settings

CS/CJ
With the CS/CJ Series, PLC Setup settings for using a Serial Communications Board or a Serial Communica-
tions Unit in protocol macro mode are made in the allocated DM area of the PMSU.

Serial Communications Board
Allocated DM area: Use the following areas in words D32000 to D32099.

Serial Communications Unit
Allocated DM area: Use the following areas in words D30000 to D31599.

Note The allocation within each DM area is as follows (m=D30000 + 100 × Unit Number):
m to m+1, m+8 to m+9: PLC Setup settings for port 1
m+10 to m+11, m+18 to m+19: PLC Setup settings for port 2
m+2 to m+27, m+212 to m+217: Not used
m+20 to m+99: Not used

D32000 to D32001 PLC Setup settings for port 1

D32008 to D32009

D32010 to D32011 PLC Setup settings for port 2

D32018 to D32019

D32002 to D32007 Not used in protocol macro mode

D32012 to D32017

D32020 to D32767 Reserved for system use

Unit number DM area

0 D30000 to D30099

1 D30100 to D30199

2 D30200 to D30299

3 D30300 to D30399

4 D30400 to D30499

5 D30500 to D30599

6 D30600 to D30699

7 D30700 to D30799

8 D30800 to D30899

9 D30900 to D30999

A D31000 to D31099

B D31100 to D31199

C D31200 to D31299

D D31300 to D31399

E D31400 to D31499

F D31500 to D31599
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Contents of PLC Setup Area
m=D30000 + 100 × Unit Number

DM area Bit Contents of setting

Board Unit

Port 1 Port 2 Port 1 Port 2

D32000 D32010 m m+10 15 Port setting 0:Default, 1:Setting required

14 to 12 Reserved

11 to 08 Serial communications mode 
(6 Hexadecimal: Protocol macro)

07 to 05 Reserved

04 Start Bit
0: 1 bit, 1:1 bit 
(whether it is set to 0 or 1 it will be fixed at 1 bit)

03 Data length 0: 7 bits, 1: 8 bits

02 Stop bit 0: 2 bits, 1: 1 bit

01 Parity 0: with, 1: without

00 Parity 0: even, 1: odd

D32001 D32011 m+1 m+11 15 to 04 Reserved

03 to 00 Baud rate (bps)
0: Default (9,600), 3: 1,200, 4: 2,400, 5: 4,800, 
6: 9,600, 7: 19,200, 8: 38,400

: : : : : :

D32008 D32018 m+8 m+18 15 Transmission mode 0: Half-duplex, 1: Full-duplex

Note: When using standard system protocol, be sure 
to set to 0 (half-duplex)

14 to 00 Reserved

D32009 D32019 m+9 m+19 15 to 00 Maximum number of bytes of send/receive data: 00C8 
to 03E8 (Hexadecimal)
Note: When using standard system protocol, be sure 

to set to 03E8 Hexadecimal (1,000 bytes)
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C200HX/HG/HE
With the C200HX/HG/HE PLC, PLC Setup settings for using a Communications Board in protocol macro
mode, are made in the PLC Setup settings of the PSB.

Settings Related to the RS-232C Port
Word number Bit Function (initial values: factory-set)

DM 6645 00 to 03 RS-232C port communications conditions settings
00: Standard settings (initial values)

Start bit: 1 bit, Data length: 7 bits, Parity: even
Stop bit: 2 bits, Baud rate: 9,600bps

1: As set for DM 6646 

04 to 07 CTS control enable/disable settings
0: Without (initial value)
1: With

08 to 11 Area used for 1:1 link
0: LR00 to 63 (initial value), 1:LR00 to 31, 2: LR00 to 15

Maximum PT number for NT link 1:N connection
1 to 7 (BCD) (for C200HE: 1 to 3)

12 to 15 RS-232C port mode settings
0: Host link (initial value), 1: No RS-232C procedure, 2: 1:1 link for Slave
3: 1:1 link for Master, 4: NT link (1:1), 5: NT link (1:N)

DM 6646 00 to 07 RS-232C port baud rate setting
00: 1,200 (initial value), 01: 2,400, 02: 4,800, 03: 9,600, 04: 19,200

08 to 15 RS-232C port frame format settings
Start bit Data length Stop bit Parity

00: 1 bit 7 bits 1 bit Even (initial value)
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit Without
03: 1 bit 7 bits 2 bits Even
04: 1 bit 7 bits 2 bits Odd
05: 1 bit 7 bits 2 bits Without
06: 1 bit 8 bits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit Without
09: 1 bit 8 bits 2 bits Even
10: 1 bit 8 bits 2 bits Odd
11: 1 bit 8 bits 2 bits Without

DM 6647 00 to 15 RS-232C port send delay time settings
0000 (initial value) to 9999 (BCD, unit: 10ms)

DM 6648 00 to 07 Unit number settings for RS-232C port host link mode
00 (initial value) to 31 (BCD)
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Settings Related to Peripheral Port

Word number Bit Function (initial values: factory set)

DM 6650 00 to 03 Peripheral port communications conditions standard format settings
00: Standard settings (initial values)

Start bit: 1 bit, Data length: 7 bits, Parity: even
Stop bit: 2 bits, Baud rate: 9,600bps

1: Set separately 

04 to 11 Reserved for system

12 to 15 Peripheral port mode settings
0: Host link (initial value), 1: No RS-232C procedure

DM 6651 00 to 07 Peripheral port baud rate settings (bps)
00: 1,200 (initial value), 01: 2,400, 02: 4,800, 03: 9,600, 04: 19,200

08 to 15 Peripheral port frame format settings
Start bit Data length Stop bit Parity

00: 1 bit 7 bits 1 bit Even (initial value)
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit Without
03: 1 bit 7 bits 2 bits Even
04: 1 bit 7 bits 2 bits Odd
05: 1 bit 7 bits 2 bits Without
06: 1 bit 8 bits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit Without
09: 1 bit 8 bits 2 bits Even
10: 1 bit 8 bits 2 bits Odd
11: 1 bit 8 bits 2 bits Without

DM 6652 00 to 15 Peripheral port send delay settings (host link):
0000 (initial value) to 9999 (units: 10ms)

DM 6653 00 to 07 Unit number settings for peripheral port host link mode
00 (initial value) to 31 (unit number)
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Communications Board Settings
Settings Related to Port B

Word 
number

Bit Mode Function Note

DM 6550 00 to 03 Host link
No procedure

Protocol macro

Port B communications conditions standard format set-
tings
0: Standard settings (initial values)

Start bit: 1 bit, Data length: 7 bits, Parity: even
Stop bit: 2 bits, Baud rate: 9,600bps

01: Set separately → DM 6551: 00 to 15 enabled

04 to 07 Host link

No procedure
1:1 link

CTS control enable/disable settings
0: Without (initial value)
1: With

08 to 11 1:1 link 
(Master)

NT link (1:N)

Port B 1:1 link area
0: LR00 to 63 (initial value), 1:LR00 to 31, 
2: LR00 to 15

Maximum PT unit number for port B, NT link 1:N
1 to 7 (BCD) (for C200HE: 1 to 3)

Once a 1:1 link 
with a Master 
has been set, it 
cannot be 
changed.

12 to 15 All modes Port B mode setting
0: Host link (initial value), 1: No RS-232 procedure
2: 1:1 link for Slave, 3: 1:1 link for Master, 
4:NT link (1:1), 5: NT link (1:N), 6: Protocol macro

DM 6551 00 to 07 Host link

No procedure
Protocol macro

Port B baud rate settings (bps)
00: 1,200 (initial value), 01: 2,400, 02: 4,800, 
03: 9,600, 04: 19,200

Only valid when 
set separately.

08 to 15 Host link

No procedure

Protocol macro

Port B frame format settings

Start bit Data length Stop bit Parity
00: 1 bit 7 bits 1 bit Even (initial value)
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit Without
03: 1 bit 7 bits 2 bits Even
04: 1 bit 7 bits 2 bits Odd
05: 1 bit 7 bits 2 bits Without
06: 1 bit 8 bits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit Without
09: 1 bit 8 bits 2 bits Even
10: 1 bit 8 bits 2 bits Odd
11: 1 bit 8 bits 2 bits Without
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Settings Related to Port A

Word 
number

Bit Mode Function Note

DM 6555 00 to 03 Host link

No procedure
Protocol macro

Port A communications conditions standard format set-
tings
0: Standard settings (initial values)

Start bit: 1 bit, Data length: 7 bits, Parity: even
Stop bit: 2 bits, Baud rate: 9,600bps

01: Set separately → DM 6556: 00 to 15 enabled

04 to 07 Host link

No procedure

1:1 link

CTS control enable/disable settings
0: Without (initial value)
1: With

08 to 11 1:1 link (Master)
NT link (1:N)

Port A 1:1 link area
0: LR00 to 63 (initial value), 1:LR00 to 31, 
2: LR00 to 15

Maximum PT unit number for port A, NT link 1:N
1 to 7 (BCD) (for C200HE: 1 to 3)

Once 1:1 link 
with a Master 
has been set, it 
cannot be 
changed.

12 to 15 All modes Port A mode setting
0: Host link (initial value), 1: No RS-232 procedure
2: 1:1 link for Slave, 3: 1:1 link for Master, 

4:NT link (1:1), 5: NT link (1:N), 6: Protocol macro

DM 6556 00 to 07 Host link

No procedure

Protocol macro

Port A baud rate settings (bps)
00: 1,200 (initial value), 01: 2,400, 02: 4,800, 
03: 9,600, 04: 19,200

Only valid when 
set separately.

08 to 15 Host link
No procedure

Protocol macro

Port A frame format settings
Start bit Data length Stop bit Parity

00: 1 bit 7 bits 1 bit Even (initial value)
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit Without
03: 1 bit 7 bits 2 bits Even
04: 1 bit 7 bits 2 bits Odd
05: 1 bit 7 bits 2 bits Without
06: 1 bit 8 bits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit Without
09: 1 bit 8 bits 2 bits Even
10: 1 bit 8 bits 2 bits Odd
11: 1 bit 8 bits 2 bits Without
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Wiring RS-232C Cable Connectors

Cable Processing (End Connected to FG)
See the diagrams for the lengths required in each set.

1,2,3... 1. Cut the cable to the required length.

2. Peel the sheath using a razor blade without damaging the shield weaving.

3. Remove the shield using scissors.

4. Peel the core wire of each wire using a stripper.

5. Fold back the shield wire.

6. Wrap aluminum foil tape on top of the folded shield.

40 mm (RS-232C)
25 mm (RS-422)

10 mm

5 mm

Aluminum 
foil tape
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Soldering
Solder as described next.

1,2,3... 1. Place a heat-shrinking tube around each wire.

2. Pre-solder each wire and to its connector pin.

3. Solder each wire firmly in place.

4. Move the heat-shrinking tube to the soldered section and shrink the tube by heating it.

Assembling Hood
Assemble the connector hood as shown below.

CS/CJ

Soldering iron

Heat-shrinking tube 
(Internal diameter: 1.5, r=10)

1 mm

Heat-shrinking tube

Connected to FG

Aluminum foil tape

Not connected to FG

Ground plate
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C200HX/HG/HE

Connected to FG

Aluminum foil tape

Not connected to FG
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Revision History

A manual revision code appears as a suffix to the catalog number on the front cover of the manual. 

The following table outlines the changes made to the manual during each revision. Page numbers refer to the
previous version.

Revision code Date Revised content

01 February 1999 Original production

02 April 1999 Pages xi, 2, 5, 24, 25, 38, 114, 268, 333, 339, and 343: Minor corrections which 
include those to the software version, ladder program examples, general wording, 
etc.

03 September 2001 Information on CJ-series PLCs was added and “CS1” was globally changed to “CS” 
or “CS/CJ” as applicable.
Pages xi, xii, 2, 5, 6, 33, 38, 42, 46, 47, 48, 54, 109, 207 to 212, 214, 228, 238, 
255, 256, 260, 262, 270, 281, 283, 284, 287, 288, 298, 299, and 334: Minor correc-
tions and additions (including changes to icon graphics).

04 December 2003 PC was changed to PLC throughout the manual, except where it is referring to a 
personal computer, and information on CS1D PLCs was added. The following 
changes were also made.
Page xi: Updated list of manuals.
Page xii: Updated table.
Page xiv: Added version upgrade summary.
Page 5: Updated table of supported PLCs.
Page 7: Added information on Communications Board for SYSMAC Alpha.
Pages 43, 44: Added Windows operating systems supported by CX-Protocol. 
Page 44: Added new instructions to procedure
Page 45: Added information on installing Windows XP.
Page 106: Added information for CS/CJ-series PLCs and removed Note 2.
Page 107: Added information on CS/CJ-series PLCs to variable format.
Page 111: Changed “fourth” to “third” and “third” to “second” in first example in 
table.
Page 112: Swapped diagrams in last two rows of table at bottom of page.
Page 116: Changed “12” to “15” in the second CRC equation. 
Page 117: Changed MSB diagram and “12” to “15” in CRC algorithm.
Page 287: Added step 5 to procedure.

Cat. No. W344-E1-18

Revision code 
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Revision History
05 February 2005 Page v: Signal word definitions altered. 
Page xi: Models added, W414 deleted, and W425 changed. 
Page xii: Paragraph and table added at top and three pages added after.
Page xiii: Version information added.
Page 5: Version changed in top table, line and “software license agreement” added 
to second table, models and note added to third table, and model versions updated 
in fourth table. 
Page 6: Model number version updated in top table. 
Pages 8 and 35: OS, memory, and hard disk drive specifications updated. 
Page 10: Model versions updated in table. 
Page 23: Model numbers and reference manual added at bottom of page. 
Page 24: “Only” deleted. 
Page 25: Note clarified and reference in first step of procedure corrected. 
Page 26: “SECTION 6” added to procedure 5. 
Page 28: Manual name corrected at bottom of page. 
Page 29: References corrected at top and bottom of page. 
Page 43: Section on installation replaced. 
Page 47: Paragraph added after graphic. 
Page 60: Product added to note. 
Page 64: Reference at bottom of graphic added. 
Page 75: “CS1” changed to “CS/CJ.”
Page 84: Note added. 
Pages 97, 271, 273, 274: “PC” corrected to “PLC.”
Page 129: Model version updated and graphic text corrected at top of page. 
Page 135: “Operation Manual” added. 
Page 168: Mode version updated at bottom of page. 
Page 183: Manual name corrected and manual added at top of page. 
Page 186: “(Only for CS1W-SCB41)” removed from Cause column.
Page 212: Text added at top of page. 
Page 229: Heading changed at top of page. 
Page 248: Section added. 
Page 274: Removed subnote at bottom of page. 
Page 279: Corrected reference in middle of page. 
Pages 280, 283, 287: Replaced graphic. 
Page 285: Corrected step reference in note at top of page. 
Page 286: Deleted step 11 and added text to new step 11. 
Page 356: Corrected reference at bottom of page. 

Revision code Date Revised content
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06 July 2006 The following changes were made.
Page xi: Communications Command Reference Manual Cat. No. changed and CX-
Programmer version updated. 
Page xiii: Table at bottom of page updated. 
Page xvii: Version upgrade information added. 
Pages 2, 56, 57, and 60: Note added. 
Page 5: Version of CX-Protocol updated and PLC models added. 
Page 6: Information added.
Page 9: Information added at top of page and versions updated in illustration at 
bottom of page. 
Page 10: Models added. 
Page 25: Versions updated in illustration at top of page.
Page 26: Section reference added at top of page. 
Page 35: Supported networks and connection with PLCs updated. 
Page 40: Windows versions added and PLC models added. 
Page 41: Illustration added. 
Page 60: Menu item added. 
Pages 63 and 64: Toolbar updated. 
Pages 98, 249, 287, and 336: “/CJ” or “/CP” added. 
Page 124: Information added to note in middle of page. 
Pages 192 and 193: “A” added to “RS-422.” 
Pages 226, 299, 306, 307, 308, 347 and 349: “SYSMAC Alpha” and “” corrected 
to “C200HX/HG/HE.” 
Pages 280, 282, and 342: “CX-Net” changed to “CX-Integrator.” 
Pages 282 and 301: Manual reference changed. 
Page 303: Information added after screen shot. 
Page 321: Reference in callout for first screen shot corrected. 
Pages 342 to 347: Error messages added. 

07 July 2007 Pages xi, xiii, and 45: Updated CX-One version to 2.1.
Page xi and xii: Added model numbers, changed paragraph at top of page, and 
added the CP Series and NSJ Series.
Page xix: Added version upgrade information.
Pages xv and 5: Added CJ-series CPU Unit model numbers.
Page 5: Updated CX-Protocol version to 1.71.
Page 9: Changed description of supported personal computers.
Page 37: Removed rows from table and added note.
Page 42: Added model numbers. 

08 June 2008 Revision and changes associated with upgrade to CX-Protocol version 1.8.

June 2022

09 February 2009 Revision and changes associated with upgrade to CX-Protocol version 1.81.
10 October 2009 Revision and changes associated with upgrade to CX-Protocol version 1.9.
11 December 2009 Revision and changes associated with upgrade to CX-Protocol version 1.91. 
12 February 2010 Revision and changes associated with upgrade to CX-Protocol version 1.92. 
13 July 2011 Revision and changes associated with upgrade to CX-Protocol version 1.93.
14 January 2012 Revision and changes associated with upgrade to CX-Protocol version 1.95.
15 April 2012 Revision and changes associated with upgrade to CX-Protocol version 1.96.
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April 2016 Supported Windows 10

Corrected mistakes.

17 December 2018 Revision and changes associated with upgrade to CX-Protocol version 2.00.
(Supported CS1D-CPU68HA,67HA, 67SA and 44SA)
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